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Preface

Purpose of this IVlanual
The LIBRARIAN/iX Reference Guide provides detailed information on
LIBRARIAN functions, including complete command syntax, and
contains reference material for all LIBRARLAN features.

Information in this guide includes:

� Co m m a nd Syntax andExamples
� Da t a -entry screens

� Re por ts

� Da t asets

Audience
The LIBRARIAN/iX Reference Guide is for operators, programmers, and
other users who have a basic knowledge of LIBR~ V J co n cepts.
Knowledge of basic MPE and/or UNIX concepts and terminology is
required.

How This Guide ls Organized
The LIBRA

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Chapter 5

Chapter 6

Chapter 7

Chapter 8

RIAN/iX Reference Guide contains the following chapters:

"Commands": presents LIBRARIAN commands and their
syntax in detail, together with examples.

(FMAINT) commands.
"Listfile Maintenance Commands": discusses the listfile
m anagement ('LMAINT) tools available with LIBRA& A N .

"SHOWLOG Commands": gives the syntax of
SHOWLOG commands and examples.

"Screens": shows LIBRARU&J data entry screens, and
explains how to use them.

"Reports": describes reports available from LIBRARIAN
and shows samples.

"Macro Control Language": discusses the commands you
can use in XEQ files to implement rnacros.

"MAKE": explains the MJIJCE facility used to
automatically rebuild or recompile changed components of
an application.

"User Fileset Commands": describes the user fileset
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Chapter 9

Chapter 10

Chapter 11

Chapter 12

"Menu Hierarchy": shows LIBRARIAN's hierarchy of
menus and describes menu options.

"Utility Program":explains how to use the LIBRARIAN
Utility p rogram,LI BUTILP.

"Configuration Program": describes the configuration

program, CONFIGP.
"Datasets": describes datasets in the LIBDB and LIBLQG
databases.

Conventions
We use the following conventions throughout this guide.

COMMANDS

KEYWORDS

All commands appear in bold capital letters. If a
command can be abbreviated, the optional portion of the
command is enclosed in brackets ( [ ] ). A blank space
must separate the command from the parameterlist.

Keywords and parameters (shown in bold capital letters)
must be entered exactly as specified

Words or characters in italics represent variables or
arguments that you must replace with an actual value. In
the following example, you must replace fileset with the
name of the file you want to copy

italics

> COPY fileset

Italics are also used to introduce new terminology or for

emphasis.
Enter punctuation exactly as shown. (Refer to specific
instructions for brackets and braces, below.)

Braces endose required elements. When there are several
elements within braces, you must select oneelement. In
the following example, you must select one of
PROCEDURES, PROJECTS, or STEPS.

>HELP PROCEDURES

punctuation

PROJECTS
STEPS

Brackets enclose optional elements. In the following
example, brackets around the letters UPDATE indicate
that you do not have to type the entire word.

>AUTO (UPDATE)
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If there are several elements, you can select any one or
none of thezn. In the following example you can select
BATCH, CONFIRM or MEMO, or none.

>COMPRESS [ filelist ]

[; CONFIRM ]
[; MEMO ]

[; BATCH ]

When brackets are used, you cannot enter a value in the
inner brackets unless you enter a value (wildcard or
literal) in the outer brackets.

An ellipsis indicates that the previous bracketed element
can be repeated or that elements have been omitted.

An ampersand indicates that the command continues on
the next line.

The white flag symbolindicates that the text pertains to
LIBRARIAN running under the MPE operating system.

The gray flag symbol indicates that the text pertains to
LIBRAMAN running under the UNIX operating system.

The striped flag symbolindicates that the feature being
described is only available with LIBRARIAN / iX — Plus.

This symbol identifies LIBRARIAN commands that have
no equivalent under the UMX operating system.

File Naming Conventions

Wildwildcard conventions:

alone, denotes all members of a set.

In specifying fi les, LIBRARI/QU commands use the following

© Z er o o r m ore alphabetic and/or numeric characters. Used

Zero or more alphabetic and/or numeric characters. Used
alone, denotes all znembers of a set.

Single numeric character.

FUUIX

? Sing l e alphabetic or numeric character.

In addition, a slash /, a single period and slash ./, a double period
and slash ../, or a tilde and a slash -/ im m ediately preceding a filename
indicate a UNIX fi le.
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Related Documentation

OCS.
Along with this manual, you can refer to the following documentation by

The LIBRARMN/iX Administrator's Guide contains instructions on how
to set up LIBRAJUAN for your envirorunent.

The LIBRAR1AN/iX User's Guide contains instructions on how to
perform LIBRARIAN functions. It also includes detailed descriptions
of the MAKE facility and the XEQ macro language.

Online help contains the contents of all LIBRARIAN manuals. You
can access online help with the HELP command or pressing Fl (Help)
in menu mode.

Client Services
LIBRARIAN is supported by OCS Client Services, which is dedicated to
providing timely and accurate information and solutions. For fast,
accurate answers, we maintain a telephone hotline that includes
emergency after-hours service. You can count on OCS to isolate any
problems quickly and provide conscientious support and a fast response.

Operations Control Systemshotline numbers:
Phone (415) 493-4122
FAX (415) 493-3393

Your Comments
We value your comments. As we write, revise, and evaluate our
documentation, your opinions are the most important input we receive.
Please use the Reader's Comment F orm at the end of this guide to tell us
what you like and dislike about and of the OCS manuals.
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Commands

This chapter describes LIBRARIAN operations in detail. Topics in this
chapter include:

� Ac c essing LIBRARIAN from MPE

a Ac cessing LIBRARIAN f rom UNIX

� Op t i o ns and Environment Variables for ~

� Men u Mode

� Co n u nand Mode

� On l ine Help

� Ho w to Refer to Files

� Ed i t Masks

� Ba tch Operations

� M em o s

� LI B R ARIAN Commands

Accessing LIBRARIAN from MPE
To access LIBRARIAN from MPE, type:

:LIB

Note You can save the original user function keys by setting an MPE system
variable called LIBSAVEFKEYS to TRUE.

Accessing LIBRARIAN from UNIX
To access LIBRARIAN from UNIX, type:

UNIX(1) ocslib if path is set,

otherwise

UNIX(1) SOCSllBDIR/ocslib

where $OCSLIBDIR is the name of the directory in which the
LIBRARIAN client software is installed.

Options and Environment Variables for UNIX
Table 1 — 1 describes UNIX command line options. Table 1 — 2 lists the
environment variables currently recognized by LIBRARIAN for UNIX.

Commands 1 -1



Table 1-1 Co m m and Line Opfions

Option Arguments

None

Effect

-config

— hpterm

None

None
and line.8x16, if available.

Translates line drawing characters (between ~N and ~O) to
nearesl ASCII equivalents. This isautomaticallydetected
except when the xterm/hpterm and the actual login shell
are running on different machines. This occurs if you are on
a workstation and run xterm on another machine.

Spawn an hpterrn and run ocslib there. Uses fonts hp.Sx16

Modify the ocslib configuration file. This option is re­

-noxlate

stricted to root users.

Overrides the default mode, which tests whether ocslib is
run from an X-terminal. This is primarily used for the
spawned mode to avoid infinitely recursive hpterms.

None

Table 1-2 Environment Variables

Variable

XTERM

Value

Any value

Effect

DISPLAY

Indicates xterm mode, same effect as the -xterm
command-line option.

Used to verify that -hpterm mode is running on an
X server capable of supporting hpterm.

OCSLIB›
SERVER

Name of X-Window
display server (see
X(1))

Name of an MPE
I.IBRARIAN server

When ocslib is invoked, it will use the server name
in the config file. This envirorunent variable can be
used to override the name of the LIBRARIAN
MPE server.

SHELL

LIB›
PRINT

OCSLIB›
DIR

Path to user's default
shell

Path to LIBRARIAN
client software

Options for lp Overrides default for printed output from

Invoked when user selects a shell escape or issues
shell conunands from the LIBRAIUAN client.

Used to determine where the client software is
installed.

LIB­
BATCH

LIB›
PROMPT

Prompt string

Options for at

LIBRARIAN.

Overrides default LIBRARIAN prompt.

Overrides default for jobs crea ted by LIBRAMAN
and launched with at.

1-2 LIB RARIAN/iX Reference Guide



Menu Mode

By default LIBRARIAN operates in menu mode to let you select options
from a set of menus. The main menu consists of a horizontal menu bar
that appears under the "OCS/LIBRARIAN for MPE/iX" (or "UMX")
title bar. This title is displayed at the top of the screen whenever
LIBRARIAN is runrung in menu mode.

To use the menus to issue the commands described in this chapter:

1. Use the right and left arrow keys to highlight the appropriate main
menu bar option.

2. Press ENTER.

3. Use the up and down arrow keys to highlight the desired pull-down
menu option.

4. Press ENTER to select the option.

5. I f required, enter the appropriate information in the dialog window.
You can also specify file revision criteria and options using the
appropriate function keys. Press Go (F7) to proceed with an
operation, or Cancel to close the dialog (F8).

6. Use the F8 function key to return to the preceding menu.

Refer to Chapter 2, "Getting Started" in the LIBRARlAN User's Guide for
detailed information about the menus.

Command Mode
As an alternative to menu mode and for batch mode operation, a
command line interface is also provided. Available commands are
described in this and subsequent chapters.

You can switch between menu and command modes by pressing the F2
function key. You can also put the comxnand MENU OFF in an AUTOXEQ
file to bypass the menus automatically when running LIBRAIGAN.

In addition to LIBRARIAN commands, you can run any of the following:

� MPE o r UMX c ommands

� UNlX scripts

� M PE U D C s

� MPE u ser programs

Commands 1- 3



T here are two ways to run any of the above, without exiting L I B E R I A N :

1. Type a colon (:) at the LIBRARIAN prompt >, and then press
RETURN to break to the MPE/UMX she l l .

For MPE, you can only issue commands that are available in BREAK
mode. Type RESUME to return to LIBRARIAN f rom MPE.

Type exit to return to LIBRARIAN f rom the UNIX shell.

2. Issue a UNIX or MPE command preceded by a colon (:) at the
LIBRARIAN prompt >. The colon is optional if it wil l not be confused
with a LIBRARIAN command.

You can configure the LIBRARIAN p rompt by setting asystemvariable
called LIBPROMPT to the string you want to use as a prompt. For
example:

:SETVAR LIBPROMPT "LIB>"

:export LIBPROMPT = "LIB>"

You can put the SETVAR statement in the LIBRARIAN UDC f i le for the
LIS and LIBSERV commands on the MPE/iX server. Then, each time you
run LIBRAIUAN, the prompt is set automatically.

Background Process on UNiX ClientsUNIX

$ocslib — bg

UNIX users can run a background process to issue LIBRARIAN
commands from a UNIX shell promptor within a script

Since the background process maintains its connection to the server,
LIBRARIAN is ready to accept requests at any time without the overhead
of reconnecting. This capability greatly improves performance.

One use of the background feature is to check out files from MAKE f i les.

Start a background process by entering the following:

To issue LIBRARIAN commands to the background process, use the

followingsyntax:

$ocslib — fg command

where command can be any of the LIBRARIAN commands, except screens
and utilit ies. For security reasons, all requests must be made from the
same terminal (or terminal window ).
To terminate the background process, enter the exit cornrnand, as shown

$ocslib — fg exit

If your command includes delimiters or special characters that the shell

might interpret, you must use a prefix of "K" with these characters, or
enclose the entire command portion in quotations.

below:
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Note The background process inherits its environment from the process you
started from, including the working directory and environment
variables. However, you can change the current directory for the
background process, as shown below:

$ocslib — fg cd directory name

Online Help
Comprehensive online help is available for all LIBRARIAN commands
and their parameters. Use the Fl function key or the kELP command
described in this chapter.

You can also select Help f rom the main menu bar to open the help index,
review the glossary, or get information about the current version of
LIBRARJAN that you are running.

How to Refer fo Files
Most LIBRARIAN commands operate on files, In the syntax description
for these commands, a filelist parameter is included.

The following methods of referring to files are allowed alone or in
combination, unless otherwise noted:

Direct reference
Filename

Logical fileset

Listfile (indirect file of filenames)

Files from the last transaction

Indirect reference
Revision

Version and version count

Generation count

Secondary location

Implied fileset by project
Implied fileset by step
Multiple file references
Exclusions
Subset selecfion

Project

Tag

Modification status

User confirmation

Tracking status
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The following sections describe each of these methods in detail.
Direcf References

Filename
You can directly refer to files by name and location, The syntax for MPE

[system: ] file [.group [.acct J]

where file, group, and acct identify the MPE filename. You can use
wildcards consistent with MPE LISTF conventions. The syntax for UNIX

iS:

iS:

AUIX

FUU IX
[system.] /[path.../] file

where file identifies filename, including- path preceding the fil ename. Use
wildcards consistent with UMX conventions (see "Filenaming
Conventions" in the preface of this guide).

For both MPE and UNIX, system is the naxne of the system where the file
is located. Your current login values are used for omitted elements, except
when performing steps, in which case configured values are used.

By default, LIBRARIAN treats all path references recursively; That is, all
f iles in subdirectories of any directory specified are included when
LIBRARIAN authorizes files. Recursion can be disabled by adding a
suffix of a plus sign followed by a zero (+0) to the file reference.

For example, "/usr/devel /d ' +0" f inds aH files starting with the letter "d"
in the devel directory without including fi les that are in subdirectories
starting with the letter "d."

You can also control the number of levels of recursion, by adding a suffix
of "+n", where "n" is the inaximum number of directory levels to

Logical Fileset
You can directly refer to files in a logical fileset by specifying the fileset
name preceded by a percent sign (%). A logical fileset can be a master
fileset, user fileset, or project fileset.

When a project fileset is specified on a step (see PERFORM command),
LIBRARIAN authorizes the secondary or retained files in the "from"
location of the step that are related to the master files in the project fileset
and associated with the project. The syntax is:

traverse

Xfileset

Listfile (Indirect File)
A listfile is a file that contains a list of filenaines. You can use listfiles as a
way to refer to files in all LIBRARIAN cornrnands. Create listfiles using
the LMAINT module of LIBRARIAN or with the editor of your choice.
You can directly refer to files in a listfile by specifying the listfile name
preceded by an exclamation point (I) or a caret (~), The syntax is:

! filename
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(MPE) or * (UNIX)

Files from the Last Transaction
You can directly refer to files from the last 1ogged transaction by
specifying a star (') or double — star ("). Destination files associated with,
or the files processed in the last logged transaction, are authorized. The
syntax is:

The single or double asterisk refers to the destination files successfully
processed in the last transaction (or frozen with the SET ’ command ).

Note P To use this feature, transaction logging must be enabled on the System
Profile (SP) screen.

indirect References

to specify indirect criteria.

Revision
You can indirectiy refer to revisions of master files by specifying the
master file (s) and a revision ID. The syntax is.

[system: ] file [.group [.acct ]]

[system: ] i[path.../] file

%fileset

In a menu mode file dialog, press the F2 function key (Revision Criteria)

;REV[ISION]=revision-id I ALL
UNIX

The revision ID is in the format VERSION:VCOUNT [.BRANCH. LEAF...],

You can authorize all revisions of a master file when using the SET and
PURGE commands To do this, use the REVISION parameter with the
value of ALL For example,

PURGE MYFILE.PUB LIBRARY;REVISION=ALL

purges all revisions of the files associated with the master file,
MYFILE.PLIB.LIBRARY.

Version and Version Count
You can indirectly refer to versions of master files by specifying the
master file(s) and a version and version count. The syntax is:

versi onid OF

[system: ] file [.group [.acct ]]

[system: ]! [path...f] file

%fileset
[;VCOUNT =versioncount ]

Versionid is the identifier of a version. If the application for the version is
ambiguous, LIBRARIAN prompts for it.

VCOUNT identifies the files with a version count equal to VCOUNT(the
number of times the master file has been revised since the base version
was created). Default: 0 (baseline version).
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AII IX

revision of a file within a version.
A VCOUNT value of LAST causes LIBRARIAN to operate on the last

For example, the following corrunand copies the latest revision of each file
in the 1.0 version to the V100 area:

>COPY 1,0 OF IIoFINANCE TO =.=.V100,'VCOUNT=LAST;OLDNAME

>COPY 1.0 OF %FINANCE TO /apps/gl/v100/(3,");VCOUNT=LAST;OLDNAME

A VCOUNT value of LASTNOTO causes LIBRARIAN to operate on the last
revision of a file within a retained version that is not a base revision. (e.g.
to create a patch tape.)
For example, the following corrunand distributes only those files that
have changed since the base version was distributed:

>COPY RE.1.0 OF %IVIYFILES TO =.=.RELEASE;VCOUNT=LASTNOTO

>COPY RE.1.0 OF %MYFILES TO /apps/gi/release/(3, );VCOUNT=LASTNOTO

Generation CoUnt
You can indirectly refer to generations of a master file by specifying a
master file(s) and a generation count. The syntax is:

@IX

[system: ] file [ group [.acct ]]

[system: ] /[path.. /] file

%fileset

;GCOUNT = [- ] gcount

The GCOUNT parameterdirects LIBRA.'RIAN to operate on files with the
specified generation count (total number of times the master file has been
replaced since its creation). This value can be either a positive or a
negative value.

A negative value describes the generation relative to the current
generation. For example, GCOUNT = -2 specifies files two generations
prior to the current one

1-8 LIB RARIAN/IX Reference Guide



Secondary Location

You can indirectly refer to secondary fi les by specifying the master
filename(s) 'and the general location to search for associated secondaries.
The syntax for MPE is:

%fileset

[system:]file [,group [.acct] ] AT

AT
[system:]file [.group [.acct ]]

When using this syntax, LIBRARIAN operates on secondaries of the
specified master files found in the specified secondary (AT) location, For
example:

refers to all secondary copies of %AP-FILES,

Alternatively, the syntax for UNIX is:

%AP-FILES AT I:O.@.Q

%fileset AT

[system: ] /[path.../] file AT
[system: ] /[path.../] file

When using this syntax, LIBRARIAN operates on secondaries of the
specified master files found in the specified secondary (AT) location. For
example:

refers to all secondary copies of %AP-FILES,

%AP-FILES AT:/ *

Note In a menu mode dialog, enter the "AT" syntax directly in the filelist
f ield, as you would in command mode

Implied Reference by Project

You can implythe files associated with a project when p erforminga step
by specifying the project name, rather than files. The syntax is:

>step. project

Alternatively, you can omit the project name and select your project f rom
the project menu when projects are defined. In menu mode, this is the
only alternative.
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Implied Reference by Step

>step

Multiple File References

If you do not specify any files when performing a step, the step fileset (as
defined on the Step (ST) screen) is used. For example:

If projects are being used, you are presented a menu of projects. By
selecting- a project, you imply the project fileset when no files are
specified.

You can refer to multiple files combining any of the methods described
above, Use commas to create a list of file specifications. The syntax is:

Each filelist is processed by the LIBRARIAN program in a single

fi!elrst (, filelist (, ... j )

transaction.

Exclusions
This method designates files to be excluded from the operation. The
syntax is:

— [system: ] file [.group [.acct ]]

— [system: ] /[path.../] file

— %fileset

When specifying mult iple filelists, specify the exclusion(s) last.
Exdusion(s) must be direct references, with or without wi ldcards Use
commas to separate exclusions.

Subset Selection
Project
Subset selection by project selects only files associated with a particular
project. This parameter must follow all file references, incIuding
destination locations, if specified. PROJECT is valid for all commands.
The syntax is:

filelist; PROJECT= praj

If you use a step to copy files in read — mode (e.g., move — to — production),
LIBRARIAN automatically copies the appropriate revisions of the files
associated with the project that you specify However, if you do not use a
step for file distribution (e.g., COPY), then use the project fileset as well as
the PROJECT parameter.

Tag
Subset selection by tag selects only files that were assigned a specific tag
with the SET TAG command. This parameter must follow all f i le
references incIuding destination locations, if specified. The syntax is:

filelist TAG= tagid
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Modification Status
Subset selection by modification status selects files based upon v "hether
or not they have been modified since LIBRARIAN created them. Use the
MODIFIED or UNMODIFIED parameters to select only those files modified
or not modified since they were last copied or moved by LIBRARIAN.
The current timestamp in the file label is compared with the timestamp in
the LIBRARIAN database. For example:

filelist, MODIFIED

User Confirmation
S ubset selection by user confirmation has LIBRAI~ pr om p t f o r
confirmation of each authorized file prior to processing. Use the
CONFIRM parameter to request prompting. Files not confirmed are
excluded from the operation. For example:

filelist CONFIRM

Tracking Status
Subset selection by tracking status lets you select files being tracked by
LIBRARIAN, excluding those not being tracked. This applies only to ad
hoc commands, such as COPY and PURGE, To include only Files,
untracked files, prefix these commands with "X". For example:

filelist;TRACKED

Edit masks are used to determine the correct destination given a specific
source name. The masks are either defined in the destination of a step, or
specified when performing the step or other file movement command.

Edit masks are also used to specify refinements for step destinations, and
to translate pending production secondary filenames into pending master
filenames. This enables LIBRARIAN to create pending master records

automatically.
There is a one-to-one correspondence between elements of a fully
qualified filename (For MPE, elements aresystem., file, group, and
account. For UNIX, elements aresystem, path components, and
filename.) For each element, the mask can result in carrying forward the
element, replacing the element, or editing the element:

� Elements are carried forward using the equal sign (=), or the at sign
(©) in a step definition, if the user can override the element.

� El e ments are replaced by using a string literal.

� El e ments can be edited using a combination of equal(= ), at (Q~),
question (?), minus ( — ) sign, and literals, as described below,

Edit Masks
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Table 1 — 3 describes the valid edit mask characters for any element of an
MPE or UNIX fi lename,, along with their descriptions and examples.

Table 1-3. Edit Mask Symbols and Descriptions

DescriptionEdit Mask
Character

Minus sign

Question
mark

@ �
At sign/Star

Copies original value into edited version. Typically preceded and/or
followed by other characters. For example, when edited with the edit
mask of ABC@XYZ, the value of FRED results in a value of
ABCFREDXYZ. For MPE filenames, the result is truncated to eight
characters (ABCFREDX).

Copies the character at this posihon into the resulhng string. For
example, the mask?? applied to the string FRED results in the string
FR. The question mark can be combined with literal characters such
as??X, which would result in the string, FRX, or X??, resulting in
XRE. It can also be combined v'ith the minus sign (-).

Indicates that the original character in that position should not be
included in the edited result. For example, the mask -? applied to the
string FRED results in R.Alternatively,the mask ­ = — results in the
string RE An additional feature is the use of "-" in conjunction with
"@", which strips characters from the beginning and /or end of the
original element before adding other characters to the beginning or
end. For example, PRTA100 edited with — — -@S results in A100S,
deleting the first three characters before adding the S:. Note tha t ­ ­

— =S would result in A10S, replacing the last character.

Copies all remaining characters after the minus sign, question mark,
and literal characters have been evaluated. For example, a mask of =X
with the original string FRED results in the string FREX, The mask
=Q? with the initial string FRED results in FRQD.

Equal sign

Edit Masks for UNIX Pathnames
To carry forward, edit, or replace an element that is at the same level in
both the source and destination f i l enames, follow the rules described
above.

Uhllx

Because UNIX pathnaznes can have varying numbers of path elements
(directories), you can edit (or skip) components at varying levels in the
source filename using the following construct:

/(x ( — y] ) [edit — mask)

where x and y represent the desired range of components frown the source
pathname. x and y are numbers from 1 to ', where ' is the last directory
element of the pathname. If you want a specific element, omit y which is
optional.

The optional edit mask is applied to each element in the range (do not
include the brackets).

For example, the mask/(1 — 2)/devel/! USERID/(4 ­ *)/ = applied to the
f ilename /usr/usr2/master/screens/abc results in the fi l ename
/usr/usr2/devel/rnilind/screens/abc.

1-12 LI BRARIAN/iX Reference Guide



You can also use the following wi ldcards in place of x or y:

number of levels in home directory path

number of levels in the current working directory path

one less than the number of levels in the current working
directory path

You can use curly braces, i.e., ( x [ — yi ), to indicate mapping from the
master file name rather than the current secondary file name For
examples, see Chapter 3, "File Transactions" in the LIBRARIAN/iX User's
Guide, and Chapter 4, "File Movement Rules" in the LIBRARIAN/iX
Administrator 's Guide.

Edit Masks for Group and Accounts
You can specify an edit mask that refers to a different element (i.e., file,
group or account). To do this, use the following syntax in your edit mask:

F
G star t : length
A

where F is for filename, G is for group name, and A is for account name.
Start is the starting position, and length is the number of characters to be

Theexamplebelow shows an edit mask that. creates a group name using

used.

the first three characters of the filename:

Source:
Edit:
Destination:

ABC100S.PSOURCE
PRG??? .P(F:1:3) OBJ
PRG100.PABCOBJ

Batch Operations
When you use the BATCH parameter under MPE, LIBRARIAN p rompts
you for a! JOB command and MPE:STREAM options. All job parameters,
such as INPRI, PRI, OUTCLASS, STREAM, AT, and DATE are supported.

If the OCS-ENABLED flag is set to Y on the System Profile (SP) screen, the
EXPRESS SUBMIT facility is invoked enabling you to schedule the
transaction. If the flag is set to N, you are prompted to supply the login
values and MPE:STREAM options for the transaction job before it is

When you use the BATCH parameter under ~, L IBRA R I AN l aunches
jobs using the UNIX at command. LIBRARIAN prompts you for at
options, or you can set the environment variable, LIBBATCH, to provide
these options.

streamed.
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Memos
A memo is text that describes the current transaction in the audit trail .
Use the MEMO parameter to include a memo. To create one — line memos
up to 72 characters, enter the memo text on the command line as a value
for the MEMO parameter (i.e, MEMO = memo — text) . For multi- l ine
memos, do not specify the text on the command line and LIBRARIAN
will invoke the configured editor; by default, EDITOR/3000 on MPE, or vI
on UNIX. You can review and modify the text through SHOWLOG.
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LIBRARIAN Commands
There are five types of LIBRARIAN operations:

Steps

Other achvit ies

Information displays

Ad hoc file operations

PERFORM command.

Execute defined file movements or approvals,
Step operation is described under the

Execute a full rang e of file transactions. File
system security is enforced for fi les not
tracked by LIBRARIAN, (X capability can be
assigned to override this security).

Show file data, source code comparisons, and
transaction logs.

User identification, utili t ies, and work
environment setup.

Execute ad hoc file operations only on files
not tracked by LIBRARIAN, by prefixing the
command v ith X in cornrnand mode.

X coznrnands

Note In all cases, XSCAN, XPRINT, XLCOMPARE, and XSCOM PARE operate on
both tracked and untracked files.

LIBRAIGAN permits access to the five types of commands at three levels,

Ad hoc file
operations

Operations on Any file

Any file

as summarized in Table 1 — 4.

Table 1-4. Command Access Restrictions

Command Type UBR A RIAN Manager Ap p l ication Manager Generat Users

PERFORM (step) Fi l es covered by a Files covered by a
defined step defined step for

own applications

Any file in os
applications

MPE security

Files they own

Must have specific
authorization

MPE security
untracked files

Information
displays

Other activities

Any file

All activities

enforced

Any file

Restricted

enforced

Anv file

Restricted

Table 1 — 5 below lists the LIBRARIAN corrunands, their functions and
page references to help you locate detailed descriptions.

Commands can be abbreviated to the least number of characters that
make it unambiguous. A menu is provided if the command is ambiguous.
Brackets indicate the shortest allowed abbreviations for each command.
The part of the command in brackets may be omitted.

C ommands 1- 1 5



Table 1-5, LIBRARIAN Commands Summary
Command Name Funct ion

Step Operation

[ PE[RFORM] ]

Rle Operations

COMPR[ESS] "

COP[Y] *

DE[COMPRESS] *

LCOMPA [RE] *

Executes predefined steps.

Packs files into a smaller space.

Copies files to a new location.

Decompresses files.

Shows differences between tex t hles,

Places files on hold.

Moves files to a new location.

Disables tracking of read-mode secondary files.

Replaces a file's contents with another file.

Transfers files to a PC.

Transfers files from a PC.

Prints files.

Deletes files from the system.
Removes MPE security from a file.

Page

1-22

I — 26

I — 31

1-46

1-52

I — 53

1-61

1&2

1-64

1-65

1-76

1-81

1-88

1-90

1-94

I — 96

I — 99

LOCK

MO[VE] *

OR[PHAN]

OV[ERLAY]

PCR[ECEIVE]

PCS [EiND]

PR [INT]

PU[RGE] "

REL[EASE] t

REN[AME] *

RESET (or **)

RESiET (EXCEPTION)

RESET
(TIME STAMP)

REST[ORE]

SCA[N]

SCO[MPARE] t

SEC[URE] t

SET*(or ** )

SET (EXPDATE)

SET (LANGUAGE)

SET (LOCKWORD) t

SET (MODE)

SET (OWNER)

SET (TAG)

refer to in future transactions.

Renames files.

Releases asterisk (') last transaction reference.

Removes exception flag on a file.

Replaces file timestamp in database with
tirnestamp from file label.

Restores retained files.

Scans/replaces text in a file.

Accesses the S/COMPARE utility.

Restores MPE security to a file.

Freezes the transaction fileset that asterisk (') will

Changes a file's expiration date.

Allows you to assign a programminglanguage,
used when annotahng source code.

Assigns a new lockword to a file.

Changes access mode of a secondary file.

Changes the file owner.

Assigns a user-defined tag to a file or group of

1-121

I — 122

1-124

1-128

]-118

1-120

1-101

1-105

I — 109

1 — 113

I — 115

1-66

files.

Continuect
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Table 1-5. LIBRARIAN Commands Summary (continued)

Command Name
Fife Operations (continued)

T[OUCH] t

Function

Updates the MPE file modihcahon tirnestamp with 1-131

Page

UN [LOCK]

UP [DATE]

current date and time.

Releases locked hles.

Updates read-mode secondaries with current

1-133

1-134
master.

VERSION

Information

H[ELP] or?

ME[MO] or MAIL

SH [OWLOG]

V[ERIFY]

Other Activities

AC[TIVATE] t

AL [LOW]

trail.

Dehnes, makes obsolete, and deletes versions.

Activates a suspended process.

Temporarily gives current user capabibties of

Runs Auto Fileset Update (AUTOUPDP) utility.

Purges records from LIBDB tracking database.

Provides comprehensive online help.

Sends a message to a particular user or to audit

Invokes SHOWLOG utility from LIBRARIAN.

Shows informa tion about files and versions.

1-43

1-55

1-130

I — 138

AU [TOUP DATE]

CLE [AND B]

CLO[SE]

CONNECTt

DO

ED[IT] t

EX[IT] or Q[UI+
FLUSH

FLUSHL[OG]

FM [AINT]

K[ILL] t

[LIBSCR[EEN] ]

LISP REDO]

LM [AINT]

MA[KE] t

PRO[JECT] t

another user.

1-19

I — 20

Terminates a remote link.

Opens connection to a remote system.

Repeats execution of the last command.

Accesses configured editor to edit a file.

Terminates an active LIBRARIAN session.

Runs the FLUSH utility.

Runs the FLUSHLOG utility.

Accesses the FMAINT user hleset module.

Terrnina tes a suspended process.

Accesses LIBRARIAN screens.

Lists the contents of LIBRARIAN command stack.

Accesses the listfile maintenance module.

Runs the MAKE utility.

Maintains the project definitions, status, and user
authorizaiion informahon for the project.

Sets promptand display level for the current
LIBRARIAN session.

Edits previous command entry.

I 2

1-39

1-40

I — 21

I — 23

I — 24

I — 27

1-37

QUIET

RED [0]

I — 83

I — 49

'I — 50

I — 51

I — 53

I — 79

1-159

1-86

Continued
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Table 1-5. LIBRARIAN CorTimands Summary (continued)

Command Name Func t ion
Other Activities (continued)

Page

R1 or R7

RED [0]

RESET
(AP PLI GATI OiN)

RESET (PROJECT)

RESET (ROUTE)

RET[RY]

SET (APPLICATION)

SET (PROJECT)

SET (PROCEDURE)

SET (ROUTE)

US[ER]

X[EQ]

t MPE only

An X version of this command is available.

are not accessible,

Executes Reflection commands within
LIBRARIAN.

Edits previous command entry.

Resets an applicaflon set with SET APPLICATION.

Resets a project set with SET PROJECT.

Resets a route set with SET ROUTE.

Sets number of times to retry remote systemsthat

Sets the application a user is currently working on.

Sets the project a user is currently working on.

Instructs LIBRARIAN to catalog aU procedures in a
m acro or procedure file.

Sets the route a user is currently working on.

1-86

1-9S

1-127

1 — 136

1 — 161

1-117

1-126

1-125

1-98

1 — 104

Establishes the current user.

Executes a macro.

information:
Restrictions

Menu Mode

Command Mode
Syntax
Parameters

Operation

Examples

Related Information

the command.

The fo]lowing pages contain descriptions of all the commands, in
alphabetical order. Each command description inc]udes the following

Minimum user capability necessary to execute

How to perform the operation f rom menu
mode (if applicable).
How the command is entered from the
command line.

Detailed descriptions of each command
parameter
Basic function and detailed descriptions of the

Examples of how to use the command
Locations of related i nformation

cornrnand

The following commands wil l also be covered in other chapters in more

FO N T co m m ands are used to define and maintain user filesets, as
described separately in Chapter 2, "User Fileset Commands".

LMAINT commands are used to create and maintain indirect files, as
covered in Chapter 3, "Listfile Maintenance Commands".
SHOWLOG commands, used to generate custom log reports, as
explained in Chapter 4, "SHOWLOG Commands".

detail:
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ACTIVATE
Activates a suspended process.

Restrictions
None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use ACTIVATE as
described below.

Command Mode Syntax

>ACTIVATE] [ PIN ]

Parameters
PIN A process ID number.

Operation
ACTIVATE allows you to activate any suspended process created with the RUN command. To
select a process to be activated, you must know its process ID number. If you enter
ACTIVATE without the parameter,LIBRARIAN sho~s you the current processes and their
corresponding process ID numbers.

Examples
Activate process number 93 by typing:

>ACTIVATE 93

If you do not know what processes are nmning or the ID number of the process, type:

>ACTIVATE

Related information

See KILL
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ALLOW
Temporarily gives the current user the capabilities of another user. Used in secure macro
files.

Restrictions
None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use ALLOW as described
below.

Command Mode Syntax
>AL[LOW] [useri d:password]

Parameters
userid

password

Name of user whose capabilities are allowed.

Password for user whose capabilities are allowed.

Note All LIBRARIAN user IDs and passwords are case-sensitive.

Operation
ALLOW lets you exercise another user's capabiIities. These capabilities will remain in effect
until you turn them off by invoking ALLOW without parameters.

Typically, ALLOW is used in a macro, where NOHELP and NOBREAK are set so that the
user's password cannot be seen.

Examples
In the following secure macro, the hrst ALLOW command temporarily grants the user Paul
the capabilities of Derek. The second ALLOW (without parameters) restores Paul's
capabilities

OPTION FILES, NOHELP, NOBREAK
USER PAUL
ALLOW DEREK:PASS
SET %%[] MODE=WRITE
ALLOW

Related Information
See XEQ

Chapter 9, "Macros" in the LIBRARIAN/iX User's Guide
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AUTOUP DATE
Runs the Auto Fileset Update (AUTOUPDP) utility which adds files to filesets based on auto
fileset descriptors.

Restrictions

LIBRAIDAN Manager

Menu Mode
Select the Autoupdate option from the Admin menu.

Command Mode Syntax
> AU tTOUPDATE]

Parameters
None

Operation
AUTOUPDATE invokes the Auto Fileset Update (AUTOUPDP) utility. LIB1VVGAN p rompts
you to choose an automatic update of one of the following:

1. Application (program prompts for an application)

2. F i leset (program prompts for a fileset name)

3. Al l f i lesets in all applications

The Auto Fileset Update utility determines which files belong to which filesets based on
automatic fileset descriptors that you defined. It then adds any files found which are not
presently members of the appropriate filesets. You can review the automatic fileset
descriptors on the Auto Fileset Explosion Report (RAF10) and the Automatic Filesets (AF)

You can add files individually to fi lesets using the Files in Filesets (FF) screen.

Examples
Invoke the Auto Fileset Update util ity by typing:

screen.

>AUTO

Related Information

See Auto Filesets (AF) Screens in Chapter 5, "Screens"

Chapter 3, "Master Library" in the LIBRARIAN/iX Administrator's Guide
Auto Fileset Explosion Report (R M10) in Chapter 6, "Reports"
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CHEC J|lDB
Monitors LIBRARIAN da tabase capacities.

Restrictions
None

Menu Mode
None

Command Mode Syntax
>CHECKDB threshold

Parameters
threshold An op ti on a l threshold for checking percentage full, expressed as a whole

Operation
CHECKDS allows you to check LIBDB and LIBLOG dataset capacities from within
LIBRARIAN. CHECKDB is available as a command f rom the LIBRARIAN prompt.

You can send the output of CHECKDB as mail to a user using the LIBRARIAN MAIL
command with the CHECKDB parameter.
Example
Display all datasets that are at least percent full:

number between 0 and 100. The default is 90.

> CHECKDB 80

M-USER of dataset LlBDB,PUB.LIBDOC is 85% full.
D-USER — CAPS of dataset LIBDB.PUB.UBDOC is 82% full.

Related Information
See the MAIL command,
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CLEANDB
Purges records from the LIBRARIAN database for files that no longer exist on disk.

Restrictions
LIBRAMAN Manager

Menu Mode

Select the Cleandb option from the Admin menu. A dialog appears allowing you to specify
files, revision criteria, and options.

Command Mode Syntax
> CLE[ANDB] fiielist

[; EXTERNAL ]

Parameters
filelist A list of files, as described in How to Refer to Files at the beginning of this

chapter. You are not allowed to refer to files that contain wiIdcards (e.g., @, ¹,
', or?).

Input to CLEANDB can also be the listfile, LISTFX10, created by the RFX10
exception report program.

A llows you to delete tracking for fi les on systems not ruruung LIBRAMAN ,EXTERNAL

Operation
CLEANDB allows you to delete tracking records for files that were purged from disk by
some means other than through LIBRARIAN; for example, via MPE's PURGE command or
UNIX rm command.

Note When you use CLEANDB to remove the last master, related secondary,
or retained file, the master filename will automatically be removed
from the project fileset.

Examples
Clean up nonexistent files reported by the RFX10 exception report by typing:

> CLEANDB! LISTFX10

Related Information
See File Exceptions Report (RFX10) in Chapter 6, "Reports"
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CLOSE
Terzninates a remote link that was opened duzing the current LIBRARIAN session.

Restrictions
None

Menu Mode
Not available in menu znode Press F2 for command mode and then use CLOSE as described

Command Mode Syntax

below.

> CLO[SE] system

Parameters
system The link to be terzninated. Use the same system name as was used to establish

the link,

Operation
CLOSE terzninates a remote link that was opened during the current session by
LIBRAjUAN. The reznote session is not terzninated if it was established by the user prior to

Since there is a limit on the number of links that can be established during one LIBRARIAN
session (currently set at 22 ), or if you are using a dial up, you can use the CLOSE cozzun.md
to provide space for new links (or free up the telephone line) by terminating those that are
no longer required.

Examples
Terminate a remote link with the system name of DST068 by typing:

the current LIBRARIAN session.

>CLOSE DST068

1-2I LI BRARIAN/IX Reference Guide



COMPRESS (XCOMPRESS)
Packs 6les into a smaller space.

Restrictions
File Ovmer for tracked files; read/wr i te access for untracked files.

Menu Mode

Select the Compressoption from the Tools menu. A dialog appears allowing you to specify
files, revision criteria, and options.

Command Mode Syntax
>COMPR[ESS] filelist

[; BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
fileiist

BATCH

A list of files, as described in How to Refer to Files at the begiruung
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include corrunents describing the current transaction I f
you do not specify memo text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
COMPRESS packs files to save disk space. Savings vary according to file type, but generally
range from 60 to 90 percent for source or data files. Compressed MPE files are assigned a
special filecode of 1012 (or -1012 if the file is privileged). ~ u ses adapt ive Lernpel-Ziv
coding, via the UNIX compress command. Transactions are logged.

XCOMPRESS operates on untracked files only and enforces normal file system security,
unless the user has X capability.

Examples

Compress all source files in the library by typing:

> COMPRESS C f.SOURCE.MFG

lf lx > COMPRESS /library/mfg/source/'

Compressversion REL2.0 of the MFG-FILES fileset by typing:

) COMPRESS REL2.0 OF %MFG-FILES
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COMPRESS (XCOMPRESS) (continued)

Examples, continued

Compressall of the files in batch mode v;ith names ending in DB or names that use DB
followed by two digits by typing:

> COMPRESS @DB.@.@, @DB¹¹ .@.(R;BATCH

>COMPRESS /*/db, /*/ db[0 — 9] [0-9];BATCH

Related Information
See Chapter 3, "File Transactions" in the LIBRARIAN/iX User's Guide.

UNIX
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CONNECT
Connects to a remote systemas defined in the Network Configuration (NC), Systems (SY),
and System-to-System (SS) screens.

Restrictions
LIBRARIAN Manager or Operator

Menu Mode
Not available in menu mode. Press F2 for command mode and then use CONNECT as
described below.

Command Mode Syntax
oCONNECT system [;NOLOGON ]

[;NORPM ]
[;NOQUIET ]

Parameters

system

NOLOGON Open s the DSLINE only. Do not log on to the remote system.

The LIBRARIAN system name.

NORPM

NOQUIET

Performs the remote login as configured, but does not initiate remote process
management (interprocess communication).

Instructs LIBRAMAN not to use the QUIET option when opening the
DSLINE.

Operation
CONNECT is typically used in a macro to connect to a remote systemusing the NORPM
option. This option allows network activities such as DSCOPY (used by the
INSTMPEC.INSTALL macro to connect to remote systems to install the LIBRARIAN product).
The benefit from using CONNECT is that it uses the LIB&QQAN network con6guration and
overrides information. Additionally, the RETRY corrunand can be used in conjunction with
CONNECT.

Examples
The following example connects to a remote system called JUlVSLE without logging in and
omitting the QUIET option when opening the DSLINE:

> CONNECT JUMBLE; NOLOGON; NOQUI ET

CONNECTING TO REMOTE SYSTEM JUMBLE...OK
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CONNECT (continued)

Related Information

See XEQ
RETRY

in Chapter 5, "Screens"
Network Configuration (NC), Systems (SY), and System-to-System (SS) screens

If you are running UNIX, see the rlogin manual page for equivalent functionality.
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COPY (XCOPY)
Copies files to a new location.

Restrictions
File owner for tracked files; read access for untracked files.

Menu Mode
Select the Copy option from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command Mode Syntax
> COP[Y] filelist [ TO tolocation ] [,filelist [ TO tolocati on j ... ]

[; ANNOTATE [ = NODELETE ] ]
[; APPEND ]
[; BATCH ]
[; COMPRESS ]
[; CREATE [ = GROUP ][,ACCOUNT][,CREATOR ] ]
[; CREATOR = creator ]
[; DECOMPRESS ]
[; GROUP = vnixgrovp ]
[; KEEP ]
[;LOG KWORD = lockword ]
[; MEMO [ = memo — text ] ]
[,’OLDDATE ]
[;ORPHAN]
[; PERMISSIONS = vnixpermissions ]
[; RENUMBER ]
[;RESET ]
[; VERIFY ]

Not available with xcopY

Parameters
filelist A list of files, as described in How to Refer to Files at the beginning

of this chapter.

The destination location for the filelist. The syntax is:TO tolocation

TO [system: ] file [.grovp [,acct ]]

TO [system: ] /[path.../] file

The equal sign ( = ) wildcard can be entered in any fi lename
element, It takes the same value as the corresponding element in
the filelist (source file), Also, a single at sign (©) can be used. It has
the same meaning as the equal sign (=) wildcard. The tolocation
can also be an Edit Mask, as described earlier in this chapter.

If tolocation is omitted, your current login location is assumed.
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COPY (continued)

Parameters, continued
ANNOTATE Creates an annotated copy of source code based on the delta file,

showing lines that were inserted and deleted for each revision,
including date/ t ime, user, and project, Annotation appears as
commented code appropriate f’ or the progra~g language set
for the file (see SET LANGUAGE command).

If you attempt to ANNOTATE files for which deltas are not being
stored, LIBRARIAN wi l l notify you that a violation has occurred.

NODELETE Sh o w s only insertions. Deleted linesnormally
appear as cornrnented text but are not shown when
the NODELETE option is specified.

APPEND

UNIX C R EATE

BATCH

COMPRESS

M E CREATE =GROUP,
ACCOUNT, and/or
CREATOR

exist.

exceeds the file LIMIT.

Appends data from the source file to the end of the destination
file, if it exists. In MPE, an error occurs if the EOF plus new data

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Compresses the new destination file(s).

Makes any directories on the destination path that do not already

Creates MPE group, account, and/or creator if it does not exist.
If none of GROUP, ACCOUNT, or CREATOR is specified,
all will be created if necessary.

H — P's Security Monitor product enables system managers to
prevent the creation of users, groups, or accounts without
passwords. If CREATE is specified and this Security Monitor
feature is in use, users will receive the error message "Password
required for user".

Note

CREATOR = creator Overrides the MPE creator/UNIX owner of the new file, For MPE,
i t can be a specific MPE user. For UNIX, it can be a specific UNIX
user login, or decimal user ID found in /etc/passwd. Alternatively,
you can use one of the following.

! USER!D

! LOGON

!KEEP

Uses current LIBRARIAN user.

Uses MPE current login user.

Uses MPE creator/UNIX owner of the file
being replaced.

Note All LIBRARIAN user IDs are case-sensitive.

1-30 LI BRARIAN/IX Reference Guide



COPY (continued)
Parameters, continued
DECOMPRESS

r

KEEP

ORPHAN

OLD DATE

u tx GROUP = unixgroup

M E LOCKWORD =/ockword

MEIVIO = memo — text

KEEP overrides both of' these defaults.

dates of the destination file to be the same as the from file.

Decornpresses the new destination file if the source file is
compressed,

Changes the group ID of the new destination file. It can be a
specific UNIX group name or decimal group ID found in
!etcigroup.

Indicates not to copy a file if the destination file already exists.
When using batch mode or QUIET ON, the default is to purge
existing destination files. Otherwise, the default is to prompt,

Assigns the given lockword to the destination file. You can specify
! KEEP as the lockword, which instructs LIBRARIAN to use the
lockword from the old destination file.

Lets you include comments describing the current transaction, If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

Leaves timestamp in database as is and sets the create and modify
Creates files that are not tracked by LIBRARIAN.

Changes the permissions of the new destination file
according to the unixpermissions mode, which is a number
constructed from the following mode bits:

UNtx PERMISSIONS =

unixpermissions

0400 read by owner
0200 write by owner
0100 execute/search by owner

0040 read by group
0020 write by group
0010 execute/search by group

0004 read by others
0002 write by others
000t execute/search by others

r rex r sr x

user g roup

M b RENUMBER

others

RESET

Renumbers a numbered file when reconstructed frozn a delta file.

Resets the modification timestamp in the database after the copy
has been completed. Generally used with the MODIFIED
parameter.

Identifies files that have been modified by comparingthe
modification timestamp in the file label with the tirnestamp stored
when it was last created by LIBRARIAN. If the file has been
modified since it was moved into its current location, the file is not
copied (violation).

VERIFY
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COPY (continved)

Operation
COPY copies any type of file currently tracked by LIBRARIAN, indud ing masters, retained
masters, secondaries, and retained secondaries. The new destination files are owned by the
user who copied them and have read-mode access.

For files not tracked by LIBRARIAN, normal file security is applied.

The new destination files are always secondary files unless they were copied f rom retained
masters/secondaries or were untracked files to begin with. LIBRARIAN normally tracks
secondary files, unless you use the ORPHAN parameter. For security reasons, COPY does not
replace a file currently tracked by LIBRARIAN, instead, use the OVER(AY command or a
defined step.

If' a version or revision is specified, the original name of the retained file is used in the new

XCOPY operates on untracked files only and enforces normal file system security, unless the
user has X capability.

Examples
Copy all secondary files of the FINANCE fi leset that currently reside in a particular
development location:

destination location.

> COPY ’/ FINANCE AT @.@.FINDEVEL

> COPY %FINANCE AT /vsr/findevel/bin/*

Copy all of the current and retained master fi les in version REL1.0 of the FINANCE fi leset to
another location with the same filename:

>COPY RELY.0 OF %FINANCE TO =.=.=.PAYR

> COPY REL1.0 OF %finance TO /apps/payroll

Copy the finance source files on system SYS68 to files of the same name in your current
logon:

UNIX

>COPY SYS68:@.SOURCE. FINANCE TO = . =

> COPY sys68:/vsr/findevel/src/ TO,/ =

From your login, copy all fi les ending in E to files of the same name in one location, and
then copy all fi les ending in J or S to files of the same name to another location:

> COPY @E TO =.EXE, @J, @S TO =.SOURCE

>COPY *e TO ../bin/ = *j,*s TO . ./src/ =
UNIX
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COPY (continued)
Examples, continued
Copy master files to your login. Exclude all retained files and all files modified since they
were moved to their current location. If a destination file of that name exists, abort the copy.

> COPY @.SOURCE. MASTER TO =,-G¹ ¹ ¹ ¹ ¹ ¹ ¹ .SOU R C E;VERIFY;KEEP

> COPY master/src/* TO src/ = , — master/src/.g???????

Related Information
See OVERLAY

UPDATE
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DECOMPRESS (XDECOMPRESS)
Decompresses files that were compressed using the COMPRESS command, the COMPRESS
parameter, or a step.

Restrictions
File Owner; read/wr i te access for untracked files,

Menu Mode
Select the Decompress option from the Tools menu. A dialog appears allowing you to
specify files, revision criteria, and options.

Command Mode Syntax
>DE[COMPRESS] filelist

[;BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
filelist

BATCH

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify rnerno text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
DECOMPRESS restores files to the state they were in before being compressed.
XDECOMPRESS operates on untracked files only and enforces normal file system security,
unless the user has X capability.

Examples
Decompress all files in the SOURCE group of your login account by typing:

> DECOMPRESS @.SOURCE

Decompress retained version REL2.0 of the MFG-FILES fileset by typing:

> DECOMPRESS REL2.0 OF %MFG-FILES
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DECOMPRESS (XDECOMPRESS) (continued)

Examples, continued
Decompress the files on the current system with names ending in DB or names that use DB
followed by two digits in batch by typing:

>DECOMPRESS NDB.@.@, IDB¹ ¹ . @.@;BATCH

> DECOMPRESS /*/*db/*,/"cib[0 — 9] [0 — 9];BATCH

Related Information
UNIX

See COMPRESS
Chapter 3, "File Transactions" in the LlBRARIAN/iX User's Guide
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DELETE
Deletes an application and all associated steps and file tracking records.

Restrictions
LIBRARIAN Manager

Menu Mode
Not available in menu mode. Press F2 for command mode and then use DELETE as
described below.

Command Mode Syntax
> DELETE appl-id

Parameters
appl-id Application ID of application to be deleted.

Operation
DELETE deletes all application-related routes, steps, and file tracking. You are prompted to

Examples

confirm the deletion.

) DELETE MFG

Related Information
See Applications (AP) screen

1-36 LI B RARIAN/IX Reference Guide



DO
Repeats the execution of a command saved in the LIBRARIAN command stack,

Restrictions
None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use DO as described
below

Command Mode Syntax
>DO [ cmdid ]

Parameters
cmdid Corrunand to re-execute. You can specify one of the following.

The nth command before the most current one, where n is a number in
the comrr~ d l i ne stack relative to most recent command, which is -1.

Number m in the cornrnand line stack. The number m is absolute (not
relative).

string Mo st recent command beginning with the text string.

If you do not speci& a value after the command, LIBRARIAN re-executes the
previous cornrnand (i,e., the default is -1).

Operation
Use DO to execute a command again.

Examples
Repeat the previous command by typing:

>DO

Repeat cornrnand 20 by typing:

>DO 20

Related Information

See LlSTREDO
REDO
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Accesses the editor of your choice to edit a file.

Restrictions

None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use EDIT as described

Command Mode Syntax

below.

>ED[I17 I filename j

Parameters
filename Name of the file you want to edit. This is only valid if your editor can accept

a filename passed via the INFO string.

Operation
EDIT invokes the editor specified in the LIBRARIAN configuration file. You can override the
default editor by issuing a file equation or setting the system variable LIBEDITOR. For
example,

: SETVAR LIBEDITOR "QEDIT PUB.ROBELLE"

Examples
Edit the file RPT100S using QEDIT, where QEDIT is the default editor by typing:

> EDIT RPT100S

Related Information

See Chapter 3, "File Transactions" in the LIBRARIAN/iX User's Guide

UNix If you are running UNIX, see the vi and ex manual entries for equivalent functionality.
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EXIT (or QUIT)
Terminates an active LIBRARIAN session.

Restrictions
None

Menu Mode
Select the Exit option from the File menu or press the F8 (Exit) function key.

Command Mode Syntax
>EX[IT] or Q[UITj

Parameters
None

Operation
EXIT (or QUIT) terminates the current LIBRARIAN session. Remote sessions initiated by
LIBRARIAN are terminated. Remote sessions that you initiated prior to invoking
LIBRARIAN are left as they w ere.

Examples
Exit the LIBEVVGAN program and return to the MPE or UNIX shell by typing:

) EXIT
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FLUSH
Runs the FLUSH utility to purge expired retained and secondary files.

Restrictions
LIBERIAN Manager or Operator

Menu Mode
Select the Flush option from the Admin menu.

Command Mode Syntax
>FLUSH

Parameters
None

expiration dates using the SET EXPDATE command.

Operation
FLUSH purges read — mode secondaries that have expired. Expiration dates for read — mode
secondaries are determined by the policy of the steps that create thezn. You can also assign

FLUSH also purges retained masters and secondaries, based on the following criteria:

� The System Profile (SP) Flush Policy allows the LIBRARIAN Manager to specify the
minimum number of retained revisions to keep, even when the retained files have
expired. If you are using branching, this number reflects the number of branches off the
trunk revisions that you want to keep. Any related branch revisions are also kept.

� FLUSH will only purge retained files which have reached their expiration dates, and are
not protected by the Flush Policy described above. Expiration dates for retained files are
determined by the Safety Retention Policy for the steps that create these files. You can use
the SET EXPDATE command to set the expiration date on retained revisions.

� Retained master files that have a Version Count (VCOUNT) of 0 are never purged, unless
the version baseline to which the revision belongs is obsolete. Vse the VERSION command

To review the files that FLUSH is ready to purge, run the RFN10 and/or RFN20 reports.

Examples
Invoke the FLUSH uti l ity by typing;

to make a version obsolete.

>FLUSH

Related Information
See Chapter 7, "Versions" in the LIBRAIUAN/iX Administrator's Guide and Pre — Flush
Notification Reports (RFN10/RFN20) in Chapter6, "Reports"
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FLUSHLOG
Runs the FLUSHLOG uti l ity v hich flushes log records older than the number of days
specified in the SystemProfile (SP) screen.

Restrictions

LIBRARIAN Manager or Operator

Menu Mode
Select the Hushlog option from the Admin menu.

Command Mode Syntax
> FLUSHL[OG]

Parameters
None

Operation
The System Profile (SP) Log Records Aging Policy determines the transactions to be flushed
from the audit trail. FLUSHLOG purges records for transactions older than the number of
days specified in the policy. Transactions associated with projects, however, are exceptions.
FLUSHLOG will only purge transactions associated with projects, when the project status is
FLUSH PENDING, You can change the project status on the PS screen.

You can also use SHOWLOG to selectively flush transactions.

Examples
Purge all log transaction records by typing:

>FLUSHLOG

Related Information
See System Profile (SP) screen in Chapter 5, "Screens"

Appendix D, "Customizing System Parameters" in the LIBRAIUAN/iX
Administrator's Guide
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FMAINT
Accesses the user fileset maintenance (FMAINT) uti l i ty.

Restrictions
None

Menu Mode
Select User Filesets from the Tools menu. A menu appears listing FMAINT operations.

Command Mode Syntax
> FM [AINT]

Parameters
None

Operation
FMAINT accesses the user fileset module that consists of separate commands to allow users
to create and maintain f i lesets for their own use. User filesets are convenient and easy to use
because they allow you to group files according to your needs.

Once invoked, the FlvlAINT module signals its active status with a FM > prompt, and only
FMAINT commands are processed,

Examples
Access the user fileset module by typing:

> FMAINT

Related Information
See Chapter 2, "User Fileset Commands"

Chapter 6, "User Filesets" in the LIBRARIAN/iX User's Guide
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HELP
Accesses online help for information about LIBRARIAN commands, about the steps you can

perform,about a specific step, or about projects you are authorized to v ork on,

Restrictions
None

Menu Mode

For context sensitive help, press FI. For general help, select the Help option from the menu
bar. Another menu appears with a variety of help options.

Command Mode Syntax
command [ option ]
PROCEDURES
PROJECTS
STEPS
step [.route [.appi] ]

>H[ELP]

macro — name

Parameters
command

appi

option

PROJECTS

STEPS

step

route

PROCEDURES
PROCEDUREcommand

Any LIBRARIAN command name. If omitted, a brief description of
LIBRARIAN appears with a list of commands.

Type of help you want to access for a command. Use one of the following
option keywords

PARMS Describes command parameters.

OPERATION Descr i b es operation of the command.

EXAMPLE Displays an example of the command.
ALL Displays all information for the command.

If you do not specify an option, LIBRARIAN displays the command
syntax.

Shows names of all procedures that were made available with the SET

Lists authorized projects for the current LIBRARIAN user.

Lists authorized steps for the current LIBRARIAN user.

The step for which you want in formation.

Route associated with the step. If LIBRARIPW cannot identify the route,
it displays a list of steps from which you can choose.

Application associated with the step. If LIBRARIAN cannot identify the
application, it displays a list of steps from which you can choose.

Displays corresponding macro/procedure help if it exists; otherwise, it
displays the contents of the macro.

macro — name
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HELP (continued)

Operation
The LIBRA&A N on l ine help module is window — based to let you scroll through the help
text for a particular topic. The F1 function key opens the help index w'hich includes the

completeLIBRA&AN G lossary, User's Guide, and Reference Guide. Some help topics have
related topics that you can access. To do this, highlight a topic and then press ENTER, To
exit the help module, press the FS function key.

Examples
Display the syntax for the PERFORM command by typing:

>HELP PERFORM

Display examples of the MOVE command by typing:

> HELP MOVE EXAMPLE

>HELP STEPS

List all of the steps the current user is authorized to perform by typing:

Display help for the CHECKOUT step in the DEVEL route of the FIN application by typing:

List of all the projects the current user is authorized to perform by typing:

> HELP CHECKOUT. DEVEL. FIN

>HELP PROJECTS
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KILL
Terminates a son process created with the MPE RUN command.

Restrictions

None

Menu Mode

Not available in menu mode. Press F2 for command mode and then use KILL as described
below.

Command Mode Syntax
>K[ILL] [PIN]

Parameters
PIN A process ID number.

Operation
KILL terminates son processes created by the RUN command. To select a process to
terminate, you must know its process ID number. If you invoke KILL without the p arameter,
LIBRARIAN shows you current processes and their corresponding process ID numbers.

Examples
Terminate process number 93 by typing:

>KILL 93

If you do not know what processes are ruruung or the ID number of the process, type:

> KILL

Related information
U ~ If you are running UNIX, see the ps and kill manual entries for equivalent functionality.
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LCOMPARE (XLCOMPARE)
Shows the differences between text files.

Restrictions
Owner for tracked files; read access for untracked files.

Menu Mode
Select the Compare option from the Tools menu. A dialog appears allowing you to specify
files, revision criteria, and options. The method of comparison is determined by the
compare method that you can change on the Settings window from the User menu.

Command Mode Syntax
~LCOMPA[RE] fI'lelist1 [TO filelist2]

[;ALL J
[; BATCH ]
[; DELTA J
[;FROMREV = revid ] or
[;FROMVCOUNT = fromvcount] or [,FROMGCOUNT = fromgcount ]
[;TOREV = revid] or
[;TOVCOUNT = tovcount ] or [;TOGCOUNT = t ogcount]
[;hllASTER]
[;NOBLANKS ]
[;OFFLINE ]
[; UNNUMBERED ]
[;UPSHIFT ]

t Not available with XLCOMPARE

Parameters
filelistf

ALL

DELTA

BATCH

TO filelist2

A list of files, as described in Haw to Refer to Files at the beginning of this
chapter.

The reference files to be used for comparisons. You can omit this
parameter when comparing revisions of the same file.

Whenfi lelistl specifies multiple files, i.e. wildcard, indirect file, etc.,
filelist2 must be a wildcard expression that maps each authorized file to a
corresponding filename. You cannot use an indirect file as a filelist2.

Shows all lines of the reference file. The default is to show ten lines before
and after file differences.

Processes the transaction in batch mode. Refer to Batch Operations at the
beginning of this chapter.

Reconstructs the reference file from the delta file corresponding to the
master to check the integrity of the current master. With this option you
do not need to specify a TO file.

Specifies which revision to retrieve as the compare file.FROMREV
= revld
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LCOMPARE (continued)

Parameters, continued

F ROM VCOUNT
= fromvcount

M E UNNUMBERED

NOBLANKS

OFFLINE

TOR EV
= I ev/d

TOVCOUNT
= tovcount

TOGCOUNT
= togcount

MASTER

FROMGCOUNT
= fl'omcount

Uses compare files with a version count equal tofromvcount
This parameter must have a positive value and be used in conjunction
with the versianid parameter.

Uses compare files with a generation count equal to fromgcount.
This parameter can have either a positive or negative value.

A negative value describes the generation equal to the current generation
minus the GCOUNT. For example,GCOUNT =-2 specifies the file two
generations earlier than the current generation.

Same as FROMREV, but applies to the reference file.

Same as FROIVIVCOUNT described earlier, but applies to the reference.

Same as the FROMGCOUNT parameter described earlier,
but applies to the reference files.

Compares secondaries to their associated master. With this option, you do
not need to specify a TO file.

Ignores spacing and blank lines when comparing files.

Prints file(s) offline to device LP.

Ignores numbering when comparing fi les.

Ignores case when comparing files.UPSHIFT

Operation
For each reference file, LCOMPARE shows lines inserted and/or deleted to resu1t in the
compare file.

LCOMPARE’s output also provides LIBRARIAN f i le information, including the file name,
file t1~e, versions, and generations of the files being compared. If the files are compressed,
LCOMPARE autornaticalIy decompresses them before a compare operation, then compresses
them again after the completion of the operation.

XLCOMPARE operates on both tracked and untracked files, and enforces normal file systemsecurity, unless the user has X capability.

You can specify a set of escape sequences for printer initialization and bold pr int in a fi le
called PRINTESC. The first line of the file is for printer initialization. The second line is for
bold print, and the third l ine is for normal print. You can use the ESC keyword in the file to
indicate the Escape character. In addition, you can use the keyword UNDERLINE rather
than an escape sequence for bold. You can use file equations for the PRINTESC file.
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LCOMPARE (continued)

Operation, continued
The following example sets escape sequences for the HP laser jet printer.

II IX

ESC(s10H
ESC(s3B
ESC(sOB

Examples
Compare the files listed in LOGFILES to files of the same name in another location. The
output device is LP. To do this, type:

LCOMPARE > ! LOGFILES TO =. =.DEVEL;OFFLINE

LCOMPARE > ! LOGFILES TO /usr/devel/=;OFFLINE

The following example compares the current master against the same file reconstructed
from the delta file. The result should be that the files match, otherwise there is an integrity
problem.

LCOMPARE > ABC1000S.SOURCE.ACCTG;DELTA

UNix LCOMPARE> /usr/master/acctg/abc100s.c; DELTA

The following example compares a secondary hie to its associated master.

LCOMPARE > ABC1000S.SOURCE.LIBDEVEL;MASTER

uNix LCOMPARE> /usr/devel/acctg/abc1000s.c, MASTER

X

Related Information
See Chapter 5, "Printing, Scanning, and ComparingFiles" in the LIBRARIAN/iX User's Guide
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LI BSCRE EN
Accesses the LIBRARIAN screen system.

Restrictions
Applications Manger/Project Manager

Menu Mode
Select the Screen option from the Admin menu. A number of screen categories appear.
Choose a category and select a screen.

Command Mode Syntax
> [ LIBSCRlEEN] ] screen code

Parameters
screen code A n y v a l id L IBRARIAN screen code.

Operation
LIBSCREEN goes directly to the specified screen after validating your current LIBRARIAN
user ID, if not already specified. You can omit the cornrnand LIBSCREEN, and access any
LIBRARIAN screen by its screen code alone.

Examples
Access the File Inquiry (FI) screen directly f rom the LIBRARIAN promp t by typing:

>FI

Related information
See Chapter 5, "Screens"
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LlSTREDO
Lists the contents of the LIBRARIAN command stack I'up to 20 commands) with
corresponding reference numbers.

Restrictions

None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use LISTREDO as

Command Mode Syntax

described belo~.

> LIS[TREDO]

Parameters
None

Operation
Use LISTREDO to list a maximum of 20 previously issued commands with corresponding
reference numbers. The LIBRARIAN LISTREDO command functions similarlyto the MPE's
LISTREDO command. For more information, refer to the MPE Commands Reference Manual.

Examples
List the previous commands (up to 20) by typing:

> LISTREDO

Related Information
See DO

REDO
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LMAINT
Accesses the listfile maintenance module.

Restrictions

None

Menu Mode
Select the Listfiles option from the Tools menu. A menu appears listing LMAIN I '
opera hons.

Command Mode Syntax
> LJVI [AINQ

Parameters
None

Operation

separate cornrr~ d s , allowing users to create, maintain, and view listfi les. Listfiles (indirect
files) are files containing a list of filenames, with or without svstezn names,

Once invoked, the LMAINT module signals its active status with a LM > prom pt, and only
LMAINT commands are processed. Return to the LIBRARIAN prompt by hging EXIT.

Examples
Access the listfile maintenance module by typing:

The LMAINT command accesses LMAINT, the listfile maintenance module that consists of

> LMAINT

Related Information

See Chapter 7, "Listfiles" in the LIBRARIAN/iX User's Guide
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LOCK
Places files on hold so they cannot be moved or copied.

Restrictions

File Owner

Menu Mode
Select the Set...Lock/Unlock option f rom the File menu. A dialog appears allowing you to
specify files, revision criteria, and options.

Command h/lode Syntax
) LOCK filelist

f;BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
file(ist

BATCH

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

NfEMO = memo — text

Operation
LOCK protects a file from being copied or moved from its current location. Use the UNLOCK
command to release files.

Examples
Lock up all tracked files in your login group:

M E )LOCK@

LI Ix )LOCK ./

hoctt ad secondary copies of the FIN hieset bv typinK:

M E ) LOCK %FIN AT @.@. I

II Ix )LOCK%FINANCE AT ./*

Related Information

See UNLOCK

t
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MAKE
Scans the specified makefile(s) for dependency rules, It determines if specified target(s) need
to be rebuilt and then generates a MAKE job with commands to bring the target up-to-date.

Restrictions
None

Menu Mode
Select the Make option from the Tools menu. A dialog appears allowing you to specify a
rnakefile and other options.

Command Mode Syntax

> MA[KE] [ makefile [,target [,listfile [,cmdfile ] ] ] ]

[;ALL ]
[; ECHO ]
[;NOMAKE ]
[; QUIET ]
[; SHOW ]
[�XEQ]

Parameters

makefile

listfile

target

cmdfile

first rule found.

A file specification consistent with MPE LISTF conventions, with or wi thout
wildcards, specifying one or more files containing MAKE rules. If omitted,
the default name and formal file designator is MAKEFILE.

Name of the target to be (re)built. If omitted, the default is the target of the

Name of the file into which a compile listing is generated. If omitted, the
default name and forrnal file designator is MAKELIST.

Name of the file into which MAKE generates commands. If omitted, the
default name and formal file designator is MAXEOUT. The file is t emporary.
Builds all components, regardless of whether or not they are out of date.

Displays echo comments in makefile(s) that begin with NOTE.

Does not automatically stream the MAKEOUT job.

Does not output summary information to terminal.

Produces detailed progress reports to the terminal,

Creates a MAKEOUT fi le, without streaming the file, that can be used used

ALL

ECHO

NOMAKE

QUIET

SHOW

XEQ
as a LIBRARIAN macro.
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MAKE (contirlued)

Examples
Process all makefiles in the BUILD group echoing NOTE comments as they are processed.
Use the default names for the compile listing 61e and command output fi le. To do this, type:

) MAKE MAKE@.BUILD; ECHO

Related Information
See Chapter 8, "Rebuilding Appl ications with MAKE" in the LIBRARIAN/iX User sGu'ide

r If you are running LIMX, see the make manual page for equivalent functionality.
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MEMO (or MAIL)
Sends a message to a particular user or the audit trail. MAIL can also alert users when
datasets are getting near capacity.

Restrictions
None

Menu Mode
Select the Memo option f rom the User menu. A dialog appears allowing you to specify who
to send mail to and a message. Press F6 to send mail.

Command Mode Syntax
>ME[MO] (or MAIL) [ useridl&LOG ] [;memotext/;CHECKDB [ = threshold ] ]

Parameters
userid The user to receive the message.

Note All LIBRARIAN user IDs are case-sensitive,

$LOG

memotext

Specifies that the memo is to be added to the audit trail.

Text consisting of a maximum of 72 characters. If omitted, an
editor is invoked for a multi-line memo.

Checks LIBDB and LIBLOG dataset capacities and notifies a user
if any datasets are getting dose to capacity. An optional threshold
for checking percentage full, expressed as a whole number
between 0 and 100. The default is 90.

CHECKDB
= threshold

Operation
With MEMO (or MAIL) you can send messages to other users. In addition, LIBRARIAN sends
messages (e g., notification of exceptions). These messages are checked before every
command. Users are informed if there are new messages. You can retrieve your messages
using the MEMO command without parameters.

If you use the CHECKDB parameter to monitor LIBRARIAN dataset capacities, mail wil l
only be sent if there are datasets that exceed the threshold.

Example
Send a messageto Derek by typing:

) MEMO DEREK; DON’T FORGET TO CHECK THOSE XEQ FILES BACK IN.

Related Information
See the CHECKDB command.
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MOVE (XMOVE)
Move files from one location to another.

Restrictions
File Owner for tracked files; read access for untracked files.

Menu Mode
Select the Move option from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command Mode Syntax
>MO[VE] filelist [ TO tolocation ] [,filelist [ TO tolocation ] .„]

[;APPEND]
[ IBATCH ]
[;COlVlPRESS ]
[;CREATE [ = GROUP ][,ACCOUNT][,CREATOR ] ]
[; CREATOR = creator ]
[; DECOMPRESS ]
[; EXTERNAL )
[; GROUP = unixgroup ]
[; KEEP ]
[;LOCIONORD = lockword ]
[ I MEMO [ = memo — text ] ]
[;OLDDATE ]
[;OLDNAME ]
[; PERMISSIONS = unixpermissions ]
[;VERIFY ]

t Not available with XlUIOVE.

Parameters
filelist A list of files, as described in Hcrw to Refer to Files at the beginning

of this chapter.

The destination location for the filelist. The syntax is:TO tolocation

TO [system: ] file [.group [.acct ]]

TO [system: ] /[path.../] file
AUIX

The = wildcard can be entered in any f i l ename element. It takes
the same value as the corresponding element in the filelist (source
file). A single © can also be entered. It has the same meaning as
the = wildcard. tolocation can also be an edit mask, as described
earlier in this chapter.
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MOVE (continued)

Parameters, continued
APPEND

BATCH

u ix CREATE

COMPRESS

CREATE =GROUP,
ACCOUNT, and/or
CREATOR

exist.

Appends a file to an existing file with the same name.

Processes the transaction in batch mode. Refer to Batch Operations
at the begiruung of this chapter.

Compresses the new destination file(s).

Makes any directories on the destination path that do not already

Creates MPE group, account, and/or creator if it does not exist.
If none of GROUP, ACCOUNT, or CREATOR is specified,
all will be created if necessary.

H — P's Security Monitor product enables system managers to
prevent the creation of users, groups, or accounts without
passwords. If CREATE is specified or configured on a step, and
this Security Monitor feature is in use, users will receive the
error message "Password required for user".

Note

u ix CREATOR = creator Overrides the MPE creator/UNIX owner of the new fi le. For MPE,
it can be a specific MPE user For UNIX, it can be a specific UMX
user login, or decimal user ID found in /etc/passwd. Alternatively,
you can use one of the following:

!USERID

! LOGON

!KEEP

Uses current LIBRARIAN user.

Uses current login user.

Uses MPE creator/UM X ow ner of the file
beingreplaced.

Note All LIBRARIAN user IDs are case-sensitive.

DECOMPRESS

EXTERNAL

Decompresses the new destination file(s ).
Records the movement of a master or secondary file to a new
location in the LIBR/QUAN database. LIBRARIAN tracks the file
in the new location, but does not physically move the files.
Physical movement of files to the new location can be
accomplished outside of LIBRARIAN.

You can use this parameterto record the move of an entire master
library to a new system, then physically move the files using
MPE’s STORE /RESTORE command.

Another example would be to logically move secondary files from
or to a PC.
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MOVE (confinued)

Parameters, continued

GROUP = unixgroup Chan ges the group ID of the new destination file. It can be a
specific LtNIX group name or decimal group ID found in
/etc/group.

Instructs LIBRARIAN not to copy a file if the destination file
already exists When you use batch znode or QUIET ON, the
default is to purge existing destination files. Otherwise, the
default is to prompt. KEEP overrides both of these defaults.

LOCKWORD = /ockword Ass igns a lockword to the destination file created by the

KEEP

OLD DATE

OLDNAME

MEMO = memo — text

operation, You can specify! KEEP as the lockword, which instructs
LIBRARIAN to use the lockword from the old destination file.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wil l invoke the
configured editor so that you can enter the rneino text.

Leaves timestamp in the database as is and sets the create and
modify dates of the destination file to be the same as the from file.

Uses the original name of the retained file in the new destination
location. Group, account, and system are established by the
toiocati on specification.

Changes the permissions of the new destination fi le
according to the unixpermissions mode, which is a number
constructed from the following mode bits

PERMISSIONS =

unixpermissi ons

0400 read by owner
0200 write by owner
0100 execute/search by owner

0040 read by group
0020 write by group
0010 execute/search by group

0004 read by others
0002 write by others
0001 execute/search by others

user g roup o thers

VERIFY Identifies files that have been modified by comparing the
modification timestamp in the file label with the timestamp stored
when it was last created by LIBRARIAN. If the file has been
modified since it was moved into its current location, the file is not
copied (violation).
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MOVE (continued)
Operation

MOVE moves any file currently tracked by LIBRARIAN, inc1uding masters, retained
masters, secondaries, and retained secondaries, MOVE copies a file into a new location and
purges the source file.

When a master file is moved, all references to the former identity of' the file are replaced
with references to the new identity so that the links between a master file and its secondaries
are not severed. The new f i l l ocation is updated for all fi lesets in which themoved file
appears. When a KSAM file is moved, the name of the associated key file does not change.

For security, MOVE cannot replace an existing file that is being tracked by LIBRARIAN.

Note When you use MOVE to remove the last master, related secondary, or
retained master associated with a project, the old filename will
automatically be removed and the new one will be added.

XMOVE operates on untracked files only and enforces normal file system security, unless the
user has X capability.

Examples
Move the HNANCE f i leset to another system and retain the same file, group, and account
names by typing.

> MOVE %FINANCE TO SYS78:= . = . =

> IVIOVE %FINANCE TO SYS78:/(1,*)

Move the FINANCE fi leset to another system and retain the same file, group, and account
names by typing:

> MOVE %FINANCE TO SYS78:= . = . =

> MOVE %finance to sys78:/(1,*)

Move all of the files that have a J as the last character of the filename from your login group
to files of the same name in the JOB group by typing:

> MOVE @J TO =.JOB

AUIX >MOVE "j TO job/ =

Move to your login the third generation of all master hles by typing:

> MOVE %SOURCE’,GCOUNT = 3
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UNIX

UNIX

MOVE (continued)

Examples, continued
From your login group, move all master fi les ending in E to files of the same name in the
EXE group, Then, copy all master files ending in J or S to files of the same name in the
SOURCE group by typing:

>MOVE @E TO =.EXE, @J, @S TO =.SOURCE

>MOVE *e TO exe/ =, *j, *s TO source/=

Move all master f i les in the SOURCE area to files of the same name in your login area.
Exclude all retained files and aH files modified since they were moved to their current
location. If a destination file of that name exists, abort the copy. To do this, type;

>MOVE @.SOURCE TO = , -G¹¹ ¹ ¹ ¹ ¹ ¹ .SO URCE;VERIFY;KEEP

> MOVE src/* TO src/ = , — src/.g¹¹ ¹ ¹ ¹ ¹ ¹ ;VE RIFY;KEEP

Copy all of the current and retained master files in REL2.0 of the MFG-FILES fileset to files
of the same name in the REL2GRP group of the MFG account. Use the original names of the
files. To do this, type:

> MOVE REL2.0 OF %MFG-FllES TO =.REL2GRPMFG; OLDNAME

> MOVE rel2.0 OF %MFG — FILES TO /usr/mfgdevel/=;OLDNAME

Related Information
See Chapter 3, "Master Library" in the LIBRARIAN/iX Administrator's Guide

UNIX
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ORPHAN
Disables tracking of read-mode secondary files and copies of previous revisions of
master/secondary fi les.

Restrictions
Owner

Menu Mode
Select the Orphan option from the File menu. A dialog appears allowing you to specify
fi le, revision criteria, and options,

Command Mode Syntax
>OR[PHAN] filelist

[;SATCH ]
[; MEMO [ = memo — text ] ]

Parameters
file!ist

SATCH

A list of files, as described in Hog's~ to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginrung of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
ORPHAN allows you to stop tracking a secondary in read-mode or copies of previous
revisions of master or secondary fi les. Once orphaned, a file is no longer tracked by
LIBRARIAN. You can also ORPHAN copies of retained master and secondary files.

Examples
Orphan all of the files in the HOLDAREA group of your login account by typing:

> ORPHAN @. l-lOLDAREA

> ORPHAN ./holldarea/*
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OVERLAY
Replaces a tracked file with the contents of another tracked or untracked file.

Restrit=tions
Application Manager; file owner (file system security enforced)

Menu Mode
Select the Overlay option from the File menu. A dialog appears allowing you to specify
files, revision criteria, and options.

Command Mode Syntax
) OV[ERLAY] filelist WITH filelist

[; BATCH ]
[; MEMO [ = memo — text ] j

Parameters
filelist

BATCH

A list of files, as described in Hollo to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

moved nor renamed.

file that has an associated delta file.

Operation
OVERLAY allows you to replace LIBRARIAN f iles with any other files, including files that
were created outside the LIBRARIAN system. With OVERLAY, the source file is neither

OVERLAY provides a convenient way to bypass normal restrictions. However, its use is
restricted to Application Managers and LIBRARIAN Managers. OVERLAY should be used
only in unusual circumstances and not as a regular procedure. You cannot overlay a master

Examples
Replace all of the files in the SOURCE location of the development area with all of the files
in the SOURCE location of the MASTER area by typing:

) OVERLAY @.SOURCE. DEVEL WITH @.SOURCE. MASTER

UNIx ) OVERLAY /usr/devel/source/* WITH /usr/master/source/"

Replace the files in the AP-FILES fileset with the files in the AP-FILES fileset in your login
area by typing:

I

M E ) OVERLAY %AP-FILES WITH %AP-FILES AT @.@

) OVERLAY %AP — FILES WITH %AP — FILES AT ./*
UNIX
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OVERLAY (continued)

Examples, continued
Replace all the files in your login with f i les in the same location on system DST068 by
typing:

>OVERLAY @ WITH DST068:

Replace all secondary copies of files in the MFG-FILES fileset with the master fi les in
MFG-FILES by typing:

) OVERLAY %MFG-FILES AT @:@.@.@ WITH %MFG-FILES

> OVERLAY %MFG — FILES AT *:/* WITH %MFG — FILES
hl E

U fx
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PCRECE IVE
Transfers files from a host computerto a PC using Reflection.

Restrictions
None. Restricted by MPE security.

Menu Mode
Not available in menu mode. Press F2 for corrunand mode and then use PCRECEIVE as

Command Mode Syntax
>PCR[ECEIVE] filename [ FROM systemffle [;L) )

[(ASCII I BINARY) ]
[ ( APPEND ] DELETE ) ]

Parameters

described below.

filename

FROM hostfile

ASCII i BINARY

intact.

Name of file to be transferred including drive/path (if desired). No
wildcards are permitted.

Name of file on the host rnachine. If omitted, the host fi l ename is the
same as the PC filename.

a file which must be returned to the host with all of its label i nformation

Transfers the file as a standard ASCII file or binary fi le. If this is orrutted,
the last file transfer value is used.

Appends a file to an existing file with the same name,

Deletes an existing PC file with the same name.

Maintains label information. Note: this option is required when receiving

APPEND

DELETE

Operation
PCRECEIVE and its parameters may not exceed 80 characters, and must be typed on one

Examples
In the following example, the host file HOSTFILE is received on the B drive of the PC.

) PCRECEIVE B:MYTXT FROM HQSTFILE.PUB ASCII

Related Information

See Reflection's RECEIVEcommand

line.
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PCSEND
Transfers files from a PC to a host computer using Reflection.

Restrictions

None. Restricted by MPE security.

Menu Mode
Not available in menu mode. Press F2 for command mode and then use PCSEND as
described below.

Command Mode Syntax
>PCS[END] filename [ TO systemfile [;P] [;L] [;F] [;Q] ]

[ ( ASCII i BINARY ) ]
[ DELETE ]
[ REC = number]

Parameters
filename The name of the file to be transferred including drive/path (if desired). No

wildcards are permitted in this name.

The name of the file on the host rnachine. If omitted, the host filename is
the same as the PC filename.

Instructs Reflection to completely replace the existing file, including file
characteristics — this is very important if the existing file is smaller than
the one being transferred.

Maintains label information. Note: This option is required for programs
transferred to the PC and then back to the host.

Produces a fixed-length file.

Transfers files in the correct format for QEDIT.
Note: Without the Q parameter, files are treated as ASCD files.

ASCII or BINARY Transfers the file as a standard ASCII file or as a binary file.

TO hostfile

DELETE

REC = number

Deletes an existing host file with the same name.

Transfers using a particular record size.

Examples
Send a fixed-length binary PC file to the HP 3000 by typing:

>PCSEND SAMPDAT TO GRAPM;F BINARY

Related Information

See Reflection's SEND command
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~ .project

PERFORM
Executes a predefined step for a file or fileset.

Restrictions
Step Authorization

Menu Mode
Select Steps... from the File menu and choose the step you want to performfrom the menu.
A dialog appears allowing you to specify files, revision criteria, and options.

Command Mode Syntax
> step g .route [ .appl ]

[ fi leli st [ (mode) ] [ TO tolocati on ] ] [, [ filelist ( (mode) j [ TO tolocation ] ] ., ]

[; ANNOTATE [ = NODELETE ] ]
[; APPEND ]
[;AUTOUPDATE ] or [;NOAUTOUPDATE ]
[; BATCH ] or [;NOBATCH ]
[; BRANCH ] or [;NOBRANCH ]
[; COMPRESS ] or [;NOCOMPRESS ]
[; CONDITIONAL = maxcon ] or [;NOCONDITIO
[;CREATE = [ GROUP ][,ACCOUNT][,CREAT
[; CREATOR = creator ~ unixowner ]
[;DBONLY] or [;NODBONLY]
[; DECOMPRESS ] or [;NODECOMPRESS ]
[; ERRORS = maxerr ] or [;NOERRORS ]
[; EXTERNAL ]
[; FROM = EXTERNAL]
[; GROUP = unixgroup ]
[;INPROGRESS ] or [;NOINPROGRESS ]
[ I KEEP ]
[;LOCKWORD = lockword ]
[,MASTER = pending — master ]
[; MEMO [ = memo — text ] ] or [;NOMEMO ]
[;MERGE = mergelist]
[;NOMOVE ]
[;NOSEARCH ]
[; NOTIFY ]
[;OLDDATE ]
[; ONLINE ]
[;ORPHAN]or [ ;NOORPHAN]
[; OWNER = owner]
[; PERMISSIONS = unixpermissions ]
[; PROJECT = project ]
[;PUSHREAD]
[;READ] or [;WRITE]
[;RENUMBER]
[; REPLACE ]
[;RESET ]

NAL ]
OR] ]
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PERFORM (continued)

Command Mode Syntax, continued

[; RETAIN ] or [;NORETAIN ]
[;REV = rev ]
[;TAG = tage]
[;TO = EXTERNAL ]

[; VERIFY ] or [;NOVERIFY]
[; VIOLATIONS = maxvio ] or [;NOVIOLATIONS ]

Parameters

step

appl

route

project

filelist (mode)

same name.

Name of the step to execute. If you do not specify a route or
application, you may be asked to select from a list of steps of the

The route to which the step belongs. If this parameter is omitted,
LIBRARIAN tr ies to uniquely identify the route. if LIBRARIAN
cannot identify it, you will be promptedfor the route. You can use
project in place of route.

Name of the project to be associated with fi les for the step. If this

parameteris omitted and projects are defined, you are prompted
for the project. The project can be used in place of the route. Log
records for this step include the project name (the special value
$NP may be used to denote No Project).

Application to which the step belongs. If this parameter is
omitted, LIBRARIAN tr ies to uniquely identify the application. If
LIBRAIGAN cannot identify it, you are prompted for the
application. In batch mode, always use the step. route application
designation to avoid ambiguous steps.

List of files, as described in How to Refer to Files at the beginning of
this chapter. You can optionally append any part of the filelist
with (R) for read, or (W) for write. (mode) overrides the global step
parameter, READ or WRIIE .

Destination location for the filelist, The syntax is:TO tolocation

[system: ] file [.group [.acct ]]

[system;] /[path.../] file
TO

The equal sign ( =) wildcard can be entered in any filename
element. It takes the same value as the corresponding element in
the filelist (source file). Also, a single at sign (0<') can be used. It has
the same meaning as the equal sign (=) wildcard. The tolocation
can also be an Edit Mask, as described earlier in this chapter.
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PERFORM (continued)

Parameters, confinued
ANNOTATE Creat

unix CREATE

BATCH

DBONLY

BRANCH

APPEND

AUTOUPDATE

COMPRESS

CONDITIONAL =

exist.

maxcon Sets the maximum number of conditional files allowed for the

es an annotated copy of source code based on the delta file,
showing lines that were inserted and deleted for each revision,
including date/ t ime, project, and user. Annotation appears as
commented code appropriate for the programming language set
for the file (see SET LANGUAGE).

If you attemptto ANNOTATE files for which deltas are not being
stored, LIBRARIAN will notify you that a violation has occurred.

Appends data from the source file to the end of the destination
file. For MPE files, EOF plus new data cannot exceed LIMIT.

Adds new master files processed by this step to filesets if they
match descriptors defined on the Auto Filesets (AF) screen. This
parameter is valid only for secondary-to-master steps.

Processes the transaction in batch mode. Refer to "Batch
Operations" at the beginning of this chapter.

Forces a branch from the most recent trunk revision, or from any
leaf that terminates a branch. The default is to increment the leaf
count. BRANCH forces the addition of a branch/leaf pair.

Compresses the new destination file(s),

transaction, If the maximum number is exceeded, it terminates the
operation.

Records a move or copy operation in the LIBRARIAN database
without physically moving or copying file(s). You are, however,
responsible for updating "tirnestarnps" in the LIBRARIAN
database with the RESET TIMESTAMP command.

Makes any directories on the destination path that do not already

Creates MPE group, account, and/or creator if it does not exist.
If none of GROUP, ACCOUNT, or CREATOR is specified,
all will be created if necessary.

M E CREATE =GROUP,
ACCOUNT, and/or
CREATOR

Note H — P's Security Monitor product enables system managers to
prevent the creation of users, groups, or accounts without
passwords. If CREATE is specified or configured on a step, and
this Security Monitor feature is in use, users will receive the
error message "Password required for user".

Note All LIBRARIAN user IDs are case sensitive.

1-68 LI BRARIAN/IX Reference Guide



PERFORM (continued)
Parameters, continued
CREATOR = creator Overrides the MPE creator/UNIX owner of the nev fi le. For MPE,

it can be a specific MPE user. For UNIX, it can be a specific UNIX
user login, or decimal user ID found in /etc/passwd. Alternatively,
you can use one of the following:

! USERID Uses current LIBRARIAN user.

! LOGON Uses current login user.

Uses MPE creator/UNIX owner of the hie
being replaced.

r KEEP

U~rx CREATOR = unixowner

KEEP

EXTERNAL

uNrx GROUP = unixgroup

INPROGRESS

DECOMPRESS

ERRORS = maxerr

FROM = EXTERNAL

Changes the owner of the new destination file. It can be a specific
~ u ser l o gin or decimal user ID found in /etc/passwd.

! USER ID LIBRARIAN user ID as creator.

! LOGON

!KEEP

Decompresses the new destination file(s).

Sets the maximum number of authorization errors (conditional
and violation files) allowed for this transaction. If the number
exceeds the maximum, it aborts the operation. This p arameteris
especially useful in batch mode.

Tracks both source and destination files as external to
LIBRA1RIAN's operating environment (e.g„PCs, machines not
linked to LIBRAIGAN). You are responsible for ensuring that
external movement completes successfully.

Specifies that the source file is located on a computer where
LIBRARIAN is not implemented.
Changes the group ID of the new destination file. It can be a
specific UNIX group name or decimal group ID found in
/etc/group.

Updates tracking to reflect the write mode secondary without
makinga new copy in the secondary location. Only available on
master-to-secondary steps.

Instructs LIBRA1UAN not to copy a file if the destination fi le
already exists. When you use batch mode or QUIET ON /DISPLAY,
the default is to purge existing destination files. Otherwise, the
default is to prompt.KEEP overrides both of these defaults.

Assigns a lockword to the destination file created by the
operation. You can specify! KEEP as the lockword, which instructs
LIBRARIAN to use the lockword from the old destination file.

Current ~ login u ser as creator.

Creator of the file being replaced.

LOCKWORD = loclNrrord
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NOBRANCH

NOAUTOUPDATE

NOBATCH

NOCOMPRESS

NOCONDITIONAL

MERGE =mergelist

MEMO = memo — text

CONDITIONAL =O,

PERFORM (continued)

Parameters, continued
MASTER =pending — master For new files that you introduce as secondaries, the master

(pending master). If you are introducing more than one file, you
can use an edit mask as described at the beginning of this chapter.
You do not need to use this parameter if the step includes rules for
how to determine the pending master name automatically.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBI~ AN w ill i n v oke the
configured editor so that you can enter the memo text.

Allows you to specify revisions to merge when performing
master-to-secondary (checkout) steps. Revisions from the
mergelist are merged into the file being checked out, Revisions in
the mergelist should be separated by commas.

� The minus ( — ) prefix is used to exclude a revision's changes
from being included in the merge.

� The exclamation point (! ) prefix is used to merge only the
changes from a specific revision without including changes that
led up to that revision.

If you attempt to MERGE files for which deltas are not being
stored, LIBRARIAN wil l notify you that a violation has occurred,

If conflicts are found when the MERGE option is used on checkout,
the file is flagged with an exception that must be reset before
continuing. Exceptions are shown in VERIFY forznat 11 with a code
of MC.

Overrides the AUTOUPDATE default parameter value for the step.

Overrides the BATCH default parameter value for the step. It is
equivalent to ONLINE.

Blocks the use of the BRANCH option. The LIBRARIAN or the
Application Manager can prevent users from using BRANCH by
coding NOBRANCH in a macro, or by configuring this option as an
additional step parameter on the STO screen.

The NOBRANCH option prevents the branch prompt prevents a
user from using the BRANCH parameter. Additionally, NOBRANCH
prevents the user from checking out a WRITE mode copy of a
previous revision of a file.

Overrides the COMPRESS default p arametervalue for the step.

Allows no conditional files for the transaction. Equivalent to

Prevents the use of the DBONLY parameter.The LIBRARIAN or
Application Manager can enforce this action by coding
NODBONLY in a macro, or configuring this option as an additional
step parameteron the STO screen.

parameter a11ows you to specify the corresponding master name

NOD BONLY
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PERFORM (continued)

Parameters, continued

NODECOMPRESS

NOERRORS

NOINPROGRESS

ONLINE

NOTIFY

OLDDATE

NOME MO

NOIVIOVE

NOSEARCH

NOORPHAN

NOR ETAIN

NOVERIFY

NOVIOLATIONS

same file,

NOBATCH

REPLACE,

VIOLATIONS =O.

Overrides the DECOMPRESS default value for the step.

Allows no errors for the transaction. Equivalent to ERROR=O.

Blocks use of the INPROGRESS parameter, The LIBRARIAN or
Application Manager can enforce this action by coding
NOINPROGRESS in a macro, or configuring this option as an
additional step parameter on the STO screen.

Overrides the MEMO default parameter value for the step,

Authorizes the request but performs no actual file operation. Used
for simulating possible transactions.

Overrides the ORPHAN default value for the step

Overrides the RETAIN default value for the step. It is equivalent to

Disables search of previous version locations. Applies onlv to
steps with forward versioning records as defined on the Forward
Versioning (FV) screen.

When checking in a file, this parameter instructs LIBRARIAN to
notify other users who are working on different versions of the

Overrides the VERIFY default value for the step.

Allows no violations for the transaction. It is equivalent to

Instructs LIBRARIAN not to update the database with the new
modification timestarnp of the destination file. When specified,
the destination file appears modihed.

Overrides the BATCH default value for the step. It is equivalent to

Creates files that are not tracked by LIBRARIAN,

Sets the LIBRARIAN owner of the file to a specific LIBRARIAN

ORPHAN

OWNER = owner
user ID.
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PERFORM (continued)

Parameters, continued
PERMISSIONS =

vnixpermissions
Changes permissionsof the new destination file according to
the vnixpermissions mode, which is a number constructed from the
following mode bits:

0400 read by owner
0200 write by owner
0100 execute/search by owner

0040 read by group
0020 write by group
0010 execute/search by group

0004 read by others
0002 write by others
0001 execute/search by others

user g roup others

PROJECT = project

READ

M s RENUIVIBER

REPLACE

RESET

RETAIN

PUSHREAD

parameter.

to NORETAIN.

well as master files.

Filters the requested fr leref by project association. Only files
associated with this project will be authorized; others will appear
as violations. For master files in fileref, retained revisions of those

asters that are associated with the project will be authorized as

Replaces a write mode file with a read mode file as an exception.
Usage of this parameter requires LIBRA&AN M a nager or
Application Manager capability, unless it is defined as a step

If PUSHREAD is used on checkin and there is another secondary in
write mode, the owner is informed via a memo that an exception
has taken place. This user must reset the exception (RESET
EXCEPTION command ) before proceeding with the next step.

Assigns read mode to all files created during this step. Note that
the fiielist access mode specified overrides this parameter.
Renumbers a numbered file when reconstructed from a delta file.

Overrides the RETAIN default value for the step. It is equivalent

Resets the modification timestamp in the database after the copy
has been completed. Generally it is used with the MODIFIED
parameter.

Retains any destination file that would otherwise be replaced. It
applies only to files tracked by LIBRARIAN.

Authorizes the specified revision of the master file(s) requested,
whether that revision happens to he the master itself or a retained
revision, Not valid for secondary files.

REV = rev
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PERFORM (continued)

Paramefers, confinued

TAG = tag

VERIFY

TO = EXTERNAL

VIOLATIONS = maxvio

LIBRARIAN is not installed.

Filters the requested fileref by tag value. Only f iles with this tag
value win be authorized; others will appear as violations. For
master files in fileref, retained revisions of those masters that have
this tag value will be authorized as well as master Files.

Specifies that the destination file is located on a computer where

Identifies files that have been modified by comparing the
modification tiinestamp in the file label with the timestamp stored
when it was last created by LIBRARIAN, If the file has been
modified since it was inoved into its current location, the file is not
copied (violation).

Sets the maximum number of violations allowed for the
transaction. If the number exceeds the rnaximurn, it aborts the
operation. Use this parameter to define batch mode operations on
an all-or-nothing basis

Assigns write mode access to all files created during this step. If
write mode access is not available for a file, it becomes conditional
on read mode. Note that the filelist access mode specified
overrides this parameter. Refer to filelist above.

WRITE

Operafion
PERFORM carries out a step that has been defined in the database. Once a step is defined,
you can use it to perform file transactions within the defined limits of the step.

When issuing PERFORM, you can override or specify additional p arametersif allowed by
the step definition. You can specify a subset of the defined fileset. You can override selected
default parameters for file retention, file compression., memo text, etc. For more inf'ormation
on defining steps, refer to the LIBRARIAN/iX User's Guide.

Examples
Perform the CHECKOUT step using the fileset, source location, target location, and default
step parameters defined for that step by typing:

> CHECKOUT

Perform the CHECKOUT step on all files in the default SOURCE area defined for the step
using defined target locations and default step parameters by typing:

>CHECKOUT @.SOURCE

> CHECKOUT src/*
UNIX

C ommands I - 7 3



>CHECKOUT.DEVEL.AP %INPUT TO =

PERFORM (continued)

Examples, continued
Perform the CHECKOUT step on the SOURCE-FILES fileset, request v "rite mode access for
these files, and prompt for xnemo text by typing:

>CHECKOUT %SOURCE-FILES;WRITE;MEMO

Perforxn the CHECKOUT step for two fi lesets, request write mode access on one fileset, and
read mode access on the other one by typing:

> CHECKOUT %SOURCE-FILES (W), %PROG-FILES (R)

Perforxn the CHECKOUT. DEVEL.AP step on the INPUT fi leset (subset of the defined fileset
for the step). Copy the files into the login location, and retain the saxne filenaxnes as in the
source location by typing:

Perform the SUBMIT step, retaining copies of any files that would otherwise be replaced
and prompt for memo text. Identify the project as MRP-PROJECT. Assign w'rite mode access
to all new fi les. Do not perform the operation if any files are conditional on read mode.

> SUBMITMRP-PROJECT;RETAIN;MEMO;WRITE;NOCONDITIONAL

Perforxn the APPROVE step for three components of the step fileset, MFG-EXE, MFG-JCL,
and MFG-SOURCE files, using the defined step values and default step parameters by
typing.

Perforxn the CHECKIN step for all fi les in the MFGDEVEL account. If any conditional or
violation errors occur, abort the operation. If there are new files that match the auto fileset
descriptors, add thexn to the defined fileset for the step. To do this, type:

> CHECKIN N.@.MFGDEVEL;NOERRORS;AUTOUPDATE

Perform the RELEASE. DISTRIBUTION,MFG step. If any file has been xnodified since it was
moved to its current location, or if any other violations occur, abort the step. To do this, type:

>APPROVE %MFG-EXE, %MFG-JCL, %MFG-SOURCE

> RELEASE, DISTRIBUTION.MFG;VERIFY;NOVIOLATIONS

Note Because a time delay exists between authoxization and actual file
xnovement, a file could be replaceable during authorization, but might
still fail with an exclusive access violation when LIBRARIAN attexnpts
to move the file. This situation is rare.
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PERFORM (continued)

Examples, continued
To merge two branches with the current mas ter, type:

) MFG-OUT MFG080S;MERGE=2.1.2,2.2.1

Related Information

See Chapter 2, "Getting Started with Basic Rules" in the LIBRARIAN/iX

Chapter 3, "File Transactions" in the LIBRARIAN/iX LIser's Guide
Administrator s Guide
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PRINT (XPRIN7)
Prints a file on the screen or printer.

Restrictions
File owner/ fi le system security for tracked files; File systemsecurity for untracked hles.

Menu Mode
Select the Print option f rom the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command IVlode Syntax
> PR[INT] filelist

[; ANNOTATE [ = NODELETE ] ]
[; BATCH ]
[; CHAR ]
[; LINES = first, last ]
[;NOPAGE ]
[; NUMBERED ]
[;OFFLINE ]

t Not available with XPRINT

Parameters
filelist

> + ANNOTATE

A list of Files, as described in How to Refer to Files at the beginning of this
chapter.

Creates an annotated copy of source code based on the delta file, showing
lines that were inserted and deleted for each revision, including
date/time, user, and project. Annotation appears as commented code
appropriate for the prograrnrrung language set for the file (see SET
LANGUAGE command).

If you attempt to ANNOTATE files for which deltas are not being stored,
LII3RAPVAN wil l notify you that a violation has occurred.

NODELETE Sho w s only insertions. Deleted linesnormallyappear as
commented text but are not shown when the NODELETE
option is specified.

BATCH

CHAR

Processes the transaction in batch mode. Refer to Batch Operations at the
beginrung of this chapter.

Replaces unprintable characters with periods (.). This is the default for
binary files. You should use this option for ASCII fi les with unprintable
data.

LINES = first, last Specifies the hrst and last line to print.

NOPAGE Specifies that there should be no page breaks between files.
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PRINT (continued)

Parameters, continued
M E NUMBERED Prin t s l ine numbers.

OFFLINE Prints file(s) offline to device LP (forrnal file designator of SCANLIST or
LIBOUT),

Operation
PRINT sends the contents of a file on the screen, printer, or other device. Use the SCAN
command to search for text strings.

When a file is displayed at the terminal, you are promptedafter each page whether or not
you wish to continue — unless the NOPAGE option is requested or you are in QUIET mode.
At this prompt, you can continue the listing by pressing RETURN. To terminate the listing
enter the letter N. You may also enter a line number. If you enter a line number, the next
page of the listing begins with that line of the file.

XPRINT operates on untracked files enforcing normal file system security, unless the user has
X capability.

For annotation, you can specify a set of escape sequences for printer initialization and bold
print in a file called PRINTESC. The first line of the file is for printer initialization. The
second line of the file is for bold print. The third line of the file is for normal print. You can
use the ESC keyword in the file to indicate the Escape character In addit ion, you can use
the keyword UNDERLINE rather than an escape sequence for bold. You can use file
equations for the PRINTESC file.

Note New files that you introduce with a step are stamped as intermediate
revisions of the latest version for an application (VCOUNT = 1).

The following examplesets escape sequences for the HP laser jet printer:

ESC(s10H
ESC(s3B
ESC(sOB

You can print QEDIT fi les (FILECODE = 111) if you are using QEDIT Version 4.L.55 or
higher.

Examples

Print all fi les in the FINANCE fi leset on the line printer by typing:

> PRINT %FINANCEIOFFLINE

Related Information
See SCAN

Chapter 3, "File Transactions" in the LIBRARIAN jiX User's Guide
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PROJECT
Allows you to maintain project definitions, status, user authorizations, and display project
information from the command l ine. You can use the PROJECT command in batch jobs. The
same functions are also provided on the PJ, PS, PA, and PI screens.

Command Mode Syntax
>PROJECT ( project — name]@) . appl — id [;ADD l SHOW [=status] I DELETE)

[; DESCRIPTION = description ]
[; ROUTE = route-alias ]
[; USERS = [ ( user — list l * ] ]
[;MANAGER = user — id ]
[; STATUS= status ]
[; USER � STATUS or l USTATUS = user — status ]
[; DATE = date — requested )
[; PRIORITY = priority ]
[; ESTIMATE = estimate ]
[;REQUESTOR = requestor]
[; DEPARTMENT = department ]

Parameters
project — name

appl — id

The name of the project, up to 12 characters. LIBRARIAN uses this
name as the name of the project fileset as well.

Lists all projects for an application.

The name of the application to which the project belongs. If SET
APPLICATION is in effect, you can orrut the application name.

Adds a new project to the database.

Displays all project data for a particular project, or lists all projects
for an application. When listing projects, you can provide one of
the following status selection values:

ADD

SHOW [ =status]

AL

Al
AO

AC

CC

CL

DC

FP

FL

OP

RO

Documented

All projects

All active projects

All inactive projects

All open projects

All closed projects

Closed to CHECKOUT

Closed to all steps

Hush Pending

Opened

Reopened

Hushed
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PROJECT (continued)

Parameters, continued
DELETE

DESCRIPTION =

STATUS = status

MANAGER = user

USERS = user — list

ROUTE = route — alias

blank.

current user.

The default is @ or the route set with SET ROUTE.

Deletes project data from the database if the status is FL (Flushed).

A description of the project, up to 150 characters. This description
will appear on menus and reports. The default description is

The route for v hich the project is valid. Use the at sign (I ) to
indicate that the project is valid for all routes in the application.

Lists users authorized to work on this project, optionally preceded
with a plus sign (+). Use a minus sign ( — ) to delete users from a
previously defined list of users. An empty list deletes all users. A
value of "' " indicates that no authorization is required. Use
commas to define a list of users.

The user responsible for the project. The user must have Project,
Application, or LIBRARIAN manager capability. The default is the

Changes the status of a project to the given value if appropriate.
For new projects, the default project status is OPEN. The
following are valid status values:

DOC[UMENTED] or DC

OP [EN]

CL[OSE]

CLOSE — TO — CHECKOUT or CC

RE[OPEN] or RO

FL[USH]

A free — form userdef ined status value,USER — STATUS = status
USTATUS = status

DATE = date — requested For d o c umentation only, up to 8 characters.

PRIORITY = priority

ESTIMATE = est

REQUESTOR = requestor For documentation only, up to 20 characters.

For documentation only, up to 20 characters.

For documentation only, up to 4 characters.

For documentation only, up to 8 characters.

DEPARTMENT =

department
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the user.

manager.

> SET ABC1000S.SOURCE PROJECT= SR1234

PROJECT (continued)

Operation
The PROJECT command mirrors the functionality of the PJ, PS, PA, and PI screens.

Users can refer to the projects defined with this command to qualify steps. If projects are
required for a route and none is specified, then LIBRARIAN displays a menu of projects for

When you define a new project, LIBRARIAN also creates a fileset with the name which is
the same as the project name. This fileset is a private user fileset owned by the Project

To add a new project, use the ADD parameter, To display a project, use SHOW. To delete a
project, use DELETE. If ADD, SHOW, and DELETE are not specified, the command changes
the project data (if the project exists).

If you do not want to require specific project authorization, specify "USERS ='". However, if
you do require project authorization, use the "USERS" parameter to identify the authorized
users separated by commas.

If you want to document the project but do not wish to have it available for use
immediately, set the STATUS to DOCUMENTED. DOCUMENTED status is only available
for new projects. The default status is OPEN.

You can only delete a project if it has been flushed. To flush a project, set the status to
FLUSH PENDING and then run the FLUSHLOG util i ty.

If you want information about a specific project, you need to mdicate both the project and
the application name and use the SHOW parameter.To list projects in an application, use
"@" in place of the project name. To select a subset of an application's projects, you can

include a status filter with the SHOW p arameter.
Examples
Associate the file ABC1000S with the project SR1234 and adds its master the project fileset:

Add a new project called SR2035 for application HR:

> PROJECT SR2035.HR;ADD;DESCRIPTION = "Fix 401K year � to � date

Modify the estimated time for project SR2035.

calculation";ROUTE= HR — MAINT;PRIORITY=HIGH

> PRO JECT SR2035. HR; ESTIMATE =5

Change the status of project SR2035 to CLOSED:

> PROJECT SR2035.HR;STATUS=CLOSED

Show all active projects in application HR:

> PROJECT @.HR;SHOW

Related information
See Cha p ter 6,"Projects" in the LIBRARIAN Administrator's Guide
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PURGE (XPURGE)
Removes disk hles from the svstem and LIBRARIAN tracking data, if it exists in the

Restrictions
File owner for tracked files. File system security for untracked files,

Menu Mode
Select the Purge option from the File menu. A dialog appears allowing you to specify fi les,
revision criteria, and options.

Command Mode Syntax

LIBRARIAN database.

>PU[RGE] filelist

[; BATCH ]
[; DELTA ]
[; MEMO [ = memo — text] ]
[; RESTORE ] or [;NORESTORE ]
[; RETAIN ]
[; REVISION = revisionlALL]

[;VERIFY ]
t Not available with XPURGE

Parameters
filelist

ix+ DELTA

BATCH

RESTORE

RETAIN

REVISION =

revisi onlALL

NORESTORE

MEMO = memo — text

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode, Refer to Batch Operations
at the beginning of this chapter.

Purges the delta file associated with a master fi le, if a master file is
being purged.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the rnerno text.

Causes the most recent re~ision on the trunk to b ecome the master
after the current master is purged.

Retains the files as generation files (or delta).

If you specify ALL, purges all revisions of a master file; otherwise,
purges a specific revision.

Causes the current master to be purged and removed from the
master fileset, Previous revisions are still available using the
VERIFY command and step operations if you refer to the specific
file; the file will not be found if you use a wildcard or master
fileset authorization

Only authorizes files that have not been modified since
LIBRARIAN created the file in its current location.

VERIFY

Cornea nds 1-81



tracked.

PURGE (continued)

Operation
All LIBRARIAN references to the purged file or fileset, including associated secondary
copies and hie detail records, are removed from the database, but log transactions are not
deleted. If the purged file was a master file, any secondaries linked to it are no longer

PURGE automatically retains base revision files. To purge a base revision, use the VERSION
command to obsolete it and then the FLUSH uti l ity to purge it.

If neither;RESTORE nor;NORESTORE option is specified, the user will be prompted to
select one of the options.;RESTORE is the default when this p rompt is made, and when
QUIET ON or QUIET DISPLAY are in effect.

Note When you use PURGE to remove the last master, related secondary, or
retained file, the master hlename will automatically be removed from
the project fileset.

AUIX

XPURGE operates on untracked files only and enforces normal file system security, unless
the user has X capability.

Examples
Purge all copies of the FINANCE fi leset currently in the GL account and the finance
development area by typing:

>PURGE %FINANCE AT@.@.GL, %FINANCE AT O.N.FINDEVEL

> PURGE %finance AT /gl/", %finance AT /finance/devel/*

Retain backup copies of the files before you purge the entire GL-FILES fileset by typing.

Purge all the retained files in all groups in your login account in batch mode by typing:

> PURGE %GL-FILES;RETAIN

M E > PURGE G¹¹¹ ¹ ¹ ¹ ¹ .@ ; B ATCH

UNix > PURGE .g¹¹¹ ¹ ¹ ¹ ¹ ;BAT CH

Purge all of the files in all of the groups of the MFG account on the DEVELCPU system by
typing.

> PURGE DEVELCPU:@.@.MFG

> PURGE develcpu:/rnfg/*

Related Information

UNIX

See CLEANDB
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QUIET
Sets the level of interaction between LIBRARIAN and the user, including prompts and
standard messages.

Restrictions
None

Menu Mode
Select the Settings...Quiet Mode option f rom the User menu. A dialog appears allo@ ing
you to specify files, revision criteria, and options.

Command Mode Syntax

>QUIET ON
OFF
DISPLAY

Parameters
ON

OFF

Uses default answers to LIBRARIAN prompts.

Prompts for answers. LIBRARIAN waits for you to answer each
authorization module question. The default is QUIET OFF.

Uses default answers to LIBRARIAN prompts and suppresses standard
messages and prompts.

DISPLAY

Operation
With QUIET OFF, the authorization module prompts you for answers to several questions.
With QUIET ON, all authorization module questions appear, but you are not prompted for
the answers. Instead, the LIBRARIAN program supplies default answers. The defaults are:

Question
SHOW violations, authorizations, etc.
EXPLAIN?
CONTINUE?
WHICH ONE DO YOU WANT?
DO YOU WANT CONDITIONAL FILES?

Default Answer
YES
YES
YES
NONE OF THE ABOVE
NO

With QUIET ON, existing destination files are purged (unless the KEEP option is in effect),
and displays are always listed.

QUIET DISPLAY operates like QUIET ON, except that standard messages and prompts are also
suppressed. Only messages that show the result of a file operation and errors are shown.
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QUIET (continued)

Examples
Set the program to use default answers for prompts, and to minimize the display of
messages by typing:

) QUIET DISPLAY

Related Information

See XEQ ECHO
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Rl (or R7)
Executes Reflection commands within LIBRARIAN.

Restrictions
None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use R1 (or R7) as

Command Mode Syntax

described below.

> R1 [ Ref lecti on command ]

or

>R7 [ Reflection command ]

Parameters
Reflection command An y Reflection command.

Operation
The R1 (or R7) cornrnand allows you to execute Reflection commands within LIBRARIAN.
For information on Reflection command syntax and usage, refer to your Reflection Command
Language Manual.

Examples
Execute the DOS DIR command with Reflection in LIBRARIAN by typing:

>R1 DIR
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Presents a previous command entry for editing.

Restrictions
None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use REDO as described

Command Mode Syntax

belo~.

>RED[O] [ cmdid ]

Parameters
cmdid Command to re-execute, You can specify one of the following:

The rrth command before most current one, where n is a number in
the command line stack relative to most recent command, w'hich is -1.

m The n u m ber m in the command line stack. The number m is absolute

string Th e most recentcommand beginrung with the text string.

If you do not specify a value, LIBRARIAN p resents the previouscommand
for editing.

(not relative).

Operation
Use REDO to correct errors in the last command issued. LIBRARIAN'S REDO functions
similarly to MPE's REDO command. REDO includes the editing character ">," to append to
the end of the command, and "U" to undo the last edit. For more information, refer to the
MPE Commands Reference Manual. REDO recognizes the following editing characters:

I <text>

D <...D>

R <text>

U

Insert text starting at position of I.

Delete characters at position of D.

Replace text starting at position of R.

Undo the last edit.

Append to the end,
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REDO (continued)

Examples
Edit the previous command by typing:

) REDO

Edit command 20 by typing:

>REDO 20

Related Information
See DO

LISTREDO
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RELEASE
Removes the MPE security from a file or fileset.

Restrictions
File owner

Menu Mode

Select the Release option from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command IVlode Syntax
> REL[EASE] filelist

[; BATCH ]
[; MEMO [ = memo — !ext ] ]

Parameters
filelist

BATCH

A list of files, as described in How to Refer to Files at the beginning
of this chapter,

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you incIude comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo-t e x t

> RELEASE REL1.0 OF %FINANCE

Operation
RELEASE suspends the MPE security for all files or filesets specified. Use RELEASE to
release security when an operation requires access to files that are not normally available.
Only the LIBRARIAN Manager and the Application Manager can release files belonging to
a different login account or MPE user.

You can reinstate the security with the SECURE command.

LIBRARIAN does not record the changes made by RELEASE in the database.

Examples
Release all of the master files in the REL1.0 version of the FINANCE fi leset by typing:

Release all of the files in the SOURCE group of the system DST068 by typing:

Release all of the files in the PROGRAM-FILES fileset by typing:

> RELEASE DST068:@.SOURCE

> RELEASE %PROGRAM-FILES
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RELEASE (continued)

Examples, continUed
Release all secondary copies of files in the PROGRAM-FILES fileset that currently reside on
the system DST068 by aging:

> RELEASE /oPRDGRAM-FILES AT DST068:@.@,@

Related Information
See SECURE

UNix If you are running UNIX, see the chmod manual entry for equivalent functionality.
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RENAME (XRENAME)
Renames a file or the files in a fileset.

Restrictions
File owner for tracked files, file system security for untracked files.

Menu Mode
Select the Rename option from the File menu. A dialog appears allowing you to specify
files, revision criteria, and options.

Command Mode Syntax
>REN[AME] filelist [ TO tolocation ]

[; BATCH ]
[;CONIPRESS ]
[; CREATE = [GROUP ] [,ACCOUNT] [,CREATOR] ]
[; CREATOR = creator ) unixowner]
[; DECOMPRESS ]
[; GROUP = unixgroup ]
[,KEEP ]
[;LOCKWORD = lockword ]
[; MEMO [ = memo-text ] ]
[;OLDDATE ]
[;OLDNAME ]
[; PERMISSIONS = unixpermissions ]
[,VERIFY ]

t Not available with XRENAME,

Parameters
filelist A list of files, as described in How to Refer to Files at the beginrung

of this chapter,

The destination location for the filelist. The syntax is:TO tolocation

TO [system: ] file [.group [ acct ]]

70 [system: ] /[path.../] file

The equal sign (=) wildcard can be entered in any filename
element It takes the same value as the corresponding element in
the filelist (source file). Also, a single at sign (0<) can be used. It has
the same meaning as the equal sign (=) wildcard. The tolocation
can also be an Edit Mask, as described earlier in this chapter.

If tolocatIon is omitted, your current login location is assumed.
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RENAME (continued)

Parameters, continued
BATCH

Note

COMPRESS

CREATE

M E CREATE = GROUP,
ACCOUNT, and/or
CREATOR

exist.

Processes the transaction in batch mode. Refer to "Batch
Operations" earlier in this chapter.

Compresses the new destination file(s).

Makes any directories on the destination path that do not already

Creates MPE group, account, and/or creator if it does not exist.
If none of GROUP, ACCOUNT, or CREATOR is specified,
all will be created if necessary.

H — P's Security Monitor product enables system managers to

prevent the creation of users, groups, or accounts without
passwords, If CREATE is specified or configured on a step, and
this Security Monitor feature is in use, users will receive the
error message "Password required for user".

Overrides the MPE creator/UNIX owner of the new fi le. For MPE,
it can be a specific MPE user. For UNIX, it can be a specific UNIX
user login, or decimal user ID found in /etc/passwd. Alternatively,
you can use one of the following:

CREATOR = creator

! USER ID

! LOGON

!KEEP

Uses current LIBRARIAN user.

Uses MPE current login user.

Uses MPE creator/UNIX owner of the file
being replaced.

Note All LIBRARIAN user IDs are case-sensitive.

DECOMPRESS

KEEP

U~ix GROUP = unixgroup

Decompresses the new destination file(s).

Changes the group ID of the new destination file. It can be a
specific UN% group name or decimal group ID found in
/etc/group.

Instructs LIBRARIAN not to copy a file if the destination file
already exists. When you use batch mode or QUIET ON, the
default purges existing destination files. When you use session
mode, the default prompts you. KEEP overrides both of these
defaults.

Assigns a lockword to the destination file created by the
operation, You can specify! KEEP as the lockword, which instructs
LIBRARIAN to use the lockword from the old destination file.

LOCKWORD = /ockword
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RENAME (continued)

Parameters, continued
MEMO = memo — text

OLD DATE

OLD NAME

Lets you inciude comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wil l invoke the
configured editor so that you can enter the memo text.

Leaves timestamp in the database as is and sets the create and
modify dates of the destination file to be the same as the from file.

Uses the original name of the retained file in the new destination
location. System, group, and account are established by the
tolocati on specification.

Changes the permissions of the new destination file
according to the vnixpermissions mode, which is a number
constructed from the following mode bits:

UNtx PERMISSIONS =

vnixpermissi ons

0400 read by owner
0200 write by owner
0100 execute/search by owner

0040 read by group
0020 write by group
0010 execute/search by group

0004 read by others
0002 write by others
OOD1 execute/search by others

user g roup o thers

VERIFY Identifies files that have been modified by comparing the
modification timestamp in the file label with the timestamp stored
when it was last created by LIBRARIAN. If the file has been
modified since it was moved into its current location, the file is not
copied (violation).

Operation
RENAME changes the identity of the specified files. When master files are renamed,
LIBRARIAN updates associated secondaries and retained files to point to the new name. For
MPE files, if you rename a master file, the original lockword is retained; if you rename a
secondary file, your personal lockword is placed on the file.

When you rename a KSAM fi le, the associated key filename does not change.

Note When you use RENAME to remove the last master, related secondary, or
retained master associated with a project, the old filename wil l
automatically be removed and the new one will be added.

XRENAME operates on untracked files only and enforces normal file systemsecurity, unless
the user has X capability.
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RENAME (continued)

Examples
Change the group name for a list of files currently in your login group and account by

U IX

typing:

>RENAME FILEA, FILEB, FILEC, FILED TO =.DATA

>RENAME filea, fileb, filec, fiied TO data/=

Change the group name for all files currently in the SUZY account by typing:

AUIX

> RENAME @.SUZY TO =.SUZETTE

> RENAME /vsr/suzy/* TO suzette/=

Rename all of the files in the REL2 0 version of the %MFG-FILES fileset to files with their
original names to another area by typing:

> RENAME REL2.0 OF '/0MFG-FILES TO =.REL2GRP;OLDNAME

>RENAME REL2.0 OF %MFG — FILES TO /apps/mfg/rel2grovp/=;OLDNAME

Related information

@QE

See MOVE
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RESET ("")
Releases the reference to a set of files frozen with the SET co mmand.

Restrictions

>RESET *

None

Menu IVlode
Select Settings...Save Star from the User menu and then choose the OFF option to release
the files saved when you turned this option ON.

Command Mode Syntax

AI’I’ IX > RESET **

Parameters
None

Operation
The asterisk as a file reference indicates files successfully created or processed in the
previous transaction. This asterisk reference can be frozen, using the SET command, so
that ' always refers to the files of a particular transaction.

Use RESET ’ if you previously used SET ’ to freeze the files referred to by the asterisk ('),
and you now want to use the asterisk to refer to files in the last transaction.

Example
Reset the last transaction back reference bv tip>tnt,:

M k >RESET*

> RESET **

Related Information
UNfx

See SET *
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RESET (APPLICATION)
Resets the default application established with the SET APPLICATION corrunand.

Restrictions
None

Menu Mode
Select Settings...Appl ication from the User menu and then choose (none> from the menu.

Command Mode Syntax
> RESET APPLICATION

Parameters
None

Operation
Use RESET (APPLICATION) to reset the default application established with SET
(APPLICATION).

Examples
Reset the current default application by typing:

> RESET APPLICATION

Related Information

See SET (APPLICATION)
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RESET (EXCEPTION)
R emoves the exception flag on a file.

Restrictions
File Owner

Menu Mode
Select the Set...Exception reset option from the File menu. A dialog appears allowing you to
specify files, revision criteria, and options.

Command Mode Syntax
> RESET filelist EXCEPTION

[; BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
filelist

BATCH

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginrung of this chapter

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN will invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
When a read mode copy is checked in using PUSHREAD and a write mode copy exists, the
write mode copy is flagged with an exception. LIBRARIAN also records exceptions when it
encounters conflicts during a merge operation, or restores an older version of a file that is
currently checked out. Use the VERIFY command (Format ll ) to see which exception is set on

Any step attempted on these files fails with an EXCEPTION violation. The purpose of this
violation is to require the owner of the write mode copy to acknowledge the exception by
using RESET (EXCEPTION). This command clears the exception flag, so that a step can be
performed against it.

Examples
Reset the exception flag for file ABC1000S by typing:

a file.

) RESET ABC' 000S EXCEPTION

Related Information
See PERFORM

VERIFY

1-96 LIB RARIAN/iX Reference Guide



RESET (PROJECT)
Resets a default project set for a LIBRARIAN session with the SET PROJECTcommand.

Restrictions

None

Menu Mode
Select Settings...Project from the User menu and then choose <none) from the menu.

Command Mode Syntax
> RESET PROJECT

Parameters
None

Operation
Use RESET (PROJECT) to reset the default project established with SET (PROJECT).

Examples
Set the ABC project by typing

) RESET PROJECT ABC

Related information
See SET (PROJECTl
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RESET (ROUTE)
Resets the default route established with the SET ROUTE command.

Restrictions
None

Menu Mode
Select Settings...Route from the User menu and then choose <none) f rom the menu.

Command Mode Syntax
> RESET ROUTE

Parameters
None

Operation
Use RESET (ROUTE) to reset the default route established with SET (ROUTE).

Examples
Reset the current default route by typing:

> RESET ROUTE

Related Information
See SET (ROUTE)
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RESET (TIMESTAMP)
Resets a file's modificat ion t imestamp in the LIBRARIAN database to reflect the current
tirnestamp recorded by the file system.

ResfrlcfIons

Application Manager

Menu Mode

Select the Set...Tirnestamp reset option from the File menu. A dialog appears allowing you
to specify files, revision criteria, and options.

Command Mode Syntax
> RESET filelist TIMESTAMP

[;BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
fi/elist

BATCH

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify rnerno text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
After each successful LIBRARIAN f i le operation, the Modification Date/Time values are
extracted from the file label of the destination file and stored in the LIBRARIAN database.

If you use the VERIFY, MODIFiED or UNMODIFIED parameter in a file operation, you can use
the RESET TIMESTAMP command to update the values stored in the database so that the file
would no longer appear modified. Use the TOUCH command to make a file appear
modified.

Examples
Reset the timestarnp on all files in MFG on system DST068 by typing:

> RESET DST066:@.@.MFG T1MESTAMP

> RESET dst068:/appl/mfg/* TIMESTAMP
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RESET (TIMESTAMP) (continued)

Examples, continued
Reset the tirnestamps for FILEA on systems DST037, DST044, and DST068 by typing:

) RESET DST037:FILEA, DST044:FILEA, DST068;FILEA TIMESTAMP

> RESET dst037:filea, dst044:fiiea, dst068:filea TIMESTAMP

Related Information
See TOUCH
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RESTORE
Reconstructs a previous revision of a file making it the most current. For masters, it
automatically retains the current file before replacing it with the older version.

Restrictions
LIBRARIAN Manager, Operator for master files, or File am er for secondary fi les

Menu Mode
Select the Restore option from the File menu. A dialog appears allowing you to specify fi les,
revision criteria, and options.

Command Mode Syntax
> REST[ORE] filelist

[;BATCH ]
[; COMPRESS ]
[; CREATE = [ GROUP ] [,ACCOUNT] [,CREATOR ] ]
[; CREATOR = creator ~ unixowner]
[; DELTA ]
[; DECOMPRESS ]
[; KEEP ]
[; MEMO [ = memo — text ] ]
[; RENUMBER ]
[; VERIFY ]

Parameters
filelist

UNix CREATE

BATCH

COMPRESS

M E CREATE =GROUP,
ACCOUNT, and/or
CREATOR

exist.

A list of files, as described in How to Refer to Files at the beginning
of this chapter. The REVISION and GCOUNT parameters are
particularly useful with this command.

Processes transactions in batch mode. Refer to Batch Operations at
the beginning of this chapter.

Compresses the new destination file(s ),
Makes any directories on the destination path that do not already

Creates MPE group, account, and/or creator if it does not exist.
If none of GROUP, ACCOUNT, or CREATOR is specified,
all will be created if necessary.

H — P's Security Monitor product enables system managers to

prevent the creation of users, groups, or accounts without
passwords. If CREATE is specified or configured on a step, and
this Security Monitor feature is in use, users will receive the
error message "Password required for user".

Note

C ommands 1- 1 0 1



RESTORE (continued)
Parameters, continUed

CREATOR = creator Overrides the MPE creator/UNIX owner of the new fi le. For MPE,
it can be a specific MPE user. For UNIX, it can be a specific UMX
user login, or decimal user ID found in /etc/passwd. Alternatively,
you can use one of the following:

! USERID

LOGON

!KEEP

Uses current LIBRARIPZ4 user.

Uses MPE current login user.

Uses MPE creator! UNIX owner of the file
being replaced.

Note All LIBRARIAN user IDs are case-sensitive.

<+ DELTA

DECOMPRESS

KEEP

MEMO = memo — text

defaults.

Reconstructs the current master f ile from the corresponding delta
file. Use this when you suspect the master file has been corrupted.

Decompresses the new destination file (s).
Instructs LIBRARIAN not to copy a file if the destination fi le
already exists. When you use batch mode or QUIET ON, the
default purges existing destination files. When you use session
mode, the default prompts you. KEEP overrides both of these

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

Renumbers a numbered file when reconstructed from a delta file.RENUMBER

VERIFY Identifies files that have been modified bycomparingthe
modification timestarnp in the file label with the timestamp stored
when it was last created by LI B E R I A N . I f the file has been
modified since it was moved into its current location, the file is not
copied (violation)

Operation
RESTORE allows you to restore a retained file to its original name and location. A restored
master file becomes a master file once again, and a restored secondary becomes a secondary.
You specify a previous revision of a file by using the REVISION or GCOUMT parameters (see

If the retained file was compressed and the current master file is not compressed, the file is

decompressed automaticallyafter it is restored.

The restored file replaces any file that may currently exist in the destination location after
being retained, unless you use the KEEP parameter.

fi lelist).
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RESTORE (continued)

Operation, continued
For secondary files, you can specify the name(s) and LIBRARIAN wi l l automatically restore
the latest retained file based on the modification timestarnp, To use this feature, enter the
following:

> RESTORE secondary — name

Examples
Replace the current production files in the FINANCE fi leset with the REL3.0 version.

Alternatively, restore a retained secondary file by specifying the secondary filename,
LIBRAI?ZAN automatically restores the latest retained file, based on the modification
tirnestamp. To use this feature, type:

> RESTORE myfile

Restore files retained in the last transaction by typing:

>RESTORE REL3 0 OF %FINANCE

M E. )RESTORE *

U ix )RESTORE '™

This syntax can be used in an XEQ procedure to automatica11y back out a partial transaction,
as shown in the following example:

D! STRI BUTE! XEQLIST;RETAIN
IF LIBFAIL>0 THEN

CONTINUE
RESTORE *
MAIL OPERATOR;DISTRIBUTION Failed!

ENDIF

In batch mode, restore and decompressthe latest retained files in the source area. If a
destination file already exists, do not replace it. Add rnerno text describing the transaction.

) RESTORE @.SOURCE; GCOUNT = � 1; DECOMPRESS;KEEP;BATCH;MEIVIO

>RESTORE /src/*; GCOUNT= � 1; DECOMPRESS; KEEP; BATCH; MEMO

Related Information
See VERIFY

Revision History Report (RRH10) in Chapter 6, "Reports"
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RETRY
Sets the number of ti mes to attempt linking to a remotesystemthat is not responding, and
the interval between attempts.

Restrictions

None

Menu Mode
Not available in menu mode. Press F2 for command mode and then use RETRY as described

Command Mode Syntax

below.

> RET[RY] [ max-retries [,retry-interval ] ]

Parameters
max-retries The number of times for LIBRARIAN to attempt linking- to remote systems.

retryinterval Th e n u m b er ofminutes between each attempt. Default: 0.

Operation
RETRY sets the number of times LIBRARIAN attempts to link to a remote system after the
first unsuccessful attempt and the number of minutes between each attempt.

If you do not specify any parameters, the current RETRY settings are displayed.

Setting a maximum RETRY value has an effect only when LIBRARIAN detects that the
remote system is not responding or has rejected the login request. Typically, this happens
when the remote system is down, the network has not been started, or the remote session
limit is too low to provide a login. No retry attempts are made if the error is an invalid
device specification.

Examples

Attemptto link to the remote system ten times, with thirty­ minute intervals between
attempts by typing:

> RETRY 3 0,30

Display the current RETRY settings by typing:

Default: 0.

> RETRY

Related Information

See Chapter 3, "File Transactions" in the LIBRAMAN/iX User's Guide
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SCAN (XSCAN)
Scans files for strings of text, and optionally replaces matchingtext,

Restrictions
File owner/ f i le system security for tracked files; file system security for untracked files.

Menu Mode
Select the Scan option from the Tools menu. A dialog appears allowing you to specify fi les,
search text, revision criteria, and options.

Command Mode Syntax
> SCA[N] filelist

[;ASK ]
[; BATCH ]
[; CHAR j
[; COLUMNS = [firstcol] [,lastcol ] ]
[; IGNORE i;UPSHIFT j
[; LINES = [firstline ] [,lastline ] ]
[;LISTFILE = filename ]
[;IVIATCHES = nummatches ]
[; MEMO [ = memo-text ] ]
[;NOPAGE ]
[;NOSHOW ]
[,NUMBERED ]
[;OEFLINE ]
[;REVERSE]
[; SHOW ]
[; SUMMARY ]
[; TEXT = search [ (replace [,...] ]
[; WINDOW = [ linesbefore ] [,bnesafter ] ]

Parameters
filelist

ASK

BATCH

COLUIVINS

A list of files, as described in How to Refer to Files at the beginrung
of this chapter.

Asks the user to cordirm each replacement.

Processes the transaction in batch mode, Refer to Batch Operations
at the beginrung of this chapter.

Displays unprintable characters as periods (,), This is the default
for binary files, You should use this option for ASCII fi les with
unprintable data.

Restricts the range of columns to scan, where firstcol is the
beginzung column (Default: 1), and lastcol is the ending column
(default is record length)

Ignores upper and lower-case.IGNORE or UPSHIFT
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SCAN (continued)

Parameters, continUed

LINES

NOPAGE

NOS HOW

NUMBERED

LISTFILE = filename

MEMO = memo — text

MATCHES = nummatches

file size).

Restricts the range of lines scanned, where firstline is the
beginrung line (Default: 1), and lastline is the ending line (Default:

Writes the names of files w ith at least one match to a listfile, where
filename is the name of a listhle in your login directory.

Specifies the number of matches required before terminating the
search. By default, it scans the entire file.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

Memos are only logged if SCAN is used with the replace option.

Specifies that there should be no page breaks.

Instructs LIBRA&AN not to display matching lines.

Displays line numbers for matchingl ines, in conjunction with the
SHOW parameter.

Directs scan listing offline.

Selects lines in which the search string is not found.

Displaysmatchinglines (default).

Displays a summary of matching files

Specifies search and replace strings containing a maximum of
50 characters each. You can specify any number of search/replace
pairs, separated by cornrnas.

Enclose the search string (search) in quotes only if it includes
commas, semicolons, slashes, or blanks.

The following pattern­matchingwildcards can appear anywhere
in the search string.

Q4 match any number of any character

? m atch any single alphanumeric character

¹ rn atc h any single numeric character

match any single alphabetic character

match any single blank character

OFFLINE

REVERSE

SHOW

SUMMARY

TEXT = search [ireplace
(, search / replace J J, ... J

! m atch an y single character

(...j rn at ch a character in the set of characters enclosed in
braces (e.g., (ABCj). You can refer to a maximum of ten
character sets in a single command.
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SCAN (continued)

Parameters, continued

characters.

itself to indicate a literal match.

for this file

All pattern-matching wi ldcards (except for @) can be followed by
+, indicating a match for one or more occurrences. A minus sign
( - ) following the wildcard, indicates zero or more occurrences.
For example, the search string 0+ informs LIBRARIAN to search
for a string containing one or more consecutive numeric

The following characters can be used at the beginrung and end of
search strings, respectively:

[ match string at beginrung of line only.

] match string at end of line only,

The backslash (X) can precede any pattern-matching character and

Each search string can have an associated replace string (reptace)
with a maximum of 50 characters. Use a slash (/) between search
and replace strings, Replace strings should be enclosed in quotes
if they include commas, semicolons, slashes, or blanks.

You can use the following variables for replacement:

! NEXTG substi t u t es next generation count (GCOUNT + 1)

substitutes next version count (VCOUNT + 1) for! NEXTV
this files

!VCOUNT sub sti t u tes version count for this file

!GCOUNT subst i t u tes generation count for this file

!VERSION subst i t u tes version name for this file

! REVISION subst i t u tes revision ID for this file

Edit masks can also be used to transform the search string into a
new replace string. Enclose the edit mask in parentheses. Edit
masks follow the same conventions as edit masks for filenames.
See the begixuung of this chapter for more information.

You can append text to the end of lines where a match was found
by putting a plus (+) in front of the replace string.

You can delete lines on which a match was found by specifying
! DELETE in place of a replace string.

Sets the number of lines to show before and after matching lines,
where linesbefore sets the number of lines to show before a
matching line (Default: 0). Iinesafter sets the number of lines to
show after a matching line (Default: 0).

WINDOW
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S CA%LIST.

SCAN (continued)

Operation
Use SCAN to search files for a particular string (or strings) of characters. You can replace
strings of text in files containing a maximum of 4096 bytes in length.

Pattern-matching characters can be used in the search string, The OFFUNE option generates
a listing on the LP device. This listing can be redirected with a file equation for LIBOUT or

You can use SCAN to review the contents of a file on your terminaL If you omit the TEXT
parameter, you wil l see 23 lines of the file at a time. At the end of each page you are
prompted to continue. The next page is displayed by pressing RETURN. If you type a
record number, a page of text is displayed starting at that record number.

A JCW, LIBMATCHES, is available after SCAN operations complete. This JCW shows the
number of fi les in which a string match was found.

XSCAN operates on untracked files enforcing normal file system security, unless the user has
X capability.

You can print QEDIT files (FILECODE = 111) if you are using QEDIT Version 4 L,55 or
higher.

Examples
Search all files in the SOURCE area for the FINANCE application for the string $INCLUDE.
Display each line of text for all occurrences found to match without sensitivity to case by
typing.

) SCAN @.SOURCE. FINANCE; TEXT= $INCLUDE; IGNORE

) SCAN /appl/finance/source/; TEXT= /¹ include; IGNORE

Search the FINANCE-FILES fileset for files that include the string VERSION:= '2.xx', where
xx are any numeric values that match without sensitivity to case and allow any number of
blanks in between. After the first rnatch quit and generate a listfile with the names of files
for which a match was found To do this, type:

> SCAN %FINANCE-FILES; TEXT= VERSION!: =! '2.¹ ¹ ' , IGNORE; MATCHES = 1; &

Search and replace by typing:

LISTFILE= VERS2LIST

) SCAN %FINANCE-FILES;TEXT ="REL¹ . ¹ 4 " / " REL! VERSION! NEXTV"

Related tnformation
See Chapter 5, "Printing, Comparing, and Scanning Files" in the LIBRARIANiiX User's Guide
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SCOMPARE (XSCOMPARE)
Accesses the S/COMPARE utility (a proprietary product of the ALDON ComputerGroup).
Must be installed on the I IBRARIAN/ iX server.

ReStrictions

File owner/ f i le system security for tracked files; file system security for untracked files.

Menv Mode
Select the Compare option from the Tools menu. A dialog appears allowing you to specify
files, revision criteria, and options. The method of comparison is determined by the
compare method that you can change on the Settings window from the User menu.

Command Mode Syntax
> SCO[MPARE] filelist TO filelist

[; BATCH ]
[;BEGINPOS = column-number ]
[;ENDPOS = column-number ]
[; BLANKS ] or [;NOBLANKS ]
[; COMMENTS = YES ] NO f NOBLANK ]
[;COPYLIB ] or [;NOCOPYLIB ]
[;EDIT] or [;NOEDIT]
[; FORMAT = [ NOOFFSET], [ NOBOX] ]
[;FROMVCOUNT = fromvcount ] or [;FROMGCOUNT= fromgcount ]
[;TOVCOUNT = tovcount] or [ ;TOGCOUNT= togcount ]
[;FROMREV = revid ]
[;TOREV = revid ]
[;LANGUAGE = langid j
[; MATCH = beforenum [,afternum ] ] or [,NOMATCH = beforenum [,afternum ] ]
[; MEMBER = refmem [,cmpmem ] j
[;OFFLINE [ = [ device ] [, [priority] [, [ copies ] [, [ env ] ] j ] ] ] or [;ONLINE]
[;PACK] or [;NOPACK]
[;PAGESIZE = pgsize ]
[; RANGE = [ first record ] [,last record ] [,RELATIVE ] ]

t Not available with XSCOMPARE

Parameters
filelist A list of files, as described in How to Refer to Files at the

beginning of this chapter.

SpeciFies the reference files to be used in comparisons.
Processes the transaction in batch mode. Refer to Batch
Operations at the beginrung of' this chapter,

TO filelist

BATCH
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SCOMPARE (continued)

Parameters, continued
BEGINPOS
= column-number

ENDPOS = column number

is the left column.
Sets the left-most column to compare, where column-number

Sets the right-most column to compare, where column-number
is the right column.

Comparison does not ignore blank lines.

Comparison ignores blank lines.

Includes or excludes comments from a comparison. setting
may be one of:

BLANKS

NOBLANKS

COM M ENTS =setting

NO

YES

excludes all comments

compares all comments

NOEDIT

COPYLIB

NOCOPYL[B

EDIT

FORMAT = type

FROMVCOUM
= fromvcount

FROMG COUNT
= tromcount

TOVCOUNT = tovcount

TOGCOUNT = togcount

ENDPOS.

reference files.

differences between the files.

NOBLANKS compares all except blank comments.
A blank comment is one that contains on1y spaces or comment
delimiters between the columns specified by BEG INPOS and

Treats sequential files as copy libraries.

Treats KSAM files as flat files,

Creates an editor USE file containing the differences between
the reference file and the compare file.
Instructs S/COMPARE not to create a USE fi l containing the

Allows you to select NOOFFSET, NOBOX, or both as the format
type.

Uses compare files with a version count equal to fromvcount
This parameter must have a positive value and be used in
conjunction with the versionid parameter.

Uses compare files with a generation count equal to
fromgcount. This parameter can have either a positive or
negative value.

A negative value describes the generation equal to the current
generation minus the GCOUNT. For example,GCOUNT =-2
specifies the file two generations earlier than the current
generation.

Same as FROMVCOUNT described above, but applies to

Same as the FROMGCOUNT described above, except defined
for the TO filelist,
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SCOMPARE (confinued)

Parameters, continued
FROMREV = revid

TOREV = revid

Specihes which revision to retrieve as the compare file.

Same as FROMREV, but applies to the reference hie(s).
The remaining parametershave the same value as the
corresponding parameterin the SET command of the
S/COMPARE product, except where noted.

Indicates the language of the source files to be compared.
Possible languages values include:

LANGUAGE =!angid

MATCH

ONLINE

PACK

NOPACK

MEMBER

OFFLINE

NOMATCH

space.

NONE RPG
PASCAL SPL
P OWERHOUSE TE X T
~ SA CT

BASIC
COBOL
FORTRAN
JCL

Controls the display of matching lines, where beforenum is
before the first number and afternum is after the last number.

Excludes some on all of the matchinglist from the output
report.

Specifies the copy library members tocompare.
Directs output to a line printer. You can specify the print
device, output priority for number of copies, and environment
filename for listing.

Directs output to your terminal.

Treats consecutive spaces as a single space.

Does not compress consecutive spaces in records to a single

Sets the number of lines per printed page.

Limits the comparison to those records between the first
record and the last record. If RELATIVE, these are relative
record numbers.

PAGESIZE = pgsize

RANGE

Operation
SCOM PARE accesses the S/COMPARE product providing it is installed on the system.
SCOMPARE supports most of the parameters of the S/COMPARE COMPARE and SET
commands.
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SCOMPARE (continued)

Operation, continued
Additionally, SCOM PARE provides you with an online display of file differences using video
enhancements, and greater flexibil ity when specifying fi les. For example,with the
SCOMPARE cornrnand you can:

'1. Comparefilesets using logical fileset identifiers.

2. Compare groups of physical files using wildcards.

3. Coznpare files without specifying the actual fil enames, using AT and version/
revision specifications instead.

SCOMPARE’s output also provides LIBRAMAN f i le information (as comments), including
file IDs, file type, versions, and generations of the files being compared. If the. files are
compressed, SCOMPAREautomaticallydecompresses them temporarily before the compare

XSCOMPARE operates on untracked files enforcing normal file system security, unless the
user has X capability.

Examples
Compare the REL3 0 and REL4.0 versions of the AP-FILES f ileset by typing,

operation.

>SCOMPARE REL3.0 OF %AP-FILES TO REL4.0 OF %AP-FILES

The following examplecompares the current and the REL1.0 versions of the SFILES fileset.
The language of the source code is Pascal and the output device is LP.

) SCOMPARE %SFILES TO REL1.0 OF %SFILES;LANGUAGE = PASCAL;OFFLINE = LP

The following example compares the current version of the LOGFILES fileset to the
secondary copy of the fileset in the SQUDEVEL account. The language for the source code is
Pascal. Show the ten lines matchingbefore and after a mismatch. The output device is LP.

>SCOMPARE %LOGFILES TO %LOGFILES AT @.N,SQUDEVEL 8r.
;LANGUAGE=PASCAL,MATCH=10,10;OFFLINE = LP

Related Information
See Chapter 5, "Printing, Comparing, and Scanning Files" in LIBRARlAN jiX User's Guide,
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SECURE
Turns on the MPE security for a file or fileset.

Restrictions
File owner

Menu Mode
Select the Secure op tion from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command Mode Syntax
>SEC[URE] filelist

[; BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
filelist

BATCH

A list of files, as described in How to Refer to Files at the beginrung
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
SECURE reinstates normal MPE file access security that was previously suspended by the
RELEASE command. You can also secure files on remote systems.

LIBRARIAN does not record changes made by the SECURE command in the database.

Examples
Secure all of the master files in the FINANCE fi leset by typing:

Secure all of the files in the FINANCE fiIeset that were retained two generations earlier by
typing:

>SECURE %FINANCE

> SECURE %FINANCE;GCOUNT =-2

Secure all files in the SOURCE group of your login account on system DST068 by typing:

> SECURE DST068:@.SOURCE

Secure all secondary copies in the PROGRAM-FILES fileset that reside on the current system
by typing:

> SECURE %PROGRAM-FILES AT @.@.@
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SECURE (continued)

Related Information

UNix If you are runrung UMX, see the chmod manual page for equivalent functionality,

See RELEASE
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Freezes the asterisk reference to files in the last transaction for use in subsequent
transactions.

Restrictions
None

Menu Mode
Select Settings ..Save Star from the User menu and then choose ON to save the filenames
from the last transaction.

Command Mode Syntax

>SET *

>SET **

Operation
SET ’ allows you to save the transaction number associated with the previous transaction so
that you can recall associated filenames at a later time, To do this, use ' for MI’E a nd " f o r
~, as a way to refer to files. If the previous transaction had destination files, the

Release the asterisk (') for redefinition by using the RESET command.

When you exit the LIBRARIAN program, the files designated by SET * are not remembered.
To save the hleset, create a listfile with the following commands:

destination filenames are used.

> LMAINT
LM>OUTPUT * TO MYFILES
LM > EXIT
> EXIT

Examples
If you perform a CHECKIN transaction and then issue SET ’, the system remembers the
transaction so that it can search for the files created by the CHECKIN step. You can then
reference them in another command (e.g., DISTRIBUTE ), even if you have performed
transactions with other files.

>SET '
>DISTRIBUTE * TO SYS1: =
> DISTRIBUTE * TO SYS2: =

> DISTRIBUTE * TO SYS3: =
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SET" (continued)

Examples, continued
Ij X >SET **

> DISTRIBUTE ** TO SYS1: =
) DISTRIBUTE ** TO SYS2:=
>DISTRIBUTE " T O SYS3:=

Related information

Chapter 3, "Master Library" in the LIBRAIUAN/iX Administrator's Guide
Chapter 3, "File Transactions" in the LIBRARIAN/iX User's Guide

See RESET’
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SET (APPLICATION)
Sets a default application to resolve ambiguous steps and versions.

Restrictions
None

Menu Mode
Select Settings...Application from the User menu. A picklist appears to let you select an
application.

Command IVlode Syntax

>SETAPPLICATION [applid]

Parameters
applid The name of the application to set as the default.

Operation
Use SET (APPLICATION) to specify the default application for a LIBRARIAN session. By
setting an application, LIBRARIAN can resolve certain ambiguities automatically (e.g.,
versions and steps). Using this command without specifying an application displays the
current default application.

Examples
Set the ABC application by typing:

> SET APPLICATION ABC

Related Information
See RESET (APPLICATION)
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SET (EXPDATE)
Changes the expiration date for read mode secondaries and retained revisions,

Restrictions
File Owner

Menu Mode
Select the Set...Expiration Date option from the File menu, A dialog appears allowing you
to specify an expiration date, files, revision criteria, and options.

Command Mode Syntax

>SET filelist EXPDATE TODAY

expire date
NONE

[; BATCH ]
[ IMEMO [ = memo — text ] ]
[; REVISIONS = revision/ALL ]

Parameters
fi lelist

BATCH

MEMO = memo — text

EXP DATE = expiration

Processes the transaction in batch mode Refer to Batch Operations

A list of files, as described in How to Refer to Fi1es at the beginning
of this chapter.

Indicates the date the file will expire. You must use one of the
following keywords, or a specific date:

TODAY Sets e x p i ra t ion date to the current date.

NONE Sets the file not to expire.

expire-date Sets expiration date to this date. You must use the
date format defined for your system on the System
Profile screen (SP).

at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify rnerno text, LIBRARIAN wil l invoke the
configured editor so that you can enter the memo text.

If you specify ALL, sets expiration date of all revisions of a master
file, otherwise, sets expiration date of a specific revision.

REVISION =

revisi on/ALL

Operation
SET EXPDATE assigns an expiration date to retained or read mode secondary files. Expired
files are flushed the next time you run the FLUSH uti l i ty.

Master files are never flushed and do not accept an expiration date. Retained base revisions
are not flushed until they are made obsolete, regardless of the expiration date. Write mode
secondaries are also ignored by the FLUSH uti l i ty, regardless of expiration date, until the
write mode has been relinquished

The RFN10 and RFN20 reports list the files that will be flushed when FLUSH is next run.
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SET (EXPDATE) (continued)

Examples
Set the expiration date to today for all of the retained files in your login group and account
by typing:

M E
> SET G ¹¹¹ ¹ ¹ ¹ ¹ .@ . @ EXP DATE= TODAY

> S ET /*/.g¹¹¹ ¹ ¹ ¹ ¹ EXP DATE= TODAY

Set no expiration date for the files in the SOURCE group of your login account by typing:
UNIX

>SET N.SOURCE EXPDATE=NONE

>set src/ expdate = none

Set the expiration date to 25 December 1991 for the files in the MYFILES fileset by typing:

M E

> SET %MYF ILES EXP DATE= 12/25/91

Related information
See FLUSH

VERIFY
Pre — Flush Notification Reports (RFN10/RFN20) in Chapter 6, "Reports"
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SET (LANGUAGE)
Allows you to assign a programming language to files for use when LIBRARIAN annotates
source code.

Restrictions

Application Manager

Menv Mode
Select the Set...Language option f rom the File menu. A dialog appears allowing you to
specify a language, files, revision criteria, and options.

Command Mode Syntax
>SET filelist LANGUAGE = langid

[; REVISIONS = revision/ALL ]

Parameters
filelist A list of files, as described in How to Refer to Files at the beginning

of this chapter.

Indicates the programming language to assign to the source file(s).
The language values include:

LANGUAGE = langid

BASIC
COBOL
FORTRAN
JCL

If you specify ALL, sets language value of all revisions of' a master
file; otherwise, sets language value of a specific revision.

NONE RPG
PASCAL SPL
P OWERHOUSE TE X T
TRANSACT

REVISION =
revisi on/ALL

Operation
Use SET (LANGUAGE) to select your progra~g l an gu a ge. A source code file must be
assigned a language type for annotation to w'ork properly.

Examples
Assign the COBOL language to all of the files in Libprod Source area by typing:

M E
) SET @.SOURCE.LIBPROD LANGUAGE =COBAL

> SET /apps/src/libp rod/' LANG UAGE = COBOL
VNIX
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SE7 (LOCKWORD)

Assigns a new lockw'ord to a file or fileset.

Restrictions
File Owner

Menu Mode
Select the Set...Lockword option from the File menu. A dialog appears allowing you to
specify a new lockword, fi les, revision criteria, and options.

Command Mode Syntax
o SET filelist LOCKWORD = lockword

[; BATCH ]
[;NIEMO [ = memo — text] ]
[; REVISIONS = revision/ALL ]

Parameters
fileiist

BATCH

MEMO = memo — text

LOCKWORD = lockword

lockword is removed.

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

Indicates the new lockword to assign. It must conform to MPE
naming conventions. If no lockword is specified, any current

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify rnerno text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

If you specify ALL, sets a lockword for all revisions of a master file;
otherwise, sets a lockword for a specific revision.

REVISION =

revision(ALL

lockwords are removed.

Operation
SET LOCKWORD changes the current lockword of a file or fileset. SET LOCKWORD updates
thesystem directory with the new lockword. If the lockword value is left blank, existing

Examples
Assign the lockword KEEPOUT to all of the files in the FINANCE fileset by typing:

For all fi les in your login group and account, remove the current lockword by typing:

) SET%FINANCE LQCKWO RD =KEEPOUT

) SET @ LOCKWORD =PRESENT
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SET (MODE)
Changes the access mode for secondary files.

Restrictions
Application Manager

Menu Mode
Select the Set...Mode option from the File menu. A dialog appears allowing you to specify a
mode, files, revision criteria, and options.

Command Mode Syntax

>SET filelist MODE = J WRITE(,
i READ J

l;BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
filelist

READ

MODE

WRITE

BATCH

A list of files, as described in Horo to Refer to Files at the beginning
of this chapter.

Specifies the access mode to be assigned to the file, as one of the
following:

Assigns write mode access to file(s). A write mode secondary can
replace its master.

Assigns read mode access to file(s). A read mode secondary
cannot replace its master

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBE R I A N w iU invoke the
configured editor so that you can enter the rnerno text,

MEMO = memo — text

Operation
SET MODE changes the current access mode of a file or fileset. Although you can use SET
MODE to change the access mode, you are restricted by the access control level of the file. If
a file has been checked out and modified but cannot replace the master file because it is in
read mode, use SET MODE to change the access mode to write mode. However, if the file has
serial access control and a write mode copy has already been checked out, change the other
file to read mode before changing the modified file to write mode
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SET (MODE) (continued)

Examples
Assign write mode access to all secondary copies of files in the FINANCE fi leset bv typing:

M E )SET %FINANCE AT @.@.@ MODE=WRITE

> SET%FINANCE AT / MODE = WRITE

Assi~ w r i te mode access to all files with names ending in S in the DEVEL group of the
MFG account on system DST068 by typing:

> SET DST068:@S.DEVEL,MFG MODE=WRITE

>SET dst068:/mfg/devel/*s MODE=WRITE

Change the access mode to read mode for secondary copies of files in the MFG-FILES fileset
that are in your login group by typing:

AUIX

> SET %MFG-FILES AT @.@ MODE= READ

>SET%MFG � FILES AT./* MODE =READ

Related information
See PERFORM

UNIX
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SET (OWNER)
Changes the LIBRARIAN owner of a file.

Restrictions

Application Manager

Menu Mode

Select the Set...Owner option from the File menu. A dialog appears allowing you to specify
a new owner, files, revision criteria, and options.

Command Mode Syntax
>SET filelist OWNER = userid

[; BATCH ]
[,MEMO [ = memo — text ] ]

Parameters
fi leiist A list of files, as described in How to Refer to Files at the beginrung

of this chapter.

Specifies a valid LIBRARIAN user.OWNER = userid

Note All LIBRARIAN user IDs are case-sensitive.

BATCH Processes the transaction in batch mode. Refer to Batch Operations
at the beginrung of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the memo text.

MEMO = memo — text

Operation
SET OWNER changes the LIBRARIAN owner of a file.

Examples
Set the owner of a file, ABC100S, to LIBMGR by typing:

)SETABC100S OWNER = LIBMGR

Related Information

See PERFORM
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SE7 (PROCEDURE)
Instructs LIBRAIUAN to catalog all procedures in a macro procedure file,

Restrictions
None

Menu Mode
Select Load procedures from the Macros menu to catalog procedures in a procedure file.
Select Unload procedures from the Macros menu to unload all procedures.

Command Mode Syntax
> SET PROCEDURE TO [ filename ]

Parameters
filename The name of a macro procedure file.

Operation
SET PROCEDURE reads through the macro procedure file specified, cataloging all
procedures so they can be used as LIBRARIAN commands. To see the list of cataloged
procedures, use the HELP PROCEDURES command. Use SET PROCEDURE without
parameters to release access to procedure files previously set by this command.

Examples
Catalog macro procedures in the file MYPROC so they can be used as commands by typing:

wSET PROCEDURE TO MYPROC

Related Information
See Chapter 9, "Macros" in the LIBRARIAN/iX User's Guide
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SET (PROJECT)
Sets a default project for the LIBRARIAN session so user does not need to select a project
from the project menu. Addit ionally, it allows you to change the project to which a file
currently belongs.

Restrictions
None

Menu iVlode
Select the Settings...Project option from the User menu. A menu appears allowing you to
select a project.

Command Mode Syntax
>SET [ filelist ] PROJECT [ [=] project — name ]

[; REVISIONS = revision/ALL ]

Parameters
filelist

project — name

REVISION =

revisi on/ALL

The file(s) for which you want to change the project.

The name of the project to be set as the default.

If you specify ALL, sets the project of all revisions of a master file;
otherwise, sets the project of a specific revision.

user must

will be displayed.

Operation
To specify the default project for a LIBRARIAN session, do not indude the filename
parameter. If you use SET without the project — name parameter, the current default project

To change the project assigned to a secondary, master, or retained file, include the filename

parameter. When used with a secondary or master file, it also removes the filename from the
old project's fileset, and adds it to the new project's fileset. To perform this command, the

� hav e 'L ' ( l ibrarian manager) capability,

� hav e 'A' (application manager) capability for the application, or

Examples
Set the ABC project by typing

� be the owner of the file.

>SET PROJECT ABC

Related Information
See RESET (PROJECT)
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SET (ROUTE)
Sets a default route to resolve step/project name ambiguities.

Restrictions
None

Menu Mode

Select the Settings...Route option from the User menu. A menu appears to let you select a

Command Mode Syntax

route,

>SET ROUTE [routeid ]

Parameters
routei d The name of the route to set as the default.

Operation
Use SET (ROUTE) to specify the default route for a LIBRARIAN session. By setting a route,
LIBRARIAN can resolve step and project ambiguities automatically. Using this command
without specifying any route causes the current default route to be displayed.

Examples
Set DEVEL as the default route by typing:

>SET DEVEL ROUTE

Related Information
See RESET (ROUTE)
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sET O'AG)
Assigns a user-defined tag to a file or set of files,

Restrictions
Application Manager

Menu Mode
Select the Set... Tag option from the File menu, A dialog appears allowing you to specify a
tag, files, revision criteria, and options.

Command Mode Syntax

[; REVISIONS = revision/ALL ]
> SET fileset TAG = f tagid ]

Parameters
fiieiist

TAG =tagid

A list of files, as described in How to Refer to Files at the beginning
of this chapter.

A user-defined text string to be assigned to a file or set of files.
tagid can be a maximum of twelve (12) characters.

If you specify ALL, sets tag value of all revisions of a master file;
otherwise, sets tag value of a specific revision.

REVISION =

revisi on/ALL

Operation
SET TAG accepts a user-defined tag that wiH be associated with any type of tracked file or
set of files, This tag can be used to select files in any command that accepts fi l enames
You can perform steps against Files that have a given tag or verify fi les with a particular tag.
The tag feature is for convenience, providing another way for you to organize and reference
different configurations of files.

Tags allow you to mark subsets of applications with an identifier that can be used to
distribute subsets of an application (e.g., a patch). Tags can be used to establish a baseline
for a subset of an application; whereas, versions establish a baseline for the entire
application.

Note Since a SET TAG transaction is not logged in the audit database, you
can not use ' or " a f ter this command to refer to files in the last
transaction.
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SET (TAG) (continued)

Examples
The following example assigns the tag PATCHI to a set of files in a project.

) SET '/PROJECT1 TAG=PATCH1

Related lnformat<on
See Chapter 7, "Versions" in the LIBRARIAN!iX Administrator's Guide
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SHOWLOG
Accesses the SHOWLOG transaction log reporting uti l i ty.

Restrictions
None

Menu Mode
Select the Log...Showlog option from the Info menu.

Command Mode Syntax
> SH [OWLOG]

Parameters
None

Operation
SMOWLOG provides direct access to the LIBRARIAN transaction log reporting subsystem,
which consists of commands that allow users to inspect transaction log data. This subsystem
allows you to select, format, and sort log database transaction records, and edit memo text

Once you access the SHOWLOG util i ty, the program uses the >SHOWLOG prompt.

Examples
Access the SHOWLOG selection menu by typing:

entered for transactions.

> S HOWLOG

Related Information
See Chapter 4, "SHONLOG Commands"

1-130 LI EIRARIAN/IX Reference Guide



TOUCH (XTOUCH)
Updates the modification timestamp in the MPE file label with the current date and time

Restrictions
File owner or MPE write access,

Menu Mode
Select the Touch option from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command Mode Syntax
> T[OUCH] fiieiist

[; BATCH ]
[; MEMO [ = memo — text] ]
[; RESET ]
[; VERIFY ]

t Not available with XTOUCH

Parameters
fiieiist

RESET

BATCH

MEMO = memo — text

A list of files, as described in Hollo to Refer to Files at the begiruung
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the begizming of this chapter.

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

Resets the modification timestarnp in the database after the touch
has been completed.

Identifies files that have been modified by comparing the
modification timestamp in the file label with the timestarnp stored
when it was last created by LIBRARIAN. If the file has been
modified since it was moved into its current location, the file is not
touched (violation).

VERIFY
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TOUCH (continued)

Operation
Generally, you need TOUCH when you are using the 1VL4XE facility: By touching a target file,
you make it up — to — date, so MAKE will not build it. By touching a dependency file, you
make the file(s) on which it depends out — ofMate, so that MAKE wil l rebuild it. TOUCH
makes a touched file appear modified to MAKE and LIBRARIAN commands that use the
MODIFIED and/or VERIFY parameters.

Note If you attempt to TOUCH a file currently being accessed, LIBRARIAN
will issue a violation.

Examples
Make a file appear modified by typing;

) TOLICH MYFILE

Related information

Chapter 8, "Using MAICE to Rebuild Appl ications" in the L1'BRARIAN!iX LLser's Guide
See NIAKE

U ~ If you are running UNIX, see the touch manual page for equivalent functionality.
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UNLOCK
Releases files that are locked.

Restrictions
File Owner

Menu Mode
Select the Unlock option from the File menu. A dialog appears allowing you to specify files,
revision criteria, and options.

Command Mode Syntax
> UN[LOCK] filelist

[; BATCH ]
[; MEMO [ = memo — text ] ]

Parameters
file/i st

BATCH

A list of files, as described in Hozu to Refer to Files at the beginning
of this chapter.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Lets you include corzunents describing the current transaction. If
you do not specify memo text, LIBRARIAN wi l l invoke the
configured editor so that you can enter the rnerno text.

MEMO = memo — text

Operation
UNLOCK releases files that were previously placed on hold by the LOCK corrunand.

Examples
Release all secondary copies of files in the FIN fileset that have not been modified smce they
were created by LIBRAIGAN by typing:

> UNLOCK %FIN AT @.@.@.@;UNMODIFIED

) UNLOCK %FINANACE AT *:/"; UNMODIFIED

Release all of the locked files that are in your login by typing:

> UNLOCK @

) UNLOCK ./*

Related information
See LOCK
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UPDATE
Updates a read mode secondary with the current associated master.

Restrictions
LIBRARIAN Manager, Application Manager, or File Owner

Menu Mode
Select the Update option from the File menu. A dialog appears allowing you to specify files,

Command Mode Syntax

revision criteria, and options.

> UP[DATE) filelist

[;APPEND]
[; BATCH ]
[; COMPRESS ]
[; DECOMPRESS ]
[; MEMO [ = memo — text ] ]
[,OLDDATE ]
[; VERIFY ]

Parameters
filelist

BATCH

APPEND

OLDDATE

COMPRESS

DECOMPRESS

MEMO = memo — text

A list of files, as described in Hozv to Refer to Files at the beginrung
of this chapter.

Appends data from the source file to the end of the destination
file. EOF plus new data may not exceed LIMIT.

Processes the transaction in batch mode. Refer to Batch Operations
at the beginning of this chapter.

Compresses the new destination file(s).

Decompresses the new destination file(s).

Lets you include comments describing the current transaction. If
you do not specify memo text, LIBRARIAN w i l l invoke the
configured editor so that you can enter the memo text.

Leaves timestarnp in the database as is and sets the create and
modify dates of the destination file to be the same as the from file.

Identifies files that have been modified by comparingthe
modification timestamp in the file label with the timestamp stored
when it was last created by LIBRARIAN. If the master file has
been modified since it was last checked in, the file is not copied
(violation).

VERIFY
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UPDATE (continued)

Operation
UPDATE updates a read mode secondary copy of a file with the current associated master of
the hie. You do not have to specify the name of the master file to update your copy.

Examples
Update a program with the most current master version by typing:

M E
> UPDATE APPROG.FINTEST

o UPDATE /fintest/prog/ap
UNIX
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USER
Establishes a new user for the current LIBRARIAN session, and/or changes user
password/lockword.

Restrictions
None

Menu Mode

Select the Identif ication option from the User menu to establish a new user for this session,
Select the Passwords option f rom the User menu to change passwords. A dialog appears
allowing you to specify a new password and/or lockword.

Command Mode Syntax
>US[ER] [user [:password] ]

[;PASS[WORD] [ = newpass ] ]
[;LOCK[WORD] [ = lockword ] ]

Parameters
user

password

The user ID of any user defined in the LIBRARIAN database.

The password of the specified user. If the password is not
speci6ed but the user ID is specified, the system prompts for
the passw'ord.

password if not specified.
PASSWORD [ = newpass ] C h an ge s the password. You will be prompted for your current

Note All LIBRARIAN users and passwords are case-sensitive.

M E LOCKWORD [ = lockword ] Changes the lockword. You will be prompted for the current

If you issue the USER command without parameters, the system displays the current active

lockword if not specified.

user.

Operation
USER establishes the active user Al l subsequent file operations are authorized on the basis
of this user. You can issue the USER command at any time during a session to change your

If you want to change your password and/or lockword, LIBRARIAN f i rst validates your
current user ID and password. It then processes the PASSWORD and LOCKWORD
parameters, If the keywords are used alone, LIBRARIAN prompts you for the nev.
password and/or lockword.

user.
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USER (continued)

Operation, continued
Using the System Profile (SP) screen, the LIBRARIAN Manager can place restrictions on
user passe ords such as expiration policy, minimum password length, and maximum
number of attempts allowed for users to provide a valid password.

Nofe The USER command enables the LIBRAMAN Manager to change any
user's password, without having to know the user's old password.
This is especially useful when users forget their passwords.

Examples
Display the active user by typing:

>USER

The LIBERIAN program displays.

"USER = Gi MGR

Set the active user ID to OPER by typing:

>USER OPER

The LIBRARIAN program then prompts for the password.

Set the active user ID to OPER and specify a password at the same ti me by typing:

Password?

USER OPER:PASS5439

Change the current user's password to GLIP by typing:

USER OPER; PASSWORD = GLIP

Related Information
See System Profile (SP) Screen in Chapter 5, "Screens"

Chapter 5, "Users and Authorizations" in the LIBRARIAN/iX Administrator's Guide
Chapter 2, "Getting Started" in the LIBRARIAN/iX User's Guide
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VERIFY
Shows information about fi les and revisions.

Restrictions
None

Menu Mode
Select the Files... Verify option from the Info menu. A dialog appears allowing you to
specify files, revision criteria, and options.

Command Mode Syntax
> V[ERIFY] fiieiist

[; EXTERNAL ]
[; FORMAT = format ]
[;LP ]
[; MODE = mode ]
[;ONDISK]
[; OWNER = owner ]
[; PROJECT = project]
[;REV[ISION] = revision/ALL ]
[; STEP = step. route.appl ]
[;UNTRACKED ]

Parameters
fiieiist

LP

EXTERNAL

MODE = mode

ONDISK

FORMAT = format

formats.

or LIBVFY has been issued.

to the disk to check for files. Do not use wildcards.

A list of files, as described in How to Refer to Files at the begiruung
of this chapter,

Causes VERIFY to check only the LIBRARIAN database without going

Specifies the format number. Default is to present a menu of

Directs output to the LP device, unless a file equation for LIBOUT

Selects only files whose mode is READ or WRITE, as specified.

When verifying master files/f i lesets, only includes files that
currently exist on disk. The ON DISK parameter excludes master
files that have been purged, but which have retained revisions.

Physical file specifications for master files using wildcards wil l
also only report. files that exist on disk. Purged master files that
still have retained revisions will not be found.

Selects only files owned by the user specified.

Selects only files that are associated with the specified project.

OWNER = owner

PROJECT = project
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STEP = step,roijte.appl

Operation

Parameters, continUed

VERIFY (continued)

REVISION = revisionlALL Retrieves all prior revisions of the file(s) requested, even if the
master file has been purged, You can VERIFY revisions of a file
even if the master file has been purged.

Selects only files whose last associated step is the one specified.

Shows only fi les not currently being tracked by LIBRARIAN,

VERIFY works as an online or offline report providing information about files. Files are
classified as Unknown, Masters, Secondaries, Retained, or Delta. Each format applies to files
in one or more categories, as shown in the VERIFY menu.

Note Purged master files (and previous revisions) are reported by VERIFY
only if requested by specific filename or fileset; requests by wildcard
expression will not find these files since they do not exist on disk

UNTRACKED

When you issue VERIFY, a menu of formats is displayed, unless the FORMAT option is used.

When you enter an option number, the requested information displays. You can continue to
choose options until you exit VERIFY (option 18) or type Q.

You can direct VERIFY output offl ine by either using the LP parameter when you issue the
command, or by including LP preceded by a comxna after the format option

Issue the VERIFY comznand with the FORMAT parameter to bypass the initial menu display.

You can also speci& a new format f'ollov ing a VERIFY display without having to return to
the VERIFY menu. The prompt is "Format[,LP] (RETURN for Menu/Q to Quit)."

Following is an illustration of the LIBRARIAN Verify Menu, which lists the 18 formats
shown on the following pages.

L I B R A R I A H V E R I F Y N E H U

Actual Nodification Timestamp, Filecode..
. . . .

LIB Nodifica1ion Timestamp, Lock S tatus... . . .
Associated Hester File (or Delta Fi le ) .

. . . . . .

Associated itaster I i leset(s). . . . . . . . . . . . . . . . .
Assoc i ated Projec I (s)
Associated User Fi leset(s).. .
Version Informat ion.
Nester Fi le Counters.
Location of Hrite-Node Copg..
Previous Versions (Generated F’i les). . . . . . . . . .

Boner. Access Node. Expiration,Exceptions...
Last Step.
Step „storg.
Original Fi le Home.
Date Retained, Expiration Date.. . . . . . . . . .

. . . .

Revision Information/Tag.
Revision Historg.
Language/Description
Return to LIBRARIAH prompt (or ’0’ )
Humber [.LP]?

Figure 1-1. V ERIFY Menu

6 Files 0 Un knoon 6 Na sters 0 Secondaries 0 Re t a ined 0 Delta

[01]
[02]
[03]
[04]
[05]
[06]
[DV]
[08]
[09]
[10]

[12]
[13]
[10]
[15]
[’16]
[t7]
[18]
[19]
Format

al I files
al I files
al I fi les
a ll f i l es
a ll f i l es
a ll f i l es
a ll f i l es
master fi les onlg
master fi les onlg
masters/secondaries
secondaries onlg
secondaries onlg
secondaries onlg
retained fi les onlg
retained files onlg
all t racked f i les
master files onlg
master f i les onlg
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VERIFY (continued)

Format 1: Actoal Modification Timestamp, Filecode

LIBRARIAff VERIFV (Af I Fil es/File Lobel Info)

el100 File

PENGUIff- AHC18DOS. SOURCE. LIBP ROD
*flOD PEIIQJ Iff: ABCZNNS. SOURCE. LIBPROO

PEMiUIff: ABC3IUIDS. SOtlRCE, L I BPROD
sputnik:/opt/ocs/ocsl ib/I ibprod/

etl00 spu tn i k./op t/ocs/ocs I i b/ I ibp rod/

spu tn ik: /opt�/ocs/ocs I ib/ I i bprod/

File File Actual Fi le Label
TUpe Code flodifU Dote E, Tine

ff EDTCT IIED, DEC 1S, 1993. 9:4S Alf
fl EDTCT IIED. OEC 1S. 1993, 9:46 Ail
if EDTCT liED. OEC 15, 1993. 9:4S Aft
ll 0 TUE. D EC 14, 1993. 5:44 Plf

ff 0 ftE D , DEC fs, 1993, 9:04 Aff

ll 8 TUE. OEC 14, 1993. 5:44 Pif

obcf088.c

abc2080. c

nbc3880. c

was created by LIBRARIAN

Figure 1-2. V ERIFY Format 1, Actual Modification Timestamp

Field Descriptions
’MOD A flag that indicates whether a file has been modified since the time it

File Name of the file including the system name.

File Type Type of file. One of the following,

M E File Code

?? Unknown fi le
M Master file
S Secondary file
D Delta file
GM Genera t ion of a master file (retained)
GS Generation of a secondary file (retained)
CM Cop y of a re tained master file
CS C opy of a retained secondary file

The filecode associated with the fi le. A fi lecode of 1012 indicates that a
file is in compressed format.

The modification timestamp recorded by the file system for the file.
Actual File Label Modify Date & Time
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VERIFY (continued)

Format 2: LlB Modification Timestamp, Lock Status

LIBRARIAN VERIFY (Al I Fi les/LIB Timestomp)

File LIBRARIAN Timestomp
Tgpe Lock llodi fg Dote 8, Time&00 F i le

PENGUIN- ABC 1088S. SOIIRCE . L IBPROD
%00 PENGUIN: AHC288DS. SDURCE. LIBPROD

PENGUIN: ABC38815. SOURCE. L I BPROD
spu to I k:/opt/ocs/ocs I i b/ I ibprod/

&00 spu t n i k: /opt /ocs/ocs I i b/1 i bprod/

spu tnik: /opt/ocs/ocs I ib/ I ibprod/

MEO. DEC 15. 1993, 9 : 4 5 Att
MEO, OEC 15, 1993, 9 : 4 5 Atl
MEll. DEC 15. 1993. 9 : 4 5 Att
TUE, OEC 14. 1993, 5 :44 Ptl

TUE. OEC 14, 1993. 5 : 5 4 Ptt

TUE, DEC ’l4, 1993, 5 : 44 Ptl

abc1888. c

obc2000. c

obc3008. c

Figvre ) -3. V ERIFY Format 2, LIB Modification Timestamp

Field Descriptions
MOD A flag that indicates whether a file has been modified since the time it

was created by LIBRARIAN.

Name of the file including the system name.

Type of file. One of the following:

File

File Type

Lock

D Delta f i l e

? ? Un kno w n fi l e
M M aste r f i le
S Sec o ndary file

GM Gen e rat ion of a master file(retained)
GS Gene rat ion of a secondary hie (retained)
CM Cop y o f a retained master file
CS Cop y of a retained secondary hie

A flag that indicates whether a file has been locked using the LOCK
comxnand.

The modification timestamp recorded by LIBRARIAN when it created the
file (or when it loaded the master during AUTOUPDATE).

LIBRARIAN Timestamp Modify Date & Time
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VERIFY (continued)

Format 3: Associated Master File (or Delta File)

c a a a a a z = = = = = w a m = a c r = = = a a = = c a = e at= = v s = = a = m a c e = = = = = a a a a m= =

LIBRARIAN VERIFY (Al I Files/Associated Ilaster File)

Fi le

PENGUIN: ABC I BOOS. VEIIONICA.LIBDEVEL
PENGUIN: ABC2088S. VERON I CA. L IBBEVEL
PENGUIN - ABC3080S. VERONICA�. L IBOEVEL
PENGUIN: ABC1000S. SOURCE. L IBPflOD
PENGUIN: ABC2000S. SOURCE.LIBPROD
PENGUIlf: ABC3000S. SOURCE. L IBPROO
PENGUIN i D0808001. SOURCE. L IBPROO
PENGUIN i 08888002. SOURCE. L I BPROD
PENGUIN: 00800803. SOURCE. L IBPROD
sputniki/opt/ocs/ocslib/ l ibdeuel/
pau I /abc1000. c

spainik: lop t/ocs/ocs I i b/ I ihdeue I l
paul/abc3000.c

sputnik:/opt/ocs/ocslib/ I ibprod/

sputnik: /opt locs/ocsI ib/ I i bprodl

abc1000. c

8IK30M . c

File
TMpe Nester File

S PENGUIN:ABC I BOOS. SDURCE. LIBPROD
S PM iUIN: ABCZOOOS. SOURCE, L IBPROD
S PENGUIN: ABC300OS. SOURCE. L I BPROD

Il (DELTA F I LE: 00000002 � COBOL/RPG)
l1 (DELTA FILE: 00000003 � COBOL/RPG)
D PENGUIN: ABC1000S. SOURCE, L IBPROD OK
0 PENGUIN iABC200OS. SOURCE. LIBPROD OK
0 PENGUIN: ABC3000S, SOIIRCE. LIBPROD OK
S s putnik-/opt/ocs/ocs I ib/ I ibprodl

S s putnik i/opt/ocs/ocs I ib/I ibprod/

= (DELTA FILE i 00000001 � COBOL/RPG)

abc IBOO. c

abc3000. c

Figure 1-4. VERIFY Format 3, Associated Master File

Field Descriptions
Name of the file including the systemname.

Type of file. One of the following:File Type

D Delta file

?? Unknown fi le
M Master file
S Secondary file

GM Genera t ion of a master file (retained)
GS Generat i on of a secondary file (retained)
CM Copy o f a retained master file
CS Copy of a retained secondary file

effect for the application, then the associated delta file name and
language is shown. If File Type is D, a checksum verification status
appears to the right of this field. I f the status is not OK then the delta file
has an integrity problem.

Master Fil e N am e of t he associated master file. If File Type is M and deltas are in
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VERIFY (continued)

Format 4: Associated Master Fileset(s)

LIBRARIAN VERIFY (AI I Files/!taster Fi resets)

!-denotes membership via the master

File TUpe !taster Fileset

PENGUIN - ABC I ODDS. SOURCE. L IBPRQD

PEHGUIH. ABC?ODDS. SOURCE. LIBPROD

PEIIGUIH-ABC3OMS. SDURCE.LIBPROO

sputnik:/opt/ocs/ocsl ib/I ibprod/

File

abc2080. c

spv In i k: /opt�/ocs/ocs I i b/ I i bprod/

abc ’IOM. c

sput n i k: /opt/ocs/ocs I ib/ I ib prod/

tIF&f ILES
HPE-SOURCE
tlF6-FILES
IIPE-SOURCE
IIFG& ILES
IIPE-SOIIRCE

IIFG& I LES
UH I H-SDURCE

IIFG-FILES
UH IH-SOURCE

I IF ~ILES
UHI!I-SOURCE

abc3MO. c

Figure 1-5, V ERIFY Format 4, Associated Master Filesets

Field Descriptions
Name of the file including the system name.

Type of file. One of the following:File Type

D Delta file

?? Unknown fi le
M Master file
S Secondary file

GM Gener a t i on of a master file (retained)
GS Gener at ion of a secondary file (retained)
CM Copy of a retained master file
CS Copy of a retained secondary file

files, all filesets to which the associated master file belongs; these filesets
appear with a prefix of "!" .

Master Fileset Th e n a mes of all master filesets to which the file belongs. For non — master
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VERIFY (continued)

Format 5: Associated Project(s)

LIBRARIAH VEItIFV (At i f iles/Associated Projects)

I-denotes neabership via the easter
0-denotes last project aorked on

f’i le TUpe project ttaoe
Fi le

PENiUI R ’ ABC 1080S. SOURCE. LI BPROD
PENGUIN-’ABC288tls. SOURCE. LIBPROD
PEIIGUIR - ABC3080S. SOURCE. L IBPRDD
sputnik:/opt/ocs/ocsi ib/I ibprod/

sputnik:/opt/ocs/ocs I ib/I ibprod/

sputni k: /op t/ocs/ocs I ib/ 1 ibprod/

ll +SR1564
ll N R1572
il eSR 1598
tl eSR15&l

tl <SR1572

tl WR1598

P roj D a t e
App I Act ive St

ttFG 12/15/93 CC
llF6 12/ ’l5/93 RO
ttFG 12/15/93 OP
ttFG 12/15/93 CC

ttFG 12/15/93 RO

11FG 12/15/93 OP

abc ’1800. c

abc2888. c

abc3000. c

Figure 1-6. V ERIFY Format 5, Associated Projects

Field Descriptions
File

File Type

Name of the file including the system name.

Type of file. One of the following:

Proj Appl

Date Active
St.

project Name

?? Unknown f i le
M Master file
S Secondary file
D Delta file
GM Gener a t ion of a master file (retained)
GS Gen er a t ion of a secondary file (retained)
CM Cop y of a re tained master file
CS Copy of a retained secondary file

The names of all projects (project filesets) to which the file belongs. For
non — master files, all projects (project filesets) to which the associated
m aster file belongs; these filesets appear with a prefix of " !" . A " " "
indicates that the file is currently being worked on under this
project, or was the last project this file was associated with.

The name of the application to which the project belongs.

The date the project was first worked on.

The current project status:

OP Opene d
RO Re — Opened

CC Closed — to � Checkout
FP Flush Pending

CL Close d
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VERIFY (continued)

Format 6: Associated User Fileset(s)

LIBRARIAN VERIFV (Al I Fi les/User Fi lesets)

! denotes membership via the master

File Type User Fileset
Fi le

PENGUIN: ABC ’lOBOS. JOSEPH LIBOEVEL

PENGUIN-ABC2080S. JOSEPH.LIBOEVEL

PENGUIN: ABC30INS. VERONICA. LIBOEVEL

sputniki/opt/ocs/ocslib/ t ibdevel/
debb!I/abc2080.c

sputnik:/opt/ocs/ocsl ib / l i bdevel/
debbie/abc3000.c

sputnik-/opt/ocs/ocsl ib / l i bdevel/
paul/abc1800.c

Figure 1-7. V ERIFY Format 6, Associated User Filesets

Field Descriptions

S P AULS-FILES

i PATCH-201

iPATCH-201

!PATCH-201

S J OSEPHSW ILES

5 J OSEPHSWI LES

S VEROHICAS-FILES

s

Fileset Bat e
Creatot. Created

JOSEPH
L IBIIGR
JOSEPH
LIBHGR
VERONICA
LI Bt!GR

12/15/93

’I 2/15/93
12/15/93
12/15/93
12/15/93
12/15/93
12/15/93

paul

File

File Type

Name of the file including the system name.

Type of file One of the following:
?? Unknown fi le
M Master file
S Secondary file
D Delta file
GM Gen er a t ion of a master file (retained)
GS Generation of a secondary file (retained)
CM Cop y of a re tained Inaster file
CS Copy of a retained secondary file

files, includes all filesets to which the associated master file belongs as
well; these filesets appear with a prefix of " !" .

User Fileset Th e nam e s of all user filesets to which the file belongs. For non — Inaster

Fileset Creator The u ser who created the user fileset

Date Created The da t e the fileset was created.
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VERIFY (continued)

Format 7: Version information

LIBRARIAH VERIFY (Al I Fi les/Version Dote)

File

PEHGUIH: ABC 1008S. SOURCE. L IBPRM
PEHGUIH: ABCZOOOS. SOURCE. LI BPROD
PEHGUIH: ABC3800S. SOURCE, L IBPROD
sputnik:/opt/ocs/ocs I ib/I ibprod/

sputnik: /opt� /ocs/ocs I i b/ I ibprod/

spu t n ik: /opt/ocs/ocs I i b/ I i bprod/

Fi le Current
Tgpe Version

11 V . 2 . 00
t t V . Z . OO
H V . Z . M
l l V.2. M

t t V . 2 . 00

H V . Z . OO

Vers i on
Cree led

V. 1.00
V.2. 00
V. 1.00
V.1.00

V.2.08

V.2.00

VC GC

0 2
1 3
0 2
0 1

1 2

1 2

obc 10M. c

obc20M. c

abc3080. c

Figure 1-8, V ERIFY Format 7, Version Information

Fieid Descriptions
File Name of the file induding the system name.

File Type Type of 61e. One of the following:

D Delta file

?? Unknown fi le
M Master 61e
S Secondary file

GM Gen er a t ion of a master file (retained)
GS Gener a t ion of a secondary file (retained)
CM Cop y of a re tained master 61e
CS Copy of a retained secondary file

version to which the file belonged.
Current Version The current version to which the file belongs. For retained files, the last

Version Created The first version to which the file belonged.

VC

GC

The version count of the file.

The generation count of the hie.
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VERIFY (continued)

Format 8: Master File Counters

LIBRARIAN VERIFV (Nester Fi les/Counters)

TOTAL

Rd tir Re t Ret R d Ur Ret Ret Check
Cop Cop Sec Nst Cop Cop Sec Nst I ns

obc1880. c

File

PENGUIN- ABC 1000S. SOURCE. L I BPROO
PEHGUI tt: ABC2000S. SOURCE. LI BPROO
P EIIGUI tt: ABC3008S. SIIRCE. LI BPROO
spu t ni k: /opt�/ocs/ocs t ib/1 ibprodl

spu tni k: lop t lees/ocs I in/ I ibpr odl

sputnik /opt/ocs/ocsl ib/I ibprod/

0 1 0 1
0 1 0 1
0 1 0
0 1 0 0

0 1 0 0

0 1 0 0

2 0 1 1
2 0 1 1
2 0 1 1
2 0 0 0

0 1 0 0 0

0 1 0 0 0
obc2080 . c

~ .c

Figure 1-9. VER IFY Format 8, Master File Counters

Field Descriptions
File Name of the file including the system naxne.

Current number of read Inode secondary copies.

Current number of write mode secondary copies.

Current number of retained secondary copies.

Current number of retained master copies.

CUR
Rd Cop

Wr Cop

Ret Sec

Ret Mst

TOTAL

Rd Cop

Wr Cop

Ret Sec

Ret Mst

Check Ins

Total number of read mode secondary copies ever created.

Total number of write mode secondary copies ever created.

Total number of retained secondary copies ever created.

Total number of retained master copies ever created.

Total number of times the file has ever been checked in.
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VERIFY (continued)

Format 9: Location of Write Mode Copy

LIBRARIAH VERIFY (Raster Fi les/Current kri te-Rode Copg)

Der

abc1080. c

abc2800. c

obc3000. c

File

PEHOUIH: ABC 1000S. SOURCE. L I BPRDD
PMiUIH: ABC2000S. SOURCE. LI BPRDD
PEHBUIH: ABC300DS. SOURCE. L I BPROD
spu tnik: /op 1/ocs/ocs I ib/1 ibprod/

spuin ik: /op 1/ocs/ocs 1 i b/ I i bprod/

sputnik: /opt� /ocs/ocs I i b/1 ib prod/

A/C A/lf Current krite-llode Colni (or Copies)

S k PEHGUIH-ABCIOOOS.VERDHICA.LIBDEVEL
S k PEH6UIH: ABC2080S. VEROHI CA. L IBDEVEL
S k P EHliUIH:ABC3000S.VEROHICA.I IBlKVEL
S k s putnik:/opt/ocs/ocsfrb/libdeuel/

S l l sputn>k:/opt/ocs/ocslib/ l ibdevel/

S k s putnik:/opt/ocs/ocslib/l ibdeuel/

paul/abctDOD.c

debbg/abc2008.c

paul/abc3000.c

Figure 1-10. VE RIFY Format 9. Location of Write Mode Copy

Fie1d Descriptions
File Name of the file including the systeIn name.

A/C Access control level for the master file:

X Exclusive Access
R Read Only Access
S Serial Write Access
M Multi Write Access

Default access mode for copies of the master file:Def A/M
R Read
W Write

Current Write-Mode Copy (or Copies)

Name(s) of the current write — mode secondary files associated with the
master file
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VERIFY (continued)

Format 10: Previous Versions (Generated Files)

LIBRARIAN VER IFV (Hast ers-Seconder i es/Prev i ous Vers i ons)

r I ie

11 PENGUIN: 4BC100OS. SOURCE LIBPROO
e PEHGUIH - G7W329$. SOURCE. L IBPROD
it PENGUIN: ABC2000S. SOURCE. L I BPROD
e PEIIGUIH’- G30M 162. SINRCE. LIBPROD
e PENGUIN- ’G740346 I.SllURCE, LIBPROD
11 PENGUIN - ABC30%% . SDURCE, LIBPROD
a PENGUIN: G74I3754. SOURCE. LI BPRDD
it sputnik:/opt/ocs/ocsl ib/I ibprod/

...Ho retained versions
it sputnik,/opt/ocs/ocsi ib/I ibprod/

w sputnik:/opt/ocs/ocsl ib/I ibprod/
. g2602531

11 sputnik./opt/ocs/ocsl ib/I ibprod/

* sputnik:/opt/ocs/ocsI ib/I ibprod/
abc3080. c

92604047

abc20OD. c

abc1000. c

V. 2.00

V.2.00

V.2.00

V 2.00
V.2.0D

V.2.00

V.2.00

V.2.00

V. 1. 00

V.2.00

V. I 00

Last active or
Current Version Version Crealed VC GC

V.2.00 V. 1.00

V.2.00
V. 1. 00

V 1.00

I 2

0 1

1 2

0 2
1 I
1 3
0 2
1 1
0 2
1 1
0 1

0 1

Figure 1-11. V ERIFY Format 10, Previous Versions

Field Descriptions
File N arne of the master or secondary file including system name. An M in

the first column indicates a master file, and an S in the first column
indicates a secondary file. A ' ind icates a generation of the master or
secondary file listed above it.

Last active or Current Version
The current version to which the file belongs.

The first version to which the file belonged.VersionCreated

VC

GC

The version count of the file,

The generation count of the file.
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VERIFY (continued)

Format 1'I: Owner, Access Mode, Expiration

LIBRARIRH VERIFY (Secondarg F i I es/Access Informat i on)

File

PEHOUIH ’ ABC1080S. JOSEPH. L I BOEVEL
PEN6UIH: ABC1010S. VEROHI CA. L IBOEVEL
PEN6UIN: ABC2880S. SOURCE. L I BTEST
PDI6UIH: ABC3880S . SOURCE. L I BTEST
sputnik:/opt/ocs/ocslib/l ibdeuel/
debbg/abc2008.c

sputnik:/opt/ocs/ocslib/ I i bdeoel/
debbg/abc3000.c

sputnik:/opt/ocs/ocslib/I ibdeuel/
paul/abc1080.c

R
H

Alii Pending Status

4 Pending Baster

Expire CopierID Ex
Dot e (Oener)

JOSEPH
VERONICA

12/28/93 L I BNiR
LIBNiR
debbg

pau I

Figure 1-12, V ERIFY Format 11, Owner, Access Mode. Expiration

Field Descriptions
File Name of the file including the system name.

The access mode of the secondary file:

Ex

Pending Status

Expire Date

Copier ID (Owner)

R Read
W Wri te

A flag to indicate whether the file is new and has no associated
physical Inaster file yet.

For read mode secondaries, the date the file expires or expired.

The LIBRARIAN user who created the secondary fi le.

The following is a list of exception codes:

PR Read mode copy checked in (emergency fix)
RS Previous version of master file restored while checked out

MC Merge conflict
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VERIFY (continued)

Format 12: Last Sfep

LIBRARIAN VERIFV (Secondary Files/Last Step)

File

PENGUIN:ABCIOOOS.JOSEPH.LIBOEVEL
PDIGU IN: ABC2000S. SOURCE LIBTEST
PENGUIN: ABC3000S. SOURCE. L I BTEST
sputnik./opt/ocs/ocslib/ l ibdevel/
debbie/abc2000.c

sputnik:/opt/ocs/ocslib/ l ibdevel/
debbg/abc3088 c

sputnik-/opt/ocs/ocslib/ l ibdevell
paul/abct000.c

A/tt Last Step Performed User

. tfFG L IBttGR

. IIFG LI BttGR

. ttFG LIBltGR

. tlFG debbie
ttFG-UIIOUT . ttFG-ttA INT . ttFG debbg

4 ttFG-UIIOUT . ttFG-ltAINT , ttFG pau I

ttFG � OK . IIF G-ttAINT
R tlFG-IN . ltFG � NAINT

tlFG-TEST . ttFG-ttAINT
4 ttF~ N OUT . t lFG-ltAINT

Figure 1-13. VERIFY Format 12, Last Step

Fieid Descriptions
File Name of the file including the system name,

The access mode of the secondary file:

R Read
W Wri te

Last Step Performed The n a me of the last step that created the file.

User The LIBRARIAN user who performed the last step on the file.
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VERIFY (continued)

Format 13: Step Hisfory

LIBRARIAN VERIFY (Secondarg F i les/Step „s torM)

F’i le

PEHGUIH: ABC1808S. JOSEPH. LIBOEVEL

PENGUIN: RBC2000S. SOURCE. L I BT EST

PENGUIN-’RBC3080S.SOURCE. LIBTEST

A/If Step „s torII

H I ) N FG-OUT
2) NF~

R l) NFGEHJT
2) NF~
3) NFG-TEST
4) NFG-TESTOK
5) NFG-IH

ll I ) N FG4NT
2) NF~
3) NFG-TEST
4) NF~RIL
5) NFG-TEST

II l ) NF G ~ T

II I ) NF G~ I I T . NF G-NA INT . IIFG

ll I ) If FG-UHOUT . NF~ IHT . NF6

. NF~ I HT

. NFfr4IA INT

. NFG-ISIINT

. IIFG-MINT
. NF~ I NT
. NF~ I N T
. NFG~ INT
. NF~ I H T
. NF~ I H T
. NFG~ IHT
, NF~ I H T
. NF~ I H T
. Iff ~ I NT

. NFG

. NFG

. NFG

. IfFG
. IfFG
. IfFG
. IIF6

. IIFG

. NF6

. NFG

. NFG

sputnik:/opt/ocs/ocsl ib/I ibdeve I/
debbie/abc2000.c

sputnik /opt/ocs/ocslib/l ibdevel/
debbie/abc3080.c

sputnik:/opt/ocs/ocsl ib / l i bdevel/
paul/abcl000,c

Figure I- I4. V ERIFY Format 13, Step History

Field Descriptions
File Name of the file including the system name.

The access mode of the secondary file:

R Read
W Wri te

Step History A chronological listing of up to the last 32 steps performed on
the file.
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VERIFY (continued)

Format 14: Original File Name

LIBRARIRN VERIFY (Retained Files/Original File None)

I’i l e

PENGUINi67442526. SOURCE. LIBPROD
PENGUIN: 67447775. SOURCE. LI BPROO
PEH6UIN: G744323 I. SOURCE. LIBPROO
spu t n i k ’. /opt�/ocs/ocs I i b/ l i bprod/

. g8725541
sputnik:/opt/ocs/ocslib/ l ibprod/

.g7864204
sputnik:/opt/ocs/ocslib/ l ibprod/

.g7078212

obcl080 c

abc2080.c

File
Tgpe Original File Hane

Gtt PENGUIN: RBC I BOOS. SOURCE. LIBPROD
GN PENGUIN: RBC2880$, SOURCE. LI BPROD
6ll PENGUIN - ABC3008S. SOURCE. L IBPRDD
GN sputnik./op t/ocs/ocs l ib/I ibprod/

GN sputnik:/opt/ocs/ocslib/l ibprod/

GN sputnik:/opt/ocs/ocslib/l ibprod/
abc3080 c

Figure 1-15. V ERIFY Format 14, Original File Name

Field Descriptions
File Naxne of the file including the system name.

File Type Type of file.
GM Gen e r at ion of a master file (retained)
GS Gene r a t ion of a secondary file (retained)
CM Cop y o f a retained master file
CS Copy o f a retained secondary fi le

Name of the file prior to having been retained.

Original File Name
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VERIFY (conhnued)

Format 15: Date Retained, Expiration Date

LIBRRRIRH VERIFY (Retained Fi les/Dates)

F ile D a t e Expi r e
Tgpe Retained Ga te

N 1 2 / 15/93 81/15/’A
GII 12/ IS/93 8 I/15/94
GII 12/15/93 8 I/ IS/%4
N t2 / 15/93 8 I/ IS/%f

6II 12/ I 5/93 81/ IS/94

N I Z / 15/93 8 I/15/94

File

PENGUIN i 67+12526, SOURCE. LIBPROD
PDIGUIHi 67442775. SOURCE. LIBPROD
POIGUIII: 67+l3231. SOURCE. L IBPROD
sputnik: /opt lees/ocsI ib/ I i bprod/

.g7864284
spot n i k: /opt locs/ocs I i b/ I i bprod/

.g7066235
sputnik:/opt/ocs/ocsIib/ i ibprod/

. g78702 12

Figure 1-16. V ERIFY Format 15, Date Retained/Expiration Date

Field Descriptions
File Name of the file including the systemname

File Type Type of file:
GM Gen e r a t ion of a master file (retained)
GS Gene r a t ion of a secondary file (retained)
CM Copy o f a retained master file
CS Co p y of a retained secondary file

Expired Date Date t he retained file expires or expired

Date Retained Date t he file was retained.
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VERIFY (continued)

Format 3 6: Revision Information/Tag

LIBRARIAN VERIFY (ttester Fi les/Revision Ristorg)

t tnster Fi le
Revision

PENIIGIN: ABC2080S. SDttRCE. L I BPRDD
V. 2. OD. 2 SR2935
V.2,00:1 1 1 sR9218
V,2,00: 1 SR9210
V,2 00-ll
«:I

sputnik:/opt/ocs/ocstib/t ibprod/ebc2000 c
V.2.09:3 sR9835
U.2.00:2.2. 1 SR9678
V.2.00: 2. ’l.2 SR9622
V.2.00:2. 1. 1 SR95’I 0
V.2 OD:2 sR921 ’l
V.2.0D: 1 SR9210
V.2 08-8

Prospect Teg

PATCH209

PATCH 101

PATCH20D

Dote/Titoe

D EC 15 1993 5 05 P t t
D EC 13, 1993, 2 :W P N
DEC ’12. 1993. 10:06 Atl
DEC 11. 1993. 1: 2 2 Ptt
NDV B. 1993. 4:5 5 Pt l

tlRR 10.
PENDING
ltAR 5.
FEB tl.
FEB 6,
FEB 2,
JAN 22,

f9%I. 1 : 0 7 Ptl

t ~ , 2 :W P t t
1994, 11:07 Atf
1994, 10:34 Atl
t ~ . 9 - 18 A H
1~ . 2 -4 5 P N

PATCH101

Figure 1-17, VERIFY Format 16, Revision Information tag

Field Descriptions
File Name of the master/secondary file including system name.

Latest Revision The revision ID for the file, including version, version count and

Tag
branch/leaf pairs (if applicable).
If the file was assigned a tag using the SET TAG command, the tag
appears under the revision ID for the file.
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VERIFY (confinued)

Format 17: Revision History

LIBRARIAH VERIFV (Nester Fi les/Revision „s torg)

Raster File
Revision

PENURIN: ABCZ000S. SDifRCE. LIBPR00
V.2.00:2 SR2935
V. 2,00: 1. 1. 1 SR9210
V.2.00:1 SR9210
V. 2.00.0
e:1

spvt n i k: lop t locs/ocs i i D/1 ibprod/abc2000. c
V.2 00-3 SR9835
V.2.00:Z.2. 1 $89678
V.2.80:2.1.2 SR9622
V. 2.00-2. 1. 1 SR9510
V. 2. 00-2 SR9211
V.2.00: 1 SR9210
V 2.00:0

Project Tag

PATCH208

PATCH181

PATCH200

Date/T i me

DEC 15. 1993, 5 :8 5 P li
DEC 13. 1993. 2 :4 8 P ll
DEC 12. 1993, 10:06 All
DEC 11, 1993. 1: 2 2 PN
HDV 8. 1993. 4 : 55 P11

HAR 10, ’I994.
PENDING
NAR 5. 1994.
FEB 14. 1994.
FEB 6, 1994.
FEB 2, 1994.
JAH 22, 1994.

1-07 Pll

2:42 Pll
11.07 All
10:34 Alt
9:18 lN
2:45 Pll

PATQf 101

Figure 1-18. V ERIFY Format 17, Revision History

Field Descriptions
Master File Nam e of t he Inaster file including system name.

Revision(s)

Project

Tag

Date/Time

A listing of all revisions (including branches) for the file.

Project with which this revision is associated.

Tag associated with this revision.

The date and time the revision was created.
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VERIFY (continued)

Format I 8: Language/Description

LIBRARIAH VERIFY (llaster Files/Language/Description)

ltaster Fi le � Language
Descr i p t i on

PENGUIN: ABC IOOOS. SOURCE. LIBPROD � COBOL/BPG
» 4I I reporting functions for the ABC module of the lfFG appl ication (IIPE)

PENGUIN: ABCZ880S. SOURCE. LI BPROD � COBOL/RPG
» 4I I screen functions for the ABC module of the IIFGapplication (IIPE)

PENiUIN - ABC3OBBS. SOURCE, L IBPROD � COBOL/RPG
» Transaction processing for the ABC module of the HFG appl ication (IIPE)

sputnik:/opt/ocs/ocst ib/I ibpr od/abc lBDO.c � C
» Al I reportingfunctions For the ABC module or the IIFG oppl ication (UNIII)

sputnik-/opt/ocs/ocslib/ l ibprod/abcWOD.c � C
» All GUI functions for the 4BC module of the IIFG appi ication (UHIH)

sputnik:/opt/ocs/ocs I ib/I ibprod/abc3OOD.c � C
» Transaction processing for the 4BC module or the HFG appl ication (UHIII)

Figure 1-19. V ERIFY Format 18, Language/Description

Field Descriptions
Fife

Language The programming language assigned to the file during AUTOUPDATE or
with the SET LANGUAGE command. Language is used for source code
annotation, and merge conflict comments.

Name of the master file including system name.

Description The fi l e' s description as defined on the EA screen.
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VERIFY (continued)

Examples
Review information on all the files in your login by typing:

> VERIFY @

>VERIFY "
UNIX

> VERIFY REL1 .0 OF %FINANCE; LP

Review the files in REL1.0 of the FINANCE fileset sending the output offline by typing:

ttevtetv all master and secondary files in the lileset MFG-FILES by typing:

AUIX

>VERIFY %MFG-FILES AT O.@.N.@, %MFG-FILES

>VERIFY %MFG-FILES AT /*, %MFG-FILES
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VERSION
Defines, shov s, makes obsolete, and deletes versions for an application.

Restrictions

None

Menu Mode

Select the Version option from the Admin menu. A dialog appears allow ing you to specify
the application and version ID.

Command Mode Syntax
>VERSION appiid [ ; ID = version-id ]

[; DELETE ]
[; DESCRIPTION = description ]
[; OBSOLETE ]
[;UNOBSOLETE ]

Parameters
appi-id

versi on-id

DELETE

DESCRIPTION
= description

OBSOLETE

maximum of 32 characters.

The unique identifier of an application, as defined on the AP screen.

The uruque identifier of the version, The version can include alphabetic,
numeric characters including the period (.), hyphen (-), and underscore
( ) characters. A version cannot be used more than once for an
application. The version is assigned to all the current master files in the
application. The version ID can contain a maximum of 16 characters.

Deletes a flushed version.

Specifies a description for a version. The description can contain a

Specifies a defined version as obsolete, so that retained base revisions can
be flushed. All previous versions must be obsolete. Use the OBSOLETE

parameter in conjunction with the application ID and version ID.

Instructs LIBRARIAN to undo the OBSOLETE operation, providing the
version has not already been flushed.

UNOBSOLETE

Operation
If you specify only the application ID, LIBRARIAN l ists all versions for that application.

Define a new version by specifying an application ID and version ID. Once a version is
defined, it can be made obsolete if all previous versions are obsolete using the OBSOLETE
parameter in conjunction with application ID and version ID. Use the UNOBSOLETE
parameter to undo the obsolete operation. This option is available only if the version has not
been flushed, using the FLUSH uti l i ty.
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VERSION (continued)

Examples
Create a new version for the MFG application by typing:

Obsolete REL1.0 of the MFG application by typing:

>VERSION MFG;ID=REL2.0;DESCRIPTION=2ND RELEASE

>VERSION MFG;ID= REL1 .0;OBSOLETE

Related Information
See FLUSH

Chapter 7, "Versions" in the LIBRARIAN/iX Administrator's Guide.
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XEQ
Executes a macro or procedure.

Restrictions
A user with read and execute access to the macro or procedure file. Anyone can execute
macros located in XEQ. QSCLI B (MPE) or /opt/ocs/ocs(ib/xeq (UNIX)

Menu Mode
Select the Execute or Procedures option from the Macros menu, A dialog appears allowing
you to specify files and parameters,
Command Mode Syntax
Format 1 (OPTION FILES):

oX[EQ] macro [ FOR ] filelist

[; EDIT = edit mask ]
[;PARMS = parmlist]

Format 2 (NO OPTION F I L E S:

>X[EQ] macro [ parmlist ]

Parameters
macro

filelist

The name of the macro file or loaded procedure

The list of filenames to be substituted in the macro during processing. In
order to use filelist substitution, OPTION FILES must be specified earlier
in the macro. Each command that uses the %% [ ] parameter wil l execute
repeatedly, once for each file to be substituted, or using the LOOP. . NEXT

EDIT = edit mask Al lows you to transform authorized filenames into new fi lenames written

control statements.

to the XEQLIST file. edit mas/c is the edit mask to be used when
transforming the filenames.

You can use the at sign (©), the question mark (?), theminus sign (-), and
the equal sign ( =) editing characters. For more i nformation on these edit
masks, refer to Edit Masks earlier in this chapter.

a list of positional parametersto be substituted. You can specify a
maximum of 100 parameters in a macro in the format %%n, where n is the
parameter number from 0 to 99.

PARMS = parmlist Al lows you to substitute parameters within the macro file. The parrnlist is

Operation
To execute a macro, enter the macro file or procedure name, If the file cannot be found in
your local directory, LIBRARIAN then checks the XEQ group of the OCSLIB (MPE) account
or the /opt/ocs/ocslib/xeq path (UNIX). You can omit the w'ord XEQ, and execute any macro
by specifying the file or procedure name alone.
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XEQ (confinuec!)

Examples
The following is an example of a macro file used to submit source for testing and compil ing
each program using the MAKE facility.

OPTION FILES=ABC � SU BMITABC � MAINTABC;ABC � SUBM(T! XEQLIST
ABC — SUBMIT!XEQLIST
LOOP

MAKE ABCMAKE.PUB,ABCQA,%%(@POBJECTABCQA]
NEXT

Related Information

See Chapter 7, "Macro Control I anguage Commands"
Chapter 7, "Macros" in the LlBRARtAiV/iX User's Guide
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User Fileset Commands

This chapter describes the FMAINT module coxnmands for maintaining
user filesets. User hlesets allow LIBRARIAN users to group fi les
according to their individual needs.

The following topics are discussed in this chapter:

� Ac cessing FMAZW

� FM A I NT Commands Summary

� FM A J NT Commands

For more information on the FMAINT module, refer to Chapter 6, "User
Filesets" in the LIBRARIAN/iX User 's Guide.

Accessing FMAINT
You can access FMAINT by performing one of the following:

1. Enter the FMAINT module by typing FM at the LIBRARIAN prompt,

From the FM > prompt you can issue any FMAINT comxnand, as
listed in this chapter. To return to the LIBRARIAN prompt, enter the
FM > EXIT command .

2. Select Tools...User Filesets from the main menu. Then select an option
from the menu.
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F MAINT Commands Summary
FMAINT provides users with a set of cornrnands to define and maintain
user filesets.

Table 2 — I lists the FMAINT commands along with their functions and
page references for locating detailed descriptions.

Table 2 � 1. FMAlNT Commands Summary

Command

Fileset Operations

FM>ADD

FM>CREATE

FM>DELETE

FM>MAKE

FM>PURGE

F M>RELATE

FM>SFVER

Information

FM>LIST

FM>SHOW

Other Commands

FM>EX(IT)

FM>HE(LP)

FM>LM(AINT)

Function

Adds a file to a user fileset.

Creates a user fileset.

Deletes a file from a user fileset.

Makes a user fileset public or private.

Purges a user fileset.

Creates a fileset-to-fileset relationship.

Severs a fileset-to-fileset relationship.

Lists all user filesets defined for a user.

Shows the files that are in a user fileset.

Returns to the LIBRARIAN main prompt.

Provides help on FMAINT commands,

Invokes the LMAINT maintenance module.

2-3

2-14

2-10

2 — 11

2 — 12

2 — 13

PQge

2 — 9

FMAINT Commands

Parameters

Operation

Examples

Menu Mode

Command
Mode Syntax

For each FMAINT command, the following information is provided:

How to perform the operation from menu mode
(if applicable).

How the command is entered from the command line
prompt.

Detailed description for each coDunand parameter.

Basic function and descriptions of the command.

Example for using the command.

Location of related reading material.Related
Information
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FM)ADD
Adds a file or group of fi les to an existing user fileset.

Menu Mode
Select the User Filesets...Add option from the Tools menu, A dialog appears allowing you
to specify a fileset, files, revision criteria, and options.

Command Mode Syntax
FM >ADD filelist TO fileset

[;USE MASTERID ]
[;ALL ]

Parameters

fi/elist

TO fifeset

ALL

A list of files, as described in How to Refer to Files at the beginrung of
Chapter 1, "Commands".

The user fileset to which the files will be added.

Includes untracked (unknown) as well as tracked files to a user fileset.
Without this parameter, only tracked files are added.

than the secondary location actually specified.
USE MASTERID Id en t i f ies the files in the user fileset by their master file location, rather

Operation
FM >ADD adds a file or group of files to an existing user fileset.

The USE MASTERID parameter allows you to add master files to the user fileset by
specifying the secondary location. Secondary copies can then be referenced with the AT
parameter for file operations,

FM>ADD does not create a new user fileset.

Examples
The following example adds h1es to the JSTDEVEL user fileset:

FM > ADD @.SOURCE. DEVEL TO JSTDEVEL;ALL

U tx FM>ADD devel/src/* TO JSTDEVEL;ALL

Add the master file associated with the specified file to the DEVELOPMENT user fileset by
typmg:

~M~ FM >ADD FILEA.OBJECT.PRODDEVEL TO DEVELOPIVIENT;USE MASTERID

Lt lx FM>ADD /usr/devel/object/filea TO DEVELOPMENT;USE MASTERID

Related information
See FM>CREATE
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F M) CREATE
Creates a user fileset.

Menu Mode
Select the User Filesets...Create option f rom the Tools menu. A dialog appears allowing you
to specify a fileset, files, revision criteria, and options.

Command Mode Syntax
FM>CREATE fileset [ FROM filelist ]

[; PRIVATE ]
[; PUBLIC ]
[;USE MASTERID ]

Parameters
fileset

FROM filelist

PUBLIC

PRIVATE

The name of the user fileset you are creating.

A list of files, as described in How to Refer to Files at the beginning of
Chapter 1, "Commands".

Identifies the user fileset as private. Only the creator of the user fileset
and the LIBRARIAN manager can change a private fileset.

Identifies the user fileset as public Any user can change a public fileset.
The default is a public fileset.

Identifies the files in the user fileset by their master file location, rather
than the secondary location actually specified.

USE MASTER ID

Operation
FM > CREATE establishes a new user fileset. A user fileset is defined by its logical and
physical components. When creating a user fileset, you can add files at the same time by
using the FROM parameter.However, you may omit the FROM parameter to create an
empty fileset. Later, you can link other user filesets (FM>RELATE), and/or add files
(FM >ADD). Use the FM> MAKE command to change the public/private designation.

Examples
Create a public user fileset named DEVELOPMENT containing no members by typing:

Create a private user Eiteset with an init ial set of files by typing:

FM >CREATE DEVELOPMENT

M z FM > CREATE RMTDEVEL FROM @,JCL.AP DEVEL;PRIVATE

FM > CREATE RMTDEVEL FROM /usr/apdevel/jcI/*;PRIVATE

Related Information
See FM>ADD

FM>MAKE
FM>RELATE
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FM) DELETE
Deletes one or more files from a user fileset. The files are not physically deleted from the
system.

Menu Mode
Select the User Filesets...Delete option from the Tools menu. A dialog appears allowing you
to specify a fileset, files, revision criteria, and options.

Command Mode Syntax

FMoDELETE filelist FROM fileset

Parameters
filelist A list of files, as described in How to Refer to Files at the begiruung of

Chapter 1, "Commands".
FROM fileset Th e user fi leset from which you are deleting the file.

Operation
FM >DELETE terminates the relationship between physical file (s) and a user fileset; however,
it does not purge the file from the systemor the database.

Use the FM>SEVER command to terminate a relationship between two user filesets.

Examples
Remove a file from the MYFILES user fileset by typing:

FM) DELETE FILEA.JCL APDEVEL FROM MYFILES

U lx FM>DELETE /usr/apdevel/jcI/filea FROM MYFILES

Related Information
See FM) SEVER
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FM)EXIT
Leaves the FMAINT module and returns to the LIBRARIAN prompt .

Command Mode Syntax
FM > EX [IT]

Parameters
None

Operation
FM >EXIT exits from the FMAINT module.

Example
Exit FMAINT and return to the LIBRARIAN prompt by typing;

FM>EXIT
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FM)HELP
Accesses online help for information on FMAINT commands.

Command Mode Syntax
EM > HE[LP] [ command ]

Parameters
command An y FM AIN ' I ' command name.

Operation
HELP invokes LIBRARIAN onl ine help. By specifying any FMAINT command, you will be
provided information for that command. If you do not specify any parameter with HELP, it
provides you with an overview of FM~ an d i t s commands.

Examples
Obtain help on using the FM >SHOW command by typing:

EM>HELP SHOW
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FM>LIST
Displays the user hlesets defined for a particular user.

Menu Mode
Select the User Filesets„,List option from the Tools menu. A dialog appears to let you
specify a user.

Command Mode Syntax
FM>LIST [ [ FOR USER [ = ] ] user ]

Parameters
FOR USER Spec i f ies the user whose filesets you want to display.

user The user whose filesets you want to list. The default is the current active user.

Operation
FM > LIST displays the user filesets created by a specific user. The information displayed
includes the public/private designation of each user fileset.

ExampIes
List the user filesets that have been defined for the OPER user by typing:

FM > LIST FOR USER= OPER

Optionally, you can list the user filesets defined for the OPER user by typing:

FM>LIST OPER
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FMo LMAINT
Accesses the LM~ li st f i l e creation and maintenance module.

Command Mode Syntax
FM>LM[AINT]

Parameters

None

Operation
FM>LMAINT terminates the FMAINT module and invokes the LMAINT module.

Examples
Access the LMAINT module by typing:

FM > LMAINT
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FM>MAKE
Changes the public/private designation on a user fileset. Only the creator of the user fileset
and the LIBRARIAN manager can make a private user fileset public.

Menu Mode
Select the Vser Filesets...Make Public/Private option f rom the Tools menu. A dialog
appears allowing you to specify a fileset and public/private flag.

Command Mode Syntax

FM>MAKE fileset (PUBLIC $
L PRIVATEJ

Parameters
fileset

PUBLIC
fileset.

Fi1eset you want to designate as public or private.

Designates the user fileset as public. Any user can change a public user

Designates the user fileset as private. Only the creator of the user fileset
and the LIBRARIAN manager can change a private user fileset.

PRIVATE

Operation
FM >MAKE allows you to change the public/private designation of a user fileset. For
example, you can create a private user fileset so that no one can change the fileset. Later, you
can make the fileset public to allow other users to change it.

You can initially set the public/private designation when creating the user fileset.

Examples
Change the APDEVEL user fileset to public by typing:

FM) MAKE APDEVEL PUBLIC
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FM0 PURGE
Removes a user fileset from the database.

Menu Mode
Select the User Filesets...Purge option from the Tools menu. A dialog appears allowing you
to specify a fileset and options.

Command Mode Syntax
FM >PURGE fr1eset

[ r EXPLODE ]

Parameters
fr'ieset

EXPLODE

The user fileset you want to purge.

Purges all filesets related to and including the specified fileset.

Operation
FM > PURGE purges all references to the user fileset definition from the database. However,
this command does not purge the files physically from the LIBRA3GAN database or f rom
the systezn.

If you issue FM) PURGE without the EXPLODE parameter, you will delete references to the
physical file rnernbers that directly belong to the user fileset. By using EXPLODE, you wil l
delete references to all of the physical file members and all of thecomponent user filesets
with their physical file members.

Examples
Purge the MYFILES user fiieset by typing.

Purge the DEVELOPMENT user fileset and all its component user filesets by typing:

FM) PURGE MYFiLES

FM) PURGE DEVELOPMENT;EXPLODE
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FM>RELATE
Creates a subset relationship between two user or project filesets.

Menu Mode
Select the User Filesets...Relate option from the Tools menu. A dialog appears allowing you

Command Mode Syntax

to specify a parent fileset and its subset.

FM > RELATE subset TO parent-fileset

Parameters
subset The user fileset that you want to make a subset of another user fileset.

TO parent-fiieset The p arent user fileset.

Operation
FM) RELATE establishes a re1ationship between two user filesets. It lets you build a user
fileset hierarchy similar to the hierarchy of an application fileset, When you relate user
f ilesets, you can issue individual LIBRARIAN commands for any subset, parent set, or
physical file,

Additionally, you can use FM >RELATE to create proj ect hierarchies. That is, this comm-md
enables you to relate project filesets to other project filesets. As a result, when you check out
files that belong to a project, these files automatically belong to any parent project fileset.
You can then perform checkins, approvals and/or distribution by referring to parent project

Transactions are logged under the parent fileset, When you refer to them in commands,
however, the last project for the file reflects the actual project name at the tizne of checkout.

ExampIes
Designate the MY%ILES user fileset as a component of the JSTDEVEL user fileset by typing:

filesets.

FM > RELATE MYFILES TO JSTDEVEL
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FM)SEVER
Terminates a subset relationship between two user filesets.

Menu Mode

Select the User Eilesets...Sever option from the Tools menu. A dialog appears allowing you
to specify a parent fileset and its subset.

Command Mode Syntax
FM >SEVER svbset FROM parent-fileset

Parameters
svbset The name of the user fileset that you no longer wish to be a subset

of a parent user fileset.

The parent user fileset.FROM parent-fileset

Operation
FM>SEVER terminates the relationship between two user filesets. If you would l ike to
remove a user fileset from its hierarchy, use this command to terminate the relationship.
Both user filesets remain in the database and wiU be independent of each other. Use the
FM >PURGE command to remove a user fileset from the database.

Examples
Sever the relationship betw'een the DEVELOPMENT and RTMDEVEL user filesets by
typing:

FM > SEVER DEVELOPMENT FROM RTMDEVEL

Related information
See FM>PURGE
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FM)SHOW
Displays the hles and subsets that comprise a user fileset.

Menu Mode
Select the User Filesets...Show option from the Tools menu. A dialog appears allowing you
to specify a fileset and options.

Command Mode Syntax
FM >SHOW fileset

[;EX[P LODE] ]
[;STR[UCTURE] ]

Parameters
fileset

EXPLODE Exp lod e s the user fileset to include all of the files and filesets that relate to
this user fileset. Each fileset shows the level relative to the fileset you are
reviewing.

The user fileset that you want to review.

filenames.
STRUCTURE Shows the hierarchy of filesets related to this user fileset, but does not show

Operation
FM >SHOW displays the file structure for any user fileset. Without the EXPLODE parameter,
this command lists only the physical file members that directly belong to the user fileset.
EXPLODE lists all physical file znembers and all component user filesets with their physical
file members, For each fileset, the level of the fileset within the hierarchy is also shown.

Examples
Show the file structure of the MYFILE user fileset by typing:

Show the file structure of the APDEVEL user hleset and all of its related filesets by typing:

FM > SHOW MYFILE

FM > SHOW AP DEVEL;EXPLODE
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Listfile Maintenance Commands

This chapter describes the LMAINT l istfile maintenance module.

LMAINT can create listfiles based on multiple selection criteria. Listfiles
are files that contain a list of filenames, with or without a system name as
a further qualification.

Listfiles can be used in LIBRARIAN commands as a way to refer to files,
and must be preceded with an exclamation point (!) or a caret (~) Listfi les
can be used as indirect store lists for MPE's STORE and RESTORE
commands. Many other MPE and UNIX system util i t ies also accept
indirect files as input.

The following topics are covered in this chapter:

a Acc essing LMAINT

� &%A I NT Commands Summary

� FM A I N ' I' Comm'wads

For more information about LMAINT, refer to Chapter 7, "Listfiles" in the
LIBRARIAN/iX User's Guide.

Accessing LMAINT
You can access LMAINT in the following ways.

1. Issue the LMAINT coma~d f r om the LIBRARIAN > prompt.

From the LM > prompt, you can issue any LMAINT command. To
return to the LIBRARIAN prompt, enter LM > EXIT.

LMAINT operations.
2. Select Tools from the main menu. Then select Listfiles... for a menu of
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LMAlNT Commands Summary
Table 3 — 1 below lists the LMAINT commands as well as their functions
and page references for locating detailed descriptions.

Table 3-1 LMAIN T Commands Summary

Command Function

LisNle Operations

LM>ALTER t

LM>DOCUMENT t

LM>EDIT t

LM>LIST f

LM>OUTPUT

LM>REPORT f

LM>S(ORT)

Other Operations

LM>EX(IT/

LM>FM(AINTJ

LIVI >HE (LP)

f = MPEonly

Returns to the LIBRARIAN main prompt.

Changes APPEND/REPLACE mode of a listfile.

Associates documentation notes with a listfile.

Edits a listfile using EDITOR.

Lists the filenames contained in the listfile.

Selects files and writes them to a listfile.

Formats the documentation notes and filenames.

Sorts a listfile by filename.

3 — 3

3-10

3-14

3 — 15

Page

Invokes the FMAINT module.

Provides online help on I.MAINT commands

LMAINT Commands
The LMAINT command descriptions and syntax include the following:

Menu Mode

Parameters

Operation

Example(sl

Command
Mode Syntax

How to perform the operation from menu mode
(if applicable).

How the command is entered from the command line
prompt.

Detailed description for each command parameter.

Basic function and description of the command.
Example(s) of the command.

Locations of related information.Related
Information
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LNt)ALTER
Alters the mode of a listfile to either APPEND or REPLACE.

Menu Mode
Select the Listfiles...Alter option from the Tools menu, A dialog appears allowing you to
specify a listfile name and its APPEND/REPLACE attribute,

Command Mode Syntax
LM >ALTER filename

[; APPEND ]
[; REPLACE ]

Parameters
filename

APPEND

Any valid listfi le.

Sets the listfile to APPEND mode When set to APPEND, all subsequent
LM >OUTPUT transactions to the listfile are automatically appended,

Sets the listfile to REPLACE mode. By default, the LM>OUTPUTcommand
replaces the contents of the listfile (unless no files are found).

REPLACE

Operation
LM>ALTER aHows you to toggle between APPEND and REPLACE mode for a listfile. When
first created, a listfile is in the REPLACE mode.

Examples
Change the default mode to APPEND by typing:

LM >ALTER MYFILE;APPEND

Related Information

See LM >OUTPUT

L istfile Maintenance Commands 3 - 3



LM~DOCUMENT
Associates documentation with a listfile.

Menu Mode
Select the Listf i les...Document option f rom the Tools menu. A dialog appears allowing you
to specify a listfile name.

Command Mode Syntax

maximum of 750 80-character lines.

LM > REPORT command substitutes the character sequence.

LM > DOCUMENT filename

Parameters
filename An y val i d l i s t f i le.

Operation

LM>DOCUMENT lets you create documentation for a listfile. LM>DOCUINENT invokes the
standard HP editor program, EDITOR.PUB.SYS. Existing documentation is brought

automaticallyinto the editor, New or modified documentation is stored automaticallywhen
you exit

Documentation is stored in the user label area of the listfile; therefore, you are limited to a

Two special directives can be embedded in your d ocumentation which affects the
LM > REPORT display

.title. When .title. is encountered starting in the first column of a line, the

When .page. is encountered starting in the first column of a line, the
LM>REPORT command issues a page break.

.page,

Examples
Document a listfile called MYHLE by typing:

LM > DOCUMENT MYFILE

Related Information

See LM > REPORT
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LM)EDIT
Edits the contents of a listfile using EDITOR.PUB.SYS.

Menu Mode
Select the Listfiles...Edit option from the Tools menu. A dialog appears allowing you to
specify a listfile name.

Command Mode Syntax
LM > EDIT filename

Parameters
filename An y vali d l i s tf ile.

Operation
LM > EDIT lets you edit the contents of a listfile with EDITOR.PUB.SYS. The listfile is

automaticallybrought into the editor. You can manually add, delete, or change filenames
that appear in this file,

Use the LM >OUTPUT command to have LIBRARIAN automaticallycreate or add to a listfile.

Examples
Edit a listfile called MYFILE by typing:

LM >EDIT MYFILE

Related Information
See LM > OUTPUT
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LM)EXIT
Terminates the LMAINT module and returns to the LIBRARIAN prompt.

Command Mode Syntax
LM > EX [ITj

Parameters
None

Operation
LM) EXIT terminates the LMAINT module.

Example
Exit LMAINT and return to the LIBRARIAN p rompt bytyping:

LM) EXIT
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LM)FMAINT
Accesses the Fh&~ T u ser f i leset definition and maintenance module.

Command Mode Syntax
LM > FM [AINQ

Parameters
None

Operation
LM > FMAINT terminates the LMAINT module and invokes the FMAINT module.

Example
Access the FMAINT module by typing:

LM) FMAINT

Related Information
See Chapter 2, "User Fileset Commands"
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LM>HELP
Accesses online help for information on using LMAINT.

Command Mode Syntax
LM > HE [LP] [ command ]

Parameters
command An y L M A IN T c ommand name.

Operation
HELP provides you with the LIBRARIAN online help. If you specify an LMAINT command,
you will be given information for that command. If you do not specify any parameters,
HELP provides you with an overview of L1VIAJINT and the LM~ commands.

Example
Obtain help on using the LM>SORT command by typing:

LM>HELP SORT
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LM)LlST
Displays the filenames contained in a listfile.

Menu Mode
Select the Listfiles...List option from the Tools menu. A dialog appears allowing you to
specify a listfile name.

Command Mode Syntax
LM > LIST filename

[FMT]

Parameters
filename

FMT

Any valid listfile

Allows you to view the list in a different format.

Operation
LM > LIST displays the filenames contained in the specified listfiie on a page-by-page basis
(36 files per page). Additionally, you can view the hlenames in one of two formats by
selecting the FMT option.

Examples
List the contents of a listfile named MYFILE by typing:

LM > LIST MYFILE

Related information

See LM > REPORT

L isXle Maintenance Commands 3 - 9



LM)OUTPUT
Outputs a list of filenames to a net or existing listfile.

Menu Mode
Select the Listf i les...Output option from the Tools menu. A dialog appears allowing you to
specify a listfile name, files, selection criteria, revision criteria, and options.

Command Mode Syntax
LM >OUTPUT filelist TO listfilename

[;ALL ]
[;APPEND]
[; AUTHORIZE stepname ]

[;EXP DATE expdate ]

[;FILECODE = filecode ]

MODDATE (filename) ]

moddate ]
TIMESTAMP (filename) ]

[;MODDATE

[; MODIFIED ]
[;OLDNAME ]
[; OWNER user ]
[; REPLACE ]
[;RESETONZERO ]
[; SIMULATE stepname ]
[;SYSTEM ]
[; UNMODIFIED ]
[: UNTRACKED ]
[;USE stepname ]

Parameters
filelist

ALL

listfilename

it must be a valid listfi le.

A lis t of files, as described in How to Refer to Files at the beginrung
of Chapter 1, "Commands".
The name of the listfile to which qualifying fi lenames should be
written. It can be any valid local filename. If the file already exists,

Listfiles are assigned a filecode of 55 (or 56 when the SYSTEM

parameteris specified).

Indicates that LM >OUTPUT should include all files found,
regardless of whether or not they are being tracked by
LIBRARIAN.
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LM>OUTPUT (continued)

Parameters, continued
APPEND

OWNER

exp date

SYSTEM

MODIFIED

OLD NAME

EXP DATE

MODDATE

FILECODE

TI ME STAMP

AUTHORIZE

MODDATE (filename)

a filecode of 56 rather than 55.

system. filename

system: filename

Appends the qualifying filenames to those already found in the
listfile. Takes precedence over the default inode assigned to the
file by using the LM >ALTER corrunand.

Creates a list of files that would be authorized for a particular
step.

Indicates that files selection is based on the expiration date
assigned by LIBRARIAN.

Any valid date, expressed in accordance with the Date Format
established on the SystemProfile (SP) screen. TODAY is a valid
mnemonic for the current system date.

Indicates that files selection is based on the specified filecode,
wherefilecode is any valid (numeric) filecode.

Indicates that the filenames written to the listfile should include
thesystem ID. By default, filenames do not include the system
name. If SYSTEM is specified, filenames are written in the format:

Listfiles that are created with a SYSTEM specification are assigned

Indicates that selection of files is based on the Date Modified (and
optionally Time Modified) value stored in the file label moddate is
any valid date, expressed in accordance with the Date Format
established on the SP screen. TODAY is a valid mnemonic for the
current system date.

Selection is based on a comparison made with the Date Modified
value of the specified filename.

Selection is based on a comparison made with both the Date
Modified and Time Modified values of the specified fi l ename.
filename is any valid filename, expressed in the format:

Selects only those files modified since they were created by the
LIBRARIAN program. The current timestamp in the file label is
compared with the timestamp in the database.

Indicates that the filename appearing in the listfile should be the
file's original name, before it was retained (for retained f'iles only).

Selects files that the specified user owns.

A ny valid LIBR ~ N u ser .

Does not append new filenames to the existing listfi le. Takes
precedence over the default mode assigned to the file by the
LM >ALTER command, The opposite of APPEND.

user

REPLACE
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LM>OUTPUT (continued)

Parameters, continued
RESETONZERO

SIMULATE

UNMODIFIED

Instructs LM >OUTPUT to replace an existing listfile with an empty
listfile whenever no files qualify. By default, an empty fi leset will
not result in an empty listfile. The existing listfile is not replaced.

Creates a list based on destination files authorized for a particular
step. Similar to USE and AUTHORIZE.

Selects only those files that were not modified since they were
created by LIBRARIAN.

Selects only files not currently being tracked by LIBRARIAN.

Creates a list based on the destination location defined for a step,
including any refined destinations. stepname is the name of the
step in the fo1lowing format:

step [.route [.applj)

UNTRACKED

USE

Unlike the SIMULATE parameter, USE indudes files regardless of
whether or not they would be authorized.

Operation
LM >OUTPUT serves several purposes. First, it provides a way of creating an indirect store
file (see the MPE's STORE command) from an existing LIBRARIAN fi leset. This indirect
store file can be updated later to include documentation notes about the files it references.

Second listfiles created by LM >OUTPUT, can in turn, be used as input to any valid
LIBRARIAN command preceded with the exclamation point (!) or caret (~), For example, a
l istfile called MYFILE can be used as input to a user-defined step called CHECKOUT as
follows:

> CHECKOUT! MYF ILE

Examples
The following example creates a listfile containing the f i l enames found in a project fileset.

M E

UNIX

LM>OUTPUT%P1-FILES TO P1FILES.STORFILE

LM>OUTPUT %P1 � FILES TO /store/lisffiles/projl files

The following example transforms the filenames found in the project fileset into the names
they would contain after a DISTRIBUTE step w'as performed.

LM >OUTPUT %P1-FILES TO P1FILES.STORFILE;SIMULATE DISTRIBUTE

LM >OUTPUT %P1 — FILES TO /store/list/projl files;SIMULATE; DISTRIBUTE
UNIX
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LM>OUTPUT (continued)

Parameters, continued
Append to a listfile the files involved in your last LIBRARIAN transaction by typing:

UNIX

LM>OUTPUT * TO MYFILES.MYGROUP;APPEND

LMoOUTPUT ** TO myfiles; APPEND

The following example creates a listfile containing all files modified since the listfile itself
was last modified. It includes any file, even those that are not tracked by LIBRARIAN. It
then recreates the listfile if no files qualify.

LM > OUTPUT Q.SOURCE TO MOD FILES; MOD DATE >TIMESTAMP (MOD FILES); &
ALL;RESETONZERO

LM o OUTPUT src/* TO modtiles; MODDATE> TIMESTAMP(moctfiles);ALL; RESETONZERO

Related Information
See LM > DOCUMENT

UNIX
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LM>REPORT
Displays the documentation notes and filenames contained in the listfile.

Menu Mode
Select the Listfiles.�Report option from the Tools menu. A dialog appears allowing you to

Command Mode Syntax

specify a listfile.

LM ) REPORT filename

Parameters
filename An y v al id l i s t f i1e.

Operation
LM >REPORT displays information pertinent to the specified listfile, including creation and
modification dates, In addition, any associated documentation notes are also formatted and
displayed on a page-by-page basis.

Filenames contained in the listfile are optionally displayed.

Examples
The following example reports the d ocumentation notes and filenames contained in the
l istfile called MYFILE.

LM >REPORT MYFILE

Related information
See LM) DOCUMENT
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LM>SORT
Sorts the filenames stored in the listfile.

Menu Mode
Select the Listfiles...Sort option from the Tools menu. A dialog appears allowing you to
specify a listfile and options.

Command Mode Syntax

LM > S [OR+ filename

[;NODUPLICATES ]

Parameters
filename Any valid listfi le.

NODUPLICATES Eliminates duplicate filenames from sorted output,

Operation
LM >SORT sorts the contents of a listfile by filename in ascending order.

Example
The following example sorts a listfile called MYHLE and eliminates duplicate filenames.

LM>SORT MYFILE;NODUPLICATES
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SHOWLOG Commands

SHOWLOG is a comprehensive and flexible tool for generating
transaction reports for meeting a variety of audit needs. Addit ionally,
SHOWLOG provides a transaction memo editing function. It allows users
to inspect transaction log records selectively in a variety of formats.

SHOWLOG has its own set of commands to set up selection criteria,
establish report format and sort sequence, and process the report online

This chapter covers the following topics:

� Ac cessing SHOWLOG

a Transaction Codes on SHOWLOG Reports

or off1ine.

� SHOWLOG Commands

Accessing SHOWLOG
You can access the SHOWLOG module in the following ways:

1. Type SHOWLOG at the LIBRARIAN ) p rompt

2 S e lect Info from the main menu followed by Log. Then, select

The default selection criteria and report settings are displayed, followed
by the SHOWLOG) prompt. From this prompt you can issue any
SHOWLOG command until you enter SHQWLOG >EXIT.

Figure 4 — 1 shows the SHOWLOG display after entering the SHOWLOG

SHOWLOG to access the SHOWLOG module.

module.

APPLICATION
PROJECT
MEMO TEXT
F ILE(S) : Masle r

ROUTE
USER(S)

STEP/CMD:
DATE

TITLE: SHO WLOG Transacljan Repov
ONLINE CONCISE UNS O RTED

Figure 4 — 1. SHOWLOG Display

SHOWLOG Commands 4- l



Transaction Codes on SHOVVLOG Reports
Table 4 — 1 lists the codes that appear on transaction reports generated
from the LIBLOG database (i,e., RTS10, RTD10, RTD40, and SHOWLOG
reports).

CO

Table 4-1. L IBLOG Transaction Codes

Transaction Code C o m m a nd

COMPRESS sc

T ransaction Code Com m a n d

CP COPY

DECOMPRESSDC

SR

SECURE

SCAN+ REPLACE

ST

LO LOCK TO TOUCH

ME MEMO UL UNLOCK

MOVE UP

OV

ORPHAN

OVERLAY

PERFORM (step)

PURGE

XC

PU

PF

XD

XMOVE

X PURGE

UPDATE

XCOMPRESS

XDECOMPRESS

XP

RE RESET XR XRENAME

RELEASE XTOUCH

RN RENAME XCOPY

RS RESTORE

SHOWLOG Commands Summary
SHOWLOG commands allow users to define selection criteria and to set
up report parameters, Use SHOWLOG commands to:

� de f i ne transaction selection criteria

a choose a report format

� ch a nge the output destination

� se t up the report sort sequence

� save and retrieve report settings

� ge nerate customized transaction reports

� select subsets of extracted transactions
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Table 4 — 2 lists the SHOWLOG commands and their functions. Page
references help you locate the detailed command descriptions.

Table 4 — 2 SHOWLOG Command Summary

FunctionCommand
Selection Criteria

SHOWLOG>SE(LECT) Ext r acts only those transaction records which

Page

4-17
match the specified selection criteria.

Report Format

SHOWLOG>FO(RMATI

SHOWLOG>LI(STJ

Changes report format,

Creates a listfile containing names of files
involved in selected transactions.

Sets the report output disposition to offline

4 — 12

SHOWLOG>OU(TPUTI
or online.

Sort Sequence

SHOWLOG>SO(RTJ Sets up the reports sort sequence.

Report Settings

SHOWLOG>GE(TI

SHOWLOG>SABRE)

Processes commands from a file.

Saves current report settings and selection

4 — 23

4-16
criteria to a file.

Generate Reports

SHOWLOG>GO Generates reports using current report selection 4-10
criteria and settings.

Subsets

SHOWLOG>SUB(SETJ 4-24Selects a subset of current! y extracted transactions
for reporting.

SHOWLOG>UN (DO)

Other Commands

SHOWLOG>EX(ITJ

Resets the current subset. 4 — 26

Exits the SHOWLOG module, and returns to the
LIBRARIAN p rompt.
Deletes all log records associated with extractedSHOWLOG>FL(USH)

SHOWLOG>HE(LP)

SHOWLOG>RED(O)

SHOWLOG>RES(ETJ

SHOWLOG>SH (OWJ

to default values.

transactions.

Accesses the online help for information about
using SHOWLOG.

Edits the previous command entry.

Resets selection criteria and/or report settings

Refreshes the display of selection criteria and
report settings.

Sets a title to appear on all pages of a report.

4-14

4-15

SHOWLOG>TI(TLE)
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SHOWLOG ComrnancIs
This section contains descriptions and syntax for all SHOWLOG
commands. The SHOWLOG command descriptions include:

Syntax

Parameters

Operation

Example(s)

How the command is entered f rom the command
line prompt.

Detailed description of each command parameter.

Basic function and description of the command.

Example(s) of’ the command.

Location of related information.Related
Information
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SHOWLOG) EXIT
Exits the SHOWLOG module and returns to the LIBRARIAN prompt ,

Syntax
SHOWLOG > EXtlTj

Parameters
None

Operation
SHOWLQG > EXIT returns to the LIBRARIAN prompt .

Examples
Exit SHOWLOG and return to the LIBRARIAN prompt by typing:

S H OWLOG > EXlT
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SHOWLOGo FLUSH
Deletes all log records associated with extracted transactions.

Syntax
SHOWLOG > FL[USH)

Parameters
None

Operation
SHOWLOG>FLUSH is available only to users with LIBRARIAN Manager capability. When
issuing this coxrunand, you are promptedfor a user and password.

Note All LIBRARIAN users and passwords are case-sensitive.

If a subset is currently active, only the subset of extracted transactions is deleted.

Examples
Flush all extracted log transaction records from the LIBLOG database by typing:

SHOWLOG> FLUSH

Related Information
See FLUSHLOG
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SHOWLOG>FORMAT
Changes report format.

Syntax

SHOWLOGo I FOjRMAT] j ALL
CONCISE
DETAIL
MENIO
MEMO EDIT
RTD10
RTD40
RTS10
SUMMARY

Parameters
ALL

RTD10

MEMO

DETAIL

CONCISE

MEMO EDIT

CONCISE format.

Changes the report format to ALL The ALL format includes surnrnary data,
memo text, and detailed data for qualifying transaction records.

Changes the report format to CONCISE (default). The CONCISE format is a
single line summary for each transaction. Reference numbers for subset
selection are available with this format by pressing CONTROL-Y. This
toggles between dates and reference numbers for each display page of the

Changes the report format to DETAIL. Transaction summary and detail
information is included. If master file is defined as the primary sort key with
the SORT command, then a different layout is used.

Changes the report format to MEMO. The MEMO format includes concise
transaction summary information and memo text.

Changes the report format to MEMO and enables the memo editing facility.
After each transaction summary and rnerno text is displayed, you are asked if
you want to edit the memo text. To edit the memo, you must supply the
password of the user who performedthe transaction. Once the password is
validated, you can edit any of that user's memos without being p rompted
again. You can replace or append a rnerno, Editing memo text is similar to
adding a memo during a LIBRARIAN t ransaction.

Changes the report format to RTD10 (Transaction Detail by Date, Time). For
more information on this report, refer to Chapter 6, "Reports." When
transaction records are extracted, they are sorted and sent to the RTD10
report program. The output is setautomaticallyto OFFICE, and the sort
sequence is set automatically to DATE, TIME,

Changes the report format to RTD40 (Transaction Detail Report by File, Date,
Time). For more information on this report, refer to Chapter 6, "Reports."
When transaction records are extracted, they are sorted and sent to the
RTD40 report program. The output is set automatically to OFFLINE, and the
sort sequence is set automaticallyto MASTERFILE, DATE, TIME.

RTD40
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SHOWLOG>FORMAT (continued)

Parameters, continued

RTS10

column and the time isomitted.
� If you use the default sort, the master filename appears in the first

� If you sort by DATE, the transaction time and date appears,

Changes the report format to RTS10 (Transaction Summary Report by Date,
Time). For more information on this report, refer to Chapter 6, "Reports,"
When transaction records are extracted, they are sorted and sent to the RTS10
report program, The output is set automatically to OFFLINE, and the sort
sequence is set automatically to DATE, TIME.

three-line summary of each transaction.

alone.

SUMMARY Cha n ges the report format to SUMMARY. The SUMMARY format includes a

Operation
SHOWLOG > FORMAT changes the currently active report format.

If your extract selection criteria and sort sequence have not changed since generating the
last report, you can use this command in conjunction with the GO command This causes the
formats to alternate without wait ing for a new extract or sort.

Generate a report in the selected format by using GO.

You can omit the word FORlVMT and execute this command by specifying the parameter

Examples
Choose the ALL report format by typing:

Choose the MEMO format with the memo editing facility enabled by typing;

SHOWLOG > FORMAT ALL

SHOWLOG>MEMO EDIT

Related Information

See SHOWLOG>GO
RTD10, RTD40, and RTS10 reports in Chapter 6, "Reports"
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SHOWLOG)GET
Processes the commands in a file.

Syntax
SHQWLOG>GE[TJ xeqfile

Parameters
xeqfife The name of a file consisting of SHOWLOG commands. You znust have

READ access to the file.

Operation
Use SHOWLOG>GET to process a SHOWLOG>SAVE file with stored settings, or to process
commands in a file you created by using an editor. SHOWLOG displays each command in
the file as it is executed. If an error is encountered, or if you press CONTROL-Y, processing

Examples
Restore settings that were saved earlier with the SAVE command in a file called SETTINGS
by typing:

of the file can be terminated.

SHOWLOG > GET SETTINGS

Related information
See SHOWLOG>SAVE
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SHOWLOG) GO
Generates reports using current report selection criteria and settings

Syntax
SHOWLOG > GO

Parameters
None

Operation
SHOWLOG > GO initiates report processing:

� If selection criteria are new or have changed, an extract occurs. Use CONTROL-Y at any
time during the extract to view the number of records that have been extracted so far.
You have the option of terminating the extract.

� If a new extract has been performed or the sort sequence has changed, the extract file is
sorted. Use CONTROL-Y to check the sort status and to discontinue, if desired.

Examples
Process the currently defined report by typing;

SHOWLOG > GO
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SHOWLOG~ HELP
Accesses the online help for information on using SHOWLOG.

Syntax
SHOWLOG>HE[LP] [ command ]

Parameters
command Any SHOWLOG command name, or one of the SELECT, OUTPUT, or FORMAT

parameters.

Operation
When you issue SHOWLOG >HELP and specify a SHOWLOG command name, you are
provided with information for that command. Without p arametersspecified, HELP provides
you with an overview' of SHOWLOG commands.

Examples
Obtain help on using the SORT command by typing:

SH OWLOG > HELP SORT
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SHOWLOG)LIST
Creates a listfile containing the names of files involved in selected transactions.

Syntax

SHOWLOG > Ll [ST] MA S TERS TO listfile
FROMFILES
TO FILES

[;APPEND]
[;SYSTEM ]

Parameters
MASTERS Li sts master filenames to the listfile.

FROMFILES Lis t s source filenames to the listfile,

TOFILES

listfile

APPEND

SYSTEM

Lists destination filenames to the listfile.

Any valid fi lename within your login account.

Appends records to an existing listfile.

Includes the system names in the listfile.

Operation
When you issue SHOWLOG >LIST, the files involved in selected transactions (MASTER,
FROM, or TO) are written to the specified listfile,

Examples
The following example appends destination filenames to a listfile called MYLIST.

SHOWLOG > LIST TOFILES TO MYL[ST; APPEND
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SHOWLOG)OUTPUT
Sets the report output disposition to offl ine or online.

Syntax

SHOWLOG> [ OU[TPUT] j J ON[LINE]
( OF[FLINE] J

Parameters
OFFLINE Redi rec ts SHOWLOG output to the LP device (i.e.,:FILE

SHLOGOUT;DEV =LP).
Redirects SHOWLOG output to the $STDLIST device (i.e, FILE
SHLOGOUT =$STDLIST). ONLINE is the default.

ONLINE

Operation
SHOWLOG >OUTPUT sets up a file equation for the forrnal file designator SHLOGOUT. To
override the file equation set up by OUTPUT, issue a file equation for LIBOUT (e.g., FILE
LIBOUT;DEV =LASER). LIBOUT always takes precedence over SHLOGOUT.

You may omit the word OUTPUT and execute this command by specifying only ONLINE or

Examples
Set the report destination so that reports are sent to the line printer by typing:

OFFLINE.

SHOWLOG > OUTPUT OFFLINE

Set the report destination so that reports are sent on the STDLIST by typing:

SHOWLOG > ONLINE
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SHOWLOG) REDO
Edits the last command entered.

Syntax
SMOWLOG > RED [0]

Parameters
None

Operation
Use SHOWLOG > REDO to correct errors in the last command issued. This command
functions like the MPE's REDO cornrnand.

Whenever you issue a command with a syntax error, SHOWLOG automatically enters
REDO mode. Bypass the Auto-Redo feature by pressing RETURN.

Examples
Edit the last command entered by typing:

SHOWLOG > REDO
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SHOWLOG) RESET
Resets selection criteria and/or report settings to default values.

Syntax
SHOWLOG > RES [ET] item

Parameters

item The report setting or selection item set to the default. Possible items to be
reset include:

AL[L]

AP [PLICATION]

DA[TES]

Fl [LES]

LA[ST]

PR[OJECT]

RO[UTE]

SE [LECT]

SO[RT]

ST[EP]

SU [BSET]

All report settings and selection criteria to default values.

Current application selection to all applications.

Current date selection to all dates.

MASTER, FROM, and TO files selection to all fi les.

Last transaction setting.

Project selection to all projects.

Route selection to all routes.

All selection criteria,

Sort sequence to unsorted.

Current step selection to all steps.

Resets the subset. The next report shows all transactions in
the current extract file.

Report title to the default title.

Current user selection to all users.

TI [TLE]

US [ERS]

Operation
Vse SHOWLOG > RESET to return settings and criteria to default values.

Vsing RESET with the SUBSET parameter has the same effect as issuing UNDO.

Examples
Reset the sort sequence to default (unsorted ) by typing:

SHOWLOG > RESET SORT

Related Information
See SHOWLOG>UNDO

SHOWLOG > SELECT
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SHOWLOG>SAVE
Saves the current report settings and selection criteria in a file.

Syntax
SHOWLOG > SA[VE] xeqfile

Parameters
xeqfile Any valid fi lename within your login account.

Operation
SHOWLOG >SAVE builds a file with commands that can be used to restore the current report
settings at a later time. If you specify an already existing file, you are asked if you would
like to replace it. Subsets are not saved.

Use SHOWLOG>GET to execute commands in the SAVE file.

Examples
Save settings in a file called SETTINGS by typing:

SHOWLOG >SAVE SETTINGS

Related Information
See SHOWLOG >GET
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SHOWLOG)SELECT
Extracts only those transaction records which match the specified selection criteria.

Syntax
SHOWLOG> [ SEL[ECT] ]

AP [PLICATION] app/
BRANCH
[COMMAND] command
DA[TES] daterange [,daterange [,... ] ]
FA [ILUR ES]
FR[OM] filelist [ TO filelist ] [,filelist [ TO filelist] [,...] ]
INPROGRESS
m[ST]
MA[STERS] masterfile [,masterfile [,... ] ]
NE[W]
OR [P HANS]
PR[OJECT] project
RO[UTE) route
ST[EP] step
TEXT memotext
TO filelist [ FROM filelist ] [,filelist [ FROM filelist ] [,...] ]
US[ERS] user [,user [ „.. ] ]

Parameters
APPLICATION app/ Specifies application to be matched when extracting transaction

summary records. Use four asterisks ("" ) t o indicate transactions
involving more than one application. Only one application can be
specified. A warning is displayed if the application is not currently
defined, By changing the application, any values for route, step, and
project are reset. If you don't specify an application, all applications
qualify for the report.

BRANCH Selects files that were created on a branch.

COMMAND command
Indicates the LIBRARIAN command to be matched when extracting
transaction surnrnary records. Selects transaction records for a particular
command:
COMPRESS
COPY
DECOMPRESS
LOCK
MAIL
MEMO
MOVE
OVERLAY
PERFORM
PURGE

RENAME
RESET
SCAN
SECURE
SET EXPDATE
SET MODE
SET LOCKWORD
TOUCH
UNLOCK
UPDATE
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SHOWLOG>SELECT (continued)

Parameters, continUed
DATES daterange Selects transaction records for a particular date or date range. Multiple

date ranges are permitted.The keyword TODAY can be used for the
current date The date range parameter can be in these forms:

Single Date Da t e Range

xxjxx/xx
TODAY

FAILURES

FROM filelist

RESET DATES to start a new list of dates.

Enter dates in the format defined in the System Profile (SP) screen
Because the hyphen ( — ) indicates a date range, it cannot be used as a
separator; instead, use a slash (/).
Each SELECT DATE command appends to a list of selected dates. Use

Selects transactions that failed to complete or that failed during fi le
operation.

Selects transaction detail records for file operations associated with a
particular FROM file location or locations (and optionally associated TO
file locations using FROM filelist TO filelist). Each SELECT FROM command
appends to a list of selected files. Use RESET FILES to begin a neve list of
file specifications.

The filelist can be in any of these forms:

� Di r e ct reference by filename

� Di r e ct reference by logical fileset

� In d i r ect reference by secondary location

See Horo to Refer to Files a t the beginrung of Chapter j., "Commands" for
detailed information about referencing files using filelists.

Extracts only the last transaction p erformed.LAST is available for the
current LIBRARIAN session. Other selection criteria are ignored. LAST is
useful for inspecting the results of a transaction when QUIET ON is in
effect, or when results have scrolled off the screen In addit ion, LAST can
be used to generate printed documentation of your transactions.

INPROGRESS Selec t s f i les checked out in transactions that used the INPROGRESS

LAST

parameter.
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SHOWLOG>SELECT (continued)

Parameters, continued
MASTERS

TEXT

STEP

NEW

ROUTE

TO filelist

PROJECT

ORPHANS
transaction.

Selects transaction detail records for file operations associated with a
particular master file or files. Each MASTER cornrnand appends to a list
of valid file specifications. Use RESET FILES to begin a new list of file
specifications. A masterfile can take one of the following forms:

� Di r e ct reference by filename

� Di r e ct reference by fileset

Extracts transaction records only for files newly introduced to
LIBIVZCIAN during the transaction.

Extracts transactions records only for fi les orphaned during the

Selects transaction records for a particular project, Because project names
are unique, SHOWLOG is able to set the corresponding application,
Only one project name can be specified. An error occurs if the project
name is not defined or if a specified application does not match the
project application. If a slash (/) is used rather than a project name,
transactions not connected to a project will be selected.

Selects transaction records associated with a particular route. If the route
is unique, the corresponding application is also set. Only one route can
be specified. A warning is displayed if the route is not defined. An error
occurs if the route is ambiguous or if the route is not part of the current
application. When a new route is specified, the value for step is reset.

Selects records for transactions associated with a particular stepname. If
the stepname is unique, the corresponding application and route are also
set. Only one stepnarne can be specified. A warning is displayed if the
stepname is not documented. An error occurs if the step is ambiguousor
the step is not part of the current application/route.

Searches memo text for the string specified and reports the
corresponding transactions.

Selects transaction detail records for file operations associated with a
particular TO file location(s), and optionally associated FROM file
locations usIng FROM filelist TO filelist. Each SELECT TO command
appends to a list of selected files. Use RESET FILES to begin a neve list of
file specifications. The f i lelis parameter can take any of the forms
described earlier for the FROM filelist parameter.

Selects transactions performed by a particular user(s ) Each USER
command appends to the list of selected users. Use RESET USER to start
a new list of users. Warnings are issued if you specify an undocumented

USER user

user.
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SHOWLOG)SELECT (continued)

criteria

selection criteria,

SHOWLOG >APPLICATION FIN

Operafion
SHOWLOG>SELECT establishes the selection criteria that SHOWLOG uses to extract
transaction records. SMOWLOG >SELECT generates a report based on these criteria by using
GO. Once records have been extracted, they remain in effect until you change any of' the

You can omit the word SELECT and execute this command by specifying only the selection
parameters.

If you specify a project fileset, then project activity dates are setautomaticallyas selection

Examples
Extract only transactions associated with the FIN application by typing:

Extract only transactions involving mult iple applications by typing:

Extract only transactions performed on September 30, 1991 by typing:

SHOWLOG>APP ****

SHOWLOG > DATE 9/30/91

Extract only transactions performed before October 01, 1991, and between November 01,
1991 and today by typing:

SHOWLOG) DATE -10/01/91, 11/01/91-TODAY

The following exampleextracts only transaction detail records where the FROM file location
was either the JCL or PRG groups of the FINANCE account, and the TO file location in both
cases was the PROD group

SHOWLOG > FROM @.JCL. FINANCE TO @.PROD.FINANCE, @. P RG.FINANCE TO

U ~ SHOWLOG> FROM /finance/jcl/* TO /finance/prod/*, /finance/prg/* TO /finance/prod/*

Ivl E @.PROD. FINANCE

S HOWLQ G > LAST

The following example extracts only transaction detail records where the FROM file was a
secondary copy of a file in the FINANCE fi leset.

SHOWLOG > FROM %FINANCE AT @.N.Q.Q

SHOWLOG ) FROM %FINANCE AT *:/*

Select the last transaction performed only by typing:

Select only transactions associated with the PAYROLL project by typing

Select only transactions associated with the DEVEL route by typing:

SHOWLOG > PROJECT PAYROLL

SHOWLOG) ROUTE DEVEL
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SHOWLOG>SELECT (continued)

Examples, continued
Set a flag to extract transaction detailed records for new files by typing:

SHOWLOG > SELECT NEW

Se1ect only orphaned files by typing:

SHOWLOG > S ELECT ORPHANS

Select only new fi les, where the file operation failed by typing.

SHOWLOG > NEW
SHOWLOG > FAILURES

Select only transactions associated with the CHECKOUT step by typing:

SHOWLOG > STEP CHECKOUT

Select only transactions performed by users CHRIS, PAT or JEAN by typing:

SHOWLOG> USERS CHRIS, PAT, JEAN

Alternatively, select these transactions by typing:

SHOWLOG> USER CHRIS
SHOWLOG > USER PAT
SHOWLOG > USER JEAN

Related Information
See SHOWLOG> RESET
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SHOWLOG)SHOW
Refreshes the display of selection criteria and report settings.

Syntax
S HOWLOG > SH [OWj

Parameters
None

Operation
Use SHOWLOG>SHOW to refresh the display of report settings and selection criteria. This
cornrnand is useful when the display has been overwritten or when you need to review
lengthy lists of criteria.

Examples
Refresh the screen after someone has sent you a message by typing:

S HOWLOG > SHOW
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SHOWLOG>SORT
Sets up the sort sequence for a report.

Syntax
SHOWLOG>SO[RT] [-] sortkey [, [ - ] sortkey [,... ] ]

Parameters

sortkey

Uses descending sort order. If this parameteris omitted, ascending order is used.

Any of the following sort keys.

AP [PLICATION]

DA[TES]

FR [OMFILE]

MA[STERFILE]

PR[OJECT}

RO[UTE]

ST[EP]

TI [ME]

TO[FILE]

US[ERS]

Operation
SHOWLOG>SORT sets the sort sequence for SHOWLOG reports. Transaction summary
reports (CONCISE, SUlVIMFMY, MEMO, etc.) cannot include file sorts since files do not
appear in these formats. The RTD10, RTD40, and RTS10 sort sequences cannot be changed,

Examples
Sort the report by application, route, step, date and tune (descending) by typing:

Sorts by application.

Sorts by date.

Sorts by FROM file.

Sorts by master file.

Sorts by project.

Sorts by route.

Sorts by ste.

Sorts by time.

Sorts bv TO file

Sorts bv user.

SHOWLOG>SORT AP, RO, ST,-DA, -TI

Sort the report by user by typing:

SHOWLOG > SORT USER
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SHOWLOG>SUBSET
Flags a subset of currently extracted transactions for reporting.

Syntax
SHOWLDG>SUB[S~ re fnum [-refnum I [, ...]

Parameters
refnum The transaction reference number, Ranges of reference numbers can be

specified by using a hyphen ( — ).

Operation
SHOWLOG>SUBSET marks a subset of the transaction extract file for refined reports. Obtain
reference numbers by using the concise report format and press CONTROL-Y. Each SUBSET
command adds to the current subset. Use the UNDO or RESET SUBSETcommand to return
to the original set of extracted transactions

Note When you change the sort sequence, the subset is preserved even
though the reference numbers change. Without parameters, SUBSET
lists the reference numbers in the current subset.

Examples
View a refined report consisting of transactions numbered 1-4, 22, 66, and 132 through 180
by typing­

SHOWLOG>SUBSET 1-4, 22, 66, 132-180

Related Information
See SHOWLOG>UNDO

RESET SUBSET
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SHOWLOG) TITLE
Sets a title to appear on all pages of a report.

Syntax
SHOWLOG > TIP LE] title

Parameters
title A title, up to 50-characters in length, centered at the top of each page of a

report.

Operation
SHOWLOG> TITLE lets you define your own tit le for your customized SHQWLQG report.

Examples
Change the default title for a report by typing:

SHQWLOG>TITLE File Operations Performed by Finance Programmers
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SHOWLOG>UNDO
Resets the current subset.

Syntax
SHOWLOG > UN [DO]

Parameters
None

Operation
SHOWLOG> UNDO resets the subset. The next report generated uses all of the transactions in
the extracted file (same as the RESET SUBSET command ).

Examples
Return to the original set of extracted transactions by typing:

SH OWLOG > UNDO

Related Information
See SHOWLOG>RESET SUBSET

SHOWLOG > SUBSET
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Screens

This chapter describes in detail all of the LIBRARIAN screens. It includes
the following topics:

� Screen Summary

� Us er Capability Requirements for Screen Access

� Ac c essing LIBRARIAN Screens

� Us i ng LIBRARIAN Screens

� Sc reen Descriptions

Screen Summary
Table 5 — I lists the LIBRARIAN screens by their functions. Page numbers
help you locate the detailed screen descriptions in this chapter.
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Table 5 � 1 LIBRARIAN Screens

Screen Code

System Data

CE

SP

Network Data

NC

SY

SS

Screen Title

System Profile

Compress Exdusions

Nehvork Configuration

Systems

System-to­SystemTable

5-13

Page

5 — 37

Users

UC

US

Files

AF

FA

FC

FF

Fl

FS

PF

Applications/Routes/Steps

AP

CP

FV

PP

RT

SA

SR

ST

STO

Project Data

PA

Pl

PJ

PS

Miscellaneous

LP*

This screen is available only through the Steps (SPi screen.

— This screen can be accessed only through the AF, FA. FF, Fl. FV. PF, PP, SR, and ST

User Capabilities

Auto Filesets

File Access

Fileset Components

Files in Filesets

File Inquiry

Filesets

Pending Master Files

Project Authonzahons

Project Inquiry

Projects

Project Status Change

Applica lions

Composite Presteps

Fonvard Versioning

Pending Produchon Areas

Routes

Step Authorizations

Step Refinements/Exceptions

Steps

Step Op tions

5-45

5-48

5-54

5-11

5 — 14

5 — 32

5-51

5 — 57

5 — 59

5-66

5 — 71

5-76

5-16

5-19

5-21

5 — 24

5 — 29

5-89

5 — 91

Long Pathname

screens.
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User Capability Requirements for Screen Access

Accesses all screens and records stored in a database.

LIBRABIAN permits access to the screens at these five levels:

� LIB RARIAN Manager (L):

� Ap p l i cation Manager (A):
Accesses the data entry screens and records associated with their own
applications.

� Pr o ject Managers (P):
Accesses the data entry screens and records associated with their own
projects.

Accesses their own User (US) records, the File Inquiry (FI) screen, and
the Pending File (PF) screen (if LIBRARlAN is configured to allow PF
access).

� Rul e administrators (R):
Accesses the data entry screens for application related data. Users
with this capability cannot create users, authorize steps, or assign
special capabilities.

Required user capabilities for accessing each screen are listed in the
Screen Descriptions section of this chapter, as well as in the online help.

� Gen e ral Users:

Accessing LIBRARIAN Screens
There are two ways to access the LIBRAIUAN screens:

1. At the LIB&QUAN prompt >, invoke the LIBIL tQGAN screens by
entering the two-letter screen code.

Forexample, proceed directly to the Steps screen (ST) by typing:

>ST

2. From the Main menu bar, select Ad jnin followed by Screens. The
following options appear:

� Con f i g . . . A c c esses the screens to review, add, change, or delete

� User s . .. A cce s ses the screens that identify a user and define

system and network data in the database.

the user's capabilities,

� Fi l e s .. A cces ses the screens to define filesets and file
attributes.

� Step s . .. A cce s ses the screens to add and tune routes and steps.

� Pr oj e c ts... Accesses the screens to define and maintain projects.

Select the appropriate screen from one of these menus.
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Using LIBRARIAN Screens

Moving Between Screens
In the upper-left corner of each screen is the selection field. To move
directly from one screen to another, enter a two-letter screen code in the
selection field and press ENTER.

Moving Between Fields
Move from one field to another field on a screen by pressing TAB.

Enter Key
After entering data in the fields on a screen, press the ENTER key to add
new data.

Adding Data
After entering data in the fields on a screen and pressing ENTER, the data
entry program edits and verifies the data. Valid data is added to the
database, and a status message is displayed. If the data entered is invalid,
an error message will be displayed.

Finding Data
To find a record, enter data in the key fields and press the Fl (FIND)
function key, The key fields for each screen are listed in the screen
descriptions.

There are three ways to find records with the FIND function key:

� If t he key fields uniquely identify a single record, FIND retrieves that

� If t he key fields identify mult iple records, F1 retrieves the first record
that matches those fields. Subsequent FINDs locate other records that
may match those fields.

� If y o u do not make changes after a FIND operation, pressing F1 again
retrieves the next record in a database or in a chain, depending on the
last FIND operation.

To find a record when you do not know any of the key data or to revie~
all records, use F6 (FIRST REC) to access the first record in the dataset.
Then, use FI to serially access subsequent records in the set.

record.
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Using LIBRARIAN Screens, continued
Carrying Data Forward

When using the screens, LIBRARIAN automaticallycarries forward key
data values from one screen to the next. This eliminates the need to enter
the values again. The data values that LIBRARIAN carries forward
include:

Application Fileset Long Pathnames

Step name Project name

For example, if you are reviewing the Fileset Components (FC) screen
and then you proceed to the Auto Filesets (AF) screen, the fileset name is
carried forward and displayed in the Fileset field.

Route User

Changing Data
To change the data in a record, first use the F1 function key to find it. Use
the TAB key to move to the field(s) that you want to change. After typing
new values in the field (s), press F2 (CHANGE) function key to enter the
changes into the database.

Deleting Data
To delete a record, first use F1 to find it. Then, delete the record by
pressing F3 (DELETE). Screens that let you delete multiplerecords prompt
you to press the F3 (DELETE) function key again to confirm.

Using Online Help
The online help provides an overview of indiv idual screens and detailed
descriptions of their fields. To review the information about the screen
you are currently using, press FS (HELP). For help on a single field, type a
question mark (?) in the field and then press F5. You should dear the
question mark from one field before using it for another field.

Breaking to MPE/UNIX
To break from LIBIMRIAN screens to MPE or UNIX temporarily, press F7
followed by F5 (BREAK). To return to the screens from MPE issue the
RESUME command, and from UNIX type exit.

Exiting from LIBRARIAN Screens

Using Function Keys

You can exit from any screen by pressing the F8 function key (EXIT).

Use the function keys to add, change, or delete data. Each screen has two
sets of function keys, as listed in Table 5 — 2. On each set, F7 (NEXT FKEYS)
toggles between the two sets of function keys.
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Using LlBRARIAN Screens, continued

Table 5 � 2 Standard LIBRARIAN Screens Function Keys

Set 1 Set 2

Key Func t ion

F1 FIND

F2

F3

F4

F5

F6

F7

FB

CHANGE

DELETE

REFRESH or LONG PATHNAME

HELP

FIRST REC

NEXT FKEYS

EXIT

Key Function

PRINT

(NOT USED)
(NOT USED)
REFRESH

BREAK

(NOT USED)
NEXT FKEYS

EXIT

F2

F3

F4

F5

F6

F7

FS

For some screens, these standard functions are not appropriate. In these
cases, the standard function keys are not available or are replaced with
special functions. Special functions are described in the Operation section
for each detailed screen description.

Function Keys: Set l
The following list describes in detail the first set of function keys:

FI (FIND)

F3 (DELETE)

F2 (CHANGE)

screen.
Retrieves records associated with the key fields on a

Changes a record. First retrieve the data with F1
(FIND) and then change it with F2.

Deletes a record. First retrieve the data with Fl (FIND)
and then press F3 to delete the record.

Restores data as it appeared when you first retrieved it.
Use this key if you want to restore the original display
before changing the database.

F4 (REFRESH)

or

F4 (LONG PATHNAME)

F5 (HELP)

Accesses the Long Pathnarne screen, where you can
enter or view pathnames longer than 64 characters,

Accesses online help for the screen you are currently

F6 (FIRST REC) A cce sses the first record in a database for the screen.

F7 (NEXT FKEYS) Changes to the second set of function keys.

F8 (EXIT) Exi ts s c r een.

usmg,
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Using LIBRARIAN Screens, continued
Function Keys: Set 2
The following list describes in detail the second set of function keys:

F1 (PRiNT) Prints the contents of the current screen to the
line printer,

F2

F3

F4 (REFRESH)

F6

F7 (NEXT )

Fs (EXIT)

F5 (BREAK)

database.

Not used,

Not used.

Not used.

Restores data as it appeared when you first
retrieved it. Use this key if you want to restore
the original display before changing the

Breaks to MPE or UNIX. To return f rom MPE,
temporarilyissue the RESUME command, and
from UNIX type exit.

Changes to the first set of function keys.

Exits screen.

Note If you have several similar records to enter, use the following sequence

1. Type the first record and then hit the ENTER key to add to the
database. The data remains displayed on the screen

2. Next, type the data in the fields which are different and hit the
ENTER key to add the subsequent records to the database.

to minimize data entry effort.
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Screens Descriptions
The remainder of this chapter provides detailed descriptions of each
LIBRARIAN screen, presented in alphabetical order by screen code. Each
screen description includes the following topics:

Screen Name and Code

Menu Access

Screen Security

Files Impacted

Screen layou t

Key Fields

13escripti on
Explanation of Fields

Operation

Formal screen name and the associated screen
code are shown in bold at the beginning of each
screen description.
The menu from which you can access the

User level of capability required.

Datasets affected by add, change, and delete
operations.

Illustration of the screen.

List of key fields,

Basic function of the screen.

Detailed description of each field on the screen.

Special operation information about the screen.
This topic is included only for screens with
special operations.

screen.
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AUTO FILESETS
The Auto Filesets (AF) screen is where you dehne and maintain descriptors to automatically
keep master filesets up — to — date,

Menu AC C e SS Admin„ ,S creens...Files...AF Auto Filesets

SCreen SeCurity Lr o r ~ AN Manager, Rule Administrator

Files Impacte d D-AU To-m.EsET

AF

Screen Layout

AUT O F I L E S E T S AF V. 1 . OO

nester Fi lesel INclude/Dfclude

Auto Fi lesel Descriptor

Enter ~i in the s election fie ld (upper left) to r un Autoopdole.

F IINI CH A%E %1EK I .IN I 6

Key Fields
Master Fileset

Description
Before you can load Auto Fileset descriptors, you must define the fileset in the Filesets (FS)
screen. Each descriptor uses specific values or wildcards to describe a general file location
that is either included or excluded from the fileset.

Whenever the Auto Fileset Update (AUTOUPDP) program runs (by t//ping AUTO in the
selection field of any screen or through the AUTOUPDATE command or Adrnin menu
option), it explodes these descriptors into a list of valid fi les. The program adds previously

Auto Fileset descriptors are also used to update fileset definitions automaticallywhen the
AUTOUPDATE parameter is specihed on secondary-to-master steps.

undefined hles to the fileset records in the database.
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AUTO FILESETS (continued) AF

Explanafion of Fields, continued
Master Fileset
Required. Length 16.

The name of the fileset. The fileset must be previously defined by the Filesets (FS) screen, or
automatically by the Applications (AP) screen.

Required. Length 2.

A fiag indicating if the files identified by the descriptor should be included or excluded
from the fileset. Use INclude to identify valid file locations for the fileset. Use EXclude to
identify locations that should be excluded. The default is IN for include.

System
Optional. Length 8.

The LIBRARIAN system IDwhere the file(s) reside. If you do not specify a system,
LIBRARIAN defaults to the current system.

Auto Eileset Descriptor
Required. Length 64 (255 for long pathname).

The general location of files associated with this fileset. Wildcards that are consistent with
MPE/iX or UMX conventions can be used.

To enter an Auto Fileset descriptor that is longer than 64 characters, press $4 (LONG
PATHNAME). The Long Pathnarne (LP) screen appears to let you enter a string of characters
up to 255. For more information, refer to the LP screen.

INclude/EXclude
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APPLICATIONS
The Applications (AP) screen is v/here you define and maintain application records.

Menu Access
Screen Security

AP

Admin...Screens...Steps...AP Applications

LIBRAMAN Manager, Rule Administrator, and Application
Manager Appl ication Managers can only access the records for
their applications.

M -APPLICATION, M — FILE — SETFiles impacted

Screen Layout

R PP L I C A T I O N S RP V. 1.08

Rpp I i cat 1 on

Appl ication 1 ileset Appl i cat ion Name
Oel tas

Number i ng
Yes/No I gnore F i l e

Oescr 1 p t 1 on

H ELP f ’H O T NET CLOS E

Key Fields
Application

Description
An application is the highest organizational unit in LIBRARIAN. Appl ications consist of
files and standard file movement rules (defined as routes and steps).

The AP record uniquely identifies an application, The highest level fileset of the application
is defined on this screen. If the fileset has not been previously defined, it is automatically

Explanation of Fields
Application
Required Length 4.

added.
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APPLICATIONS (continued)

Explanation of Fields, continUed
A unique identifier for the application. The application identif ier can include alphabetic,
numeric, hyphen (-), and underscore ( ) characters.

Application Fileset
Required. Length 16.

Logical name of the 61eset that includes all filesets and files for the application. If you have
not previously defined the fileset on the Filesets (FS) screen, it will automatically be defined.

Required. Length 16.

A longer name for the application for documentation only.

Deltas (Yes/No)
Required. Length 1.

Specifies whether LIBRARIAN creates delta files or generation files when retaining old
versions of fixed text files. Legal values are:

Y I n s t ructs LIBRARIAN to store revisions as deltas. During checkin, only the changes
between revisions are stored. For binary fi les, all prior revisions are kept as
generation files.

N I nstructs LIBRAJGAN to store previous generations in their entirety (can be

compressedif the fiag is set on the SystemProfile (SP) screen).

AP

Application Name

Note The ANNOTATE option of the COPY, PERFORM, and PRIM
commands and MERGE feature can only be used if deltas are being
stored. This shows the change history of a text 6le as comments within
the text.

Deltas (ignore File Numbering).
Required. Length 1.

Specifies whether hie numbering is significant when determining deltas. This field is
applicable only when you specified Y in the Deltas Yes/No field. Legal values are:

Y I n s t ructs LIBRARIAN to ignore file numbering for source files.

N I nstructs LIBRARIAN not to ignore file numbering for source 61es.

Description
Optional. Length 72.

A description of the application.

Operation
When you use the DELETE function on this screen, the entire application, including fi leset
definitions and movement rules, are deleted. You will be prompted to press DELETE again to
conhrm mass deletion,
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COMPRESS EXCLUSiONS CE

The CompressExclusions (CE) screen is where you identify the types of files to be excluded
from automatic compression.

Menu Access
Screen Security
Files Impacted
Screen Layout

Adrnin. .Screens...Config...CE Compress Exclusions

LIBRAIUAN Manager

D-NO-COMPRESS

c o i I p R E s s E II E L U s I DN s CE V. I.OO

List of f i i e codes Io be exciaded fram
4vtomotic Compression of Retained Ei les ond

Parameter — Driven Compression (;CDIIPRESS)

M M W W W W M W W M

M W W W W W W W W

W

Press g fo r a I i s i o f comtmn fi lecodes

PrtfD ' CII4NOE ' ~ NELP NEIff ' CLOSE

Key Fieids
None

Description
File compression takes place when issuing LIBRARIAN commands that use the COIIPRESS
parameter.

List the MPE filecodes and/or mnemonics for the types of files that should not
automatically be compressed.

Note that the entries on this screen do not prevent files from being compressed by the

Operation

COMPRESS corrunand.

The DELETE and FIRST RECORD functions are not available on this screen.
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COMPOSITE PRESTEPS
The Composite Presteps (CP) screen is where you assign a composite prestep naxne to refer
to a collection of steps.

Menu A C CeSS Ad mi n.. .ScreenS...Steps...CP Composite Presteps

SCreen Se C u r i t y Appl i cation Managers, Rule Administrator

Files Impacted D-PREsTEPs

Screen Layout

CP

C ottP O S I T E P R E S T E P S CP V. 1. 88

Composi te Prestep tteoe

Step Route Rppf

Dat Bequ’ i (Op i i anal)

Prestep List

Interruptions Ok? g

Key Fields

Composite Prestep Name

Description
You can also use the optional Date Requirement field to create a prerequisite for a step that
prevents the step froxn being performed prior to a particular date

A composite prestep name that is used as a prestep or an alternate prestep on the Steps (ST)
screen. The order in which the presteps that make up the composite are perforxned is not
important. The steps listed must be previously defined in the Steps (ST) screen.

Each composite prestep must include either a date requirement or a xninimum of one step.
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CPCOMPOSITE PRESTEPS (continued)

Explanation of Fields

The name for this group of steps consisting of the following subfields:
Composite Prestep Name

Step
Required. Length 12

Name for this composite prestep. The step name can include alphabetic, numeric,
hyphen (-), and underscore ( ) characters.

Required. Length 12.

Identifier of the route to which the step belongs. You must have previously defined
the route on the Routes (RT) screen.

Appl
Required Length 4.

The application to which the route and step belong. You must have previously
defined the application on the Applications (AP) screen.

Route

Date Requirement
Optional. Length 8.

A date in this field indicates that the composite prestep is not satisfied until this date, even if
all of the listed steps have been performed,
Interruptions Ok?
Optional. Length l .

A flag that indicates whether intervening steps are permitted when steps in the composite
prestep are performed. Intervening steps are steps that are not part of the composite
prestep list. Legal values are:

Y I n t er rupt ions are acceptable

N I n terrupt ions are not acceptable.

For example, if three approvals comprise a composite prestep, and a file is rejected prior to
the third approval, all approvals would be required again if no interruptions are allowed.

Prestep List

A list containing a maximum of 16 steps, each of which must be completed in any order
prior to the step for which the composite is a prerequisite. The steps must be previously
defined on the Steps (ST) screen and be part of the same route.
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FILE ACCESS
The File Access (FA) screen is where you review and change the access control, default
access mode, and/or the language for a Inaster file.

Menu Access

Screen Security

FA

Adinin...Screens...Files...FA File Access

LIBRARjAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can access records only for fi les
in their applications.

Files Impacted D-F ILE

Screen Layout

F I L E A C C E S S FA V. I. DD

ttaster Fi le
~
S t a 0

Access
Control

Defaul t
Access ttode Language

I

D — NDNE
l � cQBOL/DPG
2 � PASCAL
3 — FORTRAN
0 — c
5 — SPL/Il tANSACT/THtT
6 � PSIDtNDttSE/CDGNDS
7 — JCLJttPE
D � BASICDescript ion

Key Fields
Master File

Description
The master files that you retrieve on this screen were originally loaded into the database
from the Files in Filesets (FF) screen, a step that introduces new files, or the Auto Fileset
Update (AUTOUPDP) program.
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FILE ACCESS (continued)

Explanation of Fields
System
Optional. Length 8.

The system where the file is located. If you do not specify a system, LIBRARIAN uses the
current systemas the default.

Required. Length 64 (255 on Long Pathname screen).

The name of a file that is part of an application library.

To enter a filename that is longer than 64 characters, press F4 (LONG PATHNAME). The Long
Pathname (LP) screen appears, letting you enter a maximum of 255 characters. For more
information, refer to the LP screen.

Access Control

Master File

R Read

mode).

Required. Length I .

The access control level that determines the number of read and write mode copies allowed
at one time. Legal values are:

X Exclusive The m a ster file cannot be copied at all(default access must also be read

Any number of read mode copies allowed. However, no secondary files
can have write mode access (default access must also be read mode).

S Serial-Write Any number of read copies, but only one write — mode copy, allowed at a

M Mult i -Write Any number of copies in any mode allowed at one time (not

time.

recommended).

Default Access Mode
Required. Length I .

The default access mode assigned to files if not specified when performing a step. Legal
values are:

R Read

W Write

Language
Required. Length 1.

A Hag indicating the progra~ g l an gu age for a source code file. The ANNOTATE option
available on the COPY, PERFORM, and PRINT cornrnands reconstruct the source code with
embedded comments. The language attribute determines how these comments appear,
consistent w'ith the syntax for that language.

Secondary copies default to read mode access.

Secondary copies default to write mode access,
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FILE ACCESS (continued)

Explanation of Fields, continued
The language setting is also used for creating comments regarding merge conflicts when
you use the MERGE option on a checkout step. This annotation is also embedded in the
source code. The following languages are supported:

FA

Language

COBOLfRPG
PASCAL
FORTRAN
C
SPL/TRANSACT/TEXT
POWERHOUSE/COG NOS
JCL/MPE
BASIC

Description
Optional. Length 72.

A description of the file for documentation purposes.

Operation
The ADD and DELETE function keys are not available on this screen. If you want to add or
delete records, use the Files in the Filesets (FF) screen, or the LIBRARIAN PURGE command.

Comment Syntax

' comment (' in column 7)
( comment j
' cornrnent (' in column I)
/' comment '/
(< comment >>
; comment
COMMENT comment
REM comment
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FILESET COMPONENTS
The Fileset Components (FC) screen is where you define a fi}eset hierarchy for an
application.

Menu Access

Screen Secu r it y LIB RARIAN Manager, Rule Administrator

Files Impacted

Screen Layout

Admin...Screens...Files...FC Fileset Components

FC

D-FSET-COMPONENT

F ILE S E T C o ii P O N E k T S rC U. i.80

F’i lese t Coayonen i

%Ip FJB sr ’ ABF txss E

Key Fields
Fileset, Component

Description
A fileset component is a subset of a higher — level fileset. Create a separate record for each
component. A fileset componentcan, in turn, include other components (other FC records).
The fileset names that you use in this screen must have been previously defined on the
Filesets (FS) screen.

Explanation of Fields

Required. Length 16.

A fileset name. This fileset name must have been previously defined on the Filesets (FS)

Fileset

screen.
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FILESET COMPONENTS (continued) FC

Explanation of Fields, continued
Component
Required. Length 16.

A subset of' the above fileset. The fileset name must have been previously defined on the
Filesets (FS) screen.

Operation
To change a record, you must first delete the record and then add a replacement record.
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FILES IN FILESETS
The Files in Filesets (FF) screen is where you specify files that make up a master fileset.

Menu Access

Screen Se c u r i ty LIBRA R IAN Manager, Rule Administrator

Files Impacted

Admin... Screens...Files...FF Files In Filese ts

FF

D-FSET-FILE
D-FILE
D-AUTO-FILE SET

Screen Layout

F I L E S I H F I L E S E T S FF V. 1.00

F i I eset Rote-Fi lesel Rdd g Oefer Explosion g

Fi le Descr i tor

Key Fields
Fileset, File Descriptor

Description
The physical location is described by a descriptor in the format [system: ] file. group account
(MPE) or [system: ] /[path.../] file (VNlX). Use wildcards to identify a set of files. Enter separate
records to identify other sets of files.

The descriptor is exploded to create database records for all files that match the descriptor.

You can save the file descriptor automatically as an Auto Fileset descriptor. This enables the
fileset to be automatically updated by the Auto Fileset Update (AUTOUPDP) program
when new fi les are introduced. For more information, refer to the Auto Filesets (AF) screen.

A file can belong to more than one fileset.
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FILES IN FILESETS (continued)

Fileset

values are:

Auto-Fileset Add

Explanation of Fields

Required. Length 16.

The name for a set of files, as defined on the Filesets (FS) screen.

Required. Length 'I.

A flag to indicate if the fileset descriptor will be added as an Auto Fileset (AF) record. Lega]

Y A d d s the descriptor as an AF record.

N Does no add the descriptor as an AF record (default).

Defer Explosion
Required. Length 1.

This flag indicates when to performthe explosion for this fileset. Legal values are:

Y D e fers explosion until the Auto Fileset Update program runs(Auto Fileset flag must

N Exp lodes the fileset immediately (default).

System
Optional. Length 8.

The systemwhere the file(s) are located. If you do not specify a system, LIBRARIAN uses
the current system as the default,

File Descriptor
Required. Length 64 (255 on Long Pathnarne screen).

The general location of files to be added to the fileset. To enter a descriptor that is longer
than 64 characters, press F4 (LONG PATWNAME). The Long Pathname (LP) screen appears
where you can enter a file descriptor of up to a maximum of 255 characters. For more
information, refer to the LP screen. Wildcards consistent with MPE/iX and UNIX
conventions are accepted.

Operation
F2 Function Key
(CHANGE) is not available on this screen.

ENTER Key
When you add a new FF record with ENTER, the file descriptor is exploded and database
records are created automatically. If SHOW FILES is enabled on this screen, LIBRARIAN
displays the files as they are being added (See SHOW FILES, below.) As each file in the
exploded set of files is processed, LIBRARIAj.'0 displays the filename and the status of each
file. LIBRARIAN displays up to ten files at a time with prompts to continue or stop the
transaction. After all fi les are processed, you are p rompted prior to clearing the screen in
preparation for the next transaction.

also be Y).
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FILES IN FILESETS (continued)

Operation, continUed
If you set the Auto Fileset Add fIag to Y, the descriptor is automatically added as a Auto
Fileset descriptor record. In addition, if you set the Defer Explosion flag to Y, the fileset on this
screen will not be exploded until you run the Auto Fileset Update (AUTOUPDP) p rogram.
F3 (DELETE)
The delete operation removes files from the fileset.

To delete a group of records, enter wildcards in the Filename field. All records matchingthe
specified pattern are deleted, Before LIBRARIAN deletes the records, you must press F3 a
second time to con6rm your deletion request.

F2 on Set 2 (SKQW FILES)
When an entry is made on this screen and the fileset is exploded, LIBRARIAN normally
displays the filenames and the status of each file (added, changed, etc.). Use F2 (on Set 2) to
suppress or re-enable this display function.

FF
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FILE INQUIRY

From the File Inquiry (FI) screen, you can obtain information about a specific file or files in a

Menu A C C eS S I nfo. . .Files...FI File Inquiry

Screen Security Any user

Files Impacte d None (online report)

Screen Layout

fileset.

F I L E I N QUI RY FI V . I .OO

I i tes in Fileset
S stem Fi l anomo

F iie A c c A c c
Tnne Cntr I Ilode
5 r s

~e rron t To t a I›
Read vari te Read vari te
W W W WAssociated ltaster F’i le OR

Current Nri t~ Seco nder

Version Created Current Version VCnt 6Cnt La s t S te

Revision

Last Step F ’ i l e Ex p i rat ion Date
User Bon e r Dat e Crea t ed

Date Bate
Beta ined Added

.Rte/Pro ect . I

D ate Tim e
Chanaed Chanaed

W

FINO ’ UOIO HELP’ FIRST ttE I IT CLOSE ’

Key Fields
Fileset, File

Description
The information is retrieved from the database and cannot be changed f rom this screen.

Explanation of Fields

Required. Length 16

The fileset name, as defined on the Filesets (FS) screen.

Files in Fileset
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System

FILE INQUIRY (continued)

Explanation of Fields, continued

Required. Length 8.

Thesystemwhere the file is located. If you do not specify a system, LIBRARIAN uses the
current system as the default,

Required. Length 64 (255 on Long Pathnarne screen).

The name of a master library fi le.

To enter a filename that is longer than 64 characters, press F4 (LONG PATHNAME). The Long
Pathnarne (LP) screen appears to let you enter a name up to 255 characters long. Pressing F4
displays the Filename Held on the LP screen

File Type
Display. Length 2.

Legal values are:

Filename

M M aste r

S Secon d a ry

Acc Cntrl

R Read

mode).

GM Ret a i ned master

GS Sec o n dary

CM Cop y o f master

CS Co p y of secondary

Display. Length 1.

The default copy and update capability for all members of this fileset. Legal values are:

X Exclusive Th e znaster file cannot be copied at all.(Default access must also be read

Any number of read mode copies allowed. However, no secondary files
can have write mode access. (Default access must also be read mode ).

S Serial-Write Any number of read copies, but only one write — mode copy, allowed at a

M Multi-Write Any number of copies in any mode allowed at one time (not

time.

recommended).
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Acc IVlode

Acc Mode

W Write

the master file.

FILE INQUIRY (continued)

Explanation of Fields, continued

Display. Length 1.

Display. Length 1.

The access mode for this file (or default, if a master file). Legal values are:

R Read Th e sec o n dary Be has read mode access and cannot replace

The secondary file has w'rite mode access and can replace

Fl

the master file.

VCnt

Current Version

Version Created

Associated Master File Or Current write mode Secondary
Display. Length 64 (255 on Long Pathname screen).

For a secondary file, the value in this field is the location of its master file And, for a master
file, the value in this field is the current ~r i te mode secondary file. This value is truncated if
it is greater than 64 characters.

To view the Associated Master File or Current write mode Secondary field if it is larger than 64
characters, press F4 (Long Pathname), then press Fl (FIELD TOGGLE) in the LP screen. For
more information, refer to the LP screen.

Current and total read/write
Display. Length 4 of 4.

The current number and total number of secondary copies with read and write accesses.

Display. Length 16.

The version to which this file originally belonged.

Display. Length 16.

The latest version of which this file w'as a part.

Language
Display. Length 22.

The programming language set for the file used for annotating source code.

Display. Length 4.

The number of times the master file was replaced after creating the base version for the file,

Display. Length 4.

The total number of generations of the master file that have existed over time.

Last Step
Display. Length 12.

GCnt
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Revision

File Owner

FILE INQUIRY (continued)

Explanafion of Fields, continued

The name of the last step performed on this file. If the file is a master, this value is the last
step for the write mode secondary of the file,

Route/Project
Display. Length 12

The route and project associated with the last step performed on this file.

Appl
Display. Length 4.

The application associated with the last step performed on this file.

Display. Length 48.

The revision ID for this file.

Last Step User
Display. Length 8.

The user who performed the last step for this file. If the file is a master, this is the user who
performed the last step on a write mode secondary of the file.

Display, Length 8.

The user who created the file.

Expiration Date
Display Length 8.

The expiration date for this file.

Display. Length 8

The date LIBRARIAN created the file.

Date Retained
Display. Length 8.

Date Created

The date when LIBRARIAN retained the file.

Date Added
Display. Length 8

The date when the file record was first added to the database.

Date Changed
Display. Length 8.

The date when the file record was last modified.

Time Changed
Display. Length 5.

The time the file record was last modified.
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FILE INQUIRY (continued)

Operation
If you want to retrieve the records for each file in a fileset, type a fileset name and press FI.
Each time you press FI, the next file in the fileset is retrieved

If you want to find the record for a specific file, first omit the fileset and then supply a
filename and press FI.

Fl
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FILES ETS
The Filesets (FS) screen is where you define a fileset and the default characteristics for its

FS

files,

Menu Access

SCreen SeCurit y LIB RARIAN Manager, Rule Administrator

Files Impacted

Screen Layout

Admin...Screens...Files...FS Filesets

M-FILE-SET

F I L E S E T S ES V. I .OO

E I I eset

Oefeut t Befoul t
Access ltede

Oefeul t
LeAguege

0 — NORE
I � COBOL/RPG
2 � PASCAL
3 � FORTRAR
I - C
5 � SPL/TRAIISACT/TERT
6 � PORERHIRISE/COBROS
7 � JCL/IIPE
e � BASIC

Access Cmttrol

Beset ipt ion

Key Field
File set

Description
You can define one or more fi leset components with the Fileset Components (FC) screen.
Additionally, you can specify physical file rnernbers with the Files in Filesets (FF) and Auto
Filesets (AF) screens

The default values you define on this scree~ are assigned to all master files that are added as
direct members of this fileset. You can use the File Access (FA) screen to specify different
access attributes on a file-by-file basis, once files have been loaded with default values,

The default access mode determines if a read or a write mode is assigned to a copy of a

The access control code determines how many read and write mode copies of a master file

master file.

are allowed at one time.
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FILESETS (continued)

Explanafion of Fields

FS

R Read

xnode).

Fileset
Required. Length 16.

The name of the fileset. The fileset name can include alphabetic, numeric, hyphen (-), and
underscore ( ) characters.

Default Access Control
Required. Length 1.

The access control level are to all files in this fileset by default. Legal values are:

X Exdusive Th e m a ster file cannot be copied at all. (Default access xnust also be read

Any number of read mode copies allowed. However, no secondary files
can have write mode access. (Default access xnust also be read mode),

S Serial-Write Any number of read copies, but only one write — mode copy, allowed at a

M Multi-Write Any number of copies in any mode allowed at one time (not

time.

recomznended).

Default Access Mode
Required. Length 1

The default access znode to be assigned to all files in this fileset. Legal values are:

R Read Th e d efa u l t for secondary files is read mode access.

The default for secondary files is write mode access.W Write

Default Language
Required. Length 1.

The language setting is also used for creating comments regarding merge conflicts when
you use the MERGE option on a checkout step. This annotation is also embedded in the
source code. The following languages are supported:

Language

COBOL/RPG
PASCAL
FORTRAN
C
SPL/TRANSACT/TEXT
POWERHOUSE/COG NOS
JCL/MPE
BASIC

Description.
Optional. Length 72.

A description of the fileset.

Comment Syntax

* comxnent (' in column 7)
( comment j
' comment (' in column 1)
/' comment '/
«c o mment »
; comxnent
COMMENT comment
REM comment
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F ILESETS (continued)

Operation
Because F3 (DELETE) automatically deletes all componentrelationships and hie members,
you are prompted to confirm the deletion. Component filesets are deleted unless they are
also components of another fileset. Physical file members of the main and component
filesets will be deleted from the database if they are not members of other filesets. Files are
not physically purged from the system.

FS
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file if it is not found in the master location.

FORWARD VERSIONING
The Forward Versioning (FV) screen is where you identify alternate locations to search for a

Menu Access
Screen Security

FV

Admin...Screens... Steps...FV Forward Versioning

LIBRARIPZ4 Manager, Rule Administrator, and Application
Managers. Application Managers can only access the records f' or
steps in their applications.

D-FORWARD-VERFiles impacted
Screen Layout

F O R t t A R D V E R S t O tt I H G PV V. t .OO

Step R out e Rpp I

Previous Version Search Locat ions

F i i enaaesg ~s t e m

HELP Fl I S J MST . R U SE

Key Fields
Step, Route, Application

Description
By defining forward versioning rules, you can bring fi les forward from a previous version
of an application to a new version in development when needed. Forward versioning
applies when checking out files that do not exist yet in the location defined for the step. The
alternate search locations you define on the Forward Versioning (FV) screen are typically
locations for previous versions of the application. Al ternate locations are checked in the
sequence defined on this screen.

When a file is not found in the current (or new) version location defined for the checkout
step, but is found in one of the locations defined on the Forward Versioning (FV) screen, it is
introduced to LIBRARIAN as a pending master for the current (new) version in the
application library. For more information on Forward Versioning, refer to Chapter 7,
"Versions" in the LIBRARIAN/iX Administrator's Guide.
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FORWARD VERSIONING (continued) FV

Appl

Route

Filename

Substitutes the contents of the element from the original search.

Explanation of Fields
Step
Required. Length 12.

The name of the master-to-secondary step to which the forward versioning criteria apply.
Step must have already been defined on the Steps (ST) screen.

Required. Length 12.

The name of the route to which the step belongs.

Required. Length 4.

The name of the application to which the step belongs.

Seq
Required. Length 3.

The sequence for searching for files.

System
Required. Length 8.

The system to search The default is your current login.

Required. Length 64 (255 on Long Pathname screen).

The general location (using wildcards) to search for a file that is not found in the primary
search location for the step.

To enter an UNIX f i lename that is longer than 64 characters, press F4 (LONG PATHNAME).
The Long Pathname (LP) screen appears to let you enter a maximum of 255 characters.

Descriptors consist of file. group account under UNIX. You can use the following wi ldcards:

© I n d icates zero or more alphabetic andior numeric characters. Used alone and denotes

¹ In d i cates a single numeric character

? I n d i cates a single alphabetic or numeric character.

all members of the set.

UNix Descriptors consist of /[path.../] file under UNIX. You can use the following wi ldcards

Substitutes the contents of the element from the original search.

Indicates zero or more of any characters. Used alone, denotes all members of the set.

? I n d i cates a single character.

Warning If used, the equal sign (=) wildcard must be the only character for an ele­
ment. You cannot use it in combination with any other wi ldcards and/or

alphanumeric characters Ail other wi ldcards can be used together.
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LONG PATHNAME
The Long Pathname (LP) screen is where you can enter or view a pathname that is longer

LP

than 64 characters.

Menu Access

SCreen Se C u r i t y Any u s er. This screen can only be accessed from screens that have

F iles Impacted Non e

Screen Layout

Not available directly from menu mode.

filename fields.

LON 6 P R T H R A N E LP V. 1.08

PBIllT BR O W HEH KSR RH.P t,O R B UNREEL . 4 K

Key Fields
None
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LONG PATHNAME (confinued)

Description
To access this screen, press F4 (LONG PATHNAME) on applicable screens. Applicable screens

a Au to Fi lesets(AF)
� Fi le Access (FA)
� Fi l es in Filesets (FF)

� Fi le Inquiry (FI)
� Forward Versioning (FV)

� Pending Master Files (PF)
� Pe nd ing Production Areas (PP)

� St ep Refinements/Exceptions(SR)
e Steps (ST)

The screen code of the calling screen appears in the upper left box of the LP screen,

LP

include:

Note Usually, the box in the upper left corner of a screen is blank. This lets
you access other screens by entering another screen code and pressing
ENTER. In this screen, however, the screen code that appears is the
screen from which you came, and is display only. You will always
return to that screen when you are done.

System

Explanation of Fields

Optional. Length 8.

The name of the system from the field on the preceding screen

Optional Length 255

The name of the file which has been expanded to 255 characters.

Operation
The following function keys have special meanings on the LP screen.

Fl (FIELD TOGGLE)

Use Fl to toggle between fields if the calling screen has more than one filename field.

For example on the Steps (ST) screen, you can specify a source location and a destination
location. Once in the ST screen, press F4 (LONG PATHNAME). Next, the Long Pathname (LP)
screen appears. This lets you specify a source filename that is longer than 64 characters.
After specifying a long pathname for the source filename, Fl (FIELD TOGGLE) accesses the
destination file field. Appl icable screens include:

Filename
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LONG PATHNAME (continued) LP

Operation, continued

� Fi le Inquiry (FI)
� Pending Master Files (PF)

� Pe nding Production Areas (PP)

� St ep Refinements/Exceptions (SR)

� Steps (ST)

F6 (LOAD DEFAULT)

Use F6 to load the default stored in the systemvariable, OCSUSERPATH.

F7 (CANCEL)

Use F7 to exit this screen without transferring the filename to the calling screen.

Use F8 to transfer the filename to the calling screen. You will return to the original screen,
and your long pathnarne will appear in the appropriate fields (truncated for display only, if
necessary). The pathname will be carried forward in future invocations of the LP screen.

F8 (OK)
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NETWORK CONFIGURATION
The Network Configuration (NC) screen is where you configure LIBRARIAN for network
operations.

Menu AC C e SS Admi n.. .Screens...Config...NC Network Configuration

SCreen SeCurity LIBR ARIAN Manager

F iles lrnpacted D-x z ~ o RK-co~ G

Screen Layout

N E T II O R K C O N F I G U R A T I O N NC V. I.OO

Netoork Type

Onto Transfer Buffer
sim t in cords)

Befoul t Autoootic logan HI PRI? g

Session Us er Acco u nt Gr ou
ZKt~ . Z t~~ IRKED.2l3&
Passeards ~ ~ ~

FINO C I IANGE IIEFRFSH

Key Fields
None

Description
The data in the network cordiguration record defines defaults for LIBRARIAN networking
operations in an MPH environment. If you are not using the product in a networked
environment, you do not need to use this screen.

LIBRAIGAN is shipped with init ial values already loaded for this screen. You can change
these values as needed for your own network environment.

The default automatic logon on this screen is used whenever LIBRARIAN logs on to a
remote system. You can override this login for specific systems by creating a record on the
SySteInS (SY) Screen.

The rnaximurn buffer size for the NS network type is 4096 words. The maximum buffer size
for the (DS) network type is 1023 words. Often, X 25 users are restricted to a buffer size of
138 w'ords (DS) or 1023 words (NS).
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NETWORK CONFIGURATION (continued)

Explanation of Fields

Required. Length 2

The type of network you are using. Legal values are DS or NS. The default is NS.

Default Automatic Logon
The default login to use when transactions require automatic remote login. This login is
initiated when a remote session has not been previously established. Unless there is an
override for a specific system (as specified in the Systems (SY) screen), this login is used.

The automatic login consists of the following subfields:

Network Type

Session
Required. Length 8.

The session name for automatic remote login. You can use the special wildcard
! USERID in the Session field. The default is AUTO.

User
Required. Length 8.

The user name for automatic remote login. The default is REMOTE.

Required. Length 8

The account name for automatic remote login. The default is OCSLIB.

Group
Required. Length 8.

The group name for automatic remote login. The default is PUB.

Hipri
Required. Length j..

Indicates if LIBRARIAN logs on to remote systems with HIPRI. A Y in this field
indicates that remote logins use HIPRI. An N in this field indicates that remote logins
use the default input pr ior i ty.

Account

Note In order to use Hipri for automatic remote logon to LIB1UVGAN, MPE
requires that the logon user and account have OP or SM capability.

Passwords
Optional. Length 3 fields of 8.

The user, account, and group passwords for the default automatic login. Passwords
entered are encrypted in the database. The initial default automatic login does not
include passv ords.
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NETWORK CONFIGURATION (continued)

Operation
The ADD, DELETE, and FIRST RECORD function keys are not available on this screen. There is
only one NC record. You can use this screen to change pre-loaded values.

When you define the default automatic login, you can specify any login. In addition, you
can use the special wildcard! USERID for the session. In this case, the current user ID is
substituted as the session for remote login.

NC
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PROJECT AUTHORIZATIONS
Use the Project Authorizations (PA) screen to enter, review, or delete user authorizations for
project activities.

Menu Access
Screen Security

PA

Admin...Screens...Projects...PA Project Author izations

LIBRARIAN Manager, Rule Administrator, Application Manager,
or Project Manager, Application Managers can only access the
records for their applications. Project Managers can only access
the records for their projects.

D-USER-PROJECTFiles impacted

Screen Layout

PR O J E C T R U T H O R I Z A T I o ti S PR V. 1.99

A ppl i cot ian Pr oj e c t User

FIIIQ ’
OELEfE I I EFRESR FNST :ttEIIT ’ CI.QSE

Key Fields
Application, Project, User

Description
If the project definition requires project authorization, then users must have specific
authorization on this screen. LIBRARIAN managers, Application managers, and Project
managers do not require special project authorization for their projects.
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PROJECT AUTHORIZATIONS (continued) PA

User

Application

Explanation of Fields

Required. Length 4.

The application to which this project belongs, as defined on the Projects (PJ) screen.

Project Name
Required. Length 12.

Name of the project as defined on the Projects (PJ) screen.

Required. Length 8.

User authorized to work on this project.

Operation
F2 (CHANGE) is not available on this screen. To change a project authorization, delete the
record and then add a new record.
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PENDING MASTER FILES
The Pending Master Files (PF) screen is where you can introduce new fi les to LIBRARIAN
in a secondary location, and later check those files in to a specific master location.

Menu Access

Screen Security

PF

Admin...Screens...Files...PF Pending Master Flies

Access to this screen is controlled by the PF ACCESS flag on the
System Profile (SP) screen. If PF ACCESS is set to Y, any user can
access this screen. If PF ACCESS is set to N, only the LIBRARIAN
manager, Rule administrator, or Appl ication manager can access
this screen.

D-FSET-FILE
D-FILE

Files Impacted

Screen Layout

PEM D I HG ti A S T E R F I L E S PF V . t . 8 0

ilester Fi ieset

Pending ilester Fr le
S stem F i I enmme

Current Seetmmterg Fi le
S stem F i i eneme

FIIto . ESANSE QBZTF LOHS ~ iiixi ' ~ ~ m r ' ~~

Key Fields
Master Fileset, Pending Master File

Description
Define the current location of the secondary file and the eventual location of the master file.
Identify the fileset to which it will belong.

The fileset you identify for the pending master file Inust have S or M default access control,
permitting a write mode secondary.
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screen.

Master Fileset

member of a fileset or exist on disk.

PENDING MASTER FILES (continued)

Descriptions, continued
Use pending master files as a way to introduce new files into LIBRARIAN in a secondary
location and later move those files to a predefined master location,

LIBRAIGAN automatically creates PF records for secondary copies that you check out from,
previous versions, and will move forward to a new version (as defined on the FV screen).

In addition, LIBRARIAN creates a PF record when you mtroduce a new file in a pending
production area by applying the edit mask defined on the Pending Production Areas (PP)

Explanation of Fields

Required. Length 16.

The name of a fileset to which the pending master file will belong. This fileset must be
previously defined in the Filesets (FS) screen. The default access control for the fileset (on
the FS screen) must permita write mode secondary file.

Pending Master System
Optional. Length 8.

Systemwhere the master file wil l reside. If you do not specify a system, the default is the
current system.

Pending Master File
Required. Length 64 (255 on Long Pathname screen)

The location where the master file will eventually reside. This file cannot already be a

To enter a pending master f i lename that is longer than 64 characters, press F4 (LONG
PATHNAME). The Long Pathnarne (LP) screen appears, allowing you to specify a name with a

Current Secondary System
Optional. Length 8.

System where the current secondary file resides. If you do not specify a system, the default
is the current system,

Current Secondary File
Required. Length 64 (255 on Long Pathname screen).

The current development location of the pending master file. This file cannot already be
defined to LIBRA%AN (as a master, secondary, or retained file). This file will be recorded as
a write mode secondary of the pending master file.

To enter a current secondary file that is longer than 64 characters, press F4 (LONG
PATHNAME). The Long Pathname (LP) screen appears, allowing you to specify a name with a
maximum of 255 characters. After you press F4 (LONG PATHNAME), the Pending Master File
held appears on the LP screen. To go to the Current Secondary File field, press F1 (TOGGLE)
on the LP screen. For more information, refer to the LP screen.

PF

maximum of 255 characters.
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PENDING MASTER FILES (continued) PF

Operation
To delete a record before moving it to the master file location, first find the record with FI
and then delete it with F3.

If you decide that you no longer want a file to be a master fi le, but the file has been moved
to the master file location, use the Files in Filesets (FF) screen to delete its association with
the fileset.
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PROJECT INQUIRY
The Project Inquiry (PI) screen is ~vhere you can get information about projects related to an

application.
Men U AC Ce S S Adtnin . . .Screens...Projects...PI Project Inquiry

Screen Security

Files impacted D-P aoJEcTs

Screen Layout

PI

P R O J E C T I II O U I R V PI V . I . OO

Rpplicntion ~ Selec t S tn tus �

P roject Nome St w Rout e I O llnnnger Opened
Onte
Closed

Onte
F lushed

Project O n te

> Project Ruthoriznt ion Required

ET%i IIEI I T H KV . , I I EPREM HELP ttEIIT . CLOSE

Key Fields
Application

Description
By using this screen, you can select projects to reviewer based on their status.
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PROJECT INQUIRY (continued)

Explanation of Fields

Application
Required. Length 4.

Application to which this project belongs, as defined on the Applications (AP) screen.

Optional. Length 2.

Specify one of the following:

Select Status

AL All projects

AA All active projects

Al Al l inactive projects

AO All open projects

AC All closed projects

CC Closed to CHECKOUT steps

DC D ocu m ented

FP Flu s h Pending

CL Clos ed to all steps

F L Fl us h e d

OP Ope ned

RO Reo p ened

St

project Name
Display. Length 12

Name of' the project as defined on the Projects (PJ) screen.

Display. Length 2.

Status code for project. Displays one of the following:

CC Closed to Checkout steps CL

DC Documented

FL Flushed

RO Reopened

Display, Length 1.

An asterisk in this column indicates that project authorization is required.

Display. Length 12.

The name of the route to which the project belongs.

project Manager
Display. Length 8.

The LIBRARIAN user who is responsible for the project.

FP

OP Ope ned

Closed to all steps

Flush Pending

Route ID
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Date Closed

Date Opened

PROJECT INQUIRY (continued)

Explanation of Fields, continued

Display. Length 8.

The date the project was opened

Display. Length 8.

The date the project was closed.

Display. Length 8.

The date the project was flushed.

Operation
The CHANGE, DELETE, and FIRST RECORD functions are not available on this screen. To
retrieve project records, enter the application, If you want to review projects based on their
status, enter a selection in the Select Status field, Then, use FI (FIND) to retrieve the records.

F2 and F3 have the following special functions on this screen.

NEXT RECORDS (F2)

If the application contains more projects than can be presented on one screen, press F2 to
display the next page of projects.

PREV RECORDS (F3)

If the application contains more projects than can be presented on one screen, press F3 to
display the previous page of projects.

Projects on the PI screen are sorted in reverse date sequence (i.e., most recent projects are
shown first).

Pl

Date Flushed
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PROJECTS
The Projects (PJ) screen is where you define projects.

Menu Access
Screen Security

PJ

Admin�. Screens...Projects...PJ Projects
LIBRARIAN Managers, Rule Administrator, Application
Managers, and Project Managers. Application Managers can only
access the records for their applications. Project Managers can
only access the records for their projects. All users can access this
screen for inquiry.

D-PROJECTS
M-FILE-SET
D-USER-FSET

Files Impacted

Screen Layout

P R O J E C T S PJ V. I .88

Rpp I i cat i an Project itane Route Rl ies

Project Descript ion

Praject

Required?
Ruthorization Project

Itanager

. �

Date
Open? Requested Pr i or i tg Est ieete

Depar t eenI

ETBD " meaE , OEUHK;- HEI-’BESB HELP H B S T BEITT ’ . CLOSE

Key Fields
Application, Project Name

Description
Use this screen to define projects, review', or modify project records.

Explanation of Fields

Required, Length 4.

The application name to which this project belongs.

Application
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PROJECTS (continued)

Explanation of Fields, continUed

Route Alias

Project Name
Required. Length 12.

The name of the project. This name is also assigned to the project fileset.

Required. Length 12.

The route for which this project is valid. Use the at sign (@) wildcard to indicate the project
is valid for all routes in the application.

Project Description
Optional. Length 150.

A description of the project.

Project Authorization Required?
Required. Length l .

A flag that indicates whether a user must be authorized to work on this project as defined in
the Project Authorizations (PA) screen. Legal values are:

Y I n d i cates that users must be authorized to reference this project (default).

N I n d icates that no authorization is required to reference this project.

Project Manager
Required Length 8.

The user responsible for the project. The user must have Project manager, Application

manager, or LIBRARIAN manager capability. The default is the current user.

Open?
Required. Length 1.

A flag to indicate whether the project should init ially be open. Possible values include:

Y I n d i cates that the initial project status is open (OP) (default).

N I n d icates that the initial project status is documented (DC).
Date Requested
Optional. Length 8.

For documentation only,

Priority
Optional. Length 4.

For documentation only.

Length 8,

For documentation only.

Estimate
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Requestor

PROJECTS (continued)

Explanation of Fields, continUed

Length 20.

For documentation only.

Department
Length 20.

Operation
The project name defined on this screen can be referenced in a LIBRARIAN command
instead of a route. If the project is not specified and projects are required for the route, then a
menu of projects is displayed.

A project fileset is created with the same name as the project. This fileset is a private user
fileset owned by the Project manager. If you do not want to require specific project
authorization, change the Project Authorization Required field to N.

If you require project authorization, use the Project Authorizations (PA) screen to identify

If you want to use this project immediately, set the Open flag to Y. If you want to define the
project for later use, set the flag to N.

F3 (DELETE) is allowed on this screen only if the project is flushed, A project is set to the
Flush-Pending state on the Project Status (PS) screen. A project is flushed by the
FLUSHLOG uti l ity program.

PJ

the authorized users.
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where new files can be introduced.

PENDING PRODUCTION AREAS
The Pending Production Areas (PP) screen is where you define general secondary locations

Menu Access

Screen Security

PP

Adrnin...Screens...Steps...PP Pending Production Areas

LIBRARIAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can only access the records for
their applications.

D-PENDING-AREAFiles Impacted

Screen Layout

P E N D I N G P R 0 D 0 C I I 0 tt R 8 E R S PP V.1 .00

Rpp I i cat ion Route (optional ) Step t taoe (optional)

Pending Product ion Rrea
Seq S s te a Fi l enaoe
Ql

Pending llaster Edi I ttask
S s tea P i lenaoe

Inc lode/Exc I ude g Preexist ing Nester Rl looed? g

FIND ’CHANGE DELElK ’ I DNli H EEP FI R ST ’ NE S T ’ ,CtIISE

Key Fields
Application, Route, Step Name

Description
Use this screen to define where and when users can introduce new secondary files. You
define the step, route, and/or appl ication that users can use to introduce new files, and from
what location. Each pending production area is defined in terms of areas to be included or

If a pending master editmask is provided, then a pending master record is created
automatically. This occurs when a file is introduced through the pending production area, If
no pending znask is provided, users are responsible for identifying the master file when they
perform the step that introduces the new file.

excluded.
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PENDING PRODUCTION AREAS (continued)

Route

Application

maxirnurn of 255 characters.

Explanation of Fields

Required. Length 4.

The application to which this pending production area applies, as defined on the
Applications (AP) screen.

Optional Length 12.

The route to which this pending productron area applies. If this field is left blank, the
pending production area is valid for all routes in the application.

Step Name
Optional. Length 12

The step to which this pending production area applies. If this field is left blank, the
pending production area is valid for all steps in the route.

Seq
Required. Length 2.

Specifies the sequence that LIBRARIAN uses to check pending production areas. Valid
sequence numbers range from 0 to 99. If you define multiple overlapping areas, use this
field to identify the sequence in which you want LIBRARIAN to check.

Pending Production Area (System:Location)
Required. Length 8 for system; 64 for location (255 on Long Pathname screen)

The general location where new secondary fi les can be introduced. Wildcards consistent
with MPE/iX and HP-UX conventions are accepted.

To enter a pending production area that is longer than 64 characters, press F4 (LONG
PATHNAME). The Long Pathname (LP) screen appears to let you specify a name with a

Pending Master Edit Mask (System:Filename)
Required. Length 8 for system; 64 for filename (255 on Long Pathname screen)

An edit mask is used to translate a pending production secondary f i l ename into a pending
master filename. This automatically creates a pending master record. For more information
on edit masks, refer to Edit Masks at the beginrung of Chapter 1, "Commands."

To enter a pending master edit mask that is longer than 64 characters, press F4 (LONG
PATHNAME). The Long Pathnarne (LP) screen appears to let you specify a name with a
maximum of 255 characters. After pressing F4 (LONG PATHNAM E), the Pending Production
Area field appears on the LP screen. To go to the Pending Master Edit Mast field, press FI
(TOGGLE) on the LP screen. For more information., refer to the LP screen,

Required. Length 2.

A flag to indicate whether the specified area should be included or excluded f rom the hles
for this pending production area.

Include/Exclude
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PENDING PRODUCTION AREAS (continued)

Operation, continued

Required. Length 1.

A flag to indicate whether a new file can be introduced when it maps to the name of an
already existing master file. Legal values are:

Y O kay that a master exists in the pending master location.

N No t okay that a master exists in the pending master location.

Operation
Creates a separate PP record for each area to be included or excluded from the definit ion of
a pending production area. For example, if the area includes O<.@.FIN and @.JOB.AP but
excludes PR@.JOB.AP, use three PP records to define the pending production area.

Preexisting Master Allowed?

Screens 5-53



PROJECT STATUS CHANGE
The Project Status Change (PS) screen lets you review and change the status of a project,

PS

Menu Access

Screen Security

Admin...Screens...Proj ects...PS Project Status Change

LIBRARIAN Manager, Rule Administrator, Application Manager,
or Project Manager. Application Managers and Project Managers
can only access the records for their own applications.

Files Impacted D-PRQJEcTs

Screen Layout

P RO J E C T S T A T U S C H A R G E

Appl P r oject Haec P r o ject Descript ion

Project ttanager

e Val id OperationsCurrent Project Status

DC � Docunen ted
OP › Opened
CC › Closed to CHECKOUT steps
CL › Closed to al I steps
RO › Reopened
FP › Flush Pend ing
FL › F lushed

f2
f3
f4
fs
f6
PJ

BITER›

OPER
CLOSE TO CHECKOUT
CLOSE
REOPEH
FLUSH
DELETE PROJECT
CHAHOE USER STATUS

PHD OP E R CLOSE iO CLOSE QEOPEN . FLUSH , H EHT ERAT

Key Fields
Appl, Project Name

Description
Use this screen to review and modifythe status of a project.

Explanation of Fields

Required. Length 4.

The application to which the project belongs.

Appl
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PROJECT STATUS CHANGE (continued) PS

User Status

Project Name

Explanation of Fields, continued

Required. Length 4.

The name of the project as defined on the Projects (PJ) screen.

Project Description
Display. Length 150.

The description of the project.

Optional. Length 16.

A free — form user — defined status value.

Project Manager
Display. Length 8.

The LIBRAIUF&J user who is the Project Manager.

Current Project Status
Display. Length 12.

The current status of the project.

Operation
HELP for this screen is available through F6 on function key set 2. The ADD, CHANGE, and

Add a user defined status value by pressing ENTER.

Special function keys on this screen modify project status; the current project status reflects
any change you make. The operations available for a project depend on it current status.
Operations that are currently valid appear on the screen with an asterisk ('). Descriptions of
the special function keys are below".

FIRST RECORD functions are not available.

OPEN

Use F2 to open the project if the status is documented (DC).
CLOSE — TO — CHECKOUTS

Use F3 to close a project to checkout (master — to — secondary) steps.

CLOSE

Use F4 to dose an opened or reopened project.

Note LIBRARIAN rejects attempts to close projects with associated write
mode secondaries.
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PROJECT STATUS CHANGE (continued) PS
Operation, continued
REOPEN

Use F5 to reopen a project that you closed or made "flush pending" (but not
flushed).

FLUSH

Use F6 to designate a project as flush pending. When the FLUSHLOG uti l ity runs, it
flushes the project fileset and all transaction records that refer to the project,
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ROUTES
The Routes (RT) screen is where you define routes.

Menu Access

Screen Security

Admin...Screens, .Steps...RT Routes

LIBRARIAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can only access the records for
routes associated with their own applications.

Files impacted

Screen Layout

D-ROUTE

R OU T E S RT V. 1. 09

Route
Project

Required?Rpp I icat ion

Descr i pt i an

F IRH K H RNK E TE HEFH H H HElP FH5 T IKXr ’ G.QSE ’

Key Fields
Route, Application

Description
A route is a collection of steps for copying and moving fi les in a standard sequence. Define
each step separately on the Steps (ST) screen.

The route and application uniquely identify the route. Different applications can use the

The Project Required field lets you specify whether transactions in the route must be
associated with a project.

same route name.

S creens 5 - 5 7



Route

Application

ROUTES (continued)

Explanation of Fields

Required. Length 12.

The identifier of the route. The route can include alphabetic, numeric, hyphen (-), and
underscore ( ) characters. The route must be unique within its application.

Required. Length 4.

The application to which this route belongs.

Project Required?
Required. Length 1.

A flag indicating if step transactions in this route must be associated with a project. Legal

Y I n d icates that projects must be identified

N I n d icates that no project identification is required (default).

Description
Optional. Length 72.

A description of the route.

Operation
Before you can delete the record for a route, use the Steps (ST) screen to delete the records
for the steps associated with the route.

values are:
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STEP AUTHORIZATIONS
The Step Authorizations (SA) screen is where you authorize users to perform a step.

Menu Access

Screen Security

SA

Admin... Screens...Steps...SA Step Authorizations

LIBRAMAN Manager and Application Manager. Application
Managers can only access the records for steps associated with
their own applications.

Files Impacted

Screen Layout

D-USER-STEP

S T E P A U T H O R I Z A T I OU S SA V. 1.06

User Act iueStep Route A p p I

Author ized
Access llode

Fi le Oanership
Requ iremen t

R = Reod
4 = Rr i t e

Blank Ho Restriction
V - User must INH I’i le
R = User aust HOT 1OIH fi le

FIHO CQQ@E O ELETF’ REFRESH HELP 0" IRST % RT CLOS E’

Key Fields
Step, Route, Appl, User

Description
You can authorize any number of users to performa step, Create a separate record for each
user/step authorization. In addition, you can use this record to specify the type of copies the
user can obtain with the step, if different from the step definition.

Use the Active flag to suspend and reinstate a user's access to the step at any ti me, without
deleting the record from the database,

You do not need to authorize LIBRARIAN managers and Application managersto perform
steps. The LIBRAI?JAN manager can perform all steps. Application managers can perform
all steps associated with their own applications.
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STEP AUTHORIZATIONS (continued) SA

Route

Explanation of Fields
Step
Required. Length 12.

The name of the step. You must have already defined the step on the Steps (ST) screen. You
can use an at sign (Q~) to authorize a user for all steps within a route.

Required. Length 12.

The unique identifier of the route to which this step belongs. You must have already defined
the route on the Routes (RT) screen. You can use an at sign (@) to authorize a user for all
steps within an application.

Appi
Required. Length 4.

The application to which the route and step belong. You must have already defined the
application on the Applications (Ap) screen.

Required. Length 8.

The user authorized to perform this step. You must have already defined the user on the
Users (US) screen.

To authorize all users for a step, change the Authorization Required field to N on the Steps (ST)

User

screen.

Active
Required. Length 1

A flag that indicates if a user is currently authorized to perform this step. Legal values are:

Y I n d i cates that the user is currently authorized to perform the step (default).
N In d icates that the user is not currently authorized to perform the step.

Required. Length 1.

A flag that indicates the mode available to a user for files created by the step. Legal values

Authorized Access mode.

are:

R Read

W Write

Indicates that the user can only obtain read mode copies.

Indicates that the user can obtain read or write mode copies.
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STEP AUTHORIZATIONS (continued) SA

Explanation of Fields, continued

Optional. Length 1.

A flag that indicates whether the user must own a file to be authorized to perform the step
on it. Legal values are:

File Ownership Reguirement

Blank I n d icates no file ownership restriction for the user.

Y In d i ca tes that the user must be the file owner.

N In d ica tes that the user must not own the file.

Operation
You can authorize a user to perform aU steps in a route by using the at sign (@) in the Step
field. To select all routes in an application use the at sign (@) in the Route field as well.
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SYSTEM PROFILE
The System Profile (SP) screen is where you define parameters that affect global
LIBRARIAN operation.

Menu Access

SCreen SeCurity LIB RARIAN Manager

Files impacted
Screen Layout

Admin...Screens...Config...SP System Profi le

SP

D-SYSTEM-PROFILE

File iEdit Te r minal Co nnection O p t ions W i n d ow Help

S Y S T E N P R O F I L E SP V. Z . o3

Transaction Log Records Aging Policg
Logg l ng [In Dags)

cubi �

Auto-Compress Flush
Retained Files Policg

PF EXPRESS LI BR ARIAN Date Fornat
Access Enabled Fi le Creator Input/D isp lag Separator

Sll/root capabi I i tg required fo r L i b r a r ian Reneger?
Al los route changes for read mode secondaries>

P as s e n r d s
Aging [dogs val id) gg rl i ni aum Length p Naximum tries c+

Disable user after aaxisara tries?

Key Fields

None

Description

Thesystem profile is a set of global parameters that the LIBRARIAN Manager maintains,
controlling how LIBRARIAN operates, Includes items such as flush policy, aging policy,
date formats, etc.
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Transaction Logging

tracked (default).

SYSTEM PROFILE (continued)

Explanation of Fields

Required. Length 1.

A flag to activate the LIB1VdGAN Audit Trail Logging Facility. Legal values are.

Y Indicates that Audit Trail Logging is active. LIBRARIAN command activity is

Indicates that Audit Trail Logging is inactive. LIBRARIAN command activity

SP

is not tracked.

PF Access

Log Records Aging Policy (in oays)
Required. Length 4.

The number of days you want audit trail records to be saved before they are purged by
FLUSHLOG The FLUSHLOG uti l ity uses this value to select associated records to be
purged. This value applies to all transaction records except those identified with projects.
Project transactions are retained until the project is flushed. Possible values are 1 to 9999.
The default is 30 days.

Auto-Compress Retained Files
Required. Length 1.

A flag to indicate if retained files should be compressedautomatically. This does not apply
to files retained as deltas. Legal values are;

Y C o m presses files when they are retained (default).

N Does not compress files when they are retained.
Flush Policy
Required. Length 2.

The maximum number of generations of a master file to be preserved, when running the
FLUSH util i ty. Acceptable values range from 0 to 99. The default is zero generations.

Required. Length 1

A flag to let users access the Pending Master Files (PF) screen to add or modify a pending
master file record. Legal values are:

Y I n d icates that any user can define Pending Master Files (default ).
N I n d icates that only the LIBRARIAN manager can define Pending Master Files.

Required. Length 1,

A flag to indicate whether batch file transactions will be scheduled automaticallywith the
EXPRESS SUBMIT util ity (only available if EXPRESS is installed). Legal values are:

Y Schedules all batch requests by using the EXPRESS SUBMIT util ity.

N D oes not schedule batch requests with the EXPRESS SUBMIT util ity (default).

EXPRESS Enabled
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SYSTEM PROFILE (continued) SP
Explanafion of Fields, confinued

Required. Length 8.

The default user that LIBRARIAN wi l l use when pushing a file from one account to another.
This user becomes the file creator for the new file. The default is MGR.

Date Format Input/Display
Required. Length 3.

The format for all dates used by LIBRARIAN. Legal values are:

MDY Month, Day, Year order (default)

DMY Dav, Month, Year order

Year, Month, Day order

LIBRARIAN File Creator

SM/root capability required for LIBRARIAN Manager?

Date Format Separator
Required. Length 1.

The symbol used as a separator in all date formats. Legal values are:

/ (slash is the default)

(hyphen)

(period)

Required. Length 1.

A flag to indicate whether LIBRAIUAN Manager users need to login with MPE's SM or
LrNIX's root capability. Legal values are:

Y I n d i cates that MPE/UNIX user must have SM/root capability.

N I n d icates that MPE/UNIX user is not required to have SM/root capability (default),

I f you attempt to change the "SM capability required" switch to "Y" ,
and you do not have SM capability (MPE) or superuser privi leges
(UNIX), an error occurs. This protects you from inadvertently locking
yourself out of LIBRARIAN.

Allow route changes for read mode secondaries?
Required. Length 1.

A flag to determine if you can copy or move read mode secondaries by using a step in a
route different from the one originally used. By default, attemptingto change routes results
in a violation. Legal values are:

Y I n d i cates that changing routes for read mode secondaries is allowed.

N I n d icates that changing routes for read mode secondaries is not allowed (default).

Note
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IVlaximum tries

Aging (Days Valid)

SYSTEM PROFILE (continued)
Explanation of Fields, continUed

Required. Length 3.

The number of days passwords are valid.

Passwords can expire between 1 and 500 days. The default expiration period is 999 days,
indicating that user passwords will not expire.

Minimum length
Required. Length 8.

The minimum number of characters required for each LIBRARIAN user password.

You can set passwords to have a minimum length of 1 to 8 characters, The default minimum
password length is 1 character,

Required. Length 2.

The maximum number of times a user can attemptto enter a valid password.

If a user exceeds this number of attempts and the "Disable user after maximum tries?" field
is set to "Y", LIBI~ IA N w i l l d i sable the user ID. The LIBRARIAN Manager wil l then have

You can set the maximum number of attempts to a value between 1 and 16. The default is 3
attempts.

Disable user after maximum tries?
Required. Length 1.

If this field is set to "Y", when the user exceeds the maximum number of attempts to enter a
valid password, LIBRARIAN wi l l d isable the user ID by setting the active flag to "N". The
LIBRARIAN Manager can re-activate the user on the US screen.

SP

to re-activate the user on US screen,
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STEP REFINEMENTS/EXCEPTIONS
The Step Refinements/Exceptions (SR) screen is where you refine a step definit ion based on
a file's name, fileset, or filecode.

Menu Access

Screen Security

SR

Admin...Screens...Steps...SR Step Refinement/Exceptions

LIBRAjRIAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can only access the records for
steps in their own applications.

Files Impacted

Screen Layout

D-REFINED-STEP

S T E P R E F I H E lf E H T S / E H C E P T I 0 H S SR V. I.OO

Ste Route Check Sequence
~ll I

Source F i I ecode ~ � O R � Source Fi I eset
-OR � Source Locat ion

(C)opg/(H)ave/(H)ul I/(E)xclude I Exclude from coapression (Y/H) g
Refined Dost inet ion Location

Source Fi le THpe
ST 6lohel Settings

(Copg/Hove) Destinetian File Tgpe

Fram

To

FIR( C(HIHOE ’ BELETE . LOH6 HELP ’ F NST HEHT - CLOSE

Key Fields
Step, Route, Appl

Description
You can refine or create exceptions for a step by defining different destinations and
movement types for certain files. In addition, you can specify fi les to be excluded from the
step.

Enter the step, route, application, and then use F1 to load the global step definit ion from the
Steps (ST) screen. Then, enter either a general source location using wildcaz.ds, filecode, or
fileset to refine. Finally, specify a refined movement type and/or destination location.

If you specify N (null), the destination location must be the same as the source location. If
you specify E (exclude), the destination location Inust be blank.
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STEP REFINEMENTS/EXCEPTIONS (continued) SR

Step

Route

record is created for that file.

Description, continued

If you have more than one SR record for a step, specify the sequence for checking the
definitions since a file could qualify for more than one refinement.
A Null refinement causes the step transaction to be recorded without moving/copying the
file. An Exclude refinement causes the file to be exduded f rom the step, so that no log

You can retrieve step refinements by specifying the file code, fileset, or source location and
pressing Fl.

Explanation of Fields

Required. Length 12.

The name of the step being refined.

Required. Length 12.

The route to which the step belongs.

Appl
Required. Length 4.

The application to which this route and step belong.

Check Sequence
Required. Length 4.

If you define multiple step refinements, use this field to identify the sequence to check the

E Source Filecode

definitions.

Optional. Length 5.

Apply refinement/exception to files that have this filecode or mnemonic.

Optional Length 16.

Apply refinement/exception to files belonging to this fileset.

Source Location (System)
Optional. Length 8.

The system to which this step refinement/exception applies. If you do not specify a system,
LIBEVQGAN uses the current system as the default.

Source Location (Fiiename)
Optional. Length 64 (255 on Long Pathnarne screen).

The source file(s) to which this step refinement/exception applies. Wildcards consistent
with MPE/iX and UNIX conventions are accepted.

To enter a source location that is longer than 64 characters, press F4 (LONG PATHNAME). The
Long Pathnarne (LP) screen appears to let you specify a name with a maximum of 255
characters.

Source Fileset
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STEP REFINEMENTS/EXCEPTIONS (continued) SR

Explanation of Fields, continued

Required. Length 1.

The movement type override for qualifying fi les. Legal values are:

(C) opy/(M) ove/(N) ull/(E)xclude

Copy
C M

Move

Null
Exclude

N

E

Destination Location (System)
Optional. Length 8.

The system where the file should be created. If you do not specify a system,LIBRARIAN
uses the current system as the default.

Destination Location (Filename)
Required. Length 64 (255 on Long Pathname screen).

The refined destination location or exception for qualifying fi les. You can use an edit mask
to translate source filenames into destination filenames. For more information on edit masks,
refer to Edit Masks at the beginning of Chapter 1, Commands."

To enter a refined destination location that is longer than 64 characters, press F4 (LONG
PATHNAME). The Long Pathnarne (LP) screen appears to let you specify a name with a
maximum of 255 characters. After you press F4 (LONG PATH NAME), the Source Location field
appears on the LP screen. To go to the Refined Destination Location field, press F1 (TOGGLE)
on the LP screen. For more information, refer to the LP screen.

Exclude from compression
Required. Length 1.

A flag allowing you to exclude files from compression. Legal values are:

Y I n d i cates that files should be excluded.

N I n d i cates that files should not be excluded (default).
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SYSTEM-TO-SYSTEM TABLE
The System ­To — System Table (SS) screen is where you identify the node used for
communication between two specific systems.

Menu A c c e SS A dmi n. . .Screens...Config„,SS System — To — System Table

SCreen SeCurity LIB RARIAN Manager

Files Impacted D-c o M-LINKs

Screen Layout

SS

S V S T E lt � TG � S Y S T E It T O O L E SS V. I.OO

Loca I SMstea +
+

IIode (OSi IIIE) Oooo i n Or enizat ion

+ Reaote S tjsteo +
+ +

EIIIO CHABOE OELETE BEFIKRl ’EEXP FIBST IKII I : CU I E" ’

None

Local System

Key Fields

Description
This information is necessary if the remote systemis referenced by different node names,
depending on the origin.

Explanation of Fields

Required. Length 8.

The local system name. If you do not specify a system, LIBRAMAN uses the current system
as the default.

Node (DS LINE)
Required. Length 16.
The actual device ID used for communication between this local system and the remote

system. You can use periods in node names to represent systemidentifiers with more than
three elements.
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SYSTEM-TO-SYSTEM TABLE (continued)

Explanation of Fields, continued

Optional. Length 16.

The domain associated with the specified node (NS only).

Organization
Optional. Length 16.

The organization associated with the speci6ed node (NS only).

Remote System ID
Required. Length 8.

The remote system name. If you do not specify a system, LIBRARIAN uses the current

systemas the default.

SS

Domain
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STEPS
The Steps (ST) screen is where you define file movement commands (rules).

Menu Access

Screen Security

ST

Admin...Screens...Steps...ST Steps

LIBRARIAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can only access the records in
their own applications.

Files impacted D-s TEP
D-SYSTEM-PROFILE

Screen Layout

s TE P s ST V. t .OO

Ste Roote Appl Sor t A c t ive ) taster Fi leset
� g [poop s cop )

SOURCE I e (n) as t er/(S) econdar

(C) opt)/(tt) ooe/(N) u t l

DESTINATION T e (tl) o s ter/(5 )econdar

Preste � A l ternate Prest

Press g Next Fktojs. then g to configure Step Options

FIND Ctt ANtpE D ELETE LIN N p

Key Fields
Step, Route, Appl

Description
A step is the movement of a file or group of files from a source location to a target location,
Steps can also be used to record an external event, such as approval of a set of files. Each
step is part of a defined route.

The inforznation on this screen uniquely identifies the step. While defining a step, you
identify it's application, route, and fileset to which the step applies. In addition, you can
define presteps that users Inust performbefore this step.
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Sort

Route

users,

STEPS (continued)

Description, continued
By using the Active flag on this screen, you can suspend and reinstate the step. You can
change the flag from active to inactive at any time. This way, you can disable the step
without deleting the record from the database or removing authorization of the step for all

Use the Step Refinements (SR) screen to further refine the definitions on this screen,

The source and destination file information on this screen indude the file locations, the
types of files, and the type of operation.

You can configure additional step options using the Step Options (STO) screen to further
control the behavior of the step.

Explanation of Fields
Step
Required. Length 12.

The name of the step. The step name is a user-defined LIBRARIAN command. The step
name can include alphabetic, numeric, hyphen (-), and underscore ( ) characters.

Required. Length 12.

The route to which the step belongs. You must have previously defined the route on the
Routes (RT) screen.

Appl
Required Length 4.

The application to which the step belongs. You must have previously defined the
application on the Appl ications (AP) screen.

Required. Length 2.

The number of the step you are defining. Used for reporting steps in a particular sequence
within a route. The value can range from 1 to 99.

Required. Length 1.

A flag indicating whether or not the step is currently active. Legal values are as follows:

Y I n d i cates that the step is active. Authorized users can perform this step (default).

N I n d icates that the step is inactive. No users can perform this step.

Master Fiieset (Step Scope)
Required. Length 16.

The fileset to which the step applies, as defined on the Filesets (FS) screen. This name must
be the application fileset or any component. The step only applies to files within this fileset.

ST

Active
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STEPS (continued)

Explanation of Fields, continued

ST

Location:

Filename

SOURCE LOCATION

Type
Required. Length 1.

Specifies whether the source file type is a master (M) or secondary (S).

System
Optional. Length 8.

The system where the file(s) reside. If you do not specify a system, LIBRAIGAN uses the
current system as the default.

Required. Length 64 (255 on the Long Pathname screen).

The source file(s) to which this step applies. Wildcards consistent with MPE/iX and HP-UX
conventions are accepted.

When performing the step, any elements of the source location the user omits are filled-in
using step values defined here,

Additionally, you can use three special LIBRAIGAN wi ldcards in any element of the Source

! USERID The LIBR A R IAN user performing the step.

The user's local login group and/or account.! LOCAL

! LOGON Cur r en t l o g in path element.

!hpvar

To enter a source location longer than 64 characters, press F4 (LONG PATHNAME). The Long
Pathname (LP) screen appears to let you specify a name with a maximum of 255 characters.

(Copy/Move/Null)
Required. Length 1.

The type of operation this step performs Legal values are:

C Cop y Cop ies the file wi thout purging the source.

M Mov e M ov es t h e f i le and purges the source. If the source file is amaster file, the

N Nul l Per for ms a step with no movement. A null step (approval step) does not

Any MPE system variable that is pre6xed by a!, e.g, ! HPHGROUP. The
value is determined when a user performs the step.

movement type cannot be M (Move).

involve actual movement A l t h ough the file is not actually moved,
LIBRARIAN records the event and recognizes this as a prestep.

DESTINATION LOCATION

Type
Required. Length 1.

Specifies whether the destination file type is a master (M) or secondary (S).
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System

Location:

Filename

!OWNER

! USERID

! LOGON

! NISUSER

them to a central location.

STEPS (continued)
Explanation of Fields, continued

Optional, Length 8.

Thesystemwhere the source file(s) are to be copied or moved. If you do not specify a
system, LIBRARIAN uses the current system as the default.

Required. Length 64 (255 on the Long Pathnarne screen),

The destination location for fi les copied or moved from the above source location. You can
use an edit mask to translate source filenames into destination filenames For more
information, refer to Edit Masks at the beginning of Chapter I, "Commands."

When performingthe step, any elements of the destination location which the user omits are
filled — in using step values defined here.

Additionally, you can use the following LIBRARIAN wi ldcards in elements of the Destination

Owner of the source file. Owner is the user who created the file. This is
useful when you need to return files to the programmers who submitted

The ID of the user performing the step.

Current login value.

User who origina!Iy checked out the file.

Uses corresponding master name element.

Any MPE system variable that is prefixed by a!, e.g.,! HPHGROUP. The
value is determined when a user performs the step.

ST

the LP screen,

!hpvar

To enter a destination location longer than 64 characters, press F4 (LONG PATHNAME). The
Long Pathname (LP) screen appears to let you specify a name with a maximum of 255
characters. After pressing F4, the Source Location field appears on the LP screen. To go to the
Destination Location field, press F1 (TOGGLE) on the LP screen. For more information, refer to

To configure or view addit ional step options and step parameters, press F7 (NEXT FKEYS)
followed by F2 (STEP OPTIONS). The Step Options (STO) screen appears.

Optional. Length 12

The name of a step that must be performed before this step. The prestep can be the
preceding step in the route, or it can be the name of a composite prestep, as defined on the
Composite Presteps (CP) screen.

Prestep
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STEPS (confinued)
Explanation of Fields, continUed
Alternate Presteps
Optional. Length 2 fields of 12 characters.

The name of one or two alternate steps to satisfy the prestep requirement for this step. If an
alternate prestep is defined, the prestep requirement is satisfied when any of the presteps
have been performed successfully.

Optional. Length 72.

A description of the step.

ST

Desc
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STEP OPTIONS
The Step Options (STO) screen allows you to provide additional step options.

Menu Access

Screen Security

STO

Not available directly from menu mode,

LIBRARIAN Manager, Rule Administrator, and Appl ication
Manager. Application Managers can on1y access the records in
their own applications. The only way to access this screen is from
the ST screen.

D-STEP
D-SYSTEM-PROFILE

Files impacted
Screen Layout

S T E P O P T I O N S STO Y. ’I.OO

Authorizat ion Required? ui tttetnntne in

wtr’n e te: Create: creen 0 nccennt i trente

u nix enie : n e e i cern’cc n ~ h w ~ ween ~

File Expiration (Delis)
Secondaries ~ Saf e t i I itetained ~i

Comp/Oecmp Retn Auto Read/Hrite Orph Yfg PushR ~ t e r na l ›
HV NY HY HY HY HV NY HV HY Src H Ds t H

Additional Parameters

FQS CIHHHIE D ELETE LIH IS HELP FA ST NEiitT : U.QSE,

Key Fields
Step, Route, Appl

Description
Use this screen to define additional step options from the Steps (ST) screen.

When a user requests a step that exists in more than one route and/or appl ication, an
"ambiguous step name" message is issued, and a menu of steps is displayed. This menu of
steps is alphabetically sorted and only displays steps the user is authorized to use.

Explanation of Fields

Required. Length 12.

The name of the step being defined.

Step
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STEP OPTIONS (continued) STO

Explanation of Fields, continued

LIBRARIAN Owner

Route
Required. Length 12.

The route to which the step belongs.

Appl
Required Length 4.

The application to which the step belongs

Authorization Required?
Required. Length l .

A flag indicating whether or not step authorization is required via the Step Authorization
(SA) screen. Legal values are:

Y I n d i cates that step authorization or a special capability is required (default).

N I n d icates that any user defined to LIBRARIAN can perform this step.

Required Length 8.

The LIBRARIAN owner that should be assigned to files created by this step. The default is
the user who performs the step.

Create: Group
Required, Length I .

A flag indicating if a new group should be created, if one does not exist in the destination
account. Legal values are:

Y C r eates a group if one does not exist.

N D oes not create a group if one does not exist. If no group exists, the file movement
will fail.

Create: Account
Required. Length 1.

A flag indicating whether to create a new account, if one does not exist for the destination
file. Legal values are:

Y C r eates an account if one does not exist.

N D oes not create an account if one does not exist. If no account exists, the file
movement wil l fail.
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STEP OPTIONS (continued)
Explanation of Fields, continUed

Required Length l .

A flag indicating whether to create a new MPE user, if the creator for the destination file
does not exist. Legal values are:

STO

Create: Creator

Y Creat es a user if creator does not exist in the destination account.

N D oes n o t create a user if one does not exist.

mCreator
Optional. Length 8.

Assigns the specified user as the creator of the destination file, This field is especially useful
when pushing files across account boundaries. The user does need not to exist in the
destination account if the Create: Creator flag is set to Y.

You can use the following wi ldcards:

! USERID Us e th e L IBRARIAN user as the creator.

! LOGON

!KEEP

Use the current MPE login user as the creator.

Use the creator of the file being replaced.

Mkdir
Required Length 1.

A flag indicating if LIBRARIAN should create a new directory for the destination file if it
does not already exist. Legal values are:

Y C r eates directory if it doesn't exist.

N D oes not create directory if it does not exist. If the directory does not exist, the file
movement wil l fail .

Permissions

Owner

Optional. Length 3.

Assigns permissions to the files this step creates. (For more information, see the UMX
chmod comxnand )

Optional. Length 5.

Assigns the specified user as the owner of the files this step creates. It can be a specific UNIX
user login or decimal user ID found in /etc/passwd

Group
Optional. Length 5

Allows you to specify the group for files this step creates. It can be a specific UMX group
name or decimal group ID found in /etc/group.

File Expiration (Days)

The expiration criteria for fi les this step creates. Includes separate values for read mode
secondary files and retained files,

LINI X
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STEP OPTIONS (continued)

Explanation of Fields, continUed

STO

Secondaries
Optional. Length 3.

The expiration period (in days) for read mode secondary files this step creates. Possible
values range frozn 0 to 999. A value of 0 indicates that the file expires on the same date it is
created. A value of 999 indicates that the file does not expire, When a secondary file has
expired, it can be flushed,

Safety Retained
Optional. Length 3.

The expiration period (in days) for files this step retains. Possible values range from 0 to 999.
A value of 0 indicates that the file expires on the same date it is created. A value of 999
indicates that the file does not expire. When a file has expired, it can be flushed.

Step Parameters (Default/Override Allowed)

These flags define the default parameterswhen a user performs the step. They also indicate
whether a user performing this step can override the defined default parameter value. See
the PERFORM command for more information on p arametersavailable when executing step
commands,

Batch

Memo

Required. Length 2 fields of 1.

Default (first position)

A flag to indicate if the transaction should be performed in batch mode. Legal values are:

Y P e r forms transaction in batchmode. If the EXPRESS Enabled flag in the SystemProfile (SP) screen is set to Y, the user is promptedto schedule the transaction
(EXPRESS must be installed). If EXPRESS is not enabled, the transaction will be
streamed directly through MPE.

N Per forms the transaction on1ine (default).

Ov'errl'de (second position)

A flag to indicate if you can override the default BATCH value. Legal values are:

Y I n d i cates that you can override the default BATCH value(default).

N I n d icates that all transactions must use the default BATCH value.

Required. Length 2 fields of 1.

Default (first position)

A flag to indicate if memo text is required when performing this step. Legal values are:

Y I n d i cates that memo text is required. The program will prompt for text describing

N I n d icates that memo text is not required (default).

each transaction.

S creens 5 - 7 9



STEP OPTIONS (continued) STO

Explanation of Fields, continued
Overri de (second position)

A flag to indicate whether you can override the default MEMO value. Legal values are:

Y I n d i cates that you can override the default MEMO value(default).

N I n d icates that all transactions must use the default MEMO value.

Comp (Compress)
Required. Length 2 fields of 1.

Default (f i rst position)

A flag to indicate if this step should automatically compress the new destination fi le. Legal

Y I n d i cates that LIBRARIAN shouldcompressthe destination file when performing
this step. Specific types of files in the Compress Exclusions (CE) screen will not be

compressed.If this flag is set to Y, DECMP must be set to N.

N I n d icates that LIBRARIAN should not compress destination files (default).

Override (second position)

A flag to indicate if you can override the default COMPRESS value. Legal values are:

Y I n d i cates that you can override the default COMPRESS value (default).

N I n d icates that all transactions must use the default COMPRESS value.

Decmp (Decompress)
Required. Length 2 fields of 1.

Default (first position)

A flag to indicate if this step should decompress the new destination file which is created by
this transaction automatically. Legal values are:

Y I n d i cates that LIBRARIAN should decompress the destination file when performing
this step,

N I n d icates that LIBRARIAN should not decompress the destination file (default).

Override (second position)

A flag to indicate if you can override the default DECOMPRESS value Legal values are:

Y I n d i cates that you can override the default DECOMPRESS value (default).

N I n d i cates that all transactions must use the default DECOMPRESS value.

values are:
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Read

Retn (Retain)

STEP OPTIONS (continued)

Explanation of Fields, continued

Required. Length 2 fields of 1.

Default (first position)

A flag to indicate whether to retain destination files automatically. The files would
otherwise be replaced by this step. Legal values are:

Y I n d i cates that LIBRARIAN should retain files.

N In d icates that LIBHAIRIAN should not retain files (default).

Override (second position)

A flag to indicate if you can override the default RETAIN value. Legal values are:

Y I n d i cates that you can override the default RETAIN value (def'ault).

N A l l t ransactions must use the default RETAIN value,

Auto (Autoupdate)
Required. Length 2 fields of 1.

Default (first position)

A flag to indicate whether to automaticallyupdate hlesets (Auto Fileset Update) with new
files (tor secondary-to-master steps only), Legal values are;

Y I n d i cates that LI BE RI A N should update the fileset after the transaction.
Destination files in the master location are compared to Auto Fileset descriptors in
the Auto Filesets (AF) screen. New files that are not previously defined wil l be
added to the appropriate filesets.

N In d icates that LIBRAjRIAN should not update the filesets automatically (def'ault ).
Override (second position)

A flag to indicate if you can override the default AUTOUPDATE value. Legal values are:

Y I n d i cates that you can override the default AUTOUPDATE value (default).

N I n d icates that all transactions must use the default AUTOUPDATE value.

Required. Length 2 fields of 1.

Default (first position)

A flag to indicate whether to assign read mode access to files created with this step. Legal

Y I n d i cates that LIBRARIAN should automatically assign read mode access.

N In d icates that LIBRARIAN should not automatically assign read mode access
(default).

S70

values are:
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STEP OPTIONS (continued) STO
Explanation of Fields, continued

Override (second position)

A flag to indicate if you can override the default READ parametervalue. Legal values are:

Y I n d icates that you can override the default READ value (default).

N Ind icates that all transactions must use the default READ value.

Required. Length 2 fields of 1.

Default (first position)

A flag to indicate whether to automatically assign write mode access to files created with
this step. Legal values are:

Y I n d icates that LIBRARIAN should automatically assign write mode access.

N Ind icates that LIBRARIAN should not automatically assign write mode access
(default),

Write

are:

Override (second position)

A fiag to indicate if you can override the default WRITE parameter value. Possible values

Y I n d icates that you can override the default WRITE value (default).

N I nd icates that all transactions must use the default WRITE value.

Orph (Orphan)
Required. Length 2 fields of 1.

Default (first position)

A flag to indicate whether to break the link between a master file and its secondaries
automatically when performing this step. Orphaned secondaries are not tracked by
LIBRARIAN after makingthe copy. Legal values are:

Y I n d icates that LIBRARIAN should orphan secondaries automatically.

N I n d icates that LIBRARIAN should not orphan secondaries automatically (default).

A flag to indicate if you can override the default ORPHAN parameter value, Legal values are:

Y I n d icates that you can override the default ORPHAN value (default).

N In d icates that all transactions must use the default ORPHAN value.

Override (second position)
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are:

Vfy (Verify)

PushR (Pushread)

STEP OPTIONS (confinued)

Explanation of Fields, t=ontinued

Required Length 2 fields of 1.

Default (first position)

A flag indicating if LIBRAIUAN should verify that files have not been modified since they
were created by LIBRARIAN.

Y I n d i cates that LIBRARIAN should verify fi les automatically.

N I n d icates that LIBRARIAN should not verify f i les automatically (default).

Override (second position)

A flag to indicate if you can override the default VERIFY parameter value. Legal values are:

Y I n d i cates that you can override the default VERIFY value (default).

N Ind icates that all transactions must use the default VERIFY value.

Required. Length 2 fields of 1.

Default (first position)

A flag indicating if fi les in read mode should be allowed to replace a write mode secondary
or a master file. When this is done, an exception flag is set. Legal values are:

Y I n d i cates that LIBRARIAN should allow read mode fi1es to replace write mode files.

N I n d icates that LIBRARIAN should not allow read mode files to replace write mode
files (default).

Override (second position)

A flag to indicate if you can override the default PUSHREAD parametervalue. Legal values

Y I n d i cates that you can override the default PUSHREAD value (default).

N Ind icates that all transactions must use the default PUSHREAD value.

Required. Length 2 fields of 1.

A flag indicating whether to just record the movement for files that are located on systems
inaccessible to LIBRARIAN. Users are responsible for transferring files using some other

STO

External

method than LIBRARIAN.

Src (Source)

A flag indicating whether source files should be recorded as moved, without LIBRARIAN
physically moving or copying the files. It is used when files reside on a system not running
LIBRARIAN.
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STEP OPTIONS (continued)

Explanation of Fields, continued

STO

Dst (Destination)

A flag indicating whether the destination files should be recorded as moved without
LIBRARIAN physically moving or copying the files. It is used when fi les reside on a system
n ot runrung LI B E RI A N .

Optional. Length 24.

A free-form set of parameters that are appended to the user request when performing the
step. Use the syntax described for the parameters of the PERFORM command (e.g.,
NOINPROGRESS, NOTIFY) as described in Chapter 1, "Commands". Any conflict with
user — supplied p arameters,or syntax errors are reported at the time the step is performed.
Operation
You can access the Step Options (STO) screen only from the Steps (ST) screen. To do so,
press F7 (NEXT FKEYS) followed by F2 (STEP OPTIONS), The Step Options (STO) screen

Additional Parameters

appears.

Note Pressing F8 (CLOSE) from the Step Options screen returns you to the
Steps (ST) screen.
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SYS7EMS
The Systems (SY) screen is where you define information about ho> LIBRARIAN should
connect to systems in your network.

Menu Access

SCreen SeCurity LIBR ARIAN Manager

Files Impacted
Screen Layout

Admin... Screens...Config...SY Systems

SY

D-SYSTEM-ID

S Y S T E tt S SY V. I .M

Rclual Device
t tode (DSLIRE) Domain

Buffer
Size

Hetoork Tgpe

(DS/HS/DH)
Overrrde

O r iz a t i on

llPE Logon Data HP/DH Login Dale

Ru t orna t i c Logan Overr i de H I PR I? g llse ~ Posse d ~

Remote ID

BAIRD EDRRBE .IIELETE RhRERH HELP P I Rs r REI I T a .t ) SE

Key Fields
None

Description
Use this screen to define information about how to connect to a system, if it is different from
the global definit ions on the Network Configuration (NC) screen, or if the system is a UNIX
machine,
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LIN IX

System

Actuaf Device

Domain

SYSTEMS (continued)
Description, continued
Use this screen for any of the following MPE systems:

� LI BR ARIAN 's logical system name in thesystemconfiguration file
(CONFIG.PUB.OCSLIB) is not the same as the actual MPE node name.

� The MPEsystem does not operate under the network values described on the
Network Configuration (NC) screen.

� LIBR ARIAN should be accessed by an automatic remote login different from the one
shown on the Network Configuration (NC) screen.

� Th e M PE system has different passwords for the automatic remote login.

� Th e MPEsystemis accessed via a dial-DS link,

When the MPE server installs a UNIX client, it automaticallycreates a
systemrecord.

If a system is accessed differently bv different systems, use the System­to-System Table (SS)
screen to specify the node name to be used.

Explanation of Fields

Required. Length 8.

Thesystemas it appears in the LIBRARIAN configuration file.

The actual DS/NS device name used to access this system.Domain and organization are
used only for NS networks with mult iple domain and organization values. Use these fields
if the name in the system configuration file does not adequately define the device. It consists
of the following subfields:

Node (DSLINE)
Optional. Length 16.

The actual de~ ice name for this system, if different from the LIBRARIAN
configuration fi le.

Optional. Length 16.

The domain associated with the node (NS only),

Organization
Optional. Length 16.

The organization associated with the node (NS only).

You can use ernbeded periods with all Node, Domain, and Organization
fields to handle network addresses that contain more than three parts.

SY

Note
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SYSTEMS (continued)
Explanation of Fields, continued

SY

Note If you have network node names with more than three elements, you
can put more than one element in any of the Node, Domain, and
Organization fields of the SY screen. For example, to enter the node
name abc.chicago.usa.corn on the SY screen, you can enter abc as the
Node, chicago.usa as the Domain, and corn as the Organization.

Butfer Size
Optional. Length 4.

The network communications buffer size for this system, if different from the value
on the Network Configuration (NC) screen,

Optional. Length 2.

The network type for this system, if different from the value on the Network
Cordiguration (NC) screen. (NS/DS/UX)

Network Override

MPE Logon Data

Automatic Logon Override

The login for remote transactions on this system, if different f rom the Network
Configuration (NC) screen. If used, the value overrides the automatic login for this system
only.

The special! USERID wildcard can be used in the Session field, so that automatic remote
l ogin reflects the L I B I D O u se r .

This field consists of the following subfields:

User

Session
Optional. Length 8.

The default session name for automatic remote login.

Required. Length 8.

The default user name f' or automatic remote login.

Required. Length 8.

The default account name for automatic remote login.

Group
Required. Length 8.

The default group name for automatic remote login.

Account
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SYSTEMS (continued)

Explanation of Fields, continued

SY

Passwords
Optional. Length 3 fields of 8.

The user, account, and/or group passwords for the automatic login.

HIPRI?
M E Required. Length 1.

A flag indicating whether LIBRARiAK uses HIPRI to log on to this system. Legal values are:

Y I n d i cates HIPRI is used to lo~~ to the system.

N I n d i cates HIPRI is not used to login to thesystem.

Note In order to use HIPRI for automatic remote logon to LIBRARIAN, MPE
requires that the logon user and account have OP or SM capability.

Phone Number

Remote ID

M E Optional. Length 30.

The phone number used by the modem to establish a telephone connection. (Dial DS)

Optional. Length 16.

A string that defines the valid ID sequence when attempting to establish a telephone
connection. If the remote system does not send a valid ID sequence, the telephone
connection is terminated (Dial DS).

HP/UX Login Data

User
Required. Length 8.

The default user name for automatic remote login.

Optional. Length S.

The user password for the remote login.

Operation
If you specify a login ID override, you can use the special! USERID wildcard for the session.
The user's current user wi11 be substituted as the session in the remote login.

Password
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USER CAPABfL)TIES
The User Capabilities (UC) screen allows you to provide users different levels of access.

Menu AC C e SS Ad mni .. . Sscrenn...UUser...UU User Capabilities

Screen Security

Files Impacted
Screen Layout

LIBRARIAN Manager, and Application Manager. Application
Managers cannot assign L, X, R, or 0 capabihty.

UC

D-USER-CAPS

U SE R C A P A B I L I T I E S UC V. 1.00

Capabi I i tg Appl icat ion
(8 for L, 0 , 0 . K Capabi I it ies)

L — Librarian ttanager
A � App l i ca t i on ilanager
P � Project ttanager
R — Rule Adein<strator
0 — Aperator
K � Unrestricted K~ naand Access

Key Fields
User

Description

Use this screen to provide selected users with LIBRAMAN M anager, Application Manager,
Project Manager, Rule Administrator, or Operator Capabilities. In addition, unrestricted use
of the X commands can be granted on this screen.

UC records are not required for general LIBRARIAN users.
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USER CAPABILITIES (continued)

Explanation of Fields

Required. Length S.

The unique identifier of the LIBRARIAN user. You must have previously defined the user
on the Users (US) screen.

Capability
Required. Length 1

A flag indicating a special capability for this user.

Application
Required. Length 4.

The name of the application for which the user has special capability, as defined in the
Applications (AP) screen.

If the capability is L, X, R, or 0, use the at sign (©) in this field to indicate all applications.

Application managers can only define users to have Project Manager capability.

Operation
LIBRARIAN Managers define libraries and have unrestricted access to all LIBRARIAN
functions.

Project Managers can create new projects on the Projects (PJ) screen and update the status of
their projects in the Project Status Change (PS) screen Addi t ionally, they can authorize users
for their projects in the Project Authorization (PA) screen.

Addit ionally, these users are automatically authorized to work on any projects they manage.
The users canmanipulaterelated project filesets by using the FMAINT corrunands. Project
Manager appears on standard project reports.

Rute Administrators can define libraries and file movement ru les, but cannot perform
LIBRARIAN fi le operations without authorization from a LIBRARIAN manager.

Operators can run the FLUSH and FLUSHLOG util i t ies. They can execute the LIBRARIAN
RESTORE command for master files. Operator capability is not application-specific.

The X — Command access capabflity allows a user to perform commands on untracked files
without enforcement of MPE security (see the X corrunands in Chapter 1, "Cornrnands."

UC

User
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USERS
The Users (US) screen is where you add or change user records.

Menu Access

Screen Security

US

Admin...Screens...Users...US Users

Any user. Genera1 system users and Application Managers can
only access their own records. The LIBRARIAN Manager can
access all records, and is the only person who has the capability to
add new users. No one, including the LIBRARIAN Manager, can
view the passwords of other users.

Files impacted

Screen Layout

M-USER

U S E R S US V. 'r 00

l lser Rct i oe

Possaord Lo ckgord

Fnr0 CHO KE BELErE ’ IKFRESU IHP F IRST HEHT ELUSE

Key Fields

User

Description
General system users can access this screen to add or change the data of their own records.
They can update the information, but they cannot access another user's record. No one, not
even a LIBRARIAN manager, is allowed to view another user's password.

The Active flag on this screen determines whether a user currently has access to
LIBRARIAN. A LIBRARIAN manager can set the flag at any time to change the user's
access to LIBRARIAN wi thout deleting the record from the database,

Passwords can be changed on this screen by using the USER command, or from the User
menu.
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USERS (continued)

Explanation of Fields, continued

US

User
Required. Length 8.

The identifier of the LIBRARIAN user described in this record. The user can include
alphabetic, numeric, hyphen (-), and underscore ( ) characters.

Required. Length 1.

A flag that indicates this user is currently an active user.

Legal values are:

Y I n d i cates that the user is active. The user currently has access to the LIBRARIAN
system (default).

N In d icates that the user is inactive, The user does not currently have access to the
LIBRAIDAN system.

Active

User Name

Password

Phone Number

Optional. Length 22.

The full name of the user. Use this field for documentation only

Optional. Length 20.

The phone number of the user. Use this field for documentation only.

Required. Length 8.

The password for the user. This password is selected by the user and must be supplied each
time this user accesses the LIBRA&AN system. Passwords are encrypted in the database
and are only displayed on this screen when you press F2 (Set 2).

Optional. Length 8.

The lockword for the user. LIBRARIAN assigns this lockword automatically to all secondary
files created by this user. Lockwords are encrypted in the database and are only displayed
on this screen when you press F2 (Set 2).

Lockword
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USERS (continued)

Operation
When you access this screen, the password and lockword fields are not displayed. You can
display them with the SHOW PASSWORD key, To hide them again, press HIDE PASSWORD.
The SHOW PASSWORD and HIDE PASSWORD functions are tumed on and off by F2 (Set 2).

Note P Additionally, you can change passwords and lockwords by using the
USER command in LIBRARIAN, or the Passwords option of the User

US

menu.

The DELETE (F3) key on the US screen invokes a mass delete of all associated data,
including:

� ste p authorizations (SA)

� pr o ject authorizations (PA)

� use r capabilit ies (UC)

� use r f i leset ownership

� mes s ages queued to this user

The user is prompted to confirm the mass delete by pressing F3 a second time.
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Reports

This chapter describes and provides samples of all LIBRARIAN reports.
The following topics are discussed in this chapter:

� Su mmary of LIBRARIAN Reports

� Tr ansaction Codes on Reports

� Ge nerating Reports

� Re d i recting Reports

� Report Headings

a Report Descriptions and Samples

Summary of LIBRARIAN Reports
Table 6 — 1 on the next page lists the LIBRARIAN reports categorized by
type. The table lists the five-character report codes used to generate the
reports, Additionally, page references help you locate detailed
descriptions and samples for all reports.
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Table 6-1. L IBRARIAN Reports by Type

Report Code

Step/Project Reports

Report Title Page

RAD10

RAD20

RAV10

RPJ10

RUP10

RUS10

Fileset and File Reports

Step Summary

Step Detail

Versions

Projects

Project Authoriza hons

Step Authorizations

RAF10

RFD10

RFD20

RFE10

RFX10

RGF10

RPM10

RRH10

RVD10

RVT10

RVT20

Transaction Log Reports

File Versions

Auto Filesets

Fileset Sta tus

Master File Status

Fileset Explosion

Fileset Explosion (with descriptions)

File Exceptions

Generated Files

Pending Master Files

Revision History

File Versions and Tunestamps

File Versions and Timestamp Exceptions

6-19

&21

6 — 23

6 — 29

6-31

6-35

6-37

6-13

6-52

6-54

RTD10

RTD40

RTS10

User Data Reports

RUD10

RUP10

RUS10

Flush Reports

FLUSH

RFN10

RFN20

Users

Project Authorizations

Step Authorizations

Flush Utilitv Detail

Pre-Flush Notification (by files)

Pre-Flush Notification (by user)

Transaction Detail (by date, time)

Transaction Detail (by file, date, time)

Transaction Summary (by date, time)

6-39

6-41

6-43

6-25

6 — 27
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their versions.

The File Inquiry (FI) screen and the VERIFY and SHOWLOG commands
also function as online reports,

� The FI screen displays the status of any file used by LIBRARIAN.

� Th e VERIFY corrunand displays/prints information about files and

� Th e SKOWLOG commands display/print transaction history data. For
more information on SHOWLOG conunands, refer to Chapter 4,
"SHOWLOG Commands."

Transaction Codes on Reports
Table 6 — 2 lists the transaction codes that appear on reports generated
from the LIBLOG database (i.e., RTD10, RTD40, RTS10, and SHOWLOG
reports). Table 6 — 3 lists transaction subcategory codes for the PERFORM,
SET, and RESET cornrnands.

Table 6-2. Transaction Report Codes

OV

PF

CO

CP

DC

LO

ME

MV

Transaction
Code Comm a nd

COMPRESS

COPY

DECOMPRESS

LOCK

MEMO

MOVE

ORPHAN

OVERLAY

PERFORM

PURGE

RESET

RELEASE

RENAME

RESTORE

SE

TO

UL

UP

XC

XD

XM

XP

XR

Transaction
Code Comm a nd

SC

TOLICH

UNi OCK

UPDATE

XCOMPRESS

XDECOMPRESS

XMOVE

XPURGE

XRENAME

XTOUCH

XCOPY

SECURE

SCAN with REPLACE

RL

RN

RS
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Table 6-3. LIBLOG Transaction Subcategory Codes

Subcode (or S C) is the subcategory of a transaction

For PERFORM

For SET

Copy

Move

Null

Generated (retained file)

Mode (Read/Write)

Lockword

Expiration Date

Owner

Exception

Tjrnestarnp

For RESET

Generating Reports

want to run.

)RTS10

There are three ways to generate LIBRARIAN reports:

1. In menu mode, select Info from the main menu. Then, select the
Files , Versions..., Rules..., or Log... menu and choose the report you

2. In command mode, type the report code at the LIBRARIAN prompt
and press RETURN. For example, generate the Transaction Surrunary
Report (RTS10) by typing:

3. You can also stream the appropriate report jobstream
(LIBJxxxx,JOB OCSLIB). For example, obtain the Transaction
Summary Report (RTS'10) by typing:

If you are using the EXPRESS or PRIVATE products on your system,
you can use STREAMER to generate reports.

:STREAM LIBRTS'I O,JOB.OCSLIB

Redirecting Reports
Reports run from a UNIX client are generated on the MPE server.
Outputs are sent to the default printer for the client using the UNIX Ip
command. You can set the environment variable LIBPRINT on a UMX
client to specify options for the Ip command. For example, to print all the
reports on a printer called "ocsprinter", you would put the following
command in the profile file.

LIBPRINT= -d ocsprinter"
export LIBPRINT

Offline reports are directed to the default LP device; however, you can
redirect the output destination, if desired Add i t ionally, the default
priority is assigned to LIBRARIAN reports, unless you override it.
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There are two FILE conunands available to override the output
destination and priority:

1. To redirect all LIBRARIAN reports, issue a file equahon for the formal
file designator LIBOUT. For example,

FILE LIBOUT; DEV=36,2

The FILE command above directs every report to the defined device
(in this case 36), with the defined output priority (in this case 2). The
forrnal file designator for all files will be LIBQUT.

2. To redirect a specific LIBRARIAN report, issue a file equation for a
formal file designator in the format LIBR??¹¹, where??¹ ¹
corresponds to a specific report code. For example,

FILE LIBRTS10;DEV =WIDELP3

The FILE command above directs the specified report (in this case,
LIBRTSIO) to the defined device (in this case, WIDELP), with the
defined output priority (in this case, 3). This file equation overrides
the file equation issued in the first example for this report,

Report Headings
The heading for each LIBRARIAN report contains the following
information:

Report

Page

System

Version

Sort Sequence

Report Title

Company Name

sorted.

The LIBRARIAN report code. It is also the
formal file designator for the report.

The version number of the program that
generated the report.

The identifier of the system on which this
report was generated. System is stored in the
LIBRAMAN systemconfiguration file

The sequence in which report information is

The LIBRAMAN report ti t le.

Your company name. The company name for
all reports is taken from licence information
entered during product authorization.

The page number within the report. All reports
begin with page number one.

The date the report was generated.

The time the report was generated.

Printed

Time
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Report Descriptions and Samples
The following pages contain detailed descriptions of the LIBRARIAN
reports, in alphabetical order by report code. Each report includes the
following information:

Report Name and Code Report tit le and five-character report code.

Sort Sequence

Files Accessed

When to Run

Menu Access

Description

Sequence in which report information is sorted.

Datasets/files accessed for the report.

Recommended run frequency for the report.

The menu from which you can generate the
report.

Description of the information included in the
report.

A sample of the report

Description of the fields on the report.

Sample

Field Descriptions
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FLUSH DETAIL REPORT

SortSequence

Files Accessed D-A PPL-vERsIQN

When to Run

Menu Access

Description

Master File

Admin...Flush

Automatically generated when ni n g t h e FLUSH utility

FLUSH

The FLUSH util ity generates this report to identify all secondary
files and revisions it purged. This report cross — reierences retained
files with their master files. This enables you to determine which
retained files were purged.

Report information includes the retained file name, the master file
with which it is associated, revision identifier, and expiration date.

Sample
Reiarr t c LI SF LUKB

Verrrlccr - 1 . 0 0
Sgsterr = Po gi U IH

Sort. ecereraec He a ter F i l e

FLUSHED f ILE OWEllVl%

PEKKRIIH QEI07eSO. OBJECT, LI!9%GD
PErCUIH GI301170 DEJECT LIK9%OD
PDKKUIHK 652e5175.OBJECT.LIK9%KI
PFIKEGrl 1 M724442. GRIEcT LI le%GO
PogiUIH 167403205. SKKKKCE LIKE%GO
PEFKZQH Ge215207.5KxercE LIKE%GO
PQgiVIH 67e03egI.SKKNKE,LIl9%QD
PErEKIIH 67e03751.5KEREE. LI19%QD
alar err Ck: /opc/oca/cxxrl lb/1 Cbprcrd/

. g306e613
aixcrrrrk c /opc/ooa/caal lie/1 lbprcxr/

go 7255rr 1
� txctrrck /opt/cxxr/cxerlrb/ l l bprcrd/

. g3222312

KCASTKR FILE

cgc PQRRIQI=KRP.GDJECT.LIIK%OD
6H PQKDIIHclgip-OBJECT LJI9%QD
6H PQKIUIH=IgrP.OBJECT LIK9%QD
6H PEFKZKIH=KKKP.DEJECT LIKD%OD
6H PEreZUHr AEQI0005 SKED62:. LIKE%GO
SH PQKZQHK AKE20005 SKERCE. LIKE%GO
6H PErggl IH 1 AiK20005 . SKIRCE. LIK9%OD
6H PQEKIIHK~ .SKRJK E . L I I9%KI

eisctrllk / o p t / o ca/Exmll b / l c bprraj/
absZKERK, c

CexZOKO, c

abs2000, c

Flush Detail

LI&grRIIW/IX
KKERATIKDKS 133TKRKL SYSTDEi

REVISIKKI ID

VZ. 00 r h
VZ. 00 r 3
V2.00r2
VZ.OO 1
� :1
V 2.00cl . l . l
� 11
tel
V2.00c2 1,1

V2.00c2

V2.00r2.1.2

Page: 1

T laer l l r e 5
Pe irrted r 01/Oe/94

5 12/21/93
12/21/93

3 1Z/21/93
2 12/21/93
1 1Z/15/93
3 12/15/93
1 12/15/93
1 12/15/93
3 12/15 / 9 3

3 1Z/1S/93

3 12/15/93

6rr eisrtlllk 1 /ept/ocxr/cxal lb/ I retread/
KH eierrrrlk 1 /opt/oca/cxal lb/1 lbprcxl/

Files/Rerrcsccear f lushed: 11

Field Descriptions
Flushed File Name

Type

The name of the file flushed.

The file type represented by the following codes:

S Secondary
GM Retained Master
GS Retained Secondary
CM Copies of Retained Master
CS Copies of Retained Secondary

The name of the corresponding master file.

The revision identifier associated with the Gushed file.

The generation count (GCOUNT) for the file.

The date the flushed file expired.

The total number of files flushed,

Master File

Revision ID

GCOUNT

Expired

Files/Revisions flushed
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STEP SUMMARY REPORT

Sort SequenCe Applic a tion, Route, Step

RAD10

Files Accessed D- sTEP M-APPLICATION
M-USER

When to Run

Menu Access

Descripfion

D-SYSTEM-PROFILE
D-USER-CAPS

On demand

Info...Rules...RADIO Step Suznrnary

This report provides an overview of the routes and steps in each
application.

The sumjmary information for each step in the route includes step
type, prestep, alternate presteps, source and destination locations,
movement type, file expiration, default parameters,and override

In addition, the report provides general application information
such as the name of the Application manager and phone number.

restrictions.

Sample
LI l%4010 Step Supoeey Puce = 1

V eeorrer r 1 . 0 0
S yrrteu PD ABJ I H

Soot Sequercrer Appllcurlon Route. Step �

LIIRAR Xryr/XX
IRERATIIBTS CDmBL SISTERS Pr Irrred = 01/03/94

T)mr l a 38

APPLICATIIBI FILESET; NFG-FILES

NFFe-HAXNI’ Cycle of r r tepa I' or u elnte ln lne the HFG rttr lrc e t l r e r

STEP ALTDbbtTE FIB P I/ � t STEP P ARES et
IDVE XXP ECP DI CD RE RO IIX PU
TYPE siz RET HE DE iti let vc E tSTD FI L E SET TYPE IN XESTEP PRISTIP(5) TQ LI E ’ATICrr5

01 NFGEl/T NFG � FILES

35 HFG-IN

25 HFG-FAIL

10 NF~ I H

30 HFG-TESTIˆ HFG-FILES

NF G-F I LES

HFG-FILES

HFG-FILES

NFG-FILES

NF G-F ILES

NFG-FAIL

NTFeeIEN
IIFG-f’4 I L

PDKVIN r 0. 0. L IDYBXD
PDeiUIHr IU SERID.LISBEVEL

PDEBIIH=e. IIEiDHD.LIBDEVEL
PDCUIHre. IUSXRXD.LISBEVXI.

oturtnlk r /opt/rkp/cma l lb/I l t rr tttGL �
aputnlk r /opt/acc/ reer l 1 b/I l adore l/

I USERID/u

PEIERIINre.e LXBBEVEL
PDSBIXHre.e LXSDEVEL

eputnlk r/tert/aco/reer lib/Ilbebuei/
I USERIB/ �

reer enlk I /apt / (ma/mm I lb/1 lbprad/ o

PEKRIINre.S.LISDEVEL
PDEiUIH � u. u.LXSTEST

PDDUIHre.e.LISTEST
PDeiUIN= .e LISDEVIL

PEISBIINre e.LISTEST
PDARIIH: e e. LIBTEST

PDABI IH r 0 . 0 . L I SIEST
PDEiUIH r . . LI I%%GO

0 N H
H K

0 H H
H H

0 H H
H H

0 H H
H H

0 H H
H H

0 H H
N H

O H H H HI H H
YI H H YI H H

0 H H
H H

0 H H
H H

H H
N H

Y H
Y N

H H H H
H H H H

YI N
YI H

H H l N H
H Y l H N

H H
H Y

H HI H H
H Y I H H

H H
N N

H H
H H

H H
H H

H N
H H

H H
H H

H H l
YI H
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STEP SUMMARY REPORT (continued) PAD t 0

Field Descriptions

Application Manager

Name

Phone

Application Fileset

Route

No

Step Name

Step File Set

Step Type

Prestep

Alternate Prestep(s)

From/To Locations

Move Type

Exp Sec

Exp Ret

Step Parms

Identifier for Appl ication Manager.

Name of Application Manager.

Phone number of Appl ication Manager.

Name of the fileset for the application.

Name of the route.

Step number.

Name of step.

Fileset associated with the step.

Type of step:

MS Master — t~econdary
SS Secondary — to — secondary
SM Second ary — to — master

Name of the prestep(s), if any.

Name of the alternate prestep(s), if any.

Source and destination locations for the step.

Type of movement (copy, move, or null step).

Number of days before read — mode secondaries expire.

Number of days before safety — retained files expire.

For each parameterlisted below, specifies whether setting is the
default (Y/N), and whether overrides are prohibited (!). Refer to
the PERFORM corrunand in Chapter 1, "LIBRARIAN Commands",
for more information about these parameters:

BA (BATCH)
ME (MEMO)
CO (COMPRESS)
DE (DECOMPRESS)
RE (RETAIN)
AU (AUTOUPDATE)
RD (READ)
WR (WRITE)
OR (ORPHAN)
VE (VERIFY)
PU (PUSHREAD)
EX (EXTERNAL)

BATCH default/override.
MEMO default/override.
COMPRESS default/override,
DECOMPRESS default/ override.
RETAIN default/overr ide.
AUTOUPDATE default/overr ide.
READ defauLt! override.
WR ITE default/overr ide.
ORPHAN default/override.
VERIFY default/override.
PUSHREAD default/override.
EXTERNAL default/override.
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STEP DETAIL REPORT
SortSequence
Files Accessed

RAD20
Application, Route, Step

D-PENDING-AREA D - REFINED-STEP D-USER-CAPS
D-PRESTE PS D-STEP D-USER-STEP
D-PROJECTS D-SYSTEM-PROFILE

On demand

Info...Rules...RAD20 Step Detail

Provides detailed information on the routes and steps in each
application. The information for each step includes description,
prestep, alternate prestep(s), source/target locations, movement
type, step options, and related step data.

When fo Run
Menu Access
Description

Sample
L I RCADZO

Verairm r 1 00
59aterr : PEK UIH

Sort. Setpatrce: AT Vrllcet i r vr ID . A r ette Step �

Step )kraal i

Lll%VVCIFVUlX
D'ERATICV(5 (ZVTTRCL SYSTEH5

Page: 2

Printed: 01/Oe/9e
Tidal 09CS7

STEP HARE ’ HFFre(EV
ACI)TE ID HF&etAIHT
~I CAT I OH I D : HFG
STEP DESCRIPTIDlr I r rtratkrce rreo Fi les C~ d ere l reawot

ALTERWTTE FR (VC/
PRESTZP(S) TO LCRATI(9(5

N)VE EXP EXP et CREATE OPTI(9(5 ae FILE
TYPE sEc RET GR(EI’ A(EIIVTT cREATERcREATER

05 SS HF G — FILES PCMUIH r 9. I CEIERID. L IDDEVEL
PCNZ) IHC 9 IUSKRID. LIDGEVEL

PELL 999 0 H H H

RELATED STEP DATA

~ I VE tVEIIEC)5ALTERWaTE � 1 ALTERWaTE VZ
PRESTEP LIST PRESTEP LIST PRESTEP LIST PEHDIHG PRC)CEKTI(91 (VCEAS STEP STEP

WVCE ST TETTNVCIZATICDCS PVVCCVCETIRS

PENZ)IHC e.e. LIDDEVEL
PEKUIH: . . LI )PROD

CIH) SR156e
C’Fti) SR1S7Z

SR15%I
SR1600

L I leEZZ
LI lSKR
LI)9%R
LI)DCR

CP JUSEPH (R/V) CDE.IHE
OP VERID(1 CA(R/V) N VCEN)
OP debbV ( R / v ) l i d ( ITE
OP par) ( R/il ) N)VE RIFY

I NIEXTE)044

LIIKADZO

Veraicer i 1 0 0
S Vatea : PH EZ ) I H

Sort ~ r /karl laotian ID Roote St e p �

Step Octet l

LIDlSVCIFN/CX
oKRATI(9cs ccecTREL 5YG)z)TS Pr trrtedr 01/Oe/9e

T l~ r 0 9 1 S7

sTEp we(E
RCEJTE ID ~ IHT
APPLICATI OH ID i H FG
STEP DCNRIPTI)Xil

STEP ALTERHATE TAC K/ N)VE EXP GYP E � CREATE OPTIOHS aa FILE
PRCSTIP(5) TO LC KATI (915 TYPE SEL RET GA(EF’ ACCCXerY cRCATIIY CREAT(9(HO TYPE STEP FILE SET PRE STIP

earrtolkr/apt/ace/ r e ) l b / l l b prad/ i CCPY 999 0 H H H
W artoik / a p t / r ear/ rcabl b / i ib d eva) /
IUSCRID/a

RELATED STEP DATA

ACTIVE PRCUECTSA.YE%WITE � 1 ALTERWiTE � 2 STEP STEPPRESTEP LIST FRISTCP LIST PRESTEP LIST PEHOCHG FRD)XEYTOH AREAS wvrE weerGIR ST AUTNRIIATI ( vr5 prvvecEYEAs
SRISGV
SR1572
SR15lR)
SR1600

LllSEIC

LI WCR
L 1)SCR

(R/ll) cve IHE
(R/0) W e (EN)

NXCEAD
NAFCITE
NEZDPRESS
IE)DQIDP
WVCCYAIH
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STEP DETAIL REPORT (continued) RAD20

Field Descriptions
Step Name

Route ID

Application ID

Step Description

No

Step Type

Step File Set

Prestep

Alternate Prestep(s)

From/To Locations

Move Type

Exp Sec

Exp Ret

Create Options

Group

Account

Creator

File Creator

Name of the step.

Name of the route,

Name of the application.

Description of the step.

Step number.

Type of step.

Name of the fileset for the step.

Name of the presteps, if any.

Name of the alternate presteps, if any.

Source and destination locations for the step.

Type of movement (copy, move, null step).

Number of days before read — mode secondaries expire.

Number of' days before safety — retained files expire.

Specifies creation of a group, when necessary (Y/N).

Specifies creation of an account, when necessary (Y/N).

Specifies creation of the creator, when necessary (Y/N).

The creator to assign to destination files.

Related Step Data

Prestep List

Alternate Prestep List ¹1

Alternate Prestep List ¹2

Pending Production Areas

Name of the prestep

Name of the first alternate prestep.

Name of the second alternate prestep.

Location of the pending production area(s) to introduce new files,
Shows areas to include [IN], areas to exclude [EX], and pending
master edit mask [PM].

Name of the project.

Name of the project manager.

Current status of the project (OP=open, DC=documented ).
Name of persons authorized to use the step.

Default parameters on the step (! indicates that no override is
a11owed).

Name

Manager

ST

Step Authorizations

Step Parameters
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STEP DETAIL REPORT (continued) RAD20

Fieid Descriptions, continued

Step Refinements (if applicable)

Seq

From Fileset

FCODE

From Location

To Location

Move Type

Refinement/exception check sequence.

Fileset selection criterion.

Filecode selection criterion.

Location (name) selection criterion.

Refined destination location

Refined movement type:

EXCL
COPY
MOVE
NULL

Exclude qualifying files from step
Copy qualifying files rather than move.
Move qualifying files rather than copy.
Record as null step for qualifying f i les.

Forward Versioning (Alternate Search Locations) (if applicable)

Sequence

From Location

Alternate search sequence number

Location to search if file(s) not found in step source location
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AUTO FII ESETS REPORT

SortSequence

Files Accessed

Application, Level, Fileset

D-AUTO-FILE SET
D-FSET-COMPONENT
D-SYSTEM-PROFILE

On demand

Info...Files...RAF10 Auto Filesets

Identifies the logical components of an application or fileset, and
auto — fileset descriptors. Components are listed by level to let you
review the application hierarchy.

When ruruung this report, you are promptedfor the name of the
fileset or application you want to explode.

� If you enter a fileset name, only that fileset is exploded.

� If y o u enter an application name, the application fileset and all
of its components are exploded.

� If y o u enter an asterisk ('), all of the application 6lesets in the
database are exploded.

M-APPLICATION
M-FILE-SET

RAF10

When to Run

Menu Access

Description

Sample

LIIVTOPTO

Vorotml l 1. OO

A ltO T t l o o r t o

L 1%5% I ttt/1X

POEot 1

P r lotodl O l / O t / S t
PETEETIH BVRATITETS GENTEEL STSTETTS T t~ l 1 11 1 6

Sort Sottooto: AtOItoottcn Lo o o t T1 1 o S o t

TI ZSn
SESTET PTTET

I H/
EX

0
,1
� � 2
.I

-2

TTTS-P ILE5
~- S TEETEE

IJT I X-STEOKE
PDEiUITT l 8. E.LITOTTITO

ttotol kl /to tt/cmaltmaI 1 O/I l t p r o d / t

Field Descriptions
Level

Logical Component

Fileset Descriptor

include/Exclude

The level of the fileset in the hierarchy.

The name of the fileset.

The location of files associated with the fileset,

Specifies whether files identified by the descriptor should be
included or excluded from the fileset (IN=include, EX=exclude).
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VERSIONS REPORT

SOrt SequenCe Appl ic a tion, Sequence (descending)

Files Accessed D-A PPL-vERsIoN

RAV10

D-SYSTEM-PROFILE

On demand

Info... Versions...RAV10 Versions

Identifies all defined versions in the LIBRARIAN system. This
report provides an overview of each version, including version
name, current status of the version, and dates created and
obsoleted,

When to Run

Menu Access

Descriphon

Sample

: LIIVCAVIO Vere lcecc

LIIVccVIl eel/IXVerelcec c 1.00
: PITT2IIH

Pekoe;1
Pr lrcced: OI/0C/5C

Tl~; 11106BXBATISE- aVrma. 5V5TER5

APAIlc-ec Ice - Sequin+ (Oecccercllrco>

VIRSIIVEI TIR ~ I C ATIW KFG

OATE RITE
ST4T CREATEII G BSKEIE5Eo. D EKRIPTIIec

Vl.oo
Vl 01
VZ. 00

PREY 1 2 / 15/93
ITKV 12/ 1 5 /93
CBVI 12/ 1 5 / 93

Field Descriptions
Version

Sequence

Description

Status

Versions of the application, listed in ascending order.

Chronological number of the version in the application.

Description of the version.

Status of the version, as follows.

CURR
PREV
OBS
FL

Current version
Previous version
Obsolete
Flushed

Date Created

Date Obsolete

Date the version was created.

Date the version was made obsolete.
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WRITE MODE SECONDARIES BY USER

SOrf SequenC e User , Secondary Fi]e

Files Acce sse d M — APPLIcATIDN D — sYsTEM — PRDFILE D — FILE

RSF10

M — USER

When to Run

Menu Access

Description

On demand

Info...Files...RSF10 Write Mode Secondaries by User

Shows write — mode secondary files sorted by the user who
currently owns these files.

When running this report, you are prompted to enter the name of
a user. To select all users, enter asterisk (').

LIJBJsr10 JJ Jaa Nooa S ccxmdarlaa U JJ Uaar PABal 1

Varolcm l 1 0 0
SJJOXA : PEMiVIH

Son: a aoa r aor l Uar r . ~ T l l

L I NJAR I Jal/ I X
JKS

P rln t a l l l 1 2/ 0 1 / S a
T J» l 10 J3 1

� aa Sea r le ~ J’l l r c ; fo r aar r Uor a X aa a

PEMilll H l SCIKES . AESUBS BEREX
PEMBJINJERALZBJS RLSUBS BEREK
PEMBJI Nl SJSOBJXS. RLSUBS IBREX
PEMBJIH SZBEJBS RLSUBS BEREX
PEMBJIHJSJBZT3S RLSUBS SENEX
PEMilJIH=SZˆZTS JESUBS BIREX

JRJSTER LI A T I OH

P EMEJZH=SEEPIS RL SUBS.L I X 1 0 0
PEMBJ I Hl SERALJBJS. RLSUBS 1, I Xl 00
PEMBJ I H = SCRZBJXS . RLSUBS Ll X 100
PEMBJZHJSZBJT25 RLSVBS.LIX100
PE1%U IH 1 SJBZT35 . RLSUBS . L I X I 00
PEMBJZH:SJBZTS RLSUBS l , I X 1 00

1 2/01 / S a
12/OZ/EH
12/ol / Sa
12/oz/Ba
I 2/01 / 8 4
12/01/Sa

LZX~
L I X-ZIJT
LI X � IEJT
LI X-JXJT
LIX~
LI X-JBJT

LIX � MTINT
L IX~ I NT
L I X-ICIZ HT
L IX-N AI N T
L IX ~ ZNT
L IX~ I NT

LZX
LZX
LIX
LIX
LIX
LIX

F ield Descriptions
Secondary Location

Master Location

Date Created

Days Old

Last Step

Last Route

Last Appl

Location of the write — mode secondary file.

Location of the associated master file.

Date on which the File was created

Number of days since the write — mode secondary file was created.

Last step with which this file is associated.

Last route with which this file is associated.

Last application with which this file is associated.
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WRITE MODE SECONDARIES BY PATH

Sort Sequenc e syst em, Path, File

Files Accessed M — APPLIcATIQND — sYsTEM — PRQFILE D — FILE

RSF20

M — USER

When to Run

Menu Access

Description

On demand

Info...Files...RSF20 Write Mode Secondaries by Path

Shows write — mode secondary files sorted by location.

Rettor t L I IEIS T20

Venri~ : 1 .00
Sreten : ln0EXIIH

LIsrrrEIlrt/ix
(KS

te lte Hode e e o norr iee b9 p r t n Poge: 1

P etnted 1 2 / 0 S / 9 e
Ttm: 0 9 : 12

Sde~ l et n . r i Se

� rr S emper@I lier on ogrten PEKUIH in K I VQBC.HILIHD err

U320reET PILE HeSTER F’IIL

PDEEIIH:PARSEXCL.ldr/CSRC.LIX100 e i i in d 11/ 29/ 9 t 6 LIX~ L I X- IHII HT LIX
PDEklIH PIEK. 1OVESHC. LIX100 e i it’l l 12/ 02/ 9 e 3 LIxEAJT Lix trtIHT Llx

Field Descriptions
Secondary File Name of the write — mode secondary file.

Master File

User

Date Created

Days Old

Last Step

Last Route

Last Appl

Name of the associated master file.

Name of the user who owns the file.

Date on which the file was created.

Number of days since the write­ mode secondary file was created.

Last step with which this file is associated.

Last route with which this file is associated.

Last application with which this file is associated.
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FILESET STATUS REPORT
SortSequence

Files Accessed
Application, Fileset, System, Path, Filename

D-AHFSET-COMP
D — AHF SET — FILE
D-APPL-VERSION
D-FILE

On demand

Info...Files...RFD10 Fi leset Status

Identihes all files in a fileset or application. This report includes
the version history, version and generation counts, file type, access

When running this report, you are prompted for the name of' the
fileset or application you want to explode.

� If y ou enter a fileset name, only that fileset is exploded.

� If y ou enter an application name, the application fileset and all
of its components are exploded, You are prompted for a
version identifier. Enter a version name or press RETURN to

Each application begins on a new' page.

� If y ou enter an asterisk ( ), all of the application filesets in the
database are exploded.

When to Run
Menu Access
Description

mode, and most recent transaction

D-F SET-COMP
D-FSET-FILE
D-SYSTEM-PROFILE
D-VFSET-COMP

D-VFSET-FILE
M-APPLICATION
M-FILE-SET

RFD10

use the current version.

Sample

Rcport : L ID TFOIO

Verb i tat t I . 0 0
Svetae I PEICOIH

Stet seevehta l ap p l . FJJ e se t . . Sv ~ . path . F JI~

LIISOGII JN/JX
I NEROTIDEI ~ STSTDT S

Page: 5

prlhtett: GI/oa/Ga
TJ~ : l l t 23

FILE SET 15 ERIS%I

STSTDI PDG GJIH PA T H a SD N C E.L I IEHGN

I ILE V ER G DI LAS T
TTPE DJIREHT VERSIIN Y I R S ID I D TEATIR C D N T CIGNT JPPL lAST JGRJTE lAST 5TD'

H VZ . O O V2. 00 I 3 HFG HFG V VII M ~ LINAGE IJ

I.JXI
PDEGJIH

LINONlaat/JX
INERAT I IGEI C1NTRIL SVSTDTS

P l~ t Ol / Oe/ G a
T leol l l I Z 3

APPI. File Set. Spate». Path FI!~

EXPLGSIIN OF FILE SET POTDI-203

FIIE SET IS 551590

STSTEH eta c i t PATH / op t / oo a/ ~ l Jb/ I l b a e ta t

FILE V ER GD I LO ST
TYPE D%RQTT VERS I IN VERSIDI CREATEO DINT Cl lN T APFT. I/TTT RDJTE I/TST STEPI 'ILDONE

abtZOCO. a
atb30CO. t

H V2. J X I
H VZ 00

3 a HFG HFGVIAIHT TitJXDJT Oe bbg U
2 3 HFG HFG-ala IHT ~ babbV V
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FILESET STATUS REPORT (continued) RFD10

Field Descriptions
Filename

File 7ype

Name of the file in the application.

Type of file:

M S GM
Master
Secondary
Generated master
Generated secondary
Copies of retained master
Copies of retained secondary

GS
CM
CS

Current version of the file.

Version when the file was created.

Version count (VCOUNT) for the file.

Generation count (GCOUNT) for the file.

Last application in which the file was processed,

Last route that processed the file.

Last step that processed the file.

Last user who performed a step on the file.

Access mode (W =wri te, R =read ).

Current Version

Version Created

Ver Count

Gen Count

Last Appi

Last Route

Last Step

Last User

Access Mode
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MASTER FlLE STATUS REPORT
SortSequence
Files Accessed

Application, Fileset, System, Path, Filename

D-AHFSET-COMP
D-AHFSET-FILE
D-APPL-VERSION
D-FILE

On demand

Info...Files...RFD20 Master File Status

Identifies all master files in a fileset or application with their
associated files. This report includes version data, version and
generation counts, and access control/access mode. Information
about the associated files includes file type, version data, version
and generation counts, and the last step performed.

When rluming this report, you are prompted for the name of the
fileset or application you want to explode.

� If you enter a fiieset name, only that fileset is exploded.

� If y o u enter an application name, the application fileset and all
of its componentsare exploded. You are promptedfor a
version identifier. Enter a version name or press RETURN to

Each application begins on a new page.

� I f yo u enter an asterisk ('), all of the application filesets in the
database are exploded.

When to Run
Menu Access
Description

D-FSET-COMP
D-FSET-FILE
D-SYSTEM-PROFILE
D-VFSET-COMP

D-VFSET-FILE
M-FILE-SET
M-APPLICATION

RFD20

use the current version.

Sample

LI JFTFG20 File States P4GVJ 5

Verett : I 00
SV atra : PEJ ERJI JJ

LIJSJJNIAH/JX
135RATIJDJS CICJTRJ3 stSTEHS

P latedJ 01/Ot /Dt
TlacJ 11J23

~l ID. F Jle Sct Saatea Para FJI~

CXPLGSIOH OF FILE SET PATCH-203

SVSTIN = PDEAJIN PAM SJXPCE.LIJPRGD

VERSION GD I . GEFJNLT IECESSIISJREHT VERSI JDJ VER SIJSJ CREATEII CJ33JT JSI S J T ACC ESS JEGJE CEHTRJ3FILE SET

1 3 V 5

ASSIE:IATED FILES J

5TSTEH. I IIEJVCJE
VER GE N LA S T

TIPE JXIJREHT VERS IJRJ VERSIJ7I CREATED JSEHT OSCJT APPL LAST AIIJTE

PEIEDJIH J GTAOSJSr . SIEIJGE . LI JIAVJD
PEJEAJ I H J G7ra 323 I, SJEIJGE . L I ID%DO
PEJEDJ I H J AIK30005, 3JZZPH .i. I BDEVEL

GN r
GN V2.00
5 V 2 . 0 0

I I HFG VERJRJICA
0 2 HFG 3JZiEPH
2 t HFG NFG -JVIIHT ~ L I IDES N

VI .00
V2. 00

L

Veeal~ ; 1 , 0 0
SVr tea J P EJ EAJ IH

LIRJJVJI JVJ/ JX
JPEAATIJAJS TICJTIKL SISTERS

PelptadJ OI / JNJ/Sr
Ttra: 11 J23

tccrerae; Appl ID. FJlc Set. Svs te . Para . FJJ~

EXPIJJSIJDJ OF FILE SET PATCJJ-203

SISTER = Rat ta t i r PATH / ta t/ ~ aca l J O / JJOPrad

F IIE FILE SEJ

SRI558 3 JJ 5
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MASTER FILE STATUS REPORT (continued) RFD20

Field Descriptions
Master File

File Set

Current Version

Version Created

Version Count

Gen Count

Default Access Mode

Access Control

Name of the master file,

Name of the fileset to which the master file belongs.

Current version number.

Version when the master file was created.

Version count (VCOUNT).

Generation count (GCOUNT).

Default access mode (W=write, R=read).

The access control (X=exciusive, R=read, S=serial, M=mult iwr i te ).
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FILESET EXPLOSION REPORT

SortSequence

Files Accessed

Application, Level, Fileset, File ID

D-AHF SET-COMP
D-AHF SET-FILE
D-APPL-VERSION
D-FILE
D-F SET-COMP

D-FSET-FILE
D-SYSTEM-PROFILE
D-VF SET-COMP
D-VFSET-FILE
M-APPLICATION

RFE10

M-FILE-SET

When to Run

Menu Access

Description

On demand

Info...Files...RFE10 Fileset Explosion

Identifies the logical and physical components of a fileset or
application. This report lists the components by level to let you
review the application hierarchy.

When rLmning this report, you are prompted for the name of the
fileset or application you want to explode.

e I f yo u enter a fileset name, only that fileset is exploded.

� If y o u enter an application name, the application fileset and all
of its components are exploded.

You are prompted for a version identifier. Enter a version
name or press RETURN to use the current version.

� If you enter an asterisk ('), all the application filesets in the
database are exploded.

Sample

LllRFEIO

Vrtplp n l 1 00
50 ctcp t PEN @I IH

F \ lctort: Erploolon

L I IPCCI I lot/iX
IKIPATIIOtS OM1%tL STSTUES

Pogct 1

Pntntco- O I / ( H / S I
Tinct 11 t 21

Appltcottcrt Co n : I . Ell e Sct . Fl i t IO

EtPLOSICH OF FILE SET PATCH-203

LIMNI CAL

0
.1
. .2
..2
.1
..2
..2

2
2

2
2

..2

PEICEI IH t AlK I 0005. 5QJICE. L I&%GO
tctttnlkt /opt/occ/octl lb/111crtol/olr.1000.c

PDCII IH t RIKZIXOS. 515JKE. LIP%GO
PEMII IH t RIKXXOS . SIEPCE. L IH%60
~ tn l kt / o p t / o c r / t r o t l l b / I I Ic tttot/obcl000 c
CPOttltk / O P t / OCO/OCO lib/1 tbottrt/ ~ C

PIICII I H t NK3CKX6. SINCE.L 11PI510
ctptntk t / cp t / o c c / o cc l t b / I t bpt t rc/obc2000. c
Art tnt k t/opt/occ/ocr lib/ I tbptod/occ3000. c
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FILESET EXPLOSION REPORT (continued)

Field Descriptions

RFE10

Level

Logical Component

Physical Component

The level of the fileset in the hierarchy,

The fileset name.

The names of the files in the fileset.
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FILESET EXPLOSION REPORT

SortSequence

Files Accessed

Application, Level, Fileset, File ID

D-AHF SET-COMP
D-AHFSET-FILE
D-APPL-VERSION
D-FILE
D-F SET-COMP
D-FSET-FILE

RFE20

D-SYSTEM-PROFILE
D-VFSET-COMP
D-VFSET-FILE
M-APPLICATION
M-FILE-SET

When to Run

Menu Access

Description

On demand

Info...Files.�RFE20 Fileset Explosion

Identifies the logical and physical components in a fileset or
application. This report lists the components by level to let you
review the application hierarchy.

When running this report, you are prompted for the name of the
fileset or application you want to explode.

� If y o u enter a fileset name, only that fileset is exploded

� If you enter an application name, the application fileset and all
of its components are exploded. You are prompted for a
version identifier. Enter a version name or press RETURN to

� If y o u enter an asterisk ('), all the application filesets in the
database are exploded.

use the current version.

Sample

L I JBYFE20

Veeeicec 1 . 0 0
SDctee PE)B DJIH

Suet Seccueiee.’c Afcc)caution. Le v e l . F i l e Se t F ile I D

Fl leeet Kuplaelan

LI JJRJB(I FBI/ lx
(KERATIIDFS C(B(TRK. SYSTI)(5

PeDe i 1

Pr inted = 01/OC/94
I iee t 1 1 : 22

LJIJI~
PHYS ICAL eeeBCEHT OISCRIPTIOH

0
.1

2
2

.1

..2
.2

1
.2
2

2 2

� SRI5%)

� SR15F2

C

PATCH-203
� SRIS&l

POBJUIH r AJK 10005. BIBB(CE. LI (5%QD
� putnlk c/opt/oce/ecol lb/libprod/
ebcl000 c

FS)eDJIH c ~ SJBBCEX. LI IBSFOD
elec~ k : /opt / oca/cxml ib/ l i b p racV

PENiUIH: ~ 5(BNCE. LI JP%UD
etectnlk c/cpt/oce/eccl lb/ l ibprccd/

drc1000. c

PEJe)UIH c AJK30FXS 5(BBKE . LI BPROD
cene tn 1 k; /opt/oce/cent 1 b/ 1 lbarod/

cpu tnt k c/opt/ocec/occl ib/ 1 ibpeoe/

Hf G — S R)SKI PfoDect F l l e e e t
Rl) r e p a f t i r t ( f u n c t ) ceca for th e A JK eadule o f ’ the H FG appl i c a t i o n ( t P E )
Ail re p oet inB f u nc t l a rei fo r t h e AJK eadule o f t h e H FG eppl l ccrtlcec (UHIX)

HFG-SR1572 PraDect Fi)eeet
All ecrern functicere for rhe AJK eodule of the Hfi cpa(caution (re E)
All GUI I ’ unct i one f o r t h e A I K ccecdcle o f t h e H FG cop) t e a t ) a n ( I PI I X )

Troneecr ion pe oceeetnB F’ar t he ABC eecdule al’ the HFG applicat ion ( N % )
Rll ee tecrtlnB f ~ i ce ec f o f th e AB C eodule o l ’ the H FG ~ J Jc et l cec (UHIX)

HFG-SRI598 Prelect Fllecet
Tr ~ cre e p r a ceeaine fan t h e ABC nodule of t h e HFG ~ l cce t ccn ( APE)
Tr~ ccec e cce crcrinB for th e AJK rcoctcle af rh e HFG ~ l l cot i ce t ( U HIX)

All GUI f u rc t t cere far t he. ABC rcadcle oF the HFG epplcceticec (NFIX)
C

c
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FILESET EXPLOSION REPORT (continued)

Field Descriptions

RFE20

Level

Logical Component

Physical Component

Description

Level of the fileset in the hierarchy.

Fileset nazne preceded by an asterisk (').

The naznes of the files in the fileset.

Description of the fileset or physical file (if one exists).
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PRE-FLUSH NOTIFICATION REPORT

SortSequence

Files Accessed

RFN10

Master File

D-APPL-VERSION
D-FILE
D-SYSTEM-PROFILE

On demand

Info...Files...RFN10 Pre � Flush Notification

Lists all files eligible to be flushed by the FLUSH util i ty. For each
file, this report shows the file type, the date and time of last
modification, the number of days since modification, the
associated master file, the expiration date, and the file owner.

The "as of" date for this report can be specified in MM/DD/YY
format in the INFO string of the RUNcommand. The following
exaznple lists all files to be flushed on 12/31/92 (if the FLUSH

program were run on that date).
:RUN RFN10PCOMPOCSLIB; INFO="12/31/92 4

When to Run

Menu Access

Description

Sample

LIRYFHLO Pee � Flack Hotel’Lcacla t a a ca’ DL/04/9 4

veeolcn I I OO
- PEL%OIH

LILRALU aw I X
\PEAATILO% LZWTTHL OYSTERS

Page: I

P r I ntea I DL/04/9 4
T laar l l r44

H ooter F i l e

� LRYS
SIMXFILE PEHDII% FLJLSH

PEIOZQH I GSI07450 QDJECT . LIRKOD
PEIODQH-I%301170 MLJECT.LILOHULD
PEIODQHLGS245176 QOJECT. LIHHLOD
PIJEEQ H c GG72444 Z QOJECT. L I %ALOD
PEMDQ H 1 G7403ZOS . SLEIOX. GIRDER
PD%lQ H c 642 I 5207 . SLDREZ. LJ%9%D
PEL%LQ H c G740346 I . SLUICE. LJ %SOLD
PEMRIIH I G7403754 SLXRCE. LJ %SOLO
apatnlk =/apt/cate/canc Lh/I Lhlatal/

. gRK4613
alar tnlk I /opt/aca /can 1 Ihl I Ihpradl

. LL072554 I
araccnc k I /opt/caml caa I Lh/I Ihprcal/

.g3222312

GH FILE SR%ED AS DELTA
GH FILE SQDLED AS DELTA
GH FILE STIRED AS UELTA
G K HED. JCW 5 199 4 . 1 1 3 3 A H

G H HED. JIW 5 I 994 . 1 1I X I I W

GH IKO, R W 5 . 199 4 . 1 1I X L CW

TYpE LAST I%DIE IED (ccTIHL) KLD HASTIR FILE

G H TMI O EC 23 . 1 9 93 . 9 20 C W
GH TMI. QEC Zl . 1 9 93 9 20 CW
GH TML DEC Zl . 1 99 3 9 20 AH
GH TMI. DEC 23. L993. 9120 IW

FILE SOULED AS LQiTA

12 PIMZLIHLIRP.UKKCT.LI IOTKD
12 PE7%OIH I IMP . LDLLECT . LIWTLQD
12 PEICOIHIIWP,ODJECT LE%ROD
12 PEMDIIHLIRP ODJICT.LJRHOLO

H/A FEL%0 IH =LRc I caxts . stlRcE . LI %%GO
K/A PEMZLIHL$8KZOOOS.SLDRCK.LIRSCOD
H/A PEMRI IH I Al&ROOOS, SKRCE . LI %SULU
H/A PEL%0 IH I AIKJLXXM, SLDRCE . L IRSLOD
H/A atartnck I/ckrt/aca/caML Lh/I Lhpracl/

H/A atartnc k t/cart/oca/cap L Lh/I Llgaccl/

H/a wa t n rk r / w n / ~ ~ LLh / LL Lgatal/

12/21/93 I%R7HFG
12/21 /93 I%RJHFGi
12/21/93 MiR>HFG
12/Zl/93 MiR>HFG
12/15/93 LgiR>HFG
12/LS/IEI 1%RJHFG
12/15/93 MiRJHFG
LZ/LS/RI I%R>HFG
12/15/93 I%RJHFG

12/15/93 ICR>HFG

12/LS/93 MW7HFG

C

ahc2000, c

waZOrXL. c
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PRE-FLUSH NOTIFICATION REPORT (continued) RFN10

Field Descriptions
File Pending Flush

Type

The name of the file to be flushed.

The file type:

S
GM
GS
CM
CS

Secondary
Generated Master
Generated Secondary
Copy of Generated Master
Copy of Generated Secondary

Last Modified (Actual)
were added to the delta file.
Date and time the file was last modified or date and time changes

Number of days since the file was modified.

Name of the master file associated with the file to be flushed,

Date the file expired.

For Generated Masters, this field displays the application name;
otherwise, it displays the name of the file owner.

¹Days Since Mod

Master File

Expired

Owner
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PRE-FLUSH NOTIF ICATION REPORT

Sort Seguence

Files Accessed

File Owner, File Type, Master File

RFN20

A-AP PL-VERSION
D-FILE
D-SYSTEM-PROFILE

On demand

Info...Files...RFN20 Pre-Flush Notification

For each user, this report lists the files that the FLUSH uti l ity is
ready to purge. The information for each file owner includes the
file, the file type, the date and time of last modification, the
number of days since the last modification, the associated master
file, and the file expiration date.

The "as of" date for this report can be specified in MM/DD/YY
format in the INFO string of the RUN command. The following
example lists all files to be flushed on 12/31/92 (if the FLUSH
program were run on that date)

: RUN RFN10P COMP OCS LIB; INFO= 412/31/92"

When fo Run

Menu Access

Description

Sample

� u t E � I I � E t � Eu t � � I EI I t u t u t t t u t Eu t EEu t EE � E t � EEI I u t a t u u t u EI EEE E E

E 4TTD(TI(W . HTG APPLI GATI(W lastcGER(5)
I
II � EIEIEH I I u EEIIIEI I IIE � IE � I � I � Etut u t t t I EI I E u I u u I EI I t t � I I Eu t t t t �

I � � I � T H E T D L L O II I H G F I L E S A R E � � � � �

� � � � � � � GO I H G T O D E P U R G E O � � � � � � �

� I � � a � E PL E A S E DE 4 U A R E I I I I � � I � � �

)aaaatat 3 1 00
St Etta 3 PDED) I H

l ush lt t t t l ca tl c n I a

LI IEIARI)w/ix
(DEEDA T 1(3(5 (33(TR(L STSTDCS

PlcDI 3 1

P lntaa 3 01/Uc/SC
T tu ; 111 4 5

(kuct , TU Tw, H u t u F t )a

File›" (kaac( t ata lcFG APPLICATI(DI HAHAGER(5)

� DAF5
51362

FILE PEHDIHG FLUSH

PDRZ)IH 3 (DD07CSO OD)ECT . 1 I)PROD
PI)KUIH 3 6130( 170 003ECT . L I IESOD)
PDDZ)IHlDIZC5376 OD)ECT Ll)9%08
PE)633 I H 3 667?au 2. ODIECT . L I IPI(00
PDKUIH364239207.5(EPEZ LI IP%Kl
� putnlkl / a p t / a ca/ccal l b / l l t p nac(/

. 6306c613
� puca lkl/apt / a ca /ww 1 tb/1 tttpacc/

. 107?SSE I
caacn tk /ap t / a c a / cue I I 0/I ttaatcW/

.53222312

TVPE LAST HZlIFIEO ( ~ ) ac)D HISTER FILE

G H T)EL DEE 23 19 9 3 9 20 CW
GH 3)CL DEC 23. 1993 9 20 CW
GH T)EL DEC 23. 1993 91 20 CW
G H T)t) . DEC 23 1 9 9 3 91 20 AH
GH FILE SllNED AS DELTA
GH RED. JAH 5. 19 9 ( 111 3 3 RH

JAH 5 . 19 9 C . 1 1 133 RH

GH UED. 3AH 5 . 19 9C. 1 1 133 AH

12 PDGUIHclaa QD)ECT Lll&R(D)
1Z PDDUIHcla(P.ODIECT LI)OHIO
12 PDEZ)IHICD(P.ODIECT LI)PAGO
12 PDED)IHcaNP.ODIECT LI)DHIO

I/R PDRZ)IH RIK2000S. 5(DD(CE LIIPADO
H/A Eautnlk 3/ IP I / a c a / w w l t b / I t b aatacU

I /R sputnik I/apt/aac/wwl ca/I tbpcac)/

I/R waatnt k /a pt /a ca /a pe l tb/It t tacas/

EXP IRED

12/21/93
12/21/93
12/21/93
1 2/?I / 9 3
12/15/93
12/19/93

12/15/93

12/15/93

C

IbC2000 c

abc?000. c
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PRE-FLUSH NOTIFICATION REPORT (continued) RFN20

Field Descriptions

File Pending Flush

Type

The name of the hie to be flushed.

The file type:

S GM Secondary
Generated Master
Generated Secondary
Copy of Generated Master
Copy of Generated Secondary

GS
CM
CS

&st Modified (Actual)

¹Days Since Mod

Master File
associated.

were added to the delta hi e,
Date and time the file was last modified or date and time changes

The number of days since the file was modified.

The name of the master file with which the file to be flushed is

The date the file expired.Expired
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FILE EXCEPTIONS REPORT

SortSequence

Files Accessed

File ID (System, Filename)

D-AHFSET-COMP
D-AHF SET-FILE
D-APPL-VERSION
D-FILE

On demand

Info...Files...RFX20 File Exceptions

Identifies files that do not currently exist on disk, or disk fi les that
are unknown to LIBRARIAN.

When running this report, you are promptedfor a group of
physical files using wildcards, a logical fileset, or an application. A
logical fileset name must be preceded by a percent sign (%), and
an application name must be preceded by a dollar sign ($). Enter
an asterisk (') to explode all application filesets in the database.

You can create a listfile LISTFX10 to include each exception by
responding Yes to the "Create list file of exceptions?" prompt. Then
you can use the listfile as input to any LIBRARIAN operation
(e.g, VERIFY, CLEANDB).
For wildcard specifications, "FILES UNKNOWN TO
LIBRARIAN" are listed. For logical filesets and applications,
"NONEXISTENT PERMANENT FILES" are listed.

D-F SET-COMP
D-F SET-FILE
D-SYSTEM-PROFILE
D-VFSET-COMP

D-VFSET-FILE
M-APPLICATION
M-FILE-SET

RFX10

When to Run

Menu Access

Description

Sample

LIBZFXIO

Verdlcn 1 1 . 00
Svetae 1 PEPSUIH

Sort. ~ : Fi l e 10 ( SVC t errrFi l ~ )

File Errceptt rete

L Ugbvtl rer/Ix
QKBOTI(3(S (3B(QKL SYSTEHS

P r lrrtedi 0 1 / 0 4 / 5 4
T i~ i l :2 7

)43(ExlsTEHT Grberkoit FILE5

(krcoecntzd File L ~ t lte r( e ) I' a r �

SYSTEH 1 F ILI)trt(E EXCEPT 1(N HESSOGE

pENB)IH rtlKlooos.JQSEFH.LIBOEVIL
PE)%UIH- AIKSOOOS.JOSEPH . LIBQEVEL
PE)KUIH16%2000S.LI IegiR. LIBQEVEL
PEMiUIH r G1736256. OBJECT . LI le%DO
PE)CUIH: G3301170. OBJECT LIIB%00
PEFSUIH 65245176. QK)EcT Llredg)0
PErcg) IH = EEC507450. OBJECT i. UWRDO
PEIEB) IH 1 66724442 OBJECT . LI IS%DO
ettrtnik 1 /apt /ace/mar(lb/1 ibprad/. 60~ 1
erertnik 1/opt/ rear/ ace)lb/ I l b prad/ 6260r5131
eputnlk .—/opt/aco/rearlib / l i b p r ter/ 62 6 04047
crertnik . / a p t / acc/occl i b / l l b pprel/ 63C$4613
� errrtniki / rert / ace / rc e l i b / I i b p r t er / 6 3 222312
opotnik: / r ert/occ/ace)lb/lt~ 67r ki6236
ctkrtnik r /tpt /oce/reerl lb/ I rterrter/ g70’70212
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FILE EXCEPTIONS REPORT (continued) RFX10
Field Descriptions

System:Filename

Exception Message

The name of the system and file.

If there was a problem determining a file's existence, a message is
shown here.
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GENERATED FILES REPORT

SortSequence

Files Accessed

When fo Run

Menu Access

Description

File

D-FILE

RGF10

On demand

Info...Files...RGF10 Generated Files

This report identifies retained files tracked by LIBRARIAN. These
files are retained through version activity or safety retention.

The information listed on this report includes the type of retained
file, version data, version and generation counts, and the original
filename, Use this report to review the status of the retained files
and to cross-reference retained filenames with their original
filenames.

Sample

LIDIGFIO

v eeelrer r 1 0 0
SVecerr r PDGZJIH

Sort Serreerep: File ID

Geper cled F 1 lee

LIBGIRlrvl/IX
OPEBATIOTS CDFIRCL GYSTEHS

Pr lnledr 01/OC/Se
T leel 1 1 12 8

SYSTEH PD GZIIH PATH OBJECT. LIDNIOO

VER GEH RATE
RETAIHEOTYPE CLGTREHT VERSION VEASIIST CREATER CHT CHT ORIGIIVL

G1736256
G3301170
GSZVS 176
G5307e50
667?eeez

VI .00 0 1 r erp
3 e IS P
2 3 rpp

5 WP
I 2 NV’

12/21/93
12/21/93
12/21/93
IZ/? I/93
12/21/93

StSTEN PD G RII H PAT H � SrlRCE. LID9QO

VER GDI
Fl l?HARE

GATE
RETAINER

’PIPE IZAREHY VERSION VERSION GREATER CHT C HT WIGINAL

GRICN 162
64215207
G74tLQOS
67co3A61
67e0375c
67ee2K26
67ec2775
67+e32II

Repeer, r Ll le rGFIO

Veep lrer r 1 . 00
Spe Yee � PDGZIIH

~ SPee l p ce r F i le I O

G N VZ 0 0
GH V2 00
GN �
GN �
GH �
GN VZ.OO
GH VZ.OO
GN VZ.OO

e

Vl . 00
V2. 00
Vl. 00

V1.00
V2. 00

2 AIKZIROS

I AIKIrXDS
1 AIKZIRXIS
1 IOKSOIDS
2 AIKIOOOS
3 AIR?0005
2 AlKmroS

Gereee\ed Fr i ed

LIIVOVIIrVI/r X
lˆERATIDIS CDTTRtL SYSTDCI

P rlrped l 0 1 / 0 4 / 9 e

12/I 5/93
12/I 5/93
I?/15/93
12/15/93
12/15/93
12/15/93
12/15/ID
12/15/93

Yleel 1 1 1 28

5YsTIH e ererrrrrk pAT H /o pr/ r e e / r e er l l r r / I l cp rpd

FILEHANE TYPE I1%REHT YERGIOH YERGIDI cREATEG cHT cHT f ˆ I GlrvrL
VER GEH lATE

RETAINER

607255rr 1
. GZGTG531

GZGOCIN 7
. 0306e613
. 93222312

2 3 eecZOOO.C
0 I errc 2000.c
0 I errc R XD.c
2 3 N rc? 000.c
2 3 ee c2 000.c

12/1 5/93
12/15/93
12/15/93
12/15/93
12/I 5/91

V1.00
V1.00
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GENERATED FILES REPORT (continued) RGF10

Field Descriptions
Filename

Type

Current Version

Version Created

Vers Cnt

Gen Cnt

Original

Date Retained

The version of the file.

The version when the file was first introduced.

The version count (VCOUNT) for the file.

The generation count (GCOUNT) for the file.

The name of the related master or secondary.

The name of the generated file.

The type of file (GM=generated master, GS=generated secondary).

The date the file was retained.
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PROJECTS REPORT

SortSequence

Files Accessed

RPJ10

When fo Run

Menu Access

Description

Application, Route, Project Name

D-PROJECTS
D-SYSTEM-PROFILE
M-APPLICATION

On demand

Info...Rules...RPJ10 Projects

Shows information on all projects, including the current project
status, authorization requirements, the project route ID, project
manager, and the dates the project was opened, activated, closed,
and flushed.

Sample

R eport i LI % PI I 0

Version i 1 .00
Seotee i PECCBICC

Sore. Seouenoei A p p l coet c~ . R cmto. PrCCIttt Cttoe

c gcTEC 4 � cnoleoteo t iui t p r o3eot ~ t no r c t e t ctel l e r e ecucroo.

Pro J cote

Lllecoglcpc/cx
CRERATICPCS ECPCCRCS. SISTERS P r intedi 01 /04 / 9 C

Tleei l i tl e

PRCCIEETS FCSC cgSS ICATICSC AFG
RCECTE i HF&AN INT

eSRISCrl

ESTC 5

� SAC S72

EST i 12

� SR15%C

PRI C 2 CESRED i 12/15/93 FK T IVEC 1 2/15/9 3

F ix bounds v i o i o t i o n p r obl e ln RF GICNO et 1 . 0 3 2 LICEASC 12 / 06 /93 Eetne Seel&a

PRI: 1 CSSKEDC 12/15/93 ACTIVE i 12/15/93 CLOSED

F\x str i n g ov erects pr obceu ln Ax t r ~ cees LIcesR 12/14/93 sglveeter Adust

PRI C 2 CS%3CEDC 12/1S/93 ACTIVE C 12/15/93 CL OSEDC OC/Oe/9e FLUSHEOC

L IBRPC 12 / 0 1 / 9 3 30e 5 e l t n Curn I’Oetur 1 ng

C put At t t ser t i n g ce
USER STATlECC IHVEST IGATICD

Retn 1 vl ng

USER STATLCSC

Field Descriptions
Project Name

Project Description

Project Manager

Request Date

Requestor

The name of' the project.

A short description of the project.

The name of the project manager.

The date the project was requested (documentation only).

The name of the person requesting the project (documentation
only).

The name of the department requesting the project
(documentation only).

Department
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PROJECTS REPORT (continued) RPJt 0

Field Descriptions, conhnued
Status Status of the project.

CC
CL
DC

op

Estimated length of the project.

Priority (documentation only).

Date the project was opened.

Date the project was first used.

Date the project was closed,

Date the project was flushed

User-defined status description (documentation only).

Closed to Checkout
Closed
Documented (but not opened yet)
Flush Pending
Open

EST

PRI

Opened

Active

Closed

Flushed

User Status
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PENDING MASTER FII.ES REPORT

SortSequence
Files Accessed

Application, Fileset, Master File ID

D-FILE
D-FSET-COMP
D-FSET-FILE

On demand

Info...Files...RPM10 Pending Master Files

Identifies aH pending master files defined in the LIBRARIAN
system. A pending masterfile is a new file that has not been
checked in yet A master record exists in the database, but the file
has not yet been checked in to the library.

The fields on this report include the master fileset and pending
master filename as well as the name of its current write mode
secondary. Use this report to review the status of your pending

When to Run

Menu Access
Description

D-SYSTEM-PROFILE
M-APPLICATIOK
M-FILE-SET

RPM10

master files.

Sample

LIRBttIO Ppcllr c ttrcter F i I en Pecei 1

V~ t p i 1 . 00
SVctt l PETDDJIII

I IMARI AII/ I X
IDKRATIIDEI ISDITTDD STSTDIS P rinted i 0 1 / O l / 9 4

T teei l l l 52

Appl I cbtl trt F I 1 e 5et l tet r ter I l l e I D

APPLICATIIDI APPLICATIIDI IAAF

RASTER FILE SET AAS TIR FILE 10

P EIDRII Kl ATK etXIOS, SIDKCE. L I IRDBD PEIDDIIltiAID:tOOOS. RDDI.LIBDEVIL 0 I/Ot/St

penning Abrtet F i l e t

Vereltr t I I 00
5 Vcte I PEtt i U I H

LIDDARIIDI/IX
15%RATItttS IXDITTDD. SISTERS Printed I 01/Ot/94

Tinct 11=52

CeCbterCCI A F P I I C Ct t t r t . Fi l e Se t ttcet c e Fi l e I D

IDSS I CAT IIDI APPLICATIIDI IAKE

IASTIR FILE SET tA STER F1LE 10

NIIX-RXRCE teettnt b l / tetr/ccc/ tcc I lb/I l b p r te i /
tbctOOO. c

cpu tnt b l/cpt/tetr/tebt I lb/1 1 lelcvel/
pbtl /ctcto00 c

01/Ot/St

� r IM I OF DEPTDIT � �

Field Descriptions
Application

Application Name

Master File Set

The unique identifier for the application.

The name of the application.

The name of the master fileset contairung all hlesets and files for
the application.

The pending master filename.Master File lD
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PENDING MASTER FILES REPORT (continued) RPM10

Field Descriptions, continued
Current Write-Mode
Secondary

Date Added

The name of the current write >node secondary.

The date the pending master file record was added to the
application.
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REVISION HISTORY REPORT
SortSequence
Files Accessed
When to Run
Menu Access
Description

Application, Fileset, System, Path, Fil ename
RRH10

D-FILE

On demand

Info... Versions...RRH10 Revision History

Shows the revisions associated with each master file, including the
version created, the revision number, the number of revisions, and
the revision timestamp.

Sample

Repart l L IDO( H ZO

Verellm l I .CO
SVata l PDIOJ I H

Sort Setaence l Jk p l Fi l e St't , Ovate Path T l lteeM

LIISJARIAH/IX

R evlelan H i e t a r f

(PERATIDES HNZRA. SISTERS

PAOel 3

P rlnte0 ) O l / O a / 9 (
f lee:: 11 2 9

EXPLOSI(N OF JVVLICATIJN HFB

HASTER F IlE/REV IS Ilbl( S)

Pf)AD)IN JRPISOOP . BSDZT . 13 ISHOZO

VERSI(N (IKATID REVZSI(N

Vl .00

ICHT REV ZSIIN T IJKSTJVIa

0 HED. OEC 15 1 9 93. 6:99 Je(
r evlatcna f o r t h l � I’ l i e .

NASTIR FICE/REVISZCN(5)

PBEOIZHI JHCIOOOS.S(OOKE LIKHBZO V2 00

Vl. 00

VERSI(N GKATEO REVISION

V2.00lf

V2.00JO
all

ICHT REV I SION TIIBSTAHa

0 HED. DEL 15 1993 a t e a PH

0 I (H I I B Z 15 . 1 9 93, 9145 JN
0 IB D O EL’ 15. 1 9 93 6:e9 AH

JVKTTR FILL/REVISI(OHS)

Pf)AOJIHJA!BROOOS.SKNCE.LIIOSBZO V2 .0 0

V2.00
V2. 00
VI.OO

VERS I(N CIKATID R EVISZIN ICHT REV Z SI(Ol TIJKSIJae’

0 HH) BIZ 1 5 . 19 9 3. a I a t P N

0 HEO DEL’ 15 1 9 93 . 5 .0 5 P H
H EO. DEL 15 1 99 3 2 la0 P H

0 HHL BEL 15 1 9 9 3 2:39 PH
0 I JH) B EC 15 . 1 9 93, 6:a9 lbl

V2,(RIJI . I I
V2.0011
V2.00JO
� 1

l.HONH10

Vteetan l 1. 00
SOota l PD H J IH

Sort Setpenat l AF P I . F if e Sct- Seetee Path FllanNA

Revtelan HletarV

LIDCARI JVI/IO
(PERATI(NS CZNTRR, STSTDIS

PRlel 6

Prlntc0: OI/OA/Sa
T fm’: l l 2 9

C(PLOSI(N OF IPPLICATI(N NFG

JteSTTR FICZ/RIVI SIJN(S)

PHOO/IN ~ . SK OJC E.L I NHBZO V2.00

V1.00

VERS I (N CREA TZO REVZSI(N

V2. 00 l I

Vf (Bll0

IKHT REV Z SICN TIHISTJOP

0 HEB BEL 15 1 9 93 , alee Pn
0 I KD, OIZ 1 5 19 93 . 9l e5 JN
0 IK D B EZ 15 19 93 Bl +9 J N

HISTER FILE/REVISI(N(5 )

atartn Jk l /apt/aa t / teel to / I I tenno / V2. 00
Hc 1000 . C

VIR51(N HKATID J K V I SIJN

V2. Cct I 2

ICHT JK VI S I ( N T I I BSTJOP

0 T)a ) B f Z 1 6 1993. al 02 P H

V2. 00
Vl.00

V2.00: I
V2.0010

0 i KO B E L 15 . 1 9 93 . 1 2 133 Pl l
0 TIK I K c I a 199 3 . 5 : a a pN

HASTER FILE/REVISI(bl(5)

� Catnl el /apt/ taa /ace) lb/ I 1 Ntrac/
ebc2000 C

!CHT NE VIS I IN FINEST JVO’

0 DI J . D I Z 16 f9 93. AJ0 2 P H

V2. 00 l 2. I . 2
V2.(B)12.1. I
V2,0012
V2.0011
V2.00JO

0 I K O D E Z 1 5 199 3 , 5 10 1 P H
0 HED DEZ 15 199 3 5100 PH
2 HH I D E C 1 5 19 9 3 eh 3 ( PH
0 OEO IB Z 15 . 19 9 3. 1 2 C 32 PH
0 TI K D EL’ Za 1 9 93 . 5 :5 ( P H

Vf 00
VI.OO

HASTER F ILE/REF ZS 1(N( 5)

atatnlk /apt/ate/~ IJ O/Jlbpraa/ V 2.0 0 V2.00 2
abc3000 c

VERS I (N CREATED REVISION IKHT REVI S ICN TINEST(ep

0 T)OJ IK C 1 6 19 9 3 a :02 M
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REVISION HISTORY REPORT (confinued) RRH10

Field Descriptions

Master File/Revision(sj

Version Created

Revision

BCNT

Revision Timestamp

Name of the master file and associated revisions,

Version when the master file was created.

Revision number.

Number of' branches associated with master file or revision

Tirnestamp associated with the revision.
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TRANSACTION DETAIL REPORT

Sort Sequence

Files Accessed

When to Run

Menu Access

Description

Date, Time

D-SYSTEM-PROFILE

Prior to running the FLUSHLOG uti l i ty

Info...Log...RTD10 Transaction Detail

Detailed information on transactions and corresponding file
operations since the FLUSHLOG uti l ity last purged audit trail
records. FLUSHLOG uses the aging policy from the SystemProfile
(SP) screen to determine which records to purge.

The information on this report includes type of transaction,
project, step perf'ormed, user who issued the command, logical
device, source and target locations, access mode/access control,
and final status for each file processed. For each transaction, the
report shows the number of files involved, the number of file
movements that failed, and the overall transaction status.

D-TRANSDTL

RTD10

D-TRANSUM

Sample

Rerarrt I LJ UI T DIO

Veeatcrr I I 00

Tt ptapu lan Decal I

LI I%adt ilet/ J X
PEICUIH IPIRATIIBc5 IIBJOn. STSTDC

Pe Joted I 0 I /OC /Bt
Truer 12ISl

Sort ~ I Bat e I Jue

Tpret SUB
� �

DATE TINE C IEK CODE ID RDJTEIPIIGlICT STEP laNE

1 2/I c/91 ! 7 I a5 x r

I Larter Fil e I D

XLID

S UB Prem File 10

USER ID U CI H LOEV FILES FAILED STATIC

ItiR LIXM IPIJEDJIN 17 I 0 0

To Illa ID

PDEBJIIt r DIDOJSS. INSTALL. I. I JABCPDCIJ IH ’ 0 I IJOJSS . OCT ILL . L I X 100

12/Ic/93 18IOO PF C HFG N FFetalINT N FG-UO BJT L IJBCR ac ct talk r dere k on t tttp 5 I 0 C
ICarcev Ftle ID

� pucntkr/apt / cern/mml l b/ I I ~
cbcl OM, c

SUB F~ F i l e 10

C cputnlkr/cert/aca/acaJJb/Ictcrrad/

T o Flic 10

� putnlk- / a p t / a c a / ecol lb/ I l bdevel /
L I OCR/Uc I 000. c

V 0
UCIOOO.c

12/JC/K I 1 8 0 0 PU

Recta F 1 I � I D

acartn Jk /cpt / cca / t eal Jb/ I I teetrd/
Ncc I 000. c

SUB Frtn File ID

accrtnt k r/tert/mor/taxlJ. Ib/I lbdeve I/
L I ACR/~ 1 0 00 . a

L I JBCR

I IDCR taut en ck I l arrak a t tap5

T O File 1 0

1 2/lc/93 18 J02 T O

I taater F l l » ID

PDCUIHJ AIK300CS.DBIKE. L IDRBBI

0 C

9JB Fvc F tl e IO

PEJCUIH: AIK300M. BUNCE L I IPAM

L IDCR D ERDC ICR

.LIXOC .PD CU I H 17 I 0 C

Ta Frle 10

12/1S/93 09: 10 R E T HFG

U 0

V 0

l tcrter F i l e ID

PDEiUI H r IPLAFOJT INST' . L I IPRQD
PDEiUIHJ PREFSBIT IHSTAJ .LI IPRQD
PDEiUIHIIP5CREDt I l tSTNJ .L I IPRQD
PDCUI H I E9TRElet. INST’ . L I DREBI
PDCUI H I APIPDATE. I IISTIEL. LI JPRM
PDCU I H I IEK 1000 J . JO.. L I $%00
PDEBJIHIIEKIMOJ JCL LIJPRQD
PEIEDJIH AIE3OMJ JCL L I O OD
PIJEEQHILJIAIIMJ JCL LIJBSEJD

%BI Frau F i le 1 0

, LIXIXJ rPDCU IH 25 26 0 C

To Flic ID A /H Sta t a

PDCUIH I idIJJTIBJT IHST ILL. LI JPROD
PDCUIH. PREFcBIT.IICTFLL.LDPRQD
PDEIJIHI IPSCREDI IHSTCLL. LIJPRQD
PEJEIJIHI IPSI FJat INSTILL. LIIPRQD
PDEBJIN= IecPMTE INsTALL. L UPRQD
PEJCUIN AIKIOMJ J I L . L I JPRM
PDCUIH=AIE20MJ JCL.LIIPRQD
PDCUIHJAIKBOMJ JCL,LI IPRQD
PDCUIHJLIIAIIM J J CL.LIJPRIEI
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TRANSACTION DETAIL REPORT (continued) RTD10

Field Descriptions
Date

Time

Tran Code

Sub Code

From File ID

To File ID

Appl ID

Route/Project

Step Name

User ID

Login

User LDEV

¹ Files

¹ Failed

Trans Status

Master File ID

Sub

The date the transaction was performed.

The time the transaction was performed.

The code for the type of transaction. For a listing of transaction
codes, refer to Transaction Codes in Reports at the beginning of this
chapter.

The subcode for the transaction. For a listing of transaction
subcodes, refer to Transaction Codes in Reports at the beginning of
this chapter.

The application ID.

The name of the route/project.

The name of the step performed.

The user who issued the command.

The MPE/UNIX login,

The logical device.

The number of files involved in the transaction.

The number of file movements that failed.

The overall status of the transaction (C =Complete, F=Failed).

Name of the master file associated with the transaction.

Subcode for the transaction. For a listing of transaction subcodes,
refer to TransacHon Codes in Reports at the beginning of this
chapter.

Source location for the transaction,

Target location for the transaction.

Access mode (read or write).

Status for the file.Status
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TRANSACTION DETAIL REPORT
SortSequence
Files Accessed
When to Run

Menu Access

Description

System, Filename, Date

D-SYSTEM-PROFILE

Prior to runrung the FLVSHLOG util i ty

Info...Log...RTD40 Transaction Detail

Detailed information on transactions and corresponding fi le
operations since the FLVSHLOG util ity last purged audit trail
records. FLVSHLOG uses the aging policy from the SystemProfile
(SP) screen to determine which records to purge.

From SHOWLOG this report provides two different formats
depending on the type of sort sequence selected. The default sort
is by master filename, resulting in a column for Master Filename
and no Time column. If Date is the sort sequence, the f ormat
contains a column for Time as well as a Date column. This sort
sequence is shown in the samplereport below.

The information on the report includes type of transaction, step
performed, source and target locations, access mode of the file,
and final status for each file in the transaction.

RTD40

D-TRANSDTL D-TRANSVM

Sample

Rtpcrt : LIH ITO40

Vcrvfnt : 1. 00
Svctcc I PENZ JI H

Sert ~ f SVct t t F JJ~ . Octa

Trncvnt Jpn Dctcf I

J.IHORIJV4/1X
J3%RAT IIHS CJJJTRIL STSTKHS

P r fntcd: 0 1 / 0 4 / 9 4
Tfm: 1 1 239

TR SA AJ94

JXJ:54 PF
11232 RE
f f f36 TO
18:02 TO
09210 RE
09243 PF
09444 PF
IOt08 PF
11:49 PF
16:44 PF
14:24 PF
fl :32 RE
16:48 ST
IC:CJ ST
17:05 PF
164%J ST
09 10 RE
I I I 32 RE
09210 RE
11232 RE
09210 RE
11132 RE
09:10 RE
11:32 RE
09:10 RE
11:32 RE
09210 RE
l l :3Z RE
09:10 RE
1123Z RE
09 10 RE
11:3Z RE
14!35 PF
14:40 PF
\4:40 PF
15:00 ST
16PM PU
14:37 PF
14:37 PF
14:38 PF
16nM Pv
17:45 XT
11:58 PU

JZJ DEMI
V NFG
V HFG
V KFG
IJ KFG

CV KFG
Dl KFG
l34 NFG
CV NFG
CV HFG
CV NFG

V HFC
XV NFC
XV NFG
CV KFG
XV NFG

V NFG
8 NFG
8 NFG
V NFG
V HFG
V NFG
8 KFG
V NFG
V KFG
V KFG
8 KFG
8 JOG
V KFG
8 HFG
V NFG
V NFG

JAJ NFG
GV NFG
CV JIFG
XR NFG

R NFG
HV NFC
W HFC
W HFC

V NFC
R XLID
V NFG

SR1598
SR15%I
SR1598

SR1572
SR1572
SR1572

NFTr4IA IHT
HFTr44A IHT
KFC-HA IHT
SRIS|M
NFC-44AIHT
SR1572

DATE T I N E C D CH UJ ~ SIEP HANK FR I34 FILE 10

I 2/23/93
Of /04/94
01/04/9 l
12/14/93
12/15/93
12/15/93
12/15/93
I 2/I 5/93
12/15/93
12/15/93
12/16/93
01/04/94
12/I 5/93
12/I S/93
12/15/93
12/15/93
12/15/93
0 I/04/9 4
12/15/93
01/04/94
12/15/93
Of /04/94
12/15/93
01/04/94
12/15/93
01/04/94
12/15/93
Of/04/94
I 2/I 5/93
01/04/94
12/15/93
01/04/94
12/15/93
12/15/93
12/ JS/93
12/15/93
12/I 5/93
12/15/93
12/15/93
12/15/93
12/15/93
12/14/93
12/I S/93

1 2/IS/93 11 :58 PU V H FG

1 2/14/93 18 :00 PU V K FG

KFG FAIL
NF G- I’8 I L
)6’6-FAIL

HFC � TESTJR
NF6-Ul
NFG-IH

POCUIHtAHGOJXC.RXRCE LIH%GD
PGCUIH J ~ RXREE . L I H %08
PQCUIH AR2000S RXRCE.LIH%OD
PINJGH JOCRJOUS SHRCE. LI H%OD
PIJCUIHJ AIK3DOOS.RXRCE.LIH%OD
PIMZGH AIKRJ005. RXRCE. LI H%GD
PIJCIJIH ~ . RXREE .L I I PRGD
PIMZGH AG 006 . R XRCE.LIH%GO
PGCUIH = JVKSJOOS . 5QJKE . IJ HHSOJ
PGJXJI H. ~ . R XRCE . LI HSDJO
PEJCIG H 148KJDOOS . RXRCE, L I H%08
PEMXJI H: AIK30005 . RXJKE, I. I!PROD
PEJCUIH:67442525 5HJOE.LIH%DD
JSMZJIH G7442775. RXIDE. LIH%DD
PHJZG H = G744Z775. RXRCE. L I H%DD
PEJCU I 8 = G7443231 . BXRCE . LJ JR%GO
PEMXGH 4 LIJDXOOS. RXRCE.LIJHRGO
PEICUIH f LI JR1005. RXREE . LIH%GD
PDCUIH = L JMZJOOS. RXREE . LIH%GD
PElEZG H Lll&HJOS. RXRCE . LIH%08
PEMXJIN JHGXJK6 . 5HRCE LIH%DO
PENJUI H: KFGJXIOS . RXREE . LJ H%DD
PEMiUIH tIRP0255. RXRCE. LIH%OO
PEJCUIH: JRP0215. SHJKE LIH%OO
PEMZJIH: JRP0355. RXRCE LIH%GO
PBClJINJJRP035S.RXRCK LJHRGO
PEJCIJIH J POI 01 05 . SIXRCE . IJ HRDO
PDCUIHJPIGOIOS RXRCE IJIS%GO
PIJCUIH JRT 1006. RXRCE. LIHRGO
PIMUIH 4 JRT I 005. REISE. LJlPRGO
PEMZGH=RPT500S.RXRCE LJH%IXJ
PIMZG H 4 RPT5005. SIXRCK LJH%00
PIMXJIHJ~ . SH RC E . LIDTEST
PIMXJIH - AIK20006 . 5H REX� . L I STEST
PIICIIIN ~ . RXRCE. LI JTEST
PIMXGH IVK200C6. SHlKE. L I STE5T
PDCUIH 4 AJKZOJXC. HXRCE . L IDTE5T
PIJCUIHJJUKRXXC. RXRCE LJJTEST
PEJJXJI H 4 JOKJIXXH . RXRCE . LJ STKST
PEJJXJIHJ~ . SI IR CE . LISTEST
PEMiUI H: AIKIJXXM, QXRCE fJ DIECT
PINXGH:DISXLESS, INST’ . . L IX1JXJ
R tnnf k: / K n / c c c / 4ccf Ib/ I i Ma r I /

DEDDT/KtcZJXJO, c
ccctnf k / t p t / n n / c c t I lb/ I J I M’ I /
OEDDT/tfn3000, c

cpctnfk / c p t / n n t / ccc I fb/ I Jt t fnn I /
L HJCR/Mn 1000 . c

PEJCU IH: AJK20005 . RXRCE . L I IS%CD
PENJU IH: AJKZJXXN . 5IXRCE . L I H%00

PDEXJ IN: AJKI0046 - LJ JVJR. L I DOKVEL
PEJCUIH: ~ - bt t JJL t . L I DDLVtL
PENXJ IH: AJKIOIXH . RIREE. L I DOKVEL

PDCU IH DI SXLES5- I JIST ALL . L I JOXA

PEJCUIH 2 AJX20005. LJ !JCR. L ISDKVIL

TO FILE I l l

PIJCUIN AJKZJXJOS LIHCR LIDOEVIL

PEJCUIH: AJKI0005. LJHCR. LISOEVIL
PIMIUIH: RIK30005. VERIJJICA LIDOKVEL
PEMRJ IH: JOKKXXK. VERHII CA L ~
PEJCUIH: JVKZJXXC . VERRUCA L IDOEVEL
PDCilJIH: JUC30005. JOSEPH. LIDOKVEL
PEJCUIH: AlKI0005 JIJDPH LIDDKVEL

7051

STAT

0 0 0 0

0 0 0 0 0

0 0 0 0

0 0 0 0 0 0 0 0 0

0 0 0 0 0 0 0 0 0 0 0 0 0

0 0 0 0 0

7051
7051
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TRANSACTION DETAIL REPORT (continued) RTD40

Field Descriptions

Date

Time

TR/CD

Date the transaction was performed.

Time the transaction was performed.
Transaction code. For a listing of transaction codes, refer to
Transaction Codes in Reports at the beginning of this chapter.

Access mode (W = write, R = read), For a listing of transaction
subcodes, refer to Transaction Codes in Reports at the beginrung of
this chapter.

Application ID.

Route/project name.

Name of the step performed.

Appl ID

Route/P roj

Step Name

From File ID

To File ID

Status

Source location.

Destination location, if applicable.

The status for the file,

0
6000 — 6500
7000 — 7500
7501 — 8500
8501-9998
9999

Completedsuccessfully
CIERR. Error is STATUS — 6000
FSERR, Code is STATUS — 7000
IMAGE Error Error is STATUS — 8000
Internal OCS/LIBRAIGAN error
System failure
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TRANSACTION SUMMARY REPORT

SorfSeQuence
Files Accessed

RTS10

When fo Run

Menu Access

Des cripfion

Date, Time

D-MEMO
D-SYSTEM-PROFILE
D-TRANSUM

Prior to rurming the FLUSHLOG uti l i ty

Info...Log...RTS10 Transaction Summary

This report produces surnrnaries of transactions since the
FLUSHLOG util ity last purged audit trail records. The
FLUSHLOG util ity uses the aging policy from the System Profile
(SP) screen to determine which records to purge.

This report provides an overview of the transactions that
occurred. However, it does not report the status of individual fi les

This report has the option of displaying the memo text entered for
each transaction with the optional MEMO command parameter. If
you want the text listed, respond with the letter Y to the p rompt.

within each transaction.

Sample

LIDIT510

Vereleo I 1 . 00

T r ~ lcm Sve e a rV

L I DBIRI ZW/ ZX

Pahez I

PDCUIH IBSRATIZWS CIBITT83 SVSTEHS
pezeteoz 01/Or/Sr

T t~ z 1 3 1 0 0

TTBW SUB APPL

Sor I. t a e f t rar z h a te , T lee

DATE T IKE CO BE CGDEID RZBJZK/PROJECT STEP IBWE I&ED IO LIB ;ZH

12/lr / 9 3 1 7 I2 7 XF XLIB

USER � r TRAHS
LGEV FILES FAILED STATUS

I BDI .L IXZ BI IPDCUIH 17 0 0 F

TRAH SUB APPL USER � � TRANS
LDKV FILKS FAILED 574TU5

ICR .LJXCrt Z P D C UI H 17 I 0 C

IBITE TI RE CO D E CDOE 1 0 IBI JTK/IHBZJICT STEP IBWE USER ZO LJCIH

12/lr/93 17tr5 XV

TTBW SUB APPL
� � ITBBIS

LDEV FILES F411EB ST4TUSDATE TI NE CGB K CZZBK ID RDJTK/FTIGJECT 5TEP HWE lEER ID L I C Z H

12/l r / 9 3 ZBZOO PF C HFG HFS- r rAINT F FerZGBN LJ IB C R Hattolk Z~ c n t t 805 1 0 C
I I cero thie flit for 2 oavo to fix 4 Ieoozc vz tk crrrtJFB.
I

TRAN SUB APPL
USER � � TRANS
LGEV FILES FAILED STaTUS

12/14/93 18 0 0 pU

DATE TINK cGBE cGDE ID BIIJTK/PIBLJEET 5TEP IewE UDKR ID LJKIH

LIDCR r rar t n l k

I I l ’ r e eaHA. I t i r zn b at lm p oe t I Bc 123r voz~ 3 .

1 0 C

I THJA r l« l e o ooo l e t
,

TAIW SUB APPL

12/lr/93 18 02 TG

DATE TI RE CO DE CGDK I D R ZBJTK/FRCLlKCT STIR HARE lEER ID L I C I H
U SIR � � TRANS
IJBV FILES F 4 11ED ST4TUS

ICR .LI XGA I PDCUIH 17 1 0 CLIIBCR

I Heedao to f o r te a re ot v rplle v r l o h 1 842,

R eports 6 - 4 3



TRANSACTION SUMMARY REPORT (continued) RTS10

Field Descriptions
Date

Time

Tran Code

Sub Code

Appl ID

Route/Project

Step Name

Date the transaction was performed.

Time the transaction was performed.

Transaction code. For a list of transaction codes that appear on this
report, refer to Transaction Codes in Reports at the beginning of this
chapter.

Subcode for the transaction. For a listing of transaction subcodes,
refer to Transaction Codes in Reports at the beginrung of this
chapter.

Application ID.

Name of the route/project.

Name of the step performed.

The user who issued the command.

The MPE/UMX login.

The logical device.

Number of files involved in the transaction.

Number of file movements that failed.

Status of the transaction

C Completed
F F a i led to complete

UserlD

Login

User LDEV

¹ Files

¹ Failed

Trans Status
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USERS REPORT

Sort Sequence Use r ID

Files Accessed D-s YsTEM-PRQFILE

RUD10

D-USER-CAPS
M-USER

When fo Run

Menu Access

Description

On demand

Info...Rules...RUD10 Users

This report lists LIBRARIAN users. For each user, their
capabilities and current status are shown. For users with
Application or Project Manager capability, the associated
applications are listed in addition to user information.

Sample

Raperi. i LI Ea(OOIO

Veraicm i 1 OO
6 9aiau i P EM Bl l H

L I EVTRR IRH/ 1 X
(PEROTI(9(6 (XBTTRD

PaBei !

PrifTredi
Tiuei l l ( 19

IO

JOSEPH

LRRRETT

LI IBRB(

Jcaarph ~

LIV(RBY

LIIB(TV(luu( WOVEN%

Namur( 1 Eaaru

H abxLj I ap a r r i u u l m

Eeet u 3ahcxm

V ~ l ea B lu e

OeaOV Brace

LIIVVRI(V( Iae(OOER (UX)

Paul RVlie

Oa Teui Veer

Field Descriptions
User ID

User Name

User Phone

Active

Unique identifier of the LIBRARIAN user.

Full name of the user.

Phone number of the user.

Indicates whether the user is currently an active user (Y=active
user, N =inactive user ).
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USERS REPORT (continued)

Field Descriptions, continUed

RUDt 0

Cap The user's capabilities:

L
A
R p

X NONE

LIBRARIAN manager
Application manager
Rule administrator
project manager
Operator
Unrestricted X command access
No capabilities

0

Appl The application for which the user has the special capability.
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PROJECT AUTHORIZATIONS REPORT

SortSequence

Files Accessed

RUP10
User, Application, Project Name

D-PROJECTS
D-SYSTEM-PROFILE
M-USER

When to Run

Menu Access

Descripfion

On demand

Info...Rules.�RUP10 Pro j ect Authorizations

Lists project information for each user. The information includes
the project, the project manager, the status, and the date the
project was opened.

Sample

1 � x � ssxx � ssxs � SS � � \ � � S � X � � S � � � S � � as �

� USER : de bbb x

� HaKE : Dsfxxf Ters f 1115er

� FFEETE l x2e53

� xsssssss � � � \ � sess � essex � ssxssxss � s �

L ITSY’IO

Versf~ : 1 .00
S ffefes I PD EX I I H

Sert. 5eaaxneel U s e r. asff fleer lcm. prb2eax fbae.

f.IlsffeIIfsf/ TX
~T I E STS EleffllEL SYSTEM P r lnbee I OI/b f / Sa

T lsel l l l l x

KFG SR 1522
SR1598

F lx b x xx b v f s l x x i e n p r b b f e l n KF52000 ss 1 . 03 2 KF&t & l lff LIlse3T TP 12/ 15 / SI
Flx sxrifc overf lew febbf e l n a x I r ~ fen ~ I ffT LI SCR EE 12/ 15 /5 3

Field Descriptions
Appi

project Name

Description

Route

Proj Mgr

Status

Date Opened

Application for which the user is authorized.

Name of the projects for which the user is authorized.

A short description of the project,

Name of the route corresponding to the project.

Name of the project manager.

Initial status of the project (OP=open, DC=documented ).
Date the project was opened.
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STEP AUTHORIZATIONS REPORT

SortSequence

Files Accessed

Application, Route, Sort Number, Step, User

RUS10

When to Run

Menu Access

Description

D-STEP
M-USER
D-USER-STEP
D-SYSTEM-PROFILE

On dexnand

Info...Rules...RUSIO Step Authorizations

Lists the authorization infoxmation for all defined steps. This
report provides detailed information about the step including the
authorized users and the access mode available for each user. In
addition, steps without authorized users are listed. Inactive steps
and users are identified.

Sample

Aepoet : L I IS OEI I 0

Veto (tat : 1. ( E l L I (RNll pt(/lX

Steo out)ear taatttau:

Pelotedl o l / ( )e /94
PE)KV I A IPERATI(5(5 CIE(TREL STSTE)(5 TI~ : I l l l S

APPlloat.l~ Route . Se t t )t o S tep . Ue e e

STEPS FN( aVTLICATI(5( IOG

SS(T
A(I!TE 10 (e)

AUBESIIEEII
USER ID 115E R WWE

(a � Ih&t ( K ) ( � I ooo t IK )

JRIEPH
VER(SII CA
daOOV
put(

VER(S(1 CA
dttaov
paul

Field Descriptions
Route ID

Sort No

Step Name

Unique identifier of the route.

Number of the step within the route.

Name of the step.
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STEP AUTHORIZATIONS REPORT (continued) RU S I 0

Field Descriptions (continued)
Authorized User ID

User Name

User Phone Number

Access

User Active

User ID of persons authorized to use the route.

Full name of authorized persons.

Phone nuxnber of the user.

Type of access (W r write, R=read ).
Indicates whether the user is active.
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FILE VERSIONS REPORT
SortSequence
Files Accessed
When to Run

Menu Access
Description

RVD10
Version ID, File ID

D-FILE

On demand

Info... Versions...RVD10 File Versions

Identifies all files in a version. The information for each file
includes the version ID, version count, generation count, the date
and time of last modification, the user who performed the last
step, and the access mode of the file.

Sample
H elen: I LI RIV D I O

veraccm I 1. 00
Sgacca ; PDC U I H

File V cra i a d

LI QlPRICVC/IX
OPERITIQgi EQITIOZ SYSTDCS

P~el I

Pri a ced I I / ac/ D c
i lae l 111 3 1

veralal ID Fli c ID

FILES FlÃ VERSION VZ 00 OF APPLI CAT ION KFG

SYSTIR r PDCZIIH PA T H = IN S TALL.LIQViOD

VERS ICH
TTPE VER S IQI IR E ATEIi QXKT

CPLA YCZJT
APREPQCT
APSGREDI
AFSTRDB
aelPGATE
Olg IOOOJ
BXZOOCU
IHCXXKII
LIHXIOOJ
LI ICOXi03
G1736256
GSRTI170
052a5176
05307C50
667264cz

P0101 OP
IBT I OCP

Alg:10005

H il

GRXOC 16Z
GCZI5207
674C2526
67ac2775
67ae3231

N N H N N N N Ql

H H H H

N N H H Ql

Ql
GN
GH
GH

V1.00
Vl.00
V1.00
V2. 00
V2. 00
V2. 00
Vl. 00
V2. OO
V I . 00

V I .CXI

V1.CO
vl,aa
Vl, aa
Vl 00
Vl . 00
V 1 . 00
Vl . 00
V I . 00
VI.OO
VI.IXI
V1,00
VZ,OO

ICFG
KFG
KFG
ICFG
IOG
ICFG
NFG
ICF C
ICFC
HFG
NFG
HFG
ICFG
NFG
NFC
NFG
ICFG
ICFG
ODCT NF G- lalIICT
ODXI DD XF NBIHT
KFG HFG- CBI HT
KFG
HFG
KFG
NFG NFG aB I H T
ICF 6

L IM B
L IM B
LI iggB
LIM B

IOSEPH
L llagB
IOGEPH

LIMiR
LIMiR
LIMB
LIMB
LIMB

QI
Gll
Ql

LIQCVD I 0

Veraltm I 1 . 00
S gacea I pDI ZI I H

I lie Vera iaa

L IRO|VIICVI/ IX
IPERATIQD CQIIRCL SYSTDCS

Pager Z

Pr l ated= I / OC/ O C
I lar e 1 1 131

veral<n ID. F i l e I D

OF IPPLIEATIQC NFG

SYSTEH s y acai k PAT H /c CH / a a a /aea l l a / I IC aecel

VDISIOH
TYPE VER S I QC CBEATEO CZ ICT

g07255C I
626CC253 I

, g260aoc7
. g3066613
. g322ZIIZ
, 66611761
. 6706CZOC
. 671%6235
. 67070212
abc1000. c
abcZCXXI . c
ala30CO. c

Qi
Qi
GN
GN
Ql
GH
CH
CH
GN

Vl.aa
Vl.aa

V2 . CXI
V1.00
V2.00
V2 00
V2. 00
V2 00
V2. 00
V2. 00

KFG
NFG
HFG
HFG
HFC
HFG
NFC
HFC
HFC
HFC
HFG

NFC-HAIRY
HFG-IBIHT
HF G-ICA IKT

NFGNBIKT

N N
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VERSION DETAIL REPORT (continued) RVDl 0

Field Descriptions
Name

Type

Name of file.

Type of file:

M S GM
Master
Secondary
Generated master
Generated secondary
Copy of generated master
Copy of generated secondary

GS
CM
CS

Version when the master file was first introduced.

Version count (VCOUNT).

The generation count (GCOUNT).

The last application that processed the file.

The last route that processed the file.

The last step that processed the file.

The last user who processed the file.

The access mode (W=write, R=read).

Version Created

Version Count

Gen Count

Last Appl

Last Route

Last Step

Last User

Acc Mode
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FILE VERSIONS AND TIMESTAMPS REPORT

SortSequence

Fiies Accessed

Application/Fileset, File ID

D-AHF SET-COMP
D-AHFSET-FILE
D-APPL-VERSION
D-FILE
D-FSET-COMP

On demand

D-FSET-FILE
D-SYSTEM-PROFILE
D-VFSET-COMP
D-VF SET-FILE
M-APPLICATION

M-FILE-SET

RVT10

When to Run

Menu Access

Oescription

Info�.Versions...RVT10 File Versions and Timestamps

Identifies all files in an application or fileset and highlights any
changes made outside the LIBRARIAN pxogram Shows version
and timestaxnp information for each file, including version ID,
version count, generation count, modification timestaxnp when
the file was created by LIBRARIAN, and the actual modification
timestamp for the file,

If you select the "AT" option while generating this report, all
secondary files at the location specified will be selected, rather
than the master files

Sample

L11ˆVT10 File vervtteet wet Tl teepe Peoet 3
verplcm t 1.0 0
55ete : PE)EE IIH

LIIFIAAIIW/IX
IPtRATIIDIS CtPAI51. SYSIEHS

Prl rtteot 0 I / O t / 9 t
Tl~ t l t r3 /

APPl 10/File See Elle 10

EXPLQIIIW OF FILE SET PATDt-203 FILESET TYPE: IEDR

� DE)CTES DISCRDVVKY DETIIEEH IPITE LIIFtlIIIFW IDIFATID FILE IWO ACIIPIL FILE tp)DITICATIIW DATE

FILE VER CEH FILE IEI I F I CATIIDt DATE I’ILE K I I F I CATIIDI WITE
TYPE tlPIREHT VERS IOH VERS IIW CREATED CHT CHT (LIIWAAIAH CRDITED)SYSIEH t FILE)VWE

TACTUAL FILE LADIL)

PI)AD)IHt RRDOOOS.SIDItCE.LIIDVIDD I 3 Jtet e 199 t . Io t 2 9 I W 3AH e 1 9 9t . Io t 2 9 tW
LllptVT10 File verpt xm Wet te e preepe

peretz I 1 . 00
Spetee 1 PE) EiUIH

~ 5eeteerept Appl ID/Ftle Set.. File ID

LI IWAR I IW/IX
IPIRAT I IPIS ISPITI53 StSTI)CS

P rtrlted t 0 1 /O t / 9 4
T teel I l t37

IXPLDSIOtt DF FILE SET PATIDt-203

TILE SCTt SR156t

e DE)ANTES D SOaFFIKY DETHEEH DATE LEIIIIVIIIW ISIFATIII FILE IWD ACTUAL FILE IES)IFICATTIW DATE

FILE VER CEH FILE IE)DITICATIIW DATE FILE te)DIFICATIIW DATE
TYPE CIIDIDIT VERSIIDt VEASIIW CREATED CHT CHT ILIIDIAAIIW CREATED)srsTEHt F ILEtewE

IACTUAL FILE LADEL)

• etwrrlk t /a p t / r e p / c cp l l p / l t ep r po/ tt V2 .00 V2. 00 2 3 D E L 16 . 1 9 93 . et 0 2 P H I !EC 16 1993 e t0 2 P HweIOOO 0
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FILE VERSIONS AND TIIVIESTAMPS REPORT
(continued)

Field Descriptions

RVT10

Fiie name

File Type

Name of the file in the application fileset.

Type of file:

M S GM
Master
Secondary
Generated master
Generated secondary
Copies of retained master
Copies of retained secondary

GS
CM
CS

Current Version

Version Created

Vent

Gent

File Modification Date
(LIBRARIAN Created)

File Modification Date
(Actual File Label)

Current version number.

Version when the file was first introduced.

Version count (VCOUNT) for the hie.

Generation count (GCOLtNT) for the file.

Last date and time the file was modified by LIBRARIAN.

Last date and time the file was modified (outside LIBRARIAN).
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FILE VERSIONS AND TIMESTAMPS
EXCEPTIONS REPORT
SortSequence
Files Accessed

Application/Fileset, File ID

D-AHFSET-COMP
D-AHF SET-FILE
D-APPL-VERSION
D-FILE
D-FSET-COMP

On demand

D-FSET-FILE
D-SYSTEM-PROFILE
D-VFSET-COMP
D-VFSET-FILE
M-APPLICATION

M-FILE-SET

RVT20

When to Run
Menu Access
Description

Info... Versions...RVT20 File Versions/Timestamp Exceptions

Identifies all files in an application or fi leset that have been
changed outside LIBRARIAN. Shows version and timestarnp
information for each file including version ID, version count,
generation count, modification timestamp when the hie was
created by LIBRARIAN, and current modification timestaxnp in

If you select the "AT" option while generating this report, all
secondary files at the location specified wil l be selected, rather
than the master files

the file.

Sample

LID(V)20 File ve ra (cad dec( Tcaaatdac Ecamptccec: Page: I
V era lan l 1. 0 0
Svacwc l PE )CD) IH

LI (Evv(Ice(/1 x
(PEART I (WS (39(TTCS SVSTEHS

Prcnced 1 0 1/0( /S c
T lac( 11 137

appl ID/ F i l e Se . ( l i e I O

IXPLOSI(W OF FI(E SET PATCH-203

c DE)d)IES O~ BE) SI C DAT E L I (9(N(ICW CREATED FILE CWO CV3)SR FILE KIOIFICATI(W BATE

STSTEH c FI(J)VWE

� PE)52)IHc~ . 5(XB CCE LIIPR(m

� apatnlk c/apc/aea/capi t a / 1 (ccprcal/

H V2 OO

H V2. 00

I’I LE vER GIH FILE cc)BIFIGATI(9( BATE I’ILE )B)OIFIEATI(w (9)TE
TCPE CIHREHT VIRSI(W V U ISICDC (REATED CHT CHT (LI)9(CVBcW CRERTED) (~ I ’ ILE lA BEL)

2 e J (W 4, 199 c 1012 9 (W J /W 4 , 199c 11136 Acc

3 e B E C 16 199 3 ecOQ PH DW 5 199e 1 1 133 Aac

1 1 e vera c ced dec c e e etcap Page( 2

vera(ca c 1 .00
Sgace c PE) 52)IH

LI)9(cwlcw/cx
(95)gc TI(WS CEHTR(R

PrInted; OI / Oa/Sc
Tinct 1 1 1 37

Appl IO/F(1e Sec. File ID

EKPLIElIOH OF FILE SET PATCH-203

FILE SET( 5R1598

� BE)c)TES DISC)BP(VKT BE)i%EH DATE LJ(9()VUGH CREA)ED FILE clgl ACT(a)L FILE (g)DIFICATI(W DATE

F ILE VER GEH FILE ldBIIFICATI(W DATE FILE 1510IFICATT(el DATE
TVPE Cll(REHT t93(SI(W V IRSHW CREATED CHT CHT (LI IVCCV(ICV( CREATED) (~ F ILE LA BEL)

3 e O E C 1 6 19 9 3 e (02 P H JAH 5. 199c ( I ( Xl (W

SISTER l F I LEHAHE

� ceactnck c/apc/cate/cad)10/Icaprad/
alcC2000 C

c � Ml OF REPIS(T � �

6-54 L IBRARIAN/IX Reference Guide



FILE VERSIONS AND TIMESTAMP
EXCEPTIONS REPORT (continued)

RVT20

Field Descriptions
Filename

File Type

Name of the file in the application fileset.

Type of file:

M S GM
Master
Secondary
Generated master
Generated secondary
Copies of retained master
Copies of retained secondary

GS
CM
CS

Current Version

Version Created

Ver Cnt

Gen Cnt

File Modification Date
(LIBRARIAN Created)

File Modification Date
(Actual File Label)

Current version number.

Version when the file was first introduced.

Version count (VCOUNT) for the file.

Generation count (GCOUNT) for the file.

Last date and time the file was modified by LIBRARIAN.

Last date and time the file w as modified outside of LIBRARIAN.

R eports 6 - 5 5
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Macro Control Language

Macros are files containing LIBRARIAN commands, They can operate
either on a single file or on a group of files, and can take parameters.
Macros can also contain looping and conditional logic by using the
LIBRARIAN macro control language.

This chapter describes the control language you can use in macros. The
following topics are included:

� Ex ecuting Macros

� Ed i t ing Macros

a Ma cro Filelists

� Ma c ro Parameters

� Co m ments in Macros

� Us i ng STREAM and RUN Commands in Macros

� Ma c ro Control Language Summary

� Ma c ro Control Command Descriptions and Syntax

For more information on using macros, refer to Chapter 9, "Macros" in
the LIBRARlAN/iX User's Guide.

Executing Macros
To execute comrz~ds in a macro file, type the name of the macro file at
the LIBRARIAN prompt. For example:

>PAYFILE

If the macro filename is the same name as a LIBRARIAN command or
step, precede the name with XEQ. For example:

>XEQ CHECKIN

For details on using the XEQ command to execute macros, refer to
Chapter 1, "Commands".

Macro Control EangNage 7 - I



Editing Macros
You can create and edit macros with any editor. Macros must be saved as
ASCII files. A macro file can contain system commands, LIBRARIAN
commands, and special macro control language commands, as described
later in this chapter.

System commands, if ambiguous, must be preceded with a colon (:).

Use the ampersand (k) for MPE, or the backslash (k) for UNIX as a lineNcIfe
continuation character in rnacros.

Macro Filelists
Macros can process lists of files. In addition, procedure files can contain
macros, as discussed in Chapter 9, "Macros" of the LIBRARMN/iX User's
Guide. To do this, include the following statement as the first nonblank
line in the macro file, or procedure:

The macro processor then expects you to specify files as the first
argument when you execute the macro (see the beginrung of Chapter 1).
The following example executes a macro called DISTRIB with a set of

OPTION FILES

files:

> DISTRIB @.OBJECT. PROD

> DISTRIB ./prod/object/*

The macro processor explodes these files in the same way as the VERIFY
command. You must fully qualify fi les that are outside your current logm
directory.

Macros also let you authorize files based on a specified step, For example,
the files will be authorized as though that step was about to be
performed, but the step action wil l not be taken. This feature allows you
to authorize the macro for specific users (by authorizing the step), to
default locations, and to define file scope through the step fileset, source
location, and step refinement exclusions. Macro authorization by step is
done by specifying the following statement as the first statement in the
macro file. For example:

OPTION FILES=stepname [,route [.application ] ]

When using OPTION FILES, the macro processor builds a listfile called
XEQLIST, containing the authorized files. You can refer to this listfi le
within the macro to operate on these files. The following example
authorizes files using the CHECKIN step, performs the step, and then
distributes the files to a remote system.

UNIX

OPTION FILES=CHECKIN
CHECKIN!XEQUST
DISTRIBUTE *; NOVIOLATIONS
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The files that comprise XEQLIST can be referenced one at a time, using
the %%[] parameter. For more information, refer to the %% [] parameter
in the following section.

User-Defined Help
Help for macros will display user-defined help included in the macro file
or procedure. The help text must be entered first, immediatelyfollowing
the OPTION statement, if one exists. Precede the help text by a vertical
bar ( I ) in the first column. For example:

PROCEDURE xyz
I This is help text.
I See how it works
ECHO OFF
TEST-CMD
END

or

OPTION FILES
I This is help for a macro file.
I See how it immediately follows
I the OPTION file statement.

If no help text is provided, the macro itself is listed unless OPTION
NOHELP is specified.

Macro Parameters
This section discusses the parameters that you can use in your macros.
You can use parameters to substitute values at execution ti me.
Parameters can take values such as filenames (specified when you
execute the macro), user-supplied parameter values (specified during
execution or with the PARM command), or system defined parameters.

Prefix all parameters with two percent signs (%%). The first % designates
the position where the substitution occurs

Valid parameters include:

0/ 0/ [ ] Substitutes filenames between the square brackets
(applying an optional edit mask enclosed in the
brackets). This parameter is valid only when you
use OPTION FILES. If you do not use this parameter
within a LOOP/NEXT structure, the command wil l
be iterated for each file specified.

You can transform filenames by placing edit masks
inside the brackets of the parameter%%[]. For
more information about edit rrtasks, refer to Edit
Masks at the beginning of Chapter I, "Corrunands."
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0/ Q/ +

%%G

%%N

%%0

%%P

%%A

%%E

%%0-99

If you specify a filename in the LOOP/ NEXT
structure for each iteration, the next record in that
hie is substituted wherever %%' is encountered
within the loop.

Substitutes the value of the user-supplied
parameter with the specified number from 0 to 99.

Substitutes the current login account.

Sends an escape character (for video
enhancements).

Substitutes the current login group.

Turns on line drawing (CONTROL-N).

Turns off line drawing (CONTROL-O),

Substitutes the project name supplied by the user
during OPTION FILES authorization.

Substitutes the current system name.

Substitutes the current login user.

or system defined variable enclosed in parentheses.
The exclamation point (!) is optional.

%%S

/'/ U

%% (! variable name) S u b st i tutes the value for the MPE/iX or LrMIX user

Like variables, you can reuse the parameters%%0 thr'ough %%99. In the
following example, parameter zero is reused.

PARM 0;PROMPT ="Enter your user ID"
IF "%%0" ="DEBBY" THEN

PARM 0;PROMPT ="Enter your security access code"
IF "%%0"="DUMMY" THEN

A parameter retains its assigned value until you change it

You can use additional macro parameters whose values are determined
by the current file being processed (i.e., in a LOOP...NEXT block or on a
line that refers to %% []):

%% (!OWNER) The ow n e r o f the fi le.
%% (! MSUSER) The ID o f the user who checked out the file.
%% (!TAG) The file's tag.
%% (! PROJECT) The na m e of the project this file is associated with.
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Forexample, you can automatically send mail messages to the owner or
checkout user of the file being processed. The following exa,rnple
illustrates this,

OPTION FILES = CHECKIN
LOOP

COMMENT Store off owner prior to checkin
PARM 1 = "%% (! OWNER)"
CONTINUE
CHECKIN %%[]
IF I IBERRORS>0 OR I IBFAIL>0 THEN

MAIL %%1;CHECKIN FAILED for /%[]
ELSE

MAIL %%1;CHECKIN SUCCEEDED for %%[]
ENDIF

NEXT

Comments in Macros
Comment lines can appear anyw'here in a macro. Comment lines start
with an asterisk (' ) or vertical bar ( I ).

Using STREAM and RUN Commands in Macros
When using the STREAM and RUN commands in a macro, you can
include input to them in the macro fi le. Input to STREAM would be JCL
lines, and input to RUN would include program input such as responses
to prompts. Do not precede this input with the LIBRARIAN prompt (>)
or the MPE prompt (:). Instead, use an exclamation point (!) for JCL.

For the RUN corrunand, use the STDIN parameter, setting it to XEQ (i,e,,
STDIN =XEQ). Do not precede the RUN command name with a colon.

For STREAM, do not specify a filename L i nes from the macro file are
passed to your program (RUN) or to a jobstream (STREAM) with
parameter substitution unti l ">" is encountered on a separate line.

Macro Control Language Summary
The macro control language coznrnands allow you to

� tu r n command echoing on/off, or display a message,

� co n t rol command flow through conditional logic and looping

� refer to files,

a set default values for parameters,

� de f i ne procedures,

� pr ompt users for parametervalues.

structures,
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Table 7 — 1 lists the macro control language commands and functions. Page
references locate the detailed command descriptions.

Table 7-1. M a c ro Control Language Commands Summary

Command Name Fu n c t ion

ADJUST

CONTINUE

Adjusts a JCW value up or down.

Indicates that macro processing should continue if an

Turns echoing on and off, or displays a message,

Signifies the end of a procedure or signals premature

Resumes execution at a specified location.

Executes the interverung block of commands if a
conditional expression is true.

Executes a block of commands for each file in a
filelist, or each record in a specified file

Controls default menu mode operation.
Specifies macro options.

Sets default values for parameters in macros,
ophonally prompting the user, or providing a menu,

Specifies the name of a procedure.

Executes the intervening block of commands until
a conditional expression is true.

Assigns a value to a macro variable.

Allows you to pause macro processing with a message.

Executes the intervening block of commands while
a conditional expression is true,

GOTO

IF/ELSE

ECHO

END

MENU

OPTION

PARM

LOOP/NEXT

PROCEDURE

REPEAT/UNTIL

SETVAR

WAIT

WHILE/ENDWHILE

error occurs.

terminahon of a macro

Page

7 — 21

7-19

7-20

7-14

7-15

7-16

7 — 13

7-11

7-12

7-9

7-10

7-7

7-23

Macro Control Command Descriptions anci Syntax
This section contains descriptions and syntax for all macro control
language commands.

The macro control language command descriptions include the following:

Syntax

Parameters

Operation

Examples

How to enter command.

Detailed description of each command
parameter.

The basic function and detailed descriptions

Examples of the command.

of the command.
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ADJUST
Adjusts a JCW value up or down.

Syntax
ADJUST JCWname, increment

Parameters
JCWname The n am e of the JCW.

increment A positive or negative number (often 1).

Operation
ADJUST lets you adjust the value of a JCW up or down. This is useful when creating loops
from 1 to n. If the JCW does not exist, it is created with a value of zero.

Example
Adjust the JCW MYJCW by typing.

ADJUST MYJCW,1
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CONTINUE
Indicates that macro processing should continue if an error occurs.

Syntax
CONTINUE

Parameters
None

Operation
CONTINUE lets you indicate that if an error occurs, processing of the macro file should
continue. The CONTINUE comznand must precede each command for which this behavior is
desired. If you do not use CONTINUE, the remainder of the macro file is not processed.

ExarnpIe
In the following example, if an error occurs during checkout, processing should continue:

CONTINUE
CHECKOUT ’/’I []
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ECHO
Turns echoing on and off, or displays a message.

Syntax

ON
OFF
NULL
STDLIST
[ PROMPT j message

ECHO

Parameters
ON

OFF

NULL

STD LIST

PROMPT

message

Turns ON echoing of commands in the macro.

Turns OFF echoing of commands in the macro.

Redirects LIBRARIAN output to $NULL.

Restores LIBRARIAN output to SSTDLIST.

Echoes the specified message without a carriage return.

The message displayed to the user. Omitting message produces a blank line.

Operation
ECHO lets you toggle the echoing of commands to ON and OFF, display a message to
STDLIST, and/or redirect LIBRARIAN output ,

Example
Turn the echoing of commands off by typing:

ECHO OFF

M acro Control Language 7 - 9



END
Signifies the end of a procedure in a procedure file, or premature termination of a macro
being processed.

Syntax
END

Parameters
None

Operation
END marks the end of a procedure in a procedure file. Additionally, you can use the END
command to terminate a macro permanently.

Example
The following example shows a procedure called SJJ, terminated by END:

PROCEDURE SJJ
ECHO OFF
S HOW JOB EXEC; JOB= @J
END
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GOTO
Resumes execution at a specified location.

Syntax

GOTO label

Parameters
label The location where the macro should resume execution.

Operation
GOTO allows you to resume executing a macro at a specific point. The label must appear
after the GOTO statement in the format:

label:

Example
Start execution at label ERROR: by typing:

GOTO ERROR

ERROR:
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IF/ELSE
Executes the intervening block of commands if a conditional expression is true.

Syntax

IF EXIST filename
EXISTTEMP filename
"string1" = "string2"
"string1" IN "string2"
JCWname/value <re/op > JCWname/value [THEN j

ELSE
ENDIF

Parameters
EXIST filename

M E EXISTTEIVIP filename

"string1" = "string2"

"string1" IN "stri ng2"

JCWname/value

relop

True, if the file exists in the permanent domain

True, if the file exists in the temporary d omain.
True, if the two strings match.

True, if the first string is a substring of the second substring.

The relational operator. Valid operators include:

The name of a JCW and/or a value,

equal to
not equal to
less than or equal to
greater than or equal to

Operation
The IF/ELSE structure executes the intervening block of' commands if the conditional
expression is true. IF statements can be nested, and can exist within loops:

Example
In the following example, when the condition is met, "Your JCW is set to zero" is printed. If
the condition is not met, "Your JCW is not set to zero" is printed:

IF LIBJCW = 0 THEN

ELSE

ENDIF

ECHO Your JCW is set to zero.

ECHO Your JCW is not set to zero.
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iOOP]NEXT
Executes a block of commands for each file in XEQLIST (the listfile created when an OPTION
FILES macro is invoked), or for each record in a specified file.

Syntax
LOOP [f ilename ]

NEXT

Parameters
filename By default, LOOP executes the block of cornrnands for each file in XEQLIST,

substituting the current filename wherever %%[] is encountered. If you
specify a filename, however, the LOOP is for each record in that file and the
data in that record is substituted wherever %%' is encountered within the
loop.

Operation
The LOOP/NEXT structure executes the intervening block of commands for each authorized
file. If you want to execute several commands on a group of files or records in a specific file,

The current filename is substituted wherever the %%[] parameter is located, Mlhen using
LOOP/NEXT in a file other than the default XEQLIST, use the %%» parameter wherever you
want the current record to be substituted. For more information on the %%[] and %%'

parameters, refer to Macro Parameters, earlier in this chapter.

use the LOOP/NEXT structure.

Note Loops cannot be nested.

Example
The following example shows a LOOP/NEXT structure:

LOOP
<command t >
<command 2>

NEXT
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MENU
Controls default menu mode operation.

Syntax

FILE
LAST
MACRO
MAIN
OFF
STEPS

Parameters

MENU

FILE

LAST

OFF

STEPS

MACRO

MAIN

command mode.

Opens file menu init ially and any time user returns from command mode.
Always returns to the last menu that was open when returning from

Opens macro menu initially and any ti me user returns from command mode.
Displays main menu initially and any ti me user returns from command mode
(default).

Bypasses menu mode and brings user directly to the command line prompt.

Opens the steps menu initially and any t i me user returns from cornrnand
mode.

Operation
The MENU command is designed for use in an AUTOXEQ file to control which menu
appears, by default, if any. If you want to bypass menus altogether when accessing
LIBRARIAN, then use the MENU OFF command in your AUTOXEQ file.

Example
Turn menus off so that only the cornrnand mode prompt appears:

MENU OFF
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OPTION
Specifies options to control the execution of macros.

Syntax
OPTION [ FILES [ = step [.route [.appl ] ] ] ]

PARMS

NOHELP

step The name of the step to authorize files.

Disables help for this macro.

ONEPARM Al low s t he user's input (data supplied on the command — line) to be

within another macro (parameters are global by default).

[, FILES ]
[, LOCALPARMS ]
[, NOBREAK]
[, NOHELP ]
[, NOWARN ]
I, ONEPARM ]
[, PARMS]
[, QUIET]

Parameters
FILES Requires a user to specify files when executing the macro or procedure. You

can nest multiple macros with OPTION FILES. LIBRARIAN keeps track of
the nesting level, and opens a new XEQLIST1,2,3,...n as each nested macro
is invoked Nested looping is also supported through nested OPTION
FILES macros. See the second example that follows.

route The name of the route to which the step belongs.

appl The name of the application to which the route and step belong.

LOCALPARMS Causes the XEQ parametersto be local to this macro when it is executed

With the LOCALPARIVIS option set, parameters0 — 99 are initialized to NULL
values upon entry to the macro and reset to their original values upon exit.
If this option is not used, parametervalues are inherited from the calling
macro, and if their values are modified within this macro, the changed
values are "passed back" to the calling macro on exit.

NOBREAK Di sab l e s Break and Control-Y during macro processing.

NOWARN If a parameterdoes not have a value in an XEQ macro, NOWARN will
initialize the value to blank and suppress the warrung message to the user.

accepted into PARM 0 (%%0) as a single string, rather than parsed into
separate parameters. This is useful when the intent of the macro is to extend
the operation of a defined step, but preserve step syntax including multiple
file specifications, AT and TO clauses, and run — time parameters See the last

exampleon the following page.

In menu mode, causes a dialog box to appear, allowing you to specify
parameters. If OPTION FILES has been defined, a dialog for filenames and
optional edit masks appears. If neither OPTION FILES nor OPTION PARMS is
defined, no dialog appears and the macro is executed immediately.

QUIET Suppresses the standard messages and prompts, and uses the default
answers for commands within the macro,
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OPTION (continued)
Operation
OPTION must appear as the first nonblank, noncomment line in a macro OPTION FILES
causes LIBRAIGAN to authorize the file(s) specified when executing the macro. OPTION
FILES =step authorizes files according to the authorization rules for the specified step.

The listfile XEQLIST is built containing the names of authorized files when OPTION FILES is
used, For more information, refer to Macro Filelists, earlier in this chapter.

Examples
The following example submits source code for testing, and compiles each related program
in the production account using MAKE:

OPTION FILES=ABC-SUBMITABC-MAINTABC,NOBREAK,NOHELP
ABC-SUBMIT!XEQLIST
MAKE ABCMAKE.PUB,ABCQA,%%[@-POBJECTABCQA]

The next example checks in files specified by the user, and notifies the owner of every copy
of each file checked in:

PROCEDURE ABC — IN
OPTION FILES=ABC — IN
LOOP

SETJCW LIBOK=O

CONTINUE
ABC — IN %%[ ]
IF LIBOK>0 THEN

CONTINUE
ABC — NOTIFY * AT @.@.1.@

ENDIF
NEXT
END

PROCEDURE ABC — NOTIFY
OPTION FILES
LOOP

MAIL /%(! OWNER), A new version of %% [] K
has been checked in

NEXT
END

PROCEDURE ABC- TEST

The following example changes the owner after sending files to the test area, using the same
syntax as the ABC — TEST step:

OPTION ONEPARM,NOHELPNOBREAK
PARM 1;PROMPT =" Owner for test files:";required
SETJCW LIBOK=O
CONTINUE
ABC — TEST %%0
IF LIBOK>0 THEN

ALLOW LIBMGRi pass
CONTINUE
SET * OWNER =%%1
ALLOWENDIF

END
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PARM
Sets parameter values used in macros, optionally presenting a menu or prompting the user.

Syntax
>PARM n [ = "default value "J

[;MENU=menu — file, (entryj [ INLINE
[;NUMBER ]
[; PICK [=delimiter] ) PICKFILE [; REQUIRED ] ]
[; SORT ]
[;TITLE=title ]]
[; PROMPT = "prompt text" [;NOECHO]]

[; REQUIRED]
[; UP SHIFT]

Parameters
The parameter number (0 to 99).

The default value of the parameter.

Displays a menu to get a parameter value from the user.

A text file containing a menu specification with one record for each option,
in the following format:

default value

MENU

menu-file

menu-item [=translation]

where menu-item is what appears on the user menu, and translation is the
value returned for the parameter (if different).

The following menu files are automatically created by LIBRARIAN and are
available for your use:

APPLMENU m e nu of all defined applications.

RTMENU m enu o f r ou tes for all authorized steps.

STEPMENU m e n u of all authorized steps,

PROJMENU m e n u of all authorized projects.

Menus can be combined in a single menu file by using entry points.

The name of an entry point in a menu specification file,entry
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PALM (continued)

Parameters, contInUed

Entry points are identified by a keyword that is followed by a colon (: ) in a
menu file, and a blank line between menus. For example:

MENU1:
option)
Option2
Option3

MENU2:
OptionA
Option B
Option C

INLINE

PIC KFILE

NUMBER

NOECHO

SORT

TITLE

PROMPT

prompt text

PICK =delimiter Specifies that multiple selections are allowed. Selections are returned in a

If menu — file is INLINE, menu — items are listed in the macro file on lines
immediately following the PARM command. Use a > in column 1 on a line
by itself after the last menu item to indicate the end of the menu.

Turns off echoing of the user's response to a prompt. This option is useful
when prompting for passwords within a macro.

Returns the menu item number (physical record number ) rather than the
menu item text/ t ranslation.

string separated by delimiter. If delimiter is not specified, there will be no
separation between choices.

Indicates that multiple selections are allowed. Each choice is w'ritten as a
record to a temporary file PICKx, where x is the parameter number. This file
can be used with LOOP..NEXT. The value of the parameter will be the name
of the file where selections are stored

Presents the menu in sorted order.

Specifies a title for the menu.

Allows you to prompt for a value.

The prompt to display, Use "%%%" in the text prompt to substitute the
current or default value for the parameter.

Specifies that the user must choose at least one item from a menu or must
provide a response to a prompt.

REQUIRED

Operation
PARM specifies values for parameters used in a macro. Macros can contain a maximum of
100 parameters substituted at runtime. If you refer to rnacros within a macro, they wil l al l
share the same parameter values.

Menus that you create with the PAR M command operate in the same way as standard
LIBP %MAN menus. Refer to Chapter 2, "Getting Started" in the UBRAIUAN/iX User's
Guide for more information.
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PARM (continued)

Examples
Example 1 uses a parameterto request a project name from the user.

Parameters, continued
HELP PROJECTS
PARM 1;PROMPT "Enter Project Name:";REQUIRED
ABC-CHECKIN.% /o1;NOVIOLATIONS

Example2 presents a menu of patches for the user to select from.

PARM 2;MENU = INLINE; TITLE = Patches; REQUIRED
NS Transport = NSTCDV1
Network = NMSCDU1
AIFSYSWIDESET= MPEXF46

Example 3 uses LIvV~ T t o create an indirect list of files, presented to the user as a menu.
Selections are then displayed, one per line,

ECHO NULL
LMAINT
OUTPUT %SOURCE � FILES TO SRCFILES;ALL
EXIT
ECHO STDLIST
PARM 3;MENU =SRCFILES;TITLE =Source Menu;PICKFILE
LOOP %%3

NEXT
ECHO /'/ "
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PROCEDURE
Specifies the name of a procedure in a procedure file, and marks the beginrung of that
procedure.

Syntax
PROCEDURE procname

Parameters
procname The name of the procedure.

Operation
The PROCEDURE statement indicates the beginning of a new procedure, and specifies its
name containing a maximum of twelve characters. To make procedures available in a
LIBRARIAN session, use the SET PROCEDURE command,

Note If a loaded procedure name is the same as a step name, the procedure
takes precedence over the step.

Example
The following example produces a procedure called SJJ:

PROCEDURE SJJ
ECHO OFF
SHOWJOB EXEC; JOB= @J
END
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REPEAT/UNTIL
Executes the intervening block of conunands until a conditional expression is true.

Syntax
REPEAT

UNTIL condition

Parameters
condition A v a l i d condit ion, including text strings, parameters, JCWs, or literal numbers.

Operation
The REPEAT/UNTIL structure executes the intervening block of corrunands until a
conditional expression holds a true value.

(See IF/ELSE)

Note Loops cannot be nested.

Example
The following examplerepeats the commands until the JCW LIBJCW is zero:

REPEAT
<command 1 >
<command 2>

UNTIL LIBJCW = 0
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SETVAR
Assigns a value to a macro variable.

Syntax

SETVAR varname <space> expression

must start with a letter or the underbar character.

Parameters
varname The v a r iable that is to be set to a value.

expression The expression that is evaluated and assigned to varname.

Operation
This command assigns values to macro variables. Variable names may be any combination
of letters and numbers plus the underbar character, up to a total of 255 characters. Variables

The expression parameter may be a macro expression, a Boolean, integer, or string value, or
the name of another variable. If expression consists of elements and operators ('abc' + 'cd' or
2'5+1), SETVAR will evaluate it. The operators defined in Table 7 — 2 may be used in
expression.

Table 7-2. Log ical Operators — The SETVAR Command

Logical operators:

Boolean functions and values:

Comparison operators:

Bit manipulation operators:

Arithmetic operators:

Functions returning strings:

Functions returning integers:

AND, OR, XOR, NOT

BOUND, TRUE, FALSE, ALPHA,
ALPHANUM, M.JMERIC, ODD

LSL, LSR, CSR, CSL,
BAND, BOR, BXOR, BNOT

MOD, ABS, ', /, +, —, ~ (exponentiation)

CHR, DWNS, UPS, HEX, OCTAL, INPUT,
LFT, RHT, RPT, LTRIM, RTRIM, STR

ABS, LEN, MAX. MIN, ORD, POS, TYPOF

Operands can be any variable, integer constant (hexadecimal ($), octal (%), or decimal)
quoted string constant, the Boolean constants TRUE and FALSE.

Compoundlogical expressions can be formed using the AND, NOT, XOR, and OR logical
operators, and nested w'ithin parentheses.
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Creates a pause during macro processing until the user presses a key.

Syntax
WAIT [message [ pausetimej

Parameters
message

pausetime

Operation
The WAIT command creates a pause during macro processing either until the user presses a
key or until a time interval has passed. Additionally, you can provide a message. If you do
not specify a message, users are, by default, prompted with the line "Press any key to

The message to display.

The number of seconds to wait,

continue...".

Examples
Pause with a message by typing:

WAIT Processing complete. Please press a key.

Pause for five seconds by typing:

WAIT 5
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WHILE/ENDWHILE
Executes the intervening block of commands while a conditional expression is true.

Syntax
WHILE condition

ENDWHILE

Parameters
condition The con d i t i on that should be true, including text strings, parameters, JCWs,

Operation
The WHILE/ENDWH ILE structure executes the intervening block of commands while the
conditional expression holds a true value.

or literal numbers. (See IF/ELSE)

Note Loops cannot be nested.

Example
The following example executes the commands while the JCW LIBJCW is zero,

WHILE LIBJCW = 0
<command 1 >
<command 2>

ENDWHIM
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MAKE

The MAKE facility helps you keep applications up — tubate. It
accomplishes this by building only those components whose
dependencies have changed.

This chapter explains how to create makefiles with i nformation about
Make rule syntax. The following topics are covered:

� Mak ef iles

� Ed i t Masks

� Va r iables

Refer to Chapter 8, "Rebuilding Appl ications with Make" in the
LlBRARIAN/iX User's Guide for more information.

Makefiles
A makefile is simply a text file that contains your MAKE rules, which
includes dependency information and instructions for how to rebuild
each component of your application. You can create and maintain this file
in the editor of your choice. Although "rnakefile" is the default name for
this file, you can use any name you wish A makefile can contain
comments, rules, and user-defined variables.

A makefile consists of one or more rules depending on the complexity of
your application. Each rule defines a specific or generic
target/dependency relationship and the commands required to rebuild
the target from the dependencies.

Conventions
When creating your makehle, adhere to the following conventions:

� In s ert a blank line between rules.

� Us e the backslash (>) as a line continuation character.

� Wh e n l ist ing targets and dependencies, use a mirumum of one
space between filenames.
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Comments
Comments should be on separate lines and can appear anywhere in a
makefile. A comment line in a makefile must start with a pound sign (¹) .

For example:

¹This is a comment.

Comments that begin with ¹NOTE are treated in a special way at run
time. If you use the ECHO option when you run MAKE, you wi l l see
comments displaying on the screen as the rnakefile is processed. For
example, suppose you have the following comment:

¹NOTE Processing report rules...

When MAKE processes this file with the ECHO option, the following l ine
would appear:

Processing report rules...

Comments that begin with ¹OPTION fol lowed by an option list invoke
those optionsautomaticallyat runtime. For example:

The option list can include any MAKE parameters (SHOW, ECHO,
NOMAKE, ALL, etc.) as described in Chapter 1.

„OPTION SHOW ECHO

Rules
Rules are statements that inform MAKE about dependencies between
files. They also identify the command(s) required to rebuild an object
when its dependencies change. Rules can be standard, generic, or

implicit:
� Us e standard rules when the targets and their dependencies are

specific file names. Standard rules are required for the highest level
target in a dependency tree.

� Us e generic rules to derive a dependency name f rom. a target name

� Us e implicit rules when the target and dependency have the same
name but belong to different groups.

with an edit mask.

Table 8 — 1 summarizes the standard rule elements that apply when the
targets do not include wildcards. Table 8 — 2summarizes the generic rule
elements that apply when you use wildcards in the target name.
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Table 8-1. Standard Rule Elements

Standard Rules
Standard Rule Syntax

target — list: dependency — list

Independent Rule Syntax

target-list n dependency — list
commands

Parameter
commands

Description
target-list

commands

: (standard rule)

dependency-list

:= (basic generic rule)

: — (extended generic rule)

Operators

Specifies names of target(s) that must be rebuilt if any item in
the dependency list has changed (i.e., timestamp of dependency
is later than the target).
Targets can be file names, variable expressions, or dummy
names. If a dummy name is used that does not correspond to an
existing file, commands are always performed.

Specifies names of dependencies for the tar'get(s). If any item in
the dependency has changed (i.e., limestamp of dependency is
later than the target), the command(s) given for the rule are
performed.

Specifies operating system command(s) to execute if target is
older than any of its dependencies. Any number of commands
can be issued. Because they are output to a JCL file, precede
commands with a job character, if necessary (i.e.,! ).

Specifies that target and dependency names differ only in suffix.

Specifies edit mask(s) in the dependency list, so that
dependencies are determined by applying the edit mask to the
target being evaluated,

Causes all rules tha t have targets with the same name to be
combined into one rule (i,e., all dependencies and commands
are combined).

Causes each rule to be treated independently (i.e., only the
commands of the rule whose dependency has changed are
execu ted).

:: (independent rule)
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Table 8-2. G e neric Pule Elements

Generic Rules
Extended Generic Rule Syntax

target-list: ­ dependency-edit-mask(s)

Basic Generic Rule Syntax

C<'suffix:= ©suffix
commands

Parameter
commands

Description
target-list

commands

dependency-edit-mask

suffix

Operators

Specifies names of target(s) that must be rebuilt if any item in
the dependency list has changed (i.e., the timestamp of the
dependency is later than the target).
Targets are file names with wildcards. MAKE always applies the
first generic rule found for a potenhal target being analyzed.

Specifies the edit mask describing how to create the dependency
name from the target name.

Specifies suffix of filename for a dependency or target. With the
colon equals (:=) format, filenames of dependency and target can
differ only in suffi'x (i.e., ACOBIOS and ACOBIOU).

Specifies operating system command(s) to execute if target is
older than any of its dependencies. Any number of commands
can be issued. Because commands are output to aJCL file,
precede commands with a job character, if necessary (i.e.,! ).
Since the rules are generic, commands usually refer to variables
to fill in the appropriate filenames.

Specifies that target and dependency names differ only in suffix.

Specifies edit mask(s) in the dependency list, so that
dependencies are determined by applying the edit mask to the
target being evaluated.

:= (basic generic rule)

: — (extended generic rule)
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Table 8 — 3 summarizes the implicit rule where the target and dependency
names differ by group only,

Table 8-3. i mplicit Rule Elements

commands

implicit Rules

Implicit Rule Syntax
target-group, dependency~oup:

DescriptionParameter
dependency group
target group

commands

groupl .group-:
(tm firit ru1et

Operators

Specifies the group in which the dependencies reside.

Specifies the group in which the targets reside.
Specifies the operating system command(si to execute if the
target is older than any of its dependencies. Any number of
commands can be issued. Becausecommands are output to a
JCL file, precede commands with a job character, if necessary
(e g,.').

Specifies that targets and dependencies differ in group name
only.

Job Card Placement
Since you can have MAKE evaluate any standard rule in your makefile,
you must define job cards at the likely entry points into the makefile.
Any subsequent job cards encountered after the entry point rule are
ignored by MAKE.

Because the first rule of a makefile is the default entry point, a job card
should be defined in the first rule. Consider where other typical entry
points are and place job cards in those rules.

Job card information is written on a separate line The first three nonblank
characters in a job card line must be a colon (:), followed by a greater-than
sign ()), and a job character (usually an exclamation point (!)). For
example::

: > ! JOB MYMAKE, MGR.MYACCT/FOOBAR

Source Scan for Dependencies
Use MAKE to scan COBOL, Pascal, and C source for dependent modules
identified in INCLUDE and COPY statements. When such dependencies
are found, they are treated in the same way as explicit dependencies, To
invoke source scan for dependencies, follow the dependency file name
with a plus sign (+), as in the following examples:

ABC1000P.PROG: ABC1000S.SOL!RCE+

ABCOP. PROG: — =S.SOURCE+
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Edit Masks

filename substitutions.

The edit mask above appends an S onto the current dependency name,

Edit masks are used in generic rule dependency lists and variable

For editing filename variables, edit masks are enclosed in double quotes
("") and placed immediately after the filename variable to be altered. For
example:

$ < "@S"

where the $( variable substitutes the current dependency name. Edit
masks can also be used to alter filenames derived from wi ldcard variable
substitution For example:

$[@S.RSOURCE) "= —,PROG"

The LISTF variable creates a list of files that match the wildcard
(©S.RSOURCE). The edit mask then alters the filenames obtained by
removing the last character and changing the group. It is important to
note that this expression generates filenames for the PROG group
regardless of whether the files actually exist in the PROG group.

If an edit mask is used in the dependency list of an extended generic rule,
the dependency name is derived from the target name. For example:

The generic rule above specifies that the dependency name is derived
from the target name by appending an S to the target name and looking
in the RSOURCE group. For example, a target name of RPT1020.FROG
would be transformed into RPT1020S.RSOURCE as the dependency
filename. Table 8 — 4 describes the characters that can be used in edit

@,PROG: � @S,RSOURCE

masks:

Table 8-4. E dit Mask Characters

Character Description

and/or followed by other characters.

Copies all remainingcharacters once the minus sign (-), question
mark (?), and literal characters have been evaluated.

Copies the character at this position into the resulting string. It can
also be combined with the minus sign.

Indicates that the origina! character in that position should not be
included in the edited result. It can also be combined with the equal

For more information about edit masks, see Edit Masks, at the beginning
of Chapter 1, "Commands."

Copies original value into the edited version. Typically preceded

sign.
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Variables
Variables provide a shorthand for checking makefiles. Variable references
are substituted with either user-defined or system-defined values.
User-defined variables have the following format:

variable name = substitution text

The substitution text replaces all references to the variable at run t i me.
User-defined variables can be assigned the value of other user- or
system-defined variables.

Referencing Variables
By default, references to MAKE variables are prefixed with a dollar sign
($). To use MPE — defined names, such as $OLDPASS or $NULL, you must
globaHy change the variable prefix to another character, such as %. To do
this, add the following l ine at the beginning of your rnakefile.

$ 0/

This changes the variable prefix from $ to %.

Predefined Variables
Following is a list of system-defined MAKE variables.

$[ ] (LI STF variable)

$() (Us er variable)

$( ) ( Prompt variable)

Executes LISTF and returns all fi les that match
the wildcard specification between the brackets.
Can be edited using an edit mask by placing the
edit mask in double quotes immediately after the
dosing bracket.

LISTF exdusions, e.g., $[ao-a1 — a2 — a3]
excludes ak,a2,a3 from a@.

Prompts the user with the string specified
between the braces. The value entered by the
user is then substituted into the make61e. You
can assign this value to a named variable for
repeated reference.

Substitutes the value of the variable specified
within the parenthesis. If the variable name is a
single character, the parentheses can be omitted.

$(!system variable) Sub sti t u tes the MPE system variable between
(System variable variable) the parentheses.

$< (Dependency
variable)

Substitutes the fully qualif ied name of the
current dependency when performing an action.
Can be edited using edit mask.
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(Full-target S u bst i tutes the fully qualified name (including
variabie) g r oup and account) of the current target. Can be

$* Parget variabie) S u bst i tutes the name of the current target as
entered in the rule (i.e., no group or account is
given unless it is specified in the rule).

edited using edit mask.

S pecial Variables
In addition to the standard variables, seven special variables are

STREAM = AT=17.00

available. These variables include:

� STREAM

� SCHEDULE

� STREAM and SCHEDULE

� AC COUNT

� GROUP

� EXCLUDE

� COP YMEM

� AL T P ATH

STREAM
You can optionally specify MPE:STREAM parameterswhen MAKE
streaxns a job. When the STREAM variable is used, its value is passed as a

parameter list to STREAM. For example, if the following variable is used
anywhere in a makefile, then MPE launches the job at 5:00 p.rn.

For more information on STREAM, Refer to the MPE Commands Reference
Manual.

SCHEDULE
You may have access to scheduling or streamer programs and do not
wish your jobs to be streamed directly to MPE. In this case, MAIQ.:
recognizes the SCHEDULE variable If you define a variable named
SCHEDULE anywhere in the makefile, then MAKE expects its value to be
the name of the scheduler program. MAKE runs this program (and passes
the name of the MAKE jobstream via the INFO string ), instead of
streaming the file. The p rogram name may optionally have a slash (/) at
the end, followed by S, P or G corresponding to the lib=x paraxneter that
the scheduler program requires.
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For example, if the following variable is used in the makefile, then MAKE
~ould run STREAMER.COMPEXPRESS with a LIB=G parameter, and pass
the name of the MAKE jobstream in the INFO string rather than streaming
the ~ E co mmand file directly to MPE:

SCHEDULE = STREAMER. COMP EXPRESS/G

STREAM and SCHEDULE
If you use both the STREAM and SCHEDULE variables, the scheduler
program is invoked and the stream options are appended to the
command output filename passed via the INFO string.
The EXPRESS STREAMER command, for example, implementsthe same
options as the MPE:STREAM command. This also provides a means of
specifying additional scheduling parameters.
ACCOUNT
If you run MAKE outside of the account where the files to be evaluated
reside, you can use the special ACCOUNT variable to set the account
globally. With this variable, you only need to qualify your target and
dependency filenames up to the group level in the makefile. For example:

ACCOUNT = QAACCT

If you specify the ACCOUNT variable in the makefile, you should specify
only filenames up to the group level, since the ACCOUNT variable
appends the account name to all filenames in the rnakefile.

EXCLUDE
The special EXCLUDE variable can be used to globally exclude delta files
and generation files from LISTF variable processing. For example:

EXCLUDE = D ¹¹ ¹ ¹ ¹ ¹ ¹ .@. @ G¹ ¹ ¹ ¹ ¹ ¹ ¹ .@.@

COPYMEM
The COPYMEM variable is used in conjunction with the MAKE
automatic dependency scan feature to indicate that COPYLIB members
are stored as individual fi les in [GROUP[.ACCOUNT] ]. Without the
COPYMEM variable, the COPYLIB hie name is used as the dependency,
rather than rnernber names. For example:

COPYMEM =MYGROUP
COPYMEM =MYGROUP.MYACCT

GROUP
If you run MAKE outside of the group where the files to be evaluated
reside, you can use the special GROUP variable to set the group globally.
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GROUP = MAKEGRP

For example:

If you specify the GROUP variable in a makefile, you can only specify
filenames, since the GROUP variable appends the group name to all
filenames in the makefile.

ALTPATH

The ALTPATH variable provides automatic search of an alternate account
location when a designated dependency is not found in the default
account defined by the ACCOUNT variable or logon account.

The ALTPATH account is defined by entering a variable definition,
usually at the beginning of the makefile. For example,

ACCOUNT =ABCDEV
ALTPATH=ABCLIB

ABC: $[N.PROG]
:>! JOB.......

ABC1000PPROG: ABC1000S.SOURCE
! rebuild statements...

@PPROG: ­ =S.SOURCE
!rebuild statements...

If the dependency (source file) of the target being evaluated does not exist
in the same account as the target (object fi l ), then MAJCE searches for the
samefile. group in the ALTPATH account. For instance, if ABC3000P.PROG
is found in the account ABCDEV, but ABC3000S.SOURCE.ABCDEV does
not exist, MAKE searches for ABC3000S.SOURCE.ABCLIB. If MAKE
Finds the dependent file in the ALTPATH account, it uses that file as the
dependency All other MAKE logic remains the same,
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Menu Hierarchy ancI Dialogs

LIBRARIAN menu mode is an alternative to command xnode, allowing
you to select options from a set of menus. This chapter summarizes the
LIBRARIAN menu hierarchy and describes menu options and dialogs.
The following topics are included in this chapter:

� Main Menu

� FiI e Menu

� Use r Menu

� Macr os Menu

� Too ls Menu

� Info Menu

� Ad min Menu

� Hel p M e nu

� Di a logs
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Main Menu

The main menu consists of a horizontal menu bar that appears at the top
of the screen under the OCS/LIBRARIAN ti tie bar. It also shows v hether
you are running LIBRARIAN under MPE/ iX or UNIX. Special func­
tions, such as switching between menu mode and command mode, are
available with the function keys as displayed in Figure 9 — 1.

OCS/LIBRARIOK ter IPE/ill

Q F i l e

Holy ~ . Pr int R ofroob A P E . Q<It .

Figure 9-1, LIBRARIAN Main Menu
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File Menu
The File menu displays a list of operations that apply to fi les.

Menu options followed by an ellipsis (e,g., Steps...) have subrnenus.Nofe

� R" �

LIX-IN

Steps Open a menu of steps that you are authorized to perform.

Copy Copy fi l es to a new location.

Move

Print

Orphan Di s able tracking of read — mode secondary files.

Purge Pur ge f iles from the system.

Rename Rename files or files in a fileset.

Restore

Move files from one location to another.

Print a file on the screen or a printer.

it with the older version.

Reconstruct a previous revision of a file making it the most
current. Automatically retain the current file before replacing

Displays a menu of file attributes that you can change. TheseSet
attributes include:

Exception reset
Expiration date
Language
Lockword
Lock/Unlock

Update a read — mode secondary with the latest associated

Mode
Owner

Tag
Timestamp reset

Update
master.

Terminate an active LIBRARIAN session.Exit
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User Menu
The User menu gives you access to dialogs for viewing and changing the
current environment, changing your password, and sending receiving
mail.

� Us er �

User

User

Password ~

secern~
Route
Project
Ourel Mode OFF
Save Star OM
Compare Method LCOMPARE

e N

User

Messotae rexr tteove brook lo Invoke ecator)

Identi f ication

Settings

rent user.
Enter new user name and password, or show cur­

Set up the environment for the current LIBRARIAN
session. Creates a temporary file caHed LIBSET. If
you save this file, LIBE R I A N w i l l automatically
load these settings each time you run LIBRARIAN.

Change user password/lockword.

Read mail or send a message to a user or to the audit

Passwords

Mail
trail,
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Macros Menu
The Macros menu displays the options for loading and using LIBRAM­
AN macros.

Macros

hoc edure

mmmm~� � I

PIocodUTQ2
Procedure 3

� 1 �

Execute

Procedures

Execute a specific macro file or procedure.

Open a menu of loaded macros and select macro to
execute.

Load procedure Load m a c ros from a procedure file.

Unload procedure Un l o ad all currently loaded macros.
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Tools Menu
The Tools menu displays a list of special LIBRARIAN f i le uti l i t ies.

Tools

� �

I . � � .

Make

Scan

Compare

Compress

Decompress

Lis tf iles

text.

Show differences between Files or revisions.

Compress files.

Decompress files.

Display a menu of LMAINT operations for
managing (indirect files).

Run the MAKE uti l ity to rebuild applications.

Scans files for strings of text, and optionally replace

Display a menu of FMAINT operations that lets you
group files according to your own needs

User Filesets
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Info Menu
The Info menu includes four menus for generating offline reports and
online inquiries.

Info

Versions

I �

RAD10 Ste SummaRules...
� �

I ’

�

. ’

� . �

I . � ’ � r . �

I r: �
� � . , �

Files Open the menu of reports and online inquiry screens
related to files.

Open the menu of reports related to versions

Open the menu of reports related to steps, projects and

Versions

Rules
user authorizations.

Open the menu of all reports related to the transaction log.l.og
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Admin Menu
The Admin menu displays utilities for maintaining and updating the
LIBRARIAN databases. You can also access data entry screens f rom this
menu to load and fine-tune rules.

Admin

SCl88BS.. . pg ~

AP Auto Filename
I

� • �

o ~ e

�

’

�
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Shortcut

Autoupdate

Screens

Flush

Flushlog

Clean db

records.

Set up basic LIBRARIAN rules.

Run the Auto Fileset update utility.

Purge records from the LIBDB tracking database for
files that no longer exist on a disk.

Run the FLUSH uti l ity to purge old fi les.

Run the FLUSHLOG uti l ity to purge old transaction

Open a menu of screen submenus.

Config

Files

Users

filesets and file attributes.

Open a menu of screens for examining,
adding, changing, or deleting system
and network data in the data base.

Open a menu of screens for defining
users and their capabilities.

Open a menu of screens for defining

Open a menu of screens for adding
routes and steps.

Open a menu of screens for defining
and maintaining projects.

Steps

Projects
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Help Menu
The Help menu includes a list of options for getting information about
LIBRARIAN.

Help

Contents

Contents

Glossary

How to use Help Get i n f o rmation on how to use the help facility.

Display copyright, version, and other information
about the release of LIBRA&A N you are running.

Open a menu of help topics.

Access the glossary of LIBRARIAN terms.

About
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Dialogs
Many menu options have associated dialog boxes for you to provide fur­
ther information about an operation. The most common dialog requests
a list of files and options for the current transaction For example, when
you select a step from the Steps menu, the dialog box shown m
Figure 9 — 2.

OCS/LIBRARIRH for IIPE/iH

st
� I Steps ~

IH-OUT

To

Q Revision Criteria g Option lteno

R sIp B eoIef tet Qptfon P ri n t Refresh Go . E eacel
Crf ter te Menu

Figure 9-2, Sample Dialog

In this dialog, you can enter a source and destination file. Note that
these fields scroll to the left if you type past the end of the field,

You can apply revision criteria to the files listed by pressing F2. The Re­
vision Criteria menu appears as shown in Figure 9 — 3.
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OCS/LIOttnttl4it for t tPE/IH

File

st
� I

I

Steps t
Itt-OUT

ision Criter~o
r

I �

T46
KOUNT
I%os ION
VCOUKT Option Oenu

Be fr esh Accept C t tncelM MM M
Figure 9-3. Revision Criteria Menu

When you select an option from this menu, a field appears allowing you
to specify a value. Press FS (Cancel) to leave this menu without accept­
ing the options you selected, or press F7 (Apply) to leave this menu, ap­
plying the options you selected.

You can select step options and override default parameters by pressing
F3 (Option Menu) in the dialog box. A menu of the most common op­
tions appears as shown in Figure 9-4.
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OCS/LIBRARIAit for lIPE/iN

F i le

st
� I

I

Steps ~
IR-BUT

I � From

t inns›
BATCH
BRANCH
IHPRBGREss
NElm
ItERBE

VERIFY
KKRR

instepdefault>

<step default>

Opt ion llenu

<ste default>

Refresh . ex qi t Cano e tO T IC ]C i
Figure 9-4. Sample Op<tons Menu

Other options are available by selecting More... from this menu. When
you are finished selecting options and/or setting parameter values, press
F7 to accept the values or F8 to cancel. You wil l return to the main dialog

After specifying hles, revision criteria and/or options, press F7 (Go) to
proceed with the transaction or F8 (Cancel) to return to the previous

box.

Inenu.
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10Utility Program

LIBRARIAN provides you with the LIBUTILP uti l ity p rogramto perform
miscellaneous functions, including globally changing systemreferences in
the database, This util ity facilitates moving applications or an entire
LIBRARIAN implementation to a new system.
The LIBUTILP uti l ity program enables you to do the following:

� Ch a nge the system ID for all applications.

� Ch a nge the system ID for a single application,

� Un l o ad a database to a flat file, @UL.PUB.QCSLIB.

� Lo ad a database from a flat file ©UL.PUB,OCSLIB.

Operation
Thecompletename for the LIBRARIAN ut i l i ty program is
LIBUTILP COMP OCSLIB. To use LIBUTILP, log on to MGR.OCSLIB on the
MPE/iX server and type:

: RUN LIBUTILP.COMP,OCSLI B

The program presents a menu of options, as displayed in Figure 10 — 1:

OCS/LIBRARIAH/ix Version 1.00.00 (C) Dperations Control Sgstems, Inc. 1993
L IBUTIL L IBRARIAN Uti l i t 9 f u n c t i o ns

LIBRARIAN Uti litg Functions

1 — Change Sgstem IO in LI B D B
2 � Change SDstem IO for a n Applicat i on
3 � Unload data base to a file
� Load data base from a file

E � Exit

Please tVpe desired option: I

Figure 10-L LIBRARIAN Utility Functions Menu

For Inore information on the LIBUTILP program, refer to Appendix 8,
"Using the LIBRARIAN Ut i l i ty Program" in the LIBRARIAN/IX
Administrator's Guide,
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Configuration Program

LIBRARIAN provides vou with the CONFIGP uti l ity program to perform
miscellaneous functions, including updating your LIBRARIAN
configuration and changing database passwords.

The LIBRAIGAN configuration program, CONFIGP, enables you to
perform the following:

� Up d a te the LIBRARIAN configuration hie.

� Ch a nge LIBDB/LIBLOG passwords.

� Ch a nge server logon and passwords, for client Inachines.

Operation
The complete name for the LIBRARIAN configuration program is
CONFIGPCOMPOCSLIB. To use CONFIGP, log on to MGR.OCSLIB on
the MPE/iX server and type:

:RLIN CONFIGP.COMP.OCSLIB

The program presents a menu of options, as displayed in Figure 11 — 1:

DCS/LIBRRRIRH/iX Version 1 00.00 (C) Operations Control Systems Inc. 1993
CDHFIG LIBRARIAH Conf igurator

LIBRARIAN Conf igurator Functions

1 � Update Conf i gur a t i o n F i l e
2 � Change LIBDB/LIBLOG Passwords
3 � Change SERVER Logon/Pasaaaords
E � Exit

Please tgpe desired option: �

Figure 11-1. LIBRARIAN Configuration Functions Menu

For more information on the CONFIGP program, refer to Appendix C,
"Using the LIBRARIAN Configuration Program" in the LIBRARIAN/IX
Administrator's Guide.
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12Datasets

installation.

Dataset capacity requirements are based on factors such as the number of
files, users, file movements, and versions. Therefore, capacity

requirements vary considerably among installations, The following
dataset descriptions will help you estimate dataset sizes for your

For information on database structure, data items, and initial capacities,
refer to the schema text files which are loaded during the LIBRARIAN
installation:

LIBDB
LIBLOG

This chapter describes each of the datasets which comprise the two

SCHEMA. PUB.OCSLIB
LOGSCHEM,PUB.OCSLIB

LIBRARIAN databases:

� LI B DB Database

� LI B LOG Database

LIBDB Database
The LIBDB database contains the following datasets.

M-APPLICATION

M-USER

M-F1LE-SET

D-AHFSET-COMP

screen.

Filenames within a user-defined fileset.

Application names and associated master
filesets. One record per application.
Maintained by the Appl ications (AP)

Fileset names and descriptions. One
record per fileset. Maintained by the
Filesets (FS) and Projects (PR) screens and
by FMAINT commands

User names, user data, and passwords.
One record per user. Maintained by the
Users (US) screen,

Component (hierarchy) definit ions for
user-defined filesets. One record for each
component for each fileset. Maintained by
the FMAINT subsystemof LIBRA3GAN.

One record per file per fileset M a in tained
by FMAINT.

D-AHFSET-FILE
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D-APPL-VERSION

D-FILE

D-FILE-TABLE

D-COM-LINKS

D-FORWARD-VER

D-AUTO � P5N

D-FSET-COMPONENT

screen.

Versions for an application. One record
per version, per application. Maintained
by the VERSION command.

Fileset is included in this record because
the master fileset definition for the
application can change between versions.
The fileset recorded here is the fileset as it
was at the time the version was
established.

Wildcard descriptors used for including
files including/excluding fi les from this
fileset. One record for each descriptor, for
each fileset. Used by the Auto Update
(AUTOUPDP) program to add new files
automatically to fileset when introduced.
Maintained by the Auto Filesets (AF)

Defines the actual device names for
communicating between systems, if the
device name differs from the system
name, Maintained by the
System-to-System Table (SS) screen.

Contains most of the file-specific
information in the database. Contains
statistics on number of generations,
versions, copies out, last route/step
performed, etc. One record per revision
per file defined to LIBRARIAN.
Maintained by the File Access (FA), Files
in Filesets (FF), Pending Master Files (PF)
screens, and updated by LIBRARIAN and
other utilities.

All filenames in LIBRARIAN are tracked
by tokens. This dataset is a cross-reference
between the token and the actual f i l ename.
Defines previous version locations for
forward version search. One record per
search level. Maintained by the Forward
Versioning (FV) screen.

Defines fileset hierarchy. One record for
each component fileset. Maintained by the
Fileset Components (FC) screen.

Contains the filenames within a master
fileset. One record per file per fileset.
Maintained by the Files-in-Fileset (FF)

D-FSET-FILE

screen and AUTOUPDATE.
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D-MESSAGES

D-STEP

D-ROUTE

D-SYSTEM-ID

D-PRESTEPS

D-PROJECTS

D-REFINED-STEP

D-PENDING-AREA

D-NO-COMPRESS

D-NETWORK-CONF I G

screen.

Contains messages sent to users, using the
MAIL and IVIEMO commands. One record
per each line of each message.

Contains one record for defining the type
of network and default logon information
for connecting to remote machines.
Maintained by the Network Configuration
(NC) screen.

Contains one record. Array of 40 filecodes
to be exduded from compression.
Maintained by the Compress Exclusions
(CE) screen.

Defines areas from which new files can be
introduced. One record per area per step
Maintained by the Pending Production
Areas (PP) screen.

Definescomposite presteps for a step. A
maximum of 16 presteps can be defined
for a composite prestep. Maintained by
the Composite Presteps (CP) screen.

Defines projects and specifies the routes
for which each project is valid,
Maintained by the Projects (PR) and
Project Status Change (PS) screens.

Defines different destinations and/or
movement types for subsets of the source
location defined in the related D-STEP
record. One record per refinement
defined. Maintained by the Step
Refinements/Exceptions (SR) screen

Defines routes within an application. One
record per route. Maintained by the
Routes (RT) screen.

Contains the basic definition of a step,
including the source and destination
locations, type of movement, prestep, etc.
One record per defined step. Maintained
by the Steps (ST) screen.

Defines system data including login wi th
appropriate passwords. One record per

system. Maintained by the Systems (SY)

Defines global parameters for the
LIBRARlAN installation. One record.
Maintained by the SystemProfile (SP)

D-SYSTEM-PROFILE

screen.
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D-USER-CAPS

D-USER-STEP

D-USER-FSET

D-VFSET-COMP

D-USER-PROJECT

screen.

DeFines users with special capabilities,
One record per capability per user.
Maintained by the User Capabilities (UC)

Contains one record for each user fi1eset
and it's creator, establishing a cross­
reference between users and their hlesets.
Maintained by FMAINT.

Defines user project authorizations. One
record per authorized user per project.
Maintained by the Project Authorizations
(PA) screen.

Defines user step authorizations, One
record per authorized user per step.
Maintained by the Step Authorization
(SA) screen.

Retains D-FSET-COMPONENT data at the
time a new version is established.
Contains fileset components. Maintained
by the VERSION command. Number of
records is approximately number of

application multiplied by number of

D-VF SET-FILE

D-FSET-COMPONENT records for an

versions.

Retains D-FSET-FILE data at the time a
new version is established Contains
fileset members. Maintained by the
VERSION command. Number of records is

approximatelythe number of D-FSET-FILE
records for an application multipl ied by
the number of versions.

L(BLOG Database
The LIBLOG database contains the following datasets:

D-FILE-TAB LE All filenames in LIBRARIAN are tracked
by tokens. This dataset is a cross­
reference between the token and the actual
filename.

Defines the next file ID to be used. One
record.

D-SYSTEM-PROFILE

D-TRANSUM Contains a log of transactions performed
records are added automatically by
LIBRARIAN w'hen logging is turned on.

O ne record for each transaction N e w
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D-TRANSDTL Contains detail of file operations. One
record for each file within a transaction.
New records are added automatically by
LIBRARIAN.

D-MEMO Contains memo text related to a
transaction. Related to D-TRANSUM and
D-TRANSDTL by internal TRANS-ID.
One record per line of text. New records
are added automatically by LIBRARIAN .

Flush log records from the LIBLOG database by using the FLUSH uti l i ty
or SHOWLOG) FLUSH.

Note To check LIBDB and LIBLOG dataset capacities, use the LIBIVDGAN
cornrnand CHECKDB.
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LIBRARIAN/iX Glossary of Terms

Note Terms that appear in italics in the following definit ions have separate
glossary entries.

Access Control
The attribute of a masterfile that determines how many read/wn'te mode
copies are allowed. The four access control levels are: exclusive, read only,
serial write, and multiwrite.

Access Mode
The attribute of a secondaryfile that determines whether or not it can be
checked in and replace its associated masterfile. A secondary in write mode
can replace a master. A read mode can only replace a m,aster through an
emergency checkin that is configured to use the PUSHRFAD parameter.A
file's access mode is determined by access control, user request, step
definition, and default access mode (precedence is in order listed).

Aging Policy
A system profile value that indicates how long log records are kept. When
the FL USHLOG utility is run, audit trail records that are older than the
number of days specified in the aging policy are deleted.

Transactions associated with projects override this policy and are deleted
only when the project status is flush pending.

Alternate prestep
A prestep that can be performedas an alternative to the defined prestep.
Up to three alternatives can be defined for a step,

Annotate
Comments inserted by LIBRARIAN into source listings that indicate
which lines were inserted/deleted for which revision. Date/t i me, related
project and user who made the change are included.

Application
A site — defined organizational unit including a set of masterfiles that are
being controlled by LIBRARIAN, a set of steps for file
movement/approval, and, optionally, a set of projects for tracking file
changes associated with a particular work activity.

Application Manager
A special user capability assigned to the user responsible for the files and
steps within an application.
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Application fileset
The highest level fileset for an application,

Approval step
A null step that is required as a prerequisite for a subsequent step.

Authorization
The process of deterrrurung which files have been requested in a
transaction and whether or not the rules permit the operation to be
performed on each of these files. Authorization is based on the user who
initiated the request and the current status of each file requested.

AUTOXEQ file
A macro that is executed before the first prompt! main menu appears. A
file called AUTOXEQ that exists in the product account is executed prior
to any AUTOXEQ file that might exist in the user's home directory.

Auto fileset descriptors
General locations that describe how masterf i le are assignedautomatically
to masterf i leset. Descriptors can include or exclude files from filesets
using wildcards. When you run A UTOLlPDATE, introduce new files with
a pending master, or performa checkin step with the AUTOUPDATE
parameter turned on, any previously untrackedfiles in these locations get
added to the appropriate master filesets

Automatic Login ID
The login used when transactions require automatic logging in to a
remote system.

Autoupdate
The process used to add masterfiles to masterfilesets autoxnatically based
on predefined autofilesef descriptors that include or exdude files from
filesets, typically using wildcards. Pending masters and masters not
currently assigned to required filesets are added, typically during checkin,
new steps and/or running of the AUTOUPDATE uti l i ty.

Baseline
The master library at a particular point in t ime. An application manager
establishes a baseline by creating a version. This marks and protects all of
the files in an application at that time, so that the application or any part
of the application can be restored to that baseline any time in the future

Base Revision
A revision that was current at the time a baseline version was created. The
version count (VCOUNT) for a base revision is always zero and cannot be
flushed until the version(s) of which it is a part is made obsolete.
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Branch
A set of revisions that are made as a divergence from the main
development path for a master file. A branch is created automatically
when a previous revision is checked out. A branch can also be forced
from the latest revision if the master is already checked out in write mode,
or the user does not intend to check the file back in on the trunk.
Whenever a new branch is created, a branch counter and leaf counter
(both starting at 1) are appended as a pair to the original revision ID.

Branch revision
A revision that appears on a branch.

Checkin step
Any step which copies or moves a file from a secondary location into the
master libra~, either retairung and replacing the existing master,
introducing a new one or establishing a new branch .

Checkout step
Any step which copies a file from the master library into a secondary
location, generally for modif ication by programmers.

Client
An MPE or UNIX implementation of LIBRARIAN where the LIBRARIAN
data bases reside on a different system,, but the user is able to p erformall
LIBRARIAN functions.

Command Mode
In command mode, the user enters LIBRARIAN commands at a
command line prompt. Users can switch between command mode and
menu mode by pressing the F2 function key,

Component filesets
Filesets that are subsets of higher — level filesets.

Composite prestep
A collection of presteps that must be performed before a subsequent step
can be performed. Composite presteps also permit the specification of a
date prerequisite.

Default access mode
The access mode that is assigned to a secondaryfile when neither the user or
step explicitly specify the mode. The access control level for a file
determines which access modes are allowed.
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Delta file
A privileged (MPE) or hidden (UNIX) file that contains the history of
changes made to an associated masterfile.

Deltas
A method for retaining and reconstructing previous revisions of master
@les that involves storing only the changes to files over time.

Dependency
A file that make evaluates with respect to some target to determine
whether to invoke some action, such as a compile or link.

Destination
The target locaIion when copying or moving a file,

Dummy target
A make target that does not correspond to an actual file. Dependencies of
dummy targets are actual files that are always evaluated as targets
themselves to determine whether they are out of date and need to be
rebuilt.

Edit mask
A file expression that uses special editing characters to map one filename
into another, e.g., source to destination name for a copy or move or
secondary to pending master name for introduction of a new fi le.

Emergency checkin
A checkin that moves a read mode secondaryfile into the library with the
PUSHREAD option. If a write mode copy exists, the owner is notified via a
LIBRAIGAN mail message, and an exception is recorded.

Exception Flag
An indicator that somethingspecial has happened related to a file such as
an emergency checkin, merge conflict or previous master revision was restored
at a time when the file was checked out. The exception flag must be
cleared before any further operation on the file is allowed.

Exception message
A LIBRARIAN mail message that indicates that an exception flag has been
placed on a file. This message is sent to the owner of the write mode copy of'
the file.

Exclusive access
The access control level that prevents secondary copies of a masterfile frozn
being made.

Expiration date
The date when after which a file can be flushed using the FLUSH uti l i ty.
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Expired file
A read mode secondary or retai nedfile that is eligible to be flushed by the
FLUSH util i ty.

Explosion
The creation of a list of files by expanding a fileset, listfile, or wildcard file
specification for LIBRARIAN to authorize.

External
A file that resides on a system on which LIBRARIAN is not running,
typically an unsupported platform, or system which is not on an
accessible network. LIBRARIAN steps can be used to record movement to
an external location, but cannot physically move the file or verify its
existence. Users are responsible for transf'erring files (via tape or other
means) for any transaction using the EXTERNAL option.

F
Fileset
A collection of files identified by a unique name assigned by the Librarian
Manager (masterf i leset) or any user (userfilesets). When requesting files,
filesets can be referenced by preceding the fileset name with a percent
sign (%). Because filesets contain collections of files that are related by
some criteria other than physical location, and can span directories and
systems,they are often referred to as logicalfilesets.

Note: In MPE, a fileset is any set of files that can be referred to using
wildcards in name, group and/or account. LIBRARIAN refers to this as a
physical fileset.

File structure (hierarchy)
The relationship of filesets, subsets and physical files within an
application library.

Flush policy
The system profile policy that determines how many previous file
generations to keep when the FLUSH maintenance utihty is run.

FLUSHLOG
The maintenance utility that purges old log records that have aged
beyond the aging policy specified in the system profile.

FLUSH
The maintenance utility that purges expiredfiles and obsolete versions.

Flushed project
When a project is closed and then assigned a status of flush pending, log
records associated with that project get flushed the next time the
FLUSHLOG util ity is run. After FLUSHLOG has been run, the project
status is changed to flush, and the project can be deleted, if desired.
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Flushed version
When a version's status has been changed to obsolete, base revision files that
are a part of that version are flushed if' they are not also part of a
subsequent version. After FLUSH has been run, the version status is
changed to Hush, and the version can be deleted, if desired.

Flush pending
A project status that indicates that log records for the project should be
purged when the FLUSHLOG utility is run.

FMAINT
The facility for creating and maintaining userfilesets.

Forward versioning
An option on checkout to automatically search alternate libraries (usually
previous versions) when a masterfile is not found in the expected location
as dehned by the checkout step. If the file is then found in an alternate
location, it is brought forward as a secondary of a new pending master for
the primary application.

Generation
Each time a file is checked in, a new generation is created. Previous
generations of masterfiles are stored in the library as retainedfi'les (usually
compressed)or as deltas.

Generation count (GCOUNT)
A sequential number assigned to each masterfile generation. The current
GCOUNT is the total number of times a master file has been replaced.
When specifying GCOUNT as an option in a file request, a negative
number indicates a generation relative to the latest generation.

Generic rule
A target — dependency relationship in make that uses wildcards (target) and
edit masks (dependency) to determine what is out of date. Actual target
and dependency names are substituted into the rebuild commands using
make macros.

indirect file
Also called a listfile, an indirect file is a text file that includes a list of
filenames. This file can be used in LIBRARIAN commands as a convenient
way of referencing files. Indirect hles can be created in a text editor or
through LIBRARIAN's LMAINT facility.
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INPROG RESS
A parameter used with a checkout step that instructs LIBRARIAN to record
the existence of a rvrite mode secondary without physically copying the file
from the library This param.eter is most often used when LIBI~~A N i s
initially implemented and some files are already being worked on or
tested.

Intermediate revision
Master files that are retained between versions. The version count
(VCOUNT) for intermediate revisions is always greater than 0.

Leaf Revision
Each revision on a branch is called a leaf, sequentially numbered from the
start of the branch. Whenever a new branch is created, a branch counter
and leaf counter (both starting at I) are appended as a pair to the original
revisi on ID.

LIBRARIAN
The program that controls and processes all file operations maintaining
an audit trail of activity.

Location

LIBRARIAN Manager
A special user capability assigned to the person responsible for configuring
LIBRARIAN and defining site rules. The LIBRARIAN Manager has
unrestricted access to all LIBRARIAN functions for all fi les.

Library
A library is the repository from which files are checked out, and to which
they are subsequently checked in. Files are also distributed to production
locations from the library. It is the 'official' collection of files that are
under LIBRARIAN's control. Files in the library are called masterfiles. The
l ibrary provides a central point of control for changes to production
source, object and data.

Listfiles
Also called an indirectfile, a listfile is a text file that includes a list of
fi lenames. This file can be used in LIBRARIAN corrunands as a convenient
way of referencing files. Listfiles can be created in a text editor or through
LIBRARIA¹ LM AI N T fac i l i ty.

LMAINT
The facility for creating and maintaining listfiles (indirectfiles).

The group/account (MPE) or directory (UNIX) and system where a file
exists or should be created.
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Logical fileset
A meaningful name assigned to a collection of files not bound by physical
boundaries. Seefileset.

! LOGON, ! LOGlN
A special wildcard that can be used in defining step source and
destination locations to indicate that the user's login data should be
substituted as appropriate. For MPE, this wildcard can be used for group,
account and/or system. For UNIX, this wildcard is equivalent to '.' for
current working directory and can also be used for system.

Macro
A set of LIBRARIAN and operating system commands for LIBRARIAN to
execute. A macro control language provides programmatic control
(conditions and loops) and parameter substitution. Parameter values can
besystem — defined or provided by the user via prompts and/or
customized menus. Macros are analogous to MPE command fi les and
UNIX scripts. Multiple macros can be combined in a single procedurefile.
Macros are also referred to as XEQ f i le.

Macro Control Language
The set of special corrunands and keywords that are used in macros to
control flow of execution (IF... THEN...ELSE, REPEAT,

WHILE, LOOP, GOTO) and allow for parametersubstitution (tokens
preceded by %%).

Mail
Mail indudes messages that are sent f rom one LIBRARIAN user to
another, or from UBRARIAN notifying a user that an exception condition
has occurred that affects that user's work.

Make
A util ity that automatically rebuilds/ recompiles components of an
application when they change. Make reads a makefile that shows
dependencies between application components and evaluates which
components are out of date, Based on which components are out of date,
make issues only the commands necessary to bring the application up to
date.

Makefile
A text file that contains make rules. This file can have any name and can
be created and maintained using any text editor. This file includes
target — dependency relationships and commands required to bring each
target up to date whenever their dependencies are changed. Make macros
and generic rules can be used to reduce the size and complexity of a
makefile.
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Make macros
A shorthand that simplifies creating makefiles. Macro references are
substituted with either user — defined or system — defined values when the
makefile is processed. For example, out � of � date dependency names can be
substituted in generic command descriptions.

Master file
A file that is part of a defined library and reflects the most current
production version.

Master fileset
A fileset defined by the LIBRARIAN Manager that includes library files.

Master library
The hierarchy of masterfilesets and associated masterfiles for an application.

Memo
Text that provides documentation for a transaction. Memos are stored in
the audit trail database and can be reviewed using SHOWLOG.

Menu Mode
The mode of LIBRAR1AlV operation in which users select LIBRARIAN
functions from a set of pul ld o w n menus. Users can switch to the
corrunand line promptat any tizne by pressing the F2 function key.

Merge
An option available on checkout steps to combine source code changes
from one or more branches. Conflicting changes are highlighted with
comments in the source code, and should be resolved prior to the next
step. Merge is only available if the delta feature is being used.

! MSUSER
A special wildcard that can be used in defining step destination locations.
When the step is executed, the wildcard is replaced with the user ID of
the user who originally checked out the file, For MPE, this wildcard can
be used to fill in group or account. For UNIX, this wildcard can appear
anywhere in the path name. This wildcard is typically used to reject files
and move them from a test area back to the appropriate developer's work
area.

Multi-write
The access control level that allows multiple secondaryfiles with wri te — mode
access.
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New step
A step that introduces a previously untracked file to LIBRARIAN as a
secondaryfile. The file is linked to a pre-existing masterfile or a pending
master record is created. Rules governing introduction of new files on a
step are configured on the PP (Pending Production Areas ) screen.

Node
The actual device name associated with a system in a network. This name
may or may not be the same as the LIBRARIAN system ID.

Null step
A step not involving any 61e movement. A null step is used to reflect
some external action such as an approval. Null steps are used to control
dependencies between steps; that is, they are used as presteps,

Obsolete version
When the LIBRARIAN Manager or Application Manager change the status
of a version to obsolete, any retained base revisions associated with that
version will be flushed the next time the FLUSH util i ty is run, Once a
version is flushed, it can be deleted, if desired.

Operator
A special capability assigned to a user who canflush records in the log
database and can restore previous revisions of files.

Orphan
Any file not currently being tracked by LIBRARIAN or a masterfile not
associated with an application Orphans can be created by a LIBRARIAN
operation that causes a tracked file to become untracked (unknown to
LIBRARIAN), or by operations that use the orphan option to create files
in destinations that are not to be tracked.

!OWNER
A special wildcard that can be used in defining step destination locations.
When the step is executed, the wildcard is replaced with the user ID of
the user who currently owns the file. For MPE, this wildcard can be used
to fill in group or account. For UNIX, this wildcard can appear anywhere
in the path name. This wildcard is typically used to approve files in
multiple developer work areas.
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Parent Fileset
A fileset that includes component filesets.

Pending master file
A file that is being tracked as a master libranr file, but, because it is new,
does not physically exist in the library yet, The associated secondary is
called a pending productionfile and was introduced through a new step or
through the use of LIBRARIAN's forward versioning feature.

Pending master mask
An edit mask used to automatically derive a pending masterfile name based
on the name of the secondaryfile being introduced through a new step.

Pending production area
Any location(s) defined for a step where previously untrackedfiles can be
introduced as new secondaryfiles. Steps with pending production areas
are considered to be new steps.

Pending production file
A secondaryfile that was introduced using a new step, The master file does
not currently exist in the library.

Permissions
A UMX term used to indicate file access rights; a matrix of read, write,
and execute access for owner, group and world.

Physical fileset
A collection of files that exist in a particular location. Physical fileset
references include specific filenames, or names using standard operating
system/shell wildcards.

Prestep
A step that must be completed successfully for a file before the next step
in the route can be performed. Presteps are often null approval steps.

Procedure
A macro that is included in a file with other macros with a procedure
header.

Procedure file
A file that contains multiple macros. Each macro has a procedure header
indicating the name of the macro. Procedure files can be loaded and
unloaded while using LIBRARIAN.

Project
A way of organizing transactions and associated files with a specific work
activity,
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Project fileset
A userfi'leset that is created automatically when defining a project. The
fileset is maintained automaticallywhen files are checked out or
introduced as new files for the project. Files can also be added to this
fileset in advance by a Project Manager using the FMAINT facility.

Project manager
A special user capability assigned to users who can create projects, modify
project status and authorize users to work on projects.

Project menu
Whenever projects are associated with a particular route, users are asked to
select the project that they are working on f rom a menu when checking
files out or introducing new fi les.

Project status
A flag that determines what acti~ ities can be associated with a project.

PUSHREAD
A step option which allows a read mode copy to replace a masterfile or write
mode secondary which has not been checked in yet. This option is typically
used for emergency steps.

Read mode
The attribute of a secondaryfile that indicates it cannot replace the master,
Read mode copies expire after a configured period of time and can be
flushed using the FLUSH utility.

Read only
An access control level that only allows read mode copies of a file.

Read step
A step that copies a masterfile to a secondary location in read mode, with no
intention for modification. An expiration policy can be applied, so that
read mode copies created by the step can be cleaned up automatically
with the FLUSH utility.

Receiver
A system that can receive files from other systems, but from which
LlBRAR1AN transactions cannot be initiated.

Release Step
Similar to a read step, a release step copies files from the library to a
production location in read mode. Typically, these files do not expire, and
the previous version is often retained.
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Retained file
A previous generation of a file saved under a LIBRARIAN — genera ted
name " ~ AW 4 " . F i l es are retained when the retain parameter is used
on a step and the destination file is a tracked master or secondaryfile. Base
revisions are always retained. If deltas are being used, changes to the
previous generations are stored.

Revision
Any set of changes made to a masterfile through a checkin step. Revisions
include all generations of a master File including the most current. Leaves
and branches also make up the set of revisions for a file.

Revision ID
Revisions are identified by version name followed by a colon (:) followed
by version count. If the revision is on a branch, branch and leaf count
pairs are appended delimited with periods (,),

Route
A set of' automated procedural controls for managing file changes and
distribution. A route consists of a predefined file — movement path that
reflects an established cycle. The route includes steps for all allowable
movements of the files for that cycle.

Route Alias
When defining proj ects, a route alias can be defined to indicate that the
project only applies to a particular route. The project name can be used in
place of the route name when performing a step (i.e., step. project) to
bypass the proj ect menu.

Rule Administrator
Similar to the LIBRARIAN Manager, the Rule Administrator is a user with
special user capability who can define LIBRARIAN rules such as steps and
filesets, but is notautomaticallyauthorized to perform LIB%"-dGAN
functions, and cannot create user authorizations.

Scan/Replace
A LIBRARIAN function that searches files for patterns of text, and
optionaHy replaces the matches with user — defined text

Scope
The attribute of a step that restricts which 61es the user can request. When
copying or moving fi les, the scope specifies where files come f rom and
where they can be copied. Steps can restrict by hleset, f rom location and

Secondary file
Any copy of a masterfile or another secondary file. All secondaries are
linked to a master (or pending master) either directly or indirectly, and are

to location.

in read or zurite mode,
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envirorunent.

Secondary location
Any location v here secondaryfiles can be created.

Serial write
The access control level that allows only one secondaryfile at a time to have
write mode access, preventing concurrent modifications.

Server
A system that has an implementation of LIBRARIAN which includes the
LIBRARIAN databases. Clients access this database and other
LIBRAIGAN functions remotely.

Sethngs
LIBRFQUAN session-level parameters that control the user's working

Special user capability
See user capabilities.

Standard Ru(e
A make rule that associates specific target(s) with specific dependencies.

Step
A rule governing the copying and moving of files f rom one location to
another. Steps are the basic building blocks of the LIBRARlAN f i le
movement and control system. Steps are grouped into routes and are
performed using system — and/or site — defined names.

Step parameter defaults
Options that control the behavior of a step, by default.

Step parameter overrides
If allowed, users can override step parameter defaults by specifying desired

Step refinements/exceptions
A step definition that includes rules for altering the destination location
based on the from location, filecode (MPE), and/or fileset membership.
The same criteria can be used to alter the type of znovement (copy, move
or null) or exclude files altogether from the step.

Step type
There are three types of steps: master — to — secondary (MS),
secondary — to-secondary (SS) and secondary — to — master (SM). MS steps
are steps that checkout or distribute files. SM steps are steps that check
files in. SS steps encompass all steps in between, such as move to test and
approvals

System
A unique node within a network identified to LIBRARIAN wi th a unique
system ID.

overrides.
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System lD
Used to identify systems to LIBRARIAN with in a network. Optionally
appears as a prefix to a filename delimited by ' to indicate the
appropriate system.

System Profile
A set of global parameters maintained by the LIBRARIAN manager that
control how LIBRARIAN operates. Includes items such as flush policy,
aging policy, date formats, etc.

Tag
A user — defined name for a particular revision of a file or files that can be
used to identify them at a later time, even after they have been retained.

Target
Component of a make rule that is built from one or more dependencies
using one or more commands. Object code and executables are examples
of targets.

Tracked file
A file for which there is a record in the LIBRARIAN data base. Tracked
files are masters, secondaries or retainedfiles and movement operations are
controlled by LIBRARIAN rules. All other files are untrackedfiles.

Transaction
Any LIBRARIAN operation attempted either successfully or
unsuccessfully on a set of files. Except for commands which provide
information, all transactions are logged in the LIBRARIAN audit trail .

Trunk revision
A revision that is not checked in on a branch.

Untracked file
A file for which there is no record in the LIBRARIAN database. Ad hoc
operations on these files conform to normal operating system security.
Steps cannot be perf'ormed for untracked files,

User authorizations
The mechanism for determining who can do what. Authorizations can be
defined for steps and projects, Special user capabilities can be assigned so
that specific authorization is not required in some cases.
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User capabilities
Grants users certain privileges that transcend standard user authorizations.
These include LIBRARIAN Manager, Application Manager, Project Manager,
Operator, Rule Administrator and X capability. If no special capability is
assigned, authorization is required for steps, and other commands
conform to normal operating systemsecurity.

User fiieset
A fileset created and maintained by a user through the FMAINT user
fileset module. User filesets allow users to group files for their
convenience. Like masterfilesets, precede user filesets with % when
referencing them in commands.

!USERID
A special wildcard that can be used in defining step source and destination
locations. When the step is executed, the wildcard is replaced with the
user ID of the user performing the step. For MPE, this wildcard can be
used to fill in group or account. For UNK, th is wi ldcard can appear
anywhere in the path name. This wildcard is typically used to check out
file's into the developer's work area

User ID
A unique identifier for a LIBRARIAN user that is password protected.
Users are prompted for their User ID when init iating the LIBRARIAN

User password
Used to protect against unauthorized use of the LIBRARIAN system.
Passwords are required and can be changed by the individual users.

program­

Verify
The LIBRARIAN facility for reviewing file information on — line or off — line.

Version count (VCOUNT)
The sequential number that tracks the number of generations since the
current version was defined.

Version
All the files in an application, as they were at a specific point in time.

Version ID
The name given to a version by a LIBRARIAN or Application Manager.

Wildcards
Special characters or tokens used in filenames to request multiple files
that match a pattern, and/or to determine destination locations.
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Work-in-progress
Untracked files that were in development and/or test prior to
LIBRARIAN implementation.These files can be handled using the
INPROGRESS parameter v ith a checkout step.

Write mode
The attribute of a secondaryfile indicating that it can replace its masterfile
through an authorized checkin step.

XEQ file
A text file that contains the commands for a single macro. These rnacros
are executed by filename.
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Index

Symbols

::: usr S-14

!: ref 1&, 3 — 1; adm 4-7
?: adm4 — 6
:: ref 1 — 4; usr 8 — 14

: —: usr 8 — 14, 8 — 15
:=: usr S — 15
$NP: ref l -67; usr 3 — 13
'lo'la. ref 7 — 3
C<: adm 4 — 6
—: adm4 — 6
': ref 1 — 6, 1 — 94, 1 — 115; usr 3-3; adm 4 — 6
"': ref 1 — 6, 1 — 94, 1 — 115; usr 3 — 3
"Empty': usr 9 — 5

ref 3-1
=: adm4 — 6

Access control: adm 3 — 4
setting default: ref 5 — 16, 5 — 29

Access mode: ref 1-150; adm ~

setting: ref 1 — 122
setting default: ref 5 — 16, 5 — 29

Accessing LIBRARIAN: usr 2 — 1
ACCOUNT variable for ~ : usr 8 — 17
ACTIVATE: ref 1 — 19
ADJUST: ref 7 — 7
Admin menu: ref 9-S
Aging policy: ref 1 — 41
ALL parameter for LM>OUTPUT: usr 7-2
ALL parameter for ~ : usr 8 — 5
ALLOYS: ref l — 20; usr 9 — 5
Alternate search locations: adm 7-6
ALTPATH variable for ~ : usr 8 — 18
Annotation: ref 1 — 29, 1 — 120; usr 1-4, 4 — 11, 5 — 1

example of: usr4 — 12,5 — 2
settjng language for: ref 5 — 18, 5 — 30

Applications: usr 1-2, 7-4; adm 2 — 3, 3 — 1
automated testing: usr 8 — 2
building: ref 8 — 1
compiling: ref 1 — 53; usr 8 — 1

7 — 3

Authorizations

Transactions

at command: usr 3 — 19

default: adm 3 — 12

Auto Filesets

location of: usr 9 — 7

versions of: adm 7 — 1

5 — 9,5 — 21; adm 2 — 5,3 — 8,3 — 9

descriptors: ref 6 — 13
report of: ref 6-13

Auto Filesets (AF) screen: ref 5 — 9, 5 — 21
example of: adm 3 � S

Auto Filesets (RAF10) report: ref 1-21, 6 — 13
AUTOUPDATE. See Auto Fileset Update
AUTOXEQ files: ref 1-3, 7 — 14

Background process, UNIX clients: ref 1-4; usr

Base revision: ref 1-82; adm 7 — 2
Base version. See Base revision
Baseline. See Versions
BATCH: usr 3 — '18

default for session: ref 1 — 95, 1 — 101, 1 — 117
defining: ref 5 — 11
deleting: ref 1 — 36; adm 2 — 5
dependencies in: usr 8 — 1
example of archiving: usr 7-4
file dependencies: usr S — 4
in progress: usr A — 1
menu of: ref 7 — 17
processing text: usr 8 — 2
rebuilding documents: usr 8 — 2

Applications (AP) screen: ref 5 — 11

exampleof: adm 3 — 2

AT location: ref l — 9; usr 3-4
Audit trail. See Transaction reporting;

Audit trial transaction, flushing: adm 9 — 2

projects: adm 6-4
steps: adm 5-4

AUTHORIZE parameter for LM>OUTPUT: usr

Authorized files: usr %10
Auto fileset descriptors: adm 3-8
Auto Fileset Update (AUTOUPDATE): ref 1 — 21,

2 — 1
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3 — 18; adm 4 — 9
Batch transactions: ref l — 3, 1 — 13; usr 1 — 3,3 — 9,

Branches: usr 4 — 3
BRANCH: ref 1-68
merging. See Merging revisions
NOBRANCH: ref 1-70

Building applications: usr 8 — 1
Bypassing menus: ref 1 — 3, 7 — 14

Conditional files: usr 3 — 12
in macros: usr 9-3

Conditional looping: ref 7 — 21, 7 — 24
CONFIG, changing database passwords:
CONFIGP: ref 11 — 1
Cordiguration hie: ref 1 — 2, 11 — 1

changing: adm C-1
Configuration management: usr 1 — 3

excluding files from: ref 5 — 13
Concurrent maintenance, example of: adm
Conditional expressions: ref 7 — 12

1 — 9

adm 9 — 2

See also Routes

Checkout

Checkout/checkin: adm 2 — 1

Capabilities
See also User capabilities
SM: ref 5 — 64

Capacities, LIBRAIGAN databases: ref 1 — 22, 1 — 55
Capailities. See User capabilities
Caret (~): ref 3 — 1
Change control cycle: usr 1 — 2; adm 2 — 1

CHECKDB: ref 1 — 22
Checking

LIBRARIAN databases: ref 1 — 22
LIBRA]VAN databases capacities: ref 1 — 55

previous revision: usr 4 — 1
simulating: usr A — 2

CLEANDB: ref 1 — 23
CLOSE: ref 1 — 24
Colon (:): reflux
Command mode: ref 1 — 3; usr2 — 5

switching to: usr 2-5

access restrictions: ref 1 — 15
cornrnonly used: usr 2 — 10
editing previous: ref 1 — 86, l&7
listing previous: ref 1 — 50
looping: ref 7 — 13, 7 — 21, 7 — 24
repeating execution of: ref 1 — 37
summary of: ref 1 — 16

Company name: ref 6-5
Comparing Files: ref 1 — 109

example of: usr 4 — 11
Compiling appl ications: usr 8-1

Composite Presteps (CP) screen: ref 5 — 14

exampleof: adm 4 — 10
COMPRESS: ref 1 — 25
CompressExclusions (CE) screen: ref 5 — 13
Compressing files: usr 3 — 15

automatic: ref 5 — 62

Datasets

CONFIRM: usr 3 — 7
Conflicts

example of: usr 4 — 9
resolving for merge: usr 4-9

CONNECT: ref 1 — 27
CONTINUE: ref 7 — 8
COPY: ref l — 29; usr 3 — 7
Copy steps: adm 4 — 5
Copying files: ref 1 — 66
COP~ M v ar i a b le for ~ usr 8 — 19
Create projects

PROJECT command: adm 6 — 2
Projects (PJ) Screen: adm 6 — 2

Customized software: adm 7 — 7
Cycle. See Routes

Data, deleting mass: ref 5 — 93
Database passwords: ref 11 — 1; adm C — 1
Database utility: ref 10-1

LIBDB: ref 12 — 1
LIBLOG: ref 12-4

Date format: ref 5-62
Date prerequisites: ref 5 — 14
DECOMPRESS: ref 1 — 34
Decompressing files, automatic: adm A — 1
Defining rules, Shortcut uti l i ty: adm 2 — 1
Defining steps: adm 4 — 4, 4 — 13
DELETE: ref 1 — 36
Delete, mass data: ref 5 — 93
Delta files: usr 1-4, 4-4

associated master: ref 1 — 142; usr 4 — 14
integrity of: usr 4 — 14
maintaining: usr 4-6
purging: usr 4 — 12
restoring from: r ef 1 — 102
verifying checksum: ref 1 — 142
vs. generation files: usr 4-4

Commands
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Differences between files: usr 5 — 4

ECHO: ref 7 — 9
ECHO parameter for MAKE: usr 8-5
EDIT: ref I — 38
Edit masks: ref I — 11; usr 3 — 7

for MAXE: usr 8 — 14
inmacros: usr 9 — 4
in UNIX destinations: adm 4-9
list of symbols: usr 3 — 8
pathnames: usr 3 — 8
referring to different elements: usr 3 — 9

Editing files: usr 3 — 15
Editor: ref I — 14; usr 3-15

Emergencyfix rule: adm 1 — 7
END: ref 7 — 10
Environment variables: ref 1 — 2
Error messages, security monitor: ref 1 — 30, I — 57,

Escape key: usr 2 — 5
Exception report: ref 1-23
Exclamation point (!): ref 3 — I

Dependency tree, for MAKE: usr 8 — 4

Development
inprogress: usr A — I

Dial — DS: ref 5 — 85
Dialogs: ref 9 — 11

Distribution, forward versioning with: adm 7 — 7
DO: ref 1 — 37
Documenting file movements: usr 3 — 14
DS/3000: ref 5 — 37
DSLINE: ref I — 27
Dummy target: usr 8-11

concurrent maintenance with: adm 7-7

File movement rules

File transactions: usr 3 — 1

I — 68

6 — 52

Filenames: usr 3 — 2

exclusions: usr 3 — 6

EXCLUDE variable for ~ : usr 8 — 19
Excluded fi les: usr 3-12
Exclusive access control: adm 3 — 4
EXIT: ref 1 — 39
Expiration: ref I — 150, 1 — 154

defining pol icy for: adm 4 — 12
setting: ref I — 118

EXPRESS SUBMIT: ref 1-13

conditional: usr 3 — 12

commands for: usr 3 — 17

access override: adm 3 — II

6 — 54

referring to: ref 1-6
Files: ref I — 154

access control: ref 5 — 16
access mode: ref I — 122, 1 — 150, 5 — 16

annotation: ref 1 — 30, 1 — 120
applying selection criteria to: ref 3 — 10
assigning tags: adm 7 � 8

associated master: ref 1-142
associated projects: ref 1-144
associated user filesets: ref I � 145

associated versions: ref I — 146
authorized: usr 3 — 10
automatic decompression: adm A � I
checking existence of: usr 9 — 4

compiling: ref I — 53, 8-1
compressing: ref 1 — 25

confirming authorized: ref I — 11
copying: ref 1 — 29
counts: ref I — 147

File dialog: ref 9-11
File Exceptions (RFXIO) report: ref 6 — 29
File Inquiry (FI) screen: ref 5 — 24

example of: adm 8 � 2

File rnanag ement
objectives: usr I � 5; adm I � I

overview: adm I — I
rules: adm 1 — 3

File menu: ref 9-3

See aIso Routes; Steps
reviewing: adm 4-19
routes: adm 4 — 1
sequence for defirung: adm 4 � 19

steps: adm4 — 1
File rnovernents

associating projects: adm 4 — 3
defining rules for: adm 4 — I

multiple file references: usr 3 — 6
File naming conventions: ref xv
File operations, batch mode: usr 3 — 18
File security, enhancing: usr 3 — 15

File Versions (RVD10) report: ref 6 — 50
File Versions and Tixnestamps (RVT10) rep

File Versions and Tirnestamps (RVT20) rep

ort: ref

ort: ref

Features: adm I — 2
File Access (FA) screen: ref 5 — 16

example of: adm 3 — 12
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4 — 6

creating listfile of: ref 3 — 1,0
decompressing: ref 1-34; usr 3 — 15
defining movement rules: ref 5 — 71
deleting tracking: ref 1-81
description: ref I — 157, 5 — 16
destinations: usr 3 — 7
differences between: ref 1-46, I � 109
directly referring to: usr 3 — 2
editing: usr 3 — 15
exceptions: ref I — 96
excluded: usr 3 — 12
excluding: ref I — 10
excluding from compression: ref 5 — 13
expiration date: ref I — 10, I — 150, 1-154

expiration policy: adm 4-12
expired: ref IMO
FLUSH policy: usr 4 — 6
flushed: ref 6-7
forward versioning: adm 7 — 5
generated: ref I — 149
generation count: usr 3 — 4
in last transaction: usr 3 — 3
indirectly referring to: usr 3 — 3
ixdormation about: ref 1 — 138, 5 — 24; us

adm 8 — 2,8 — 3
language: ref1-120, 1-157, 5 — 16
last step performed: ref I — 151
last transaction: ref I — 7
locking: ref I — 52, I — 133
lockword: ref I — 121
macros that process: @sr 9 — 2
merging revisions: ref I — 70
modified status: usr 3-6

moving:ref I — 56
MPE security: r ef 1-88, I — 113
new: ref l — 70,5-42,5 — 51; usr 4 — 4; adm
nonexistent: ref I — 23
on ho]d; ref I — 52, I — 133
online inquiry : ref I — 138
original filenames: ref I — 153
ownership: ref I — 124, I — 150
pathnarnes: usr ~
PC transfer: ref I — 64, I — 65
pending masters: ref 6 — 35
previous versions: ref I — 149
printing: usr 5 — I
purged: ref 1-23
purging: ref I — 81
purging old versions: adm 7 — 4
referring to: ref I — 5; usr 3 — 2

r 3-21;

ll sr

sets of: usr 6-1

referring to by project: usr 3 — 5
referring to by revision: usr 3 — 3
referring to by step; usr 3 — 5
referring to mult iple: ref I — 10
renaming: ref I — 90
replacing text in: ref 1 — 105; usr 5 — 2
report by master: ref 6-19
report of: ref 6 — 7, 6 — 17, 6 — 35
report of expired; ref 6-25
report of generations: ref 6-31
report of missing: ref E 29
report of untracked: ref 6 — 29
report of versions: ref 6-50
retained: adm 4 — 12
retaining: usr 4-4
revision storage: usr 4 — 4
revisions: ref 1 — 155, I — 156; usr 3 — 3,4 — 2
scanning: usr 5 — 2
searching for text in: ref I — 105; usr 5 — 2
secondary location: usr 3-4
selecting by date: ref 1-11
selecting by project: ref I — 10
selecting by tag: ref 1-10
selecting tracked/un t racked: ref I — 11

showing di8erences between: usr 5 — 4
showing versions of: usr 4 — 12
step history: ref 1-152
subset selection: usr 3 — 6
tagging: ref1 — 128,1 — 155; adm 7 — 8
timestamps: ref I — 99, I � 100, I � 131
tracked: ref I — 11
tracking status: usr 3 — 7
transferring fi om PC: ref I — 65
transferring to PC: ref l~
untracked: ref 1-11; usr 3 — 17
user confirznation: usr 3 — 7
VERIFY: adm 8-3
versions ofi usr 3-3; adm 7 — I, 7-4
violations: usr 3-12

Files in Filesets (FF) screen: ref I — 21, 5 — 21
exampleofi adm 3 — 10

Fileset Components (FC) screen: ref 5-19
example of: adm 3 � 6

Fileset descriptors: ref 1-21
Fileset Explosion (RFEIO) report: ref 6 — 21
Fileset Explosion (RFE20) report: ref 6 — 23
Fileset Status (RFDIO) report: ref 6 — 17
Filesets: usr 6 — I; adm 3 — 5, 3-14

ad hoc. See User filesets
auto fileset descriptors: ref 6-13
defining: ref 5 — 29

4 — 15
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FOPEN

6 — 6

files in: adm 3 — 7

numbered: usr 7 — 2

user. See User filesets

defining hierarchy of: adm 3 — 14

hierarchy of: adm 3 — 6
information about fi les in: ref 5 — 24
logical: usr 3 — 3
master. See Master filesets
members of: ref 1 — 143; adm 3 � 7

projects: ref 2 — '12; usr 6 — 3

referring to: usr 3-3
report by master: ref 6 — 19
report of: ref 6 — 17
reporting members of: ref 6-21, 6-23

Filesets (FS) screen: ref 5 — 29
example of: adm 3 — 5

FLUSH: ref 1 — 40, 1&1
Flush, preview of f i les ready for: ref 6-25, 6 — 27
Flush Detail (FLUSH) report: ref 6-7
Flush policy: ref 5-62
Flushing

expired files: adm 9 — 1
expired transactions: adm 9 — 2

FLUSHLOG: ref 1 — 41, 6 — 39, 6 — 41, 6 — 43; adm 6 — 5,

FM>ADD: re f2 — 3; usr 6 — 2
FM>CREATE; ref 2 — 4; usr 6 — 2
FM>DELETE: ref 2-5; usr 6 — 2
FM>EXIT: ref 2-6
FM>HELP: ref 2 — 7
FM>LIST: ref 2 — 8; usr 6 3
FM>LMAINT: ref 2 — 9
FM>MAKE: ref2 — 10; usr 6 — 2
FM>PURGE: ref 2 — 11; usr W2
FM>RELATE: ref2 — 12; usr 6 — 2
FM>SERVER: usr 6 — 2
FM>SEVER: ref 2 — 13
FM>SHOVt ref 2 — 14; usr 6 — 3
FMAINT: ref1 — 42, 2-1; adm 6-2

accessing: ref3-7
cornrnands: ref 2 — 2
exiting: ref 2-6

decompression: adm A — 2
trapping: adm A — 2

FORMAT parameter: usr 3 — 22
Forward versioning: adm 7 — 5

example of: adm 1-9
searching mult iple locations: adm 7 — 6

jobs: usr 3 — 21

Indirect files. See Listfiles

vs. Delta files: usr 4 — 4

IF/ELSE: ref 7 — 12

Info menu: ref 9 — 7
INPROGRESS parameter: usr A — 1

HELP: ref l — 43; usr2-6; adm 4 — 19
Help menu: ref 9 — 10
HELP PROJECTS: adm 8 — 7
HELP STEPS: usr 3 — 9; adm 4 — 19, 8-7
Housekeeping: adm 9 — 1

JCWS
adjusting values in znacros: ref 7 — 7
LIBMATCHES: ref 1 — 108

setting up: adm 7 — 5
Forward Versioning (FV) screen: ref 5-32

example of adm 7-6

Function keys: ref 1 — 1

transaction status: usr 3 � 21

example of: usr 3 — 20
running LIBRARIAN f rom: usr 3 — 19

GCOUNT. See Generation count
Generated Files (RGF10) report: ref 6 — 31
Generation count: usr 3 — 4,4 — 4

referring to: ref 1-8
Generation files: ref 1 — 7, 1-8, 1 — 149; usr 4 — 4

original filenames: ref 1 — 153, 6 — 31
report of: ref 6 — 31

Getting started: usr 2-1
Global changes to LIBRARIAN database: ref 10 — 1
Global search/replace: usr 5 — 2
GOTO: ref 7 — 11
GROUP variable for MAKE: usr 8 — 18

K
KILL: ref 1-45
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Link: ref 1 — 24
LISTF: ref I&Language: ref 1 — IS7

setting: ref 1 — 120,5 — 16; adm 3 — 12
setting default: ref 5 — 29

9 — 1

1-'102

features: usr 1 — 4
Library. See Master library
LIBSCREEN: ref 1 — 49
LIBUTIL: ref 10 — 1; adm B — 1
Lme drawing characters: ref 1 — 2
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LIBBATCH variable: usr 3 — 19

LAST: usr 3 — 4
Last transaction

referring to files in: ref 1 — 7; usr 3 — 3
resetting reference to: ref 1 — 94
saving list of files from: ref 1 — 115

LASTNOTO parameter: usr 3-4
LCOMPARE: ref 1 — 46; usr 1-5

example of: usr 5 — 5

LIBDB database: ref 12 — 1
LIBLOG database: ref 12 — 4; adm 8 — 8

znaintaining: ref 4 — 6
transaction codes: ref 6 — 3

LIBMGR. See LIB1V'DORIAN Manager
LIBPROMPT variable: usr 2-6
LIB RAIUAN

accessmg: usr 2-1
benefits and features: usr 1 — 1

components: usr 1 — 2
concepts: usr 1 — 1, 1 — 2
configuring: ref ll — 1; adm C — 1
configuring server logon/passwords:
database passwords: ref 1'I — 1
features: usr 1 — 5; adm 1 — 2

terminology:usr 1 — 2
LIBRARIAN Admin istrator, housekeeping

LIBRARIAN databases: ref 12 — 1
capacity management: adm 9 — 2
changing passwords for: adm 9-2
loading/un loading: adm B — 1
monitoring: ref 1 — ~M, 1 — S5
passwords: adm C — 1

LIBRARIAN Manager: adm 2 — 2,2 — 7, 5 — 3
capability: adm 2 — 7
creating: adm 2 — 7
deleting. adm 2 — 8
restricting: ref ~ 2

LIBRARIAN prompt,changing: usr 2-6
LIBRARIAN/iX Plus: ref 1 — 29, 1-46, 1 — 76,1 — 81,

ref ll — 1

Listfiles: usr 7 — 1

See also Transactions

in~ : usr 8 -16

appending to: ref 3 — 3
archiving with us r 7 — 4
creating: usr 7 — 1
creating with SHOWLOG: ref 4 — 12
editing: ref 3 — 5
example of: usr 7 — 2
generated by SHOWLOG: adm 8-4
listing files in: ref 3 — 9, 3 — 1S
maintaining: ref1-51, 3 — 1; usr 7-3
maintaining documentation for: ref 3-4
numbered: ref 3-13
referring to: ref 1-6; usr 3 — 3
refreshing content of: usr 7 — 2
selecting files based on step: usr 7-3
selecting files by date: usr 7 — 2
selecting files for: ref 3 — 10
showing related docuznentation: ref 3 — 16
sorting: ref 3-16
using with STORE: usr 7-4

LISTFX10: ref 1 — 23
LISTREDO: ref 1 — 50
LM>ALTER: ref 3 — 3; usr 7 — 3
LM>DOCUMENT: ref 3-4; usr 7 — 3
LM>EDIT: reft; usr 7-3
LM>EXIT: ref3-E
LM>FMP~ : ref 3 — 7
LM>HELP: ref ~
LM>LIST: ref 3-9; usr 7 — 4
LM>OUTPUT: ref 3 — 10; usr 7 — 1,7 — 3,7 — 4
LM>REPORT: ref 3 — 15; usr 7 — 4
LM>SORT: ref 3 — 16; usr 7 — 3
LMAINT: ref l — 51, 3 — 1; usr 7 — 1

accessing: ref 2 — 9
commands: ref 3 — 2
exiting: ref 3 — 6

LOCK: ref 1 — 52
Locks, status: ref 1 — 141
Lockwords: usr 3 — 15

assigning: usr 3 — 15
changing: ref 1 — 136; usr 2 — 3
setting: ref 1 — 121

Log records

deleting: ref 4 — 6
Log reporting: ref 1-130

See also Transaction reporting
Logical fileset, referring to: ref 1 — 6
LOGON wildcard: adm 4-7



9 — 5

Macros: ref 7 — 1; usr 3 — 15, 3 — 21, 9 — 1

commands: ref 7 — 13, 7 — 21, 7 — 24
in rnacros: usr 9 — 4
nesting: usr 9-5
REPEAT/UNT IL : usr 9 — 5
WHILE/ENDWHILE: usr 9 — 5

LP parameter: usr 3 — 21

Long Pathname (LP) screen: ref 5 — 34
Lookup, step refinement: ref 5 — 67
LOOP/NEXT: ref 7 — 13
Loops

automatic execution of: usr 9-7
AUTOXEQ: usr 9-7
checking file existence in: usr 9-4
comments rn: ref 7-5
conditional expressions: ref 7 — 12; usr 9 — 3
conditional looping: ref 7 — 21, 7 — 24
control language summary: ref 7W
control options: ref 7 — 15
controlling display: ref 7 — 9
displaying messages: ref 7 — 9
edit znasks: usr 9-4
editing: ref 7 — 2
entering data on the command line: ref 7 — 15
error handling: ref 7A
exampleof: usr 9 — 2
execution of: ref 1 — 161, 7 — 1
filename substitution in: ref 7 — 3
files for: ref 7 — 2, 7 — 15; usr 9 — 2
jumping to specific location in: ref 7-11
location of: usr 3 — 15, 9 — 2
looping for files: ref 7 — 13; usr 9 — 4
looping through records in a file: ref 7 — 13; usr

menus in: ref 7 — 17; usr 9 — 3
nesting: ref7 — 15; usr 9 — 6
nesting loops: ref 7 — 15; usr 9-6

parametersin: ref 7 — 3, 7 — 17, 7 — »; usr 9 — 3
pausrng ln: ref 7 — 23
procedure files: ref 1-125, 7-20; usr 9 — 7
prompting users: ref 7 — 17
providing custom help for: ref 7 — 3
reusing parameters:ref 7 — 15; usr 9-6
RUN: ref 7 — 5
signalling end of: ref 7-10
specifying parameter values: ref 1 — 161
STREAM: ref 7 — 5
suppressing commands/messages: ref 7 — 9

7 — 7

8 — 16

See also Makefiles

makefiles: usr 8 — 2

conventions: usr 8 — 5

variables. See Parameters

suppressing warrring: ref 7-15
terminating: ref 7 — 10
user capabilities in: ref 1 — 20

Macros menu: ref 9 — 5
MAIL:ref 1 — 55
Main menu: ref 9 — 2
Maintenance, concurrent development v, ith: adm

MAKE; ref 1 — 53, 8 — 1; usr 8 — 1 fl — 3

accornrnodating new fi les: usr 8 — 8
account default for: ref 8 — 9
across multiple accounts: usr 8 — 18
applying edit mask to LISTF in: usr 8 — 8
automatic dependency deterrrunation: usr

benefits: usr 8-2
COBOL COPYLIB: ref 8 — 9
controlling job launching: ref 8 — 8
controlling job logon: ref 6-5
defining rules for: ref 8-2
dependency tree: usr 8 — 4
dummy target: usr 8-11
edit masks: ref 8 — 6
example of operation: usr 8 — 3
executing. usr 8 — 20
files in mult iple accounts: ref 8 — 10
generic rules: usr 8 — 15
generic values: ref 6 — 6
group default for: ref 6 — 9
iterative command processing: usr 8 — 12
job logon: usr 8-6

promptingusers for input: usr 6 — 19
rules: ref &2; usr 8 — 5
searching for dependencies: ref 8 — 5
targets: usr 8-2
TOUCH command: usr 8 — 20
types of rules: usr 8 — 14

Makefiles: ref 8 — 1; usr 8 — 2
comments in: ref 8-2; usr 8 — 5

creating: usr 8-5
defining rules: usr 8 — 5
delimiters: usr 8 — 14
edit masks in: usr 8-14
example of: usr 8-6, 8 — 7, 6 — 9
job cards in: usr 8 — 13
LISTF variables: usr 8 — 16
multiple generic dependencies in: usr 8 — 15
rules: usr 8 — 14
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Menus

MAKEOUT: usr 8-8

associated delta files: usr 4 — 14

special variables: usr 8 — 16
system variables in: usr 8 — 20
variable substitution in: ref 8 — 7; usr 8-12

Mass changes to LIBRARIAN database: ref 10 — 1
Master File Status (RFD20) report: ref 6 — 19
Master files: usr 1 — 2; adm 1 — 3

associated: ref 1-148

associated deltas: ref 1 — 142
associated write — mode secondary: ref 1 — 148
new: ref 5-42, 5 — 51
ORPHAN: ref 1 — 61
pending: ref 1-70, 5 — 42, 5 — 51, 6-35
reporting revisions of: ref 6 — 37

Master filesets: ref 1 — 143
adding files to: ref 5 — 21; adm 3 — 10
defining hierarchy of: ref 5 — 19
deleting: adm %13
deleting files from: ref 5 — 21
reporting: adm &13

M aster library: usr 1-2; admi — 3,3 — 3, 3 — 14
defining: ref 5 — 19, 5 — 21, 5 — 29
deleting: adm 2 — 5, &13
reporting: adm 3 — 13

MASTER parameter:ref 1 — 70
Matching patterns: ref 1-106
MEMO: refl -55; usr 3 — 15
Memos: refl-14; usr 3 — 15

editing: adm 8 — 8
MENU: ref 7 — 14
Menu mode: ref 1-3; usr 2M

dialogs in: ref 9 — li
steps dialog: usr 2 — 7
switching to: usr 2 — 5
usmg: usr 2-5

Admin: ref 9A
bypassing: ref 1 — 3, 7 — 14; usr 2-4
controlling: ref 7 — 14
File: ref 9-3
Help: ref 9 — 10
hierarchy of: ref 9 — 1
inmacros: ref 7 — 17; usr 2 — 4
Info: ref 9 — 7
Macros: ref 9 — 5
Main: ref 9 — 2
Options: ref 9 — 13
Revision Criteria: ref 9 — 12
setting parameters: usr 9 — 3

MPE

conflicts: usr 4 — 9

MSUSER wildcard: adm 4 — 7

suppressing: ref 7 — 14
Tools: ref 9 — 6
User: ref 9 — 4
userMefined: ref 7 — 17; usr 9-3

Merge: usr 1-4
Merge conflicts

exampleof: usr 4 — 9
setting language for: ref 5 — 18, 5 — 30

Merging revisions: ref 1 — 70; usr 4 — 7

excluding specific changes: usr 4 — 9
including specific changes: usr 4 — 7

Messages
audit trail: ref 1-55
controlling: usr 3 — 12
to users: ref 1 — 55

Modification timestamps: ref 1 — 131
MODIFIED: ref 1 — ll; usr 3 — 6
MOVE: ref 1 — 56
Move steps: adm 4 — 5
Move — to — production: usr 1 — 3
Movement rules. See Steps
Moving files: ref 1~

commands: ref 1 — 3
security: ref 1 — 113

Multiple search locations: adm 7-6
Multiple versions, example of: adm 1 — 9
Multiple write access control: adm ~

Network Configuration (NC) screen: ref 5 — 37

exampleof: adm 2 — 5
Networking

buffer size: ref 5 — 37
changing configuration: adm 9 — 3
configuring: ref 5 — 37, ~9, 5-85
example of: adm 2 � 5

linking to remote MPE systems:ref 1 — 104
logan security: adm 2 — 5
node names: ref 5 — 69
overrides: ref 5 — 85
passwords: ref 5 — 37, 5 — 85
troubleshooting; adm 2 — 5

Nev files: ref l — 70; usr4 — 4
See also Pending master files
added with a step: ref 1 — 5
rules for: ref 5 — 51; ad m 4 — 15

X.M~: adm 2-5
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Node name, System — to — System Table (SS) screen:
ref ~9

NOMAKE parameterfor MAKE: usr 8 — 5

NS/3000: ref 5 — 37
Null steps: adm 4 — 5

NOVIOLATIONS: usr 3 — 20

Object code, introducing: ref 5-51
Objectives: adm I - l

file management: usr 1 — 5
Online help: ref l — 5; usr 2W
Online inquiry

files: ref l — 138
versions: ref I — 159

Option menu:ref 9 — 13; usr 2 — 9
OPTION statement for macros: ref 7 — 15
Original fi lename. See Generations
ORPHAN parameter: ref I — 32, 1 — 61

Output, redirecting: ref 6-4
OVERLAY: ref I — 32, I — 62
Owner, setting: ref I — 124, 1 — 150

OUTPUT: usr 7 — 3

alternate: adm 4 — 9

Pending master file, report of: ref 6-35
Pending Master Files (PF) screen: ref 5 — 42
Pending Master Files (RPM10) report: ref 6 — 35
Pending Production Areas (PP) screen: ref 5-51

example of: adm 4 — 16
field descriptions: adm 4 — 16

PERFORM: ref I&6; usr 2 — 9,3 — 13
PH capability: adm A — 1
Pre — Flush Notification (RFNIO) report: ref 6 — 25
Pre — Flush Notification (RFN20) report: ref 6 — 27
Presteps: adm 4 — 9

composite: ref 5-14; adm 4 — 9

multiple:adm 4 — 9
Steps (ST) screen: adm 4-9

Previous transaction, saving files from: ref I — 115
PRINT: ref I — 76
Printer, escape sequences: ref I — 47, I — 77
P~ SC f i l e : ref 147
Printing files: usr 5 — I

annotated: usr 5-1

recursion: usr 3 — 2

OWNER wi ldcard: adm 4 — 7

Parameters
allowing users to override: adm 4 — 12
inmacros: usr 9 — 3
step defaults: adm 4 — 12

PARM: ref 7 — 17
PASSWORD: usr 2 — 3
Passwords

changing: ref l — 136, 5 — 91
LIBRARIAN databases: ref 11 — I
providmg: usr 2 — 1
removi n: usr 2 — 3
security: ref 5 — 64, 5 — 65; adm 2-6

Pathnames: ref I — 6
entering long names on screen: ref 5-34

Pattern matching: ref I — 106

Pause in rnacros: ref 7 — 23
PC: ref I — 64,1 — 65
PCRECEIVE: ref 1-64
PCSEND; ref 1-65
Pending master: ref 1 — 70

Procedures

2 — I

I — 92; usr 6-3; adm 6 — 7

PRIVATE: usr 6 — 2
Private filesets: usr 6 — 2
PROCEDURE: ref 7-20
Procedure files: ref 1-125; usr 9 — 7

executing: ref I — 161
naming: ref 7 — 20
signalling end of: ref 7 — 10
terminating: ref 7 — 10

Process, running in the background: ref I&; usr

Process ID numbers: ref I — 19, 1-45
Programs, compiling: ref 8 — I
PROJECT: ref I — 78
Project Authorizations (PA) screen: ref 5 — 40

example of: adm 6 — 2
field descriptions: adm 6 — 2

Project Authorizations (RUP10) report: ref 6 — 47
Project fileset, implied reference to: ref I — 9
Project filesets: adm 6 — 7

findingsecondaries: usr 6 — 3; adm6-7
hierarchies: ref 2 — 12
maintaining: usr 6 — 3
updating automatically: ref I — 23, 1 — 59, I — 82,

using FMAINT wi th : adm 6-2
Project Inquiry (PI) screen: ref 5 — 45

example of: adm ~ , 8 — 3
Project manager, assigning capability: adm 6-1
Project Status (PS) screen, example of: adm 6 — 5
Project Status Change (PS) screen: ref 5 — 54

wildcards: usr5 — 3
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&5, 6-6

PUBLIC: usr 6 — 2

Projects: adm 6 — 1, 6-2
"no project" option: usr 3 — 13

associating files with: adm 6-7
authorizing users for: ref 5 — 40; adm 6 — 4
changing linkage: ref 1 — 126
changing status of: ref 5-54; adm 6 — 5
creating: adm 6 — 2
default for session: ref 1 — 97, 1 — 126
defining. ref 1 — 78
defining hierarchies: adm 6 — 3
defining manager for: adm 6-1
example of: adm W2
files in: ref 1 — 144
filesets: usr 6-3; adm 6-7

f iushing transactions associated with: adm

hierarchies: ref 2 — 12
implied reference to files: usr 3 — 5
inquiring: adm 8-5
linking fi les to: usr 3 — 13
l istof: adm ~ , 8 — 3
l ist of authorized: adm 8-7
menu of: ref 7 — 17
online listing of: ref 5 — 45
report of: ref 6 — 33
report of users authorized for: ref 6 — 47
requiring: ref 5 — 57; adm 4 — 3
selecting from menu: adm 6 — 7
specifying: adm 6-7
status change: adm 6 — 5
subset selection: usr 3-6

Projects (PJ) screen: ref 5 — 48
example of: adm 6 — 2

Projects (RPJ10) report: ref 6 — 33

Prompt:ref 1W
Prompts

changing: usr 2A
controlling: usr 3 — 12

Public filesets: usr 6 — 2
PURGE: ref 1-81; usr 3 — 7

Recursion

usl 7 — 2

Read — mode access: adm 3-4

R1: ref 1-85
R7: ref 1-85
Read access control: adm 3-4
Read mode secondary, updating: ref 1-134

Read — mode secondaries, housekeeping: adm 9 — 1

in pathnames: ref 1-6; usr 3 — 2
levels of: usr 3 — 2

REDO: ref l&6,1 — 87
Reflection: ref 1~ , 1 — 65,1 — 85
RELEASE: ref 1-88
Releases, multiple: adm 7W
Remote logon: ref 1-27

configuring: ref 5 — 37
Remote sessions: ref 1 — 39
Remote systems

linking to: ref 1 — 24, 1 — 104
logon information: adm 9-3

RENAME: ref 1 — 90
REPEAT/UNTIL: ref 7 — 21
Replacing text in files: ref 1 — 105; usr 5 — 2

variables: ref 1 — 107; usr 5-4
Reports

from command mode: adm 8 � 2
from menus: adm 8 — 1
generating: ref ~ ; adm 8 — 1
information about files: adm 8 � 2
project status: adm 8-3
redirecting. ref 6-4
retained files: ref 6 — 31

See abo Generations
SHOWLOG: adm 8-8
summary of: ref 6 — 2
transaction codes; ref 6-3
VERIFY: adm 8 — 3
version data: adm 8 — 4

Request status: usr 3 — 9
RESET (APPLICATION): ref 1 — 95, 1 — 101
RESET (EXCEPTION): ref 1 — 96
RESET (PROJECT): ref 1 — 97
RESET (ROUTE): ref 1 — 98
RESET (TQvKST~ ) : ref 1 — 99, 1 — 100
RESET'(" ) : ref 1 — 94
RESETONZERO parameter for LM) O U TPUT:

RESTORE: ref 1 — 101QA function: adm 1&
QEDIT files: ref 1 — 77, 1-108; usr 5 — 1, 5 — 3
QUIET: ref 1 — 83
QUIT: ref 1 — 39
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Retained files
See also Generation files
location of: usr 4 — 6



file reference: usr 3 — 3

Rules: adm 1 — 3

maintaining: usr 4 — 6
Retained masters, flushing: adm 9-1
Retained secondaries, flushing: adm 9 — 1
Retaining old revisions: usr 4 — 4
RETRY: ref 1 — 27, 1 — 104; usr 3 — 20
Revision Criteria menu: ref 9 — 12; usr 2-8
Revision History (RRH10) report: ref 6 — 37
Revision tree, example of: us< 4 — 2
Revisions: usr 4-1, 4 — 11

branching: usr 4 — 1

comparing:usr 4 — 9
concepts related to: adm 7 — 2
deleting: adm 7 — 4

history: ref 1 — 156
identifving: usr 4 — 2
information about: ref 1 — 138; usr 4-12
location of: usr 4 — 6
maintairung: usr 4 — 6
merging: ref 1 — 70

See also Merging revisions
printing with annotation: usr 4-11
referring to: ref 1 — 7
reports of: ref6 — 37; usr4 — 15
retrieving: adm 7 — 3
storage of: usr 4 — 4
tagging: adm 7 — 8
tags: ref 1 — 155
vs, versions: usr4 — 1; adm 7 — 1

Root revision, See Base revision
Routes: usr 1 — 3; adm 1 — 3, 4 — 1, 4 — 2

default for session: ref 1 — 127
defining: ref 5 — 57
examples of: adm 1 — 4, 4 — 2
menu of: ref 7 — 17
report of: ref 6 — 8,6 — 10
steps in: adm 4 — 3

Routes (RT) screen: ref 5 — S7

default for session: ref 1 — 98
hie movement: adm 4 — 1
setting up: adm 2 — 1
Shortcut util i ty: adm 2 — 1

RUN: ref 1 — 19, 1 — 45
Running LIBRARIAN: usr 2 — 1

S
SCAN: ref 1-105

appending to lines with match: ref 1 — 107

Screens

untracked: usr A-1

not checked out: usr A — 1

SCHEDULE variable for MAKE: usr 8 — 17

deleting lines with match: ref 1 — 107
example of: usr 5 — 3
QEDITfiles: ref 1 — 77, 1 — 108; usr5 — 1,5 — 3
replacement variables: usr 5 — 4

variables: ref 1 — 107

SCOMPARE: ref 1 — 109; usr S — 6

accessing: ref 1-49, 5-3
adding data: ref 5 — 4
breaking to UNIX/MPE: ref 5 — 5
carrying data forward: ref 5 — 5
changing data: ref 5-5
deleting data: ref 5 — 5
enter key: ref 5 — 4
exiting: ref 5 — 5
finding data: ref 5-4
function keys: ref 5 — 5
moving between: ref 5-4
movingbetween fields: ref 5-4
security: ref 5-3
summary of: ref 5-1
using: ref 5 — 4
using online help: ref 5 — 5

Searching files for text: ref l — 105; usr5 — 2
Secondary f i le : usr 1 — 2; adm 1 — 3

in progress: usr A-2
indirectly referring to: ref 1 — 9; usr 3-4
new: ref 5 — 51

ORPHAN: ref 1-61
pattern — matching: usr 5 — 3

updating with current master: ref 1 — 134
write-mode: ref 1 — 148

SECURE: ref 1 — 113
Secunty

MPE: ref 1 — 88
Setting Passwords: ref 5 — 64, 5 — 65
setting passwords: adm 2W

Security monitor: ref 1-91
error message:ref 1 — 30, 1 — S7, 1 — 68

Sequence. See Routes
Serial access control: adm 2 � 1, 3-4

Server: ref 1 — 2
configuring logon/passwords: ref ll — 1
logon: adm C — 1
passwords: adm C — 1

SET (APPLICATION): ref 1 — 117
SET (EXPDATE): ref 1 — 118
SET (LANGUAGE): ref 1 — 120
SET (LOCKWORD): ref 1 — 121

Scan
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SET (MODE): ref 1 — 122
SET (OWNER): ref 1-124
SET (PROCEDURE): ref 1 — 125
SET (PROJECT): ref 1 — 126
SET (ROUTE): ref 1 — 127
SET (TAG): ref 1 — 128
SET': usr3 — 3
SET ' ("): ref 1-115
Setting parameters using menus: usr 9-3
Setup

applications: adm 2-3
defirung steps: adm 2M
defining users: adm 2-4
deleting: adm 2 — 5
troubleshooting: adm 2 — 5

SETVAR: ref 7 — 22
Shell commands: ref 1 — 2, 1 — 3; usr 2 — 5

defining applications: adm 2-3
defining library: adm 2-4
defining steps: adm 2 — 4
defining users: adm 2M

deleting setup: adm 2 — 5
function keys: adm 2 — 3
running: adm 2 — 2
troubleshooting: adm 2 — 5

SHOW parameterfor MAKE: usr 8 — 5
SHOWLOG: ref 1 — 130, 4 — 1, 6-41; adm 8 — 8

accessing: ref 4-1
commands surnrnary: adm ~
creating listfiles with: ref 4-12

exampleof: adm 8 — 10
exiting: ref 4 — 5
generating reports: ref 4-10
getting saved settings: ref 4 — 9
refreshing display: ref 4 — 22
report format: ref 4 — 7
resetting report values: ref 4 — 15
resetting subset selection: ref 4 — 26
saving report settings: ref 4 — 16
selecting subsets: ref 4 — 24
selection criteria: ref 4 — 17
setting offline/onl ine: ref 4-13
sort sequence: ref 4 — 23
title for reports: ref 4-25
transaction codes: ref 4 — 2

SHOWLOG>EXIT: ref 4 — 5
SHOWLOG>FLUSH: ref 4-6
SHOWLOG>FORMAT; ref 4-7
SHOWLOG>GET: ref 4 — 9
SHOWLOG>GO: ref 4 — 10
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SHOWLOG>HELP: ref 4 — 11
SHOWLOG>LIST: ref 4 — 12
SHOWLOG>OUTPUT: ref 4 — 13
SHOWLOG>REDO: ref 4 — 14
SHOWLOG>RESET: ref 4 — 15
SHOWLOG>SAVE; ref 4 — 16
SHOWLOG>SELECT: ref 4 — 17
SHOWLOG>SHOW: ref 4 — 22
SHOWLOG>SORT; ref 4 — 23
SHOWLOG>SUBSET: ref 4 — 24
SHOWLOG>TITLE: ref 4 — 25
SHOWLOG>UNDO; ref 4 — 26
SIMULATE parameter for LM>OUTPUT: usr 7 — 3
SM capability, warning message: ref 5-64
Son processes: ref 1-45
Source code, annotation: usr 1-4
Source/object synchronization, exaxnple of: adm

Special characters: adm 4 — 7

Step Authorizations (RUS10) report: ref 6 — 48
Step Authorizations (SA) screen: ref 5 — 59

example of: adm 5-4
field descriptions: adm 5 — 5

Step Detail (RAD20) report: ref &-10
Step fileset, implied reference to: ref 1 — 10
Step Options (STO) screen: ref 5-76

example of: adm 4 — 10
field descriptions: adm 4 — 12

Step Options menu: usr 2 — 9
Step Refinements/Exceptions (SR) screen: ref

example of: adm 4 — 19
purpose: adm 4 — 18

Step Summary (RAD10) report: ref 6-8
Steps: usr1 — 3; adm1 — 3,2 — 1,4 — 1,4 — 3,4 — 4

authorizing users for: ref 5 — 59; usr 3 — 9
coinmand line execution: usr 2 — 9

commonly used: usr 2 — 10
copy: adm4 — 5
customizing: adm 4 — 10
date prerequisite. ref 5 — 14
default parameters: ref 5 — 76; adm 4 — 12
defining: ref 5-71
defining advanced options: ref 5 — 76
defining alternate location for: ref 5 — 32
defining ambiguous: adm 4 — 4, 4 — 13
dependencies: adm 4 — 9
description: ref 5 — 71
destination location: adm 4 — 5, 4 — 6
dialog: ref9 — 11; usr 2 — 7
entering description for: adm 4 — 10
example of executing: usr 3 — 12

Shortcut: adm 2 — 1



examples ofi adm 1 � 4, 4-2, 4 � 15

exceptions: ref5 — 66; adm4 — 18
executing: ref 1-66
explanation of: usr 3 — 1
forward versioning rules: ref 5 — 32; adm 7 — 6
implied reference to files: usr 3 — 5
inquiry: adm 8 — 5

lookup refinement: ref 5 — 67
master � to � secondary: adm 4-5, 4 � 6

rnenuof: ref7 — 17
multiple prerequisites: ref 5 — 14

System Profile (SP) screen: ref 5 — 62
example of: adm 2 — 7
SM capability: ref 5 — 64

System variables: ref 1 — 1

LIBEDITOR: ref 1 — 3S
LIBPROMPT: ref 1 — 4
source and destination: adm 4 — 6, 4-8

System — to — System Table (SS) screen: ref 5 — 69
node name: ref ~9

Systems,mass change of references to: ref 10 — 1

Systems (SY) screen: ref 5 — 85

list of authorized: adm 8 — 7

v ariable for ~ : usr 8 - 1 7

new files: adm 4 — 15
overrides: adm 4 — 12
pending productionareas: adm 4 — 15
PERFORM command: ref 1~
performing: usr 2%, 2 — 7
presteps: adm 4 — 9
refinements: ref 5 — 66; adm 4 — 18
report of: ref 6-8, 6 — 10
report of users authorized for: ref 6 — 48
request status: usr 3 — 10
restricting: ref 5 — 59
rules for: adm 1 — 4
rules for nev files: ref W51
secondary — toaster: adm 4 — 5, 4 — 6
secondary — to-secondary: adm 4 — 5, 4 — 6
sorted list of: adm 4 — 4, 4 — 13
source location: adm 4 — 5, 4 — 6
Step Options (STO) screen: adm 4-'10
Steps (ST) screen: adm 4 — 4

summary of: ref 6 — 8
tuning: ref 5 — 66
types of: adm 4 — 5
users authorized for: adm 4 � 4, 4 � 13

using: usr 3 — 9

Steps (ST) screen: ref 5 — 71
example of: adm 4-4
field descriptions: adm 4-4

Steps menu: usr 2 — 7
STORE: usr 7-4
STREAM: ref l — 13; usr 3 — 9,3-19; adm 4 — 9

Subset selection: usr 3 — 6, 3 — 7
Suspended process: ref 1 — 19
Switching modes: ref 1 — 3
System ID, changing globally: adm B — 1
System overrides: ref 5 — 85
System profile, customizing:adm 2 — 7

Text

Transactions

Tools: usr 5 — 1

definition of: adm 7-8

subset selection: usr 3 — 6

audit trail: usr 1 — 3
batch: usr 3 — 18
codes: ref 4-2,6 — 3
deleting: adm 8-8
deleting data: ref 4-6

log reporting: ref 1 — 130
logging: ref 5 — 62
memos associated with: ref 6 — 43

Tags: adm 7M

setting: ref 1-128

Targets, dependencies: usr 8 — 2
testing: adm 1-6

replacement: ref 1 — 105
search: ref 1-105

Third party software: adm 7 — 7
Timestamps: refl ­125, 1 — 131

compiling based on: usr 8 — 1
discrepancies: ref 1 — 140, 6 — 54
for MAKE: usr 8 — 20
from file label: ref 1 — 140
LIBRARIAN: ref 1 — 141
report of: ref 6 — 52, 6 — 54
validation: ref 1 — 140, 6-54

menu of: ref 9&
TOUCH: ref 1 — 131; usr 8 — 20
TRACKED parameter:usr 3 — 18
Tracking, deleting: ref 1&l
Transaction Detail (RTD10) report: ref 6 — 39
Transaction Detail (RTD40) report: ref 6 41
Transaction Summary (RTS10) report: ref 6 — 43

aging policy: ref 1&1, 5-62

files: usr 3-1
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adm 8 — 8

purging records of: ref 1-41, 4-6
report of: ref 1-130, 4 — 1, 4 — 2, 6-39, 6-41, 6-43;

status codes: ref ~2

using jobs: usr 3 — 19

User menu: ref 9 — 4
User passwords: ref 1 — 20

U

Trunk: usr 4 — 2

status of: usr 3 — 21

UNIX
background process: ref 1 — 4; usr 2 — 1
command line options: ref 1-2
commands: ref 1-3

pathnames: ref l-12; usr 3 — 8; adm 4 — 9
UNLOCK: ref 1 — 133
UNMODIFIED: ref 1 — 11; usr 3-6

inachve: adm 5 — 2

USERID wildcard: adm 4 — 7
Users: adm 5 — 1

assigning capabilities: ref 5-89; adm 5 — 3
authorizing for steps: ref 5 — 59; adm 5-4
defining: ref 5 — 91
establishing for session: ref 1 — 136

passwords: adm 5 — 2
project authorization: ref 5 — 40; adm 6 — 4
report of: ref 6 — 45
report of authorized projects: ref 6 — 47
report of authorized steps: ref 6 — 48
reports of: adm ~
sequence for defining: adm 5 — 6
step authorization: adm 5-4

Users (RUD10) report: ref 6 — 45
Users (US) screen: ref 5 — 91

deleting mass data: ref 5 — 93
example of: adm 2 — 8, 5 — 1

list of: adm 5 — 3

information about: usr &-3

Untracked files: usr 3 — 17
commands for: usr 3 — 18

UPDATE: ref 1 — 134
USE parameter for LM>OUTPUT: usr 7 — 3
USER: ref l — 136; usr2 — 3
User capabilities: ref 1 — 20

assigning: ref 5 — 89; adm 5-3
granting t emporary:usr 9 — 5

User Capabilities (UC) screen: ref 5-89
exampleof: adrn 5 — 3

User fileset maintenanceutility: ref 142
User filesets: ref1~ , 2 — 1; usr 6-1

adding files to: ref 2 — 3
creating: ref 2 — 4; usr 6 — 2
defining subsets: ref 2 — 12
deleting files from: ref 2 — 5
disconnecting subsets: ref 2 — 13
examples of using: usr 6 — 3
files in: ref 1 — 145

listing by user: ref 2 — 8
listing files in: ref 2-14
listing subsets of: ref 2 — 14
maintaining: usr 6-2
making public/private: ref 2 — 10
private: usr 6 — 2
public: usr W2
referring to: usr 6-3

removing:ref 2 — ll

switchmg: usr 2 — 3
User IDs: ref 1 — 20
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V

inrnacros: usr 9 — 3

VCOUNT. See Version count

Variables
for macros: ref 7 — 17, 7 — 22

LIBBATCH: usr 3 — 19
LIBEDITOR: ref 1 — 38
LIBPROMPT: usr 2-6
list of: usr3 � 21

MAKE: ref 8 — 7
rnakefiles: usr 8 — 12, 8 — 16
scan/replace: ref 1 — 107

Vendor software: adm 7 — 7
VERIFY: ref l — 138; usr 3 — 21,3 — 22; adm 8-3

example of: adm 8-4
retrieving files: ref 1 — 138

VERSION: ref l — 159; adm 8 — 4
Version count: usr 3 — 4, 4 — 2

referring to: ref 1 — 7
Versions: usr 1 — 3; adm 7 — 1

bringing forward: ref 5 — 32
copying: adm 7 — 3
defining: ref 1 — 159; adm 7 — 3
deleting: ref 1 — 159; adm 7W

exampleof: adm 7 — 2
files: ref 1 — 146
flushing: ref 1 — 159
forward versioning: adm 7 — 5

User identification: usr 2 — 1



XPURGE: ref 1-81
XRENAME: ref 1 — 90
XSCAN: ref 1 — 105
XSCOMPARE: ref 1 — 109
xterm: ref 1 — 2
XTOUCH: ref 1-131

identifying: adm 7 — 3
indirect file reference: usr 3 — 3
information about: adm 8 — 4
list of: ref l — 159; adm 8 — 4
obsolete: ref l — 40; adm 7 — 4
reterring to: ref 1 — 7; adm 7 — 3
report of: ref 6 — 14
report of fi les in: ref 6-50
restoring: adm 7 — 3
retained: usr 3 — 4
status of: adm 7 — 4
vs. revisions: adm 7 — 1

Versions (RAV10) report: ref 6 — 14
Video enhancements: usr ~
Violations: usr 3-12

W
WAIT: ref 7-23
WHILE/ENDWHILE: ref 7 — 24
Wildcards: ref xv, 1 — 6

?: adm 4-6, 4 — 7
adm 4 — 7

—: adm4 — 6, 4 — 7
'. adm 4 — 7
=: adm4 — 6
for pattern­matching: usr 5 — 3
special: adm 4 — 7

Work in progress: usr A — 1
simulating checkout: usr 8-5

Write Mode Secondaries by Path (RSF20) report:
ref 6 — 16

Write Mode Secondaries by User (RSF10) report:
ref 6 — 15

Write — mode secondaries: ref 1 — 148
Write — mode access: adm 3-4

X commands: usr 3 — 17, 3 — 18
X.25: ref W37; adm 2 — 5
X — terminal: ref 1-2
XCOMPRESS: ref 1-25
XCOPY: rej 1 — 29
XDECOMPRESS: ref 1 — 34
XEQ: ref 1 — 161
XEQ file, See Macros
XEQLIST: ref 7 — 13
XLCOMPARE: ref 1 — 46
XMOVE: ref 1 — 56
XPRINT: ref 1 — 76

Index xv
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